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Previzion Preface

About this Manual

This manual is provided to help users get a better understanding of the
technologies, practices and other aspects of the specifics that
surrounds your Previzion system.  It will cover all aspects of Previzion,
recommendations, configurations, updates, features and operations.

Topics and user interface workspaces are grouped in chapters and
subsections.  Each section has subsections marked by title headers.

Setting you a Previzion system requires actual training that is provided
by Lightcraft.  This manual is not intended for starting from no
understanding of the technology, but instead as a reference manual to
all active Previzion operators, owners and enthusiasts that would like to
get up to date with the latest features and functions in operations. New
features and elements are added to Previzion almost daily and this is
the best way to check what is new.

Check this documentation often.  This manual is constantly updated
without prior notice.  The priority in which things are updated and written
more about varies depending on customer input and needs.  Please
contact your Lightcraft representative for clarifications or documentation
requests.

 

 

User Information

All Lightcraft systems and system components have a 1-year factory
warranty, after which it may be renewed depending on the device.
 Lightacraft's hardware and software support services are limited to
yearly renewal fees after the anniversary of the delivery of your system
unless otherwise negotiated.  For more information, refer to our
Standard Terms and Conditions.

User Notice

All information, recommendations, documentation, screen shots and
specifications are subject to change and updates without prior notice
from Lightcraft (or "manufacturer") or any of its team members.  The
manufacturer team members writes and updates documentation based
on customer input, technical recommendations by the respective
industry standard and on field experience as professionals in the field.
 The manufacturer's system is constantly improved and perfected with
basis on customer feedback.  Any and all features described in the
manual as updates as often as possible and in no shape or form do
they reflect the very latest state of Previzion as there may be
discrepancies in build versions from machine to machine.  Should the
programs, plugins and hardware associated with your Lighcraft system
prove defective or show signs of unexpected behavior not explained in
this manual, please contact your Lightcraft Representative.   The
manufacturer is not responsible for misuse, misunderstanding
or noncomprehending of this manual that results in damage of your
system and associated equipment.

The manufacturer has a knowledgeable support team and training team

on call that can assist with any questions or concerns found in this
manual.  Should there be any section that requires updating or
clarifications, please contact your Lightcraft Representative.

The manufacturer is not responsible for consequential damages,
incidental damages or unapproved servicing and repairs that results in
damage or malfunctions.  It is the responsibility of the end-user to
properly operate, maintain and undergo servicing of their system as
instructed by the manufacturer.

Always verify with the manufacturer that voltage, temperature and
humidity is up to specifications before using the Lightcraft system in
untested conditions.
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Previzion Interface Introduction

Anatomy Of Previzion

Lightcraft's Previzion is a real-time vfx pipeline in one box.  The
interface for Previzion is designed to encompass what is sometimes
complex and cumbersome technical elements and makes it into a
series of procedural-based tabs, panes, sliders and inputs.

Like everything Previzion, features and functionalities are subject to
change and continually improves.

The basic anatomy of Previzion and some of the terminology to be
referred to in this manual are setup as follows:

1.Common Elements:
Viewer Window - Main video window to display scene,
key mattes, foreground, scene blends and depth views.
 These can be selected from the Keying Tab.
Observer View Controls - This toggle function allows
the user to view the loaded scene, camera position and
video in perspective to one another as well as the
wireframe of their scene.
Full Screen Button - Toggles full screen for the whole
application (Keystroke is "Ctrl + F").
Video Output Select - Previzion has the ability to output
two full HD-SDI signals.  This is what is being output to
set.  Set it to "None" to gray out output while making
drastic scene changes. Set it to "Matte" to output a
parallel matte output.  Or set it to "Composite" to send
the full rendered scene.
Timecode/Take Monitor - Samples a timecode to
monitor the input.  The blue "recording light" indicates
when a take is being recorded.
Memory Monitor -  Displays the used memory for the
loaded scene.
Sync Frame Viewer - Displays the actual sync rate for
which video is being timed to.  This number may
fluctuate depending on the frame rate.
Error Lights - These are your best friend when on set.
 Should there be any input in the wrong frame rate, a
missing input, a flaky input, a mismatching sync rate or a
scene that is too heavy to load in the given frame rate,
then these error lights light up pointing out to a current
problem.
Quit Button - Closes the whole application and adjacent
windows.

2.Tab Specific Elements:
Tabs - Previzion's settings and parameters are
distributed between 10 tabs: Tracking, Lens, Stereo,
Video, Keying, Garbage Matte, Scene, Color, Takes and
System.  Each one of these have very specific
configurations needed to adjust each setting in
Previzion.

Panels - Each tab has its own set of panels.  From 
Tracker to Add Mix, this is how every setting is
categorized in your Tabs.
Inputs, Sliders, Drop-Down Menus, Configuration
Windows - Previzion's interface has a handful of
components to know about:

Input boxes take in typed numbers and display
the current values.
Sliders allow you to click and drag the slider to
adjust values.  Sliders in Previzion
are demarcated by two tiny opposing arrows right
next to an Input box or by a line with a small
handle.
Drop-Down Menus - For selecting specific
settings and pre-assigned adjustments, 
Drop-Down Menus allow you to select things
quickly.
Configuration Windows - For some settings like
color pickers, tracker configurations and so on,
there are secondary Configuration
Windows that open on top of the main Previzion
window.

Observer View

Toggle into Observer View to verify your Sensor to Camera Offset or
to look around your scene to familiarize with the set.

This view is denoted by yellow corners around your viewer window.
 This is also the only way to view Wireframe in Previzion currently.

Press RESET to position the Observer View Camera on top of the
virtual camera as a way to find a starting point from which to look at the
scene.

Full Screen Mode

As opposed to maximize, full screen uses the entire real-estate of your
screen to dedicate to Previzion, avoiding distracting top bars and Start
Bars.

The Keystroke for this is feature is Ctrl + F.

Video Output Select

Previzion default HD-SDI Video Output Select is Composite for Output
1 and None for Output 2. Other available views are:

Foreground: shows the unchanged incoming live action
footage.
Unspilled: show Foreground with despilled image.
Matte: shows the current matte.
Blend: shows the detail extraction image, that will be used to
extract fine details.
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Scene Blend: shows the background image with a rough
composite of the foreground image, using only the details that
will be added during the blend operation.
Depth: shows a "near-versus-far" display of gradients to
represent the virtual depth.
Composite: shows final composite view.

Sync Warning Lights

The set of red lights highlighted above measure the current status of all
incoming data signals.

Sync Frame Rate Light - checks the rate of incoming data from
the Sync Source against the currently selected Video Format,
and goes red if they do not match.
Sync Frame Rate Display Box - The incoming data frame rate
is displayed below the Sync Frame Rate Light in the
corresponding incoming video frame rate.  This is determined by
your Sync/Genlock input which may be an analog genlock input
or by Previzion's built-in timer.  This value is more accurate than
the nominal frame rate value and may fluctuate within a .5 fps
range.
Sync Source Light - indicates when the selected sync input
source present is not compatible or missing.
Location Source Light - indicates when the selected location
tracker is not present or has a bad incoming location data.
Lens Source Light - indicates when the selected lens controller
is not present.
Stereo Source Light - indicated when the selected stereo
metadata source is not present.
Video Source Light - will light up if any of the data sources do
not provide a data sample in real time.
Frame Drop Light - indicates when a scene either has
incoming video or video playback in the wrong frame rate.  An
intermittent blinking indicates a scene that is too much
geometry, too many shadders or too many videos playing back.
 This error light comes on whenever the rendering of each frame
is taking longer than the length of a single frame itself at the
given frame rate.

When there are more than one error light on at a given time, it is often
an indicator that either something is not plugged in, has been
disconnected or has been selected when it was not powered on yet.
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Previzion Hot Keys List

 Hot keys as of Build 6903

Ctrl+F Toggle Previzion Full screen mode

F1   Tracking Tab
F2   Lens Tab
F3   Stereo Tab
F4   Video Tab
F5   Keying Tab
F6   Mattes Tab
F7   Scene Tab
F8   Color Tab
F9   Takes Tab
F10  System Tab

Shift+1  Display View Comp
Shift+2  Display View Foreground
Shift+3  Display View Scene 
Shift+4  Display View Matte
Shift+5  Display View Scene Blend
Shift+6  Display View None

Ctrl+1  SDI 1 Comp
Ctrl+2  SDI 1 Foreground
Ctrl+3  SDI 1 Scene
Ctrl+4  SDI 1 Matte
Ctrl+5  SDI 1 Scene Blend
Ctrl+6  SDI 1 None

Alt+1  SDI 2 Comp
Alt+2  SDI 2 Foreground
Alt+3  SDI 2 Scene
Alt+4  SDI 2 Matte
Alt+5  SDI 2 Scene Blend
Alt+6  SDI 2 None

 

 

 

Ctrl+Alt+I   Roll Take
Ctrl+Alt+O   Cut Take

J   Restart All Videos
K   Pause All Videos
L   Play All Videos
T   Show/Hide Screen Text
M   Enable/Disable Mattes
N   Show/Hide Mattes
C   Show/Hide Survey Markers
V   Add/Remove Light
U   Capture Thumbnail Now

H   Toggle Horizon Line
G   Toggle Wireframe mode

Ctrl+S   Save Current System State
Ctrl+T   Send System State Over Network
Ctrl+O   Load Scene
Ctrl+N   Clear Scene

P     Enable/Disable Observer View
;     Reset Observer View
Alt+;
 Resets Virtual Camera to Observer View/Observer View
 to Virtual Camera

Keying Tab Only
= Pick High Color - Pick Low Color

Tracking Tab Only
W Enable/Disable Edit Camera Position
Q Save Current Camera Position 
Page Up Go Up To Next Saved Camera Position 
Page Down Go Down To Next Saved Camera Position

Drawn Matte Window Only
Backspace
 Removes last point added and allows flipping matte s
election

Hot keys for build 6903 and above.

Download the latest Hot Keys list from the Dashboard
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Sensors

Sensors

These are the actual imaging chip(s). The common sizes found are
"Super 35",
2/3" (not really 2/3" at all — see
http://www.dpreview.com/news/0210/02100402sensorsizes.asp).

Super 35 sized sensors are found on the digital motion picture cameras,
such as the Sony F35, Red, etc. 2/3" sensors are typically found on
traditional video cameras used for news shooting like the Sony F900,
F950, and nearly any other professional camera that was not designed
explicitly for motion picture production. These cameras are called
"broadcast" or "ENG" (Electronic News Gathering) cameras, as
opposed to Cine- or "EFP" (Electronic Film Production) targeted
cameras.

The additional twist here is that lenses are typically designed for one
chip size, and the mechanical mounts that connect lens to camera are
incompatible between the sizes. Most 2/3" broadcast cameras use what
is called a "B4" mount, and most 35mm digital and motion picture
cameras use what is called a PL mount for the lens. The function is
similar (it's basically a 1/4 turn lock that snugs the lens to the camera),
but lenses are typically made for one type of camera or another.

The reason for the detail here is that the precise sensor width is the
measurement that you need in order to accurately calibrate a lens. For
the high end professional cameras, this is published, and usually found
in the manual. It always deviates slightly from the "standard" Super35
size of 24.9 mm, so if you know you'll be dealing with a certain type of
camera, you want to hunt down that sensor size early on. We have a
few of the more common standards built into Previzion, but it's worth
planning ahead.
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Lenses

ENG and EFP

A typical ENG camera will come with a single ENG style zoom lens,
which is designed to be used by a single operator. Thus, the focus ring
on the camera will go from close focus to infinity focus with about 1/4
twist of the lens barrel. It works great for news shoots, largely due to the
wide range of focus that a smaller 2/3" camera lets you get away with.
(The shot will look in focus even if you're fairly far off on the focus
setting.)

Cine-type lenses have a *lot* of focus ring travel, and are typically
marked in very fine focus increments. They are designed to be used
with a separate focus puller, a person who stands off to the side of the
camera (or rides on the dolly along with the camera), and remotely
drives the focus mechanism to make sure that the shot is focused. The
ring on their remote focus device (we were using a Preston Cinema FIZ
(Focus Iris Zoom) hand control) is marked with the same markings that
are on the lens' focus ring.

This is needed because the 35mm motion picture camera image
causes a very narrow depth of field — if you're not within a very close
range, the shot will be fuzzy and the operator gets fired.

TV news always use zoom lenses, as they are very quick to set, but
most feature film and episodic TV work uses a combination of zoom
lenses and prime lenses. "Primes" have a single focal length: 15mm,
17mm, 24mm, 100mm, etc. A production will switch back and forth from
one prime to another for various shots, going in for close-ups, etc.

A typical example would be starting out with a 18mm or a 24mm lens
for the "wide" establishing shot, then switching to a 100mm or a 130mm
lens for the close-up "portrait" shots. The longer lenses have much less
distortion, so faces look more natural in close-up shots. If they used a
wide lens, the actors" noses would look gigantic; not good.

Prime vs. Zoom

This of course begs the question — why don't features just use zoom
lenses if they are so quick? The basic answer is that until recently, it
was hard to make a zoom lens that had the same quality as a prime
lens, and even when you did they tend to be staggeringly heavy (60 lbs
+ for a modern Optimo zoom made by Angenieux.). This is fine on a
crane or a jib arm, which is where you see the cine zooms with
cine-style focus rings used, but in handheld or Steadicam type shots,
the operator just can't take the weight.

Prime lenses, since they just have a single focal length and far fewer
"elements" (pieces of glass) in the lens, weigh less and make a better
quality image than a cheap ENG-style zoom. They also have a lower F
number and are thus "faster" — the F number tells you how much light
makes it through the lens and onto the imager.

Faster lenses and higher camera sensitivities mean that you need to
haul around fewer lights to get a good exposure, which translates to
savings.

Typical ranges for modern digital cameras range from about 320 ISO
for the Red, to 500 ISO for the new Arri. The next generation of
cameras are coming in at the 1000 ISO mark, which was previously
considered the domain of high speed film. The lack of noise and
highlight handling in the new sensors make them extremely useful for
compositing work, both in the greenscreen capture and in the
background capture stages.
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Entry Pupil and Barrel Measurement

Entry Pupil

The lens "entry pupil" (http://en.wikipedia.org/wiki/Entrance_pupil) is the
location where we have to put the virtual camera in order to match up
properly to the optical properties of the lens. I'll get into this more later,
but the important points are:

1) it does not correspond to a physical part of the lens — you can't
measure it

2) in zoom lenses, it moves around a lot — many tens of centimeters —
as the focal length of the lens is increased.

Finding the correct entry pupil is critical for proper CG line-up, and it's
why we had to custom build our own lens calibration system to solve
this for each combination of zoom and focus barrel position.

Reading Lens Data

All cine type lenses have the same gear pitch on the barrels, about
0.8M/32 pitch. This is a pretty coarse gear, which is good for moving big
lenses. The various types of ENG lenses all have their own pitch by
manufacturer (Canon, Nikon, etc.) and have smaller gear teeth, so it's a
real pain to use an external focus system on these.

Fortunately, the ENG type lenses are usually encoded internally, so we
don't need a Preston type lens controller on these lenses to read what
position the barrels are at. We already read the Fujinon lens protocol,
so pretty much any Fujinon ENG lens with a serial port works with
Previzion.
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Matte Box Rails

Matte Box Rails

Usually, to remotely control the focus, iris, and/or zoom, operators need
a set of motors to drive the lenses. As noted the Preston is one of the
standards, which is why we use it. Other devices commonly used are
the Cmotion in Europe. All of these motors need to mount to something,
and we use the same mount — matte box rails.

A matte box is the funny looking square bellows on the front of the
camera lens that makes it look like a movie camera. It keeps lights from
hitting the lens directly and "flaring" the lens. Fortunately, there are only
about 3 separate standards for matte box "rails", the rods that all of this
stuff is mounted to. There are 2 sizes of rail, 15mm and 19mm, and two
sets of spacings for the 15mm rails.

- 19mm diameter, 104 mm spacing. This is the standard "big camera"
rail system on the US East Coast and Europe.

- 15mm diameter, 100 mm spacing. This is the standard "big camera"
rail system usually seen on the US West Coast.

- 15mm diameter, 60 mm spacing. This is a "video" rail system, typically
found on smaller cameras.

The Airtrack and Intersense mounts are designed around the 15mm x
60 mm spacing video rail system, and then we use a few different
adapters to mount them to the more common 100-104mm spacing.
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'Film Look', and Video Signals

"Video Look" vs. "Film Look"

The next subject is the cause of a lot of discussion among
cinematographers, which is "video look" vs. "film look". Here's what
generally makes the difference on the timing front.

Most "video" cameras used to shoot at 29.97 frames/second (or
59.94 interlaced fields/second), resulting in a very characteristic
look.
Film cameras shoot at 24 frames per second, and film is
projected at 24 fps with a triple bladed mechanical shutter that
blinks the image on and off a couple of times per frame.
Most electronic cameras that are set up for digital motion picture
shooting actually operate at 23.976 frames per second (called
23.98p). Even when the camera is advertised as 24p, if it's an
electronic camera it's 99.9% likely that it's actually shooting at
23.976 frames/second. This is so that the signal remains
compatible with the 29.97 frames/second rate that is used by
most video playback systems.
Almost all video cameras that are shooting 23.976 frames per
second transmit the data over a serial digital connection called
HD-SDI. (High Definition Serial Digital Interface.) The frame is
captured in one shot at the sensor (called "progressive scan")
and transmitted in two separate fields. This progressive
capture/segmented field combination is called 23.976 PsF. It's
used on every Sony camera (F23, F35, F900, F950), the
Panavision Genesis, and most other digital motion picture
cameras.

Pulldown

A few cameras use a 2:3 pulldown, where they shoot 23.976 frames per
second progressively, then put this into an output stream at 59.94
interlaced fields/second, by repeating fields. Since Previzion expects a
steady stream of frames, the uneven frame timing causes problems.
We have some code that can perform a reverse pulldown, and extract
the progressively scanned frames, but it's painful to deal with, and you'll
need to externally "genlock" the camera to our sensors to get it to sync
properly.

RED Pulldown

The RED cameras shoot internally at a 4k resolution, but have a live
video output that has a 2:3 pulldown that is placed into a 720p 59.94
video stream. The Previzion RED input setting automatically removes
the pulldown, so that the correct frames are shown. This also requires
an external genlock to get the sensors to sync properly. (Genlock is
discussed below.)

Synchronization with the RED is still experimental. It works, but
intermittently.
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Color Space

REC. 709

In addition to the above video signal timings, there are two color space
formats that are typically encountered, called 4:2:2 and 4:4:4.
(http://en.wikipedia.org/wiki/Chroma_subsampling#4:2:2)

A 4:2:2 signal fits into a single HD-SDI cable link, and is the most
common signal for monitoring and standard video acquisition. A 4:4:4
signal requires 2 HD-SDI cable links (called, appropriately enough,
"dual-link" HDSDI), and is more commonly used in high end feature film
production. The signal bandwidth requires a recording deck that can
handle this; the most common recording deck found on these
productions is a Sony SRW-1.
(http://pro.sony.com/bbsc/ssr/product-SRW1/)

The color space used on most 4:2:2 video signals is called "Rec. 709"
(http://en.wikipedia.org/wiki/Rec._709). This corresponds to a standard,
video-type color space, but it's pretty common on episodic shoots
because everyone understands it.

Log Color

The color space used on most 4:4:4 shoots is some form of logarithmic
encoding. This is done to more closely simulate the way a film negative
records light, since the modern digital cameras have enough range (11
+ stops) to simulate film quite closely. The problem with shooting "log"
is that the uncorrected images look kind of flat in a monitor, so a
temporary "LUT" (look up table) is applied to them for on-set viewing.
This doesn't touch the underlying image, but makes it so people can get
an idea of what the final shot will look like.

There are several different flavors of log recording — Sony's S-Log,
Panavision's Panalog, etc. They all basically do a input/output transfer
curve that causes brighter highlights to "roll off" smoothly, instead of
clipping harshly, which is a prime giveaway of a cheap video camera.
They all need to have reverse transfer functions used when importing
video recorded in log format into whatever system you'll use for
editing/FX work.

Previzion presently uses a standard 4:2:2 single link HDSDI video input
for its live keyer, and assumes Rec. 709 encoding, as it's the on stage
standard for monitoring. We have a second 4:2:2 live single link input
that works, and at some point we'll tackle reading in 4:4:4 log encoded
video, but that's a ways off.
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Timecode

LTC Timecode

In order to keep track of which frame of video/footage is which, SMPTE
standard timecode is used. Timecode shows up in a format of
hours:minutes:seconds:frames, like 01:20:03:29. Timecode has [many
forms](http://en.wikipedia.org/wiki/SMPTE_time_code), but fortunately
the only two you'll run into on a stage are LTC analog time code, and
digital timecode embedded into the vertical ancilliary section (VANC) of
the HD-SDI video signal.

LTC is described here (http://en.wikipedia.org/wiki/Linear_timecode),
but all you need to know is how to embed it into a digital audio signal,
and connect it to Previzion. This is typically done with an embedder, like
the AJA HD10AMA. There are some details on the connection at
http://www.lightcrafttech.com/support/documentation/takes-interface/tim
ecode-source/.

VANC

The other (and easier) way of getting timecode is when it is already
embedded into the HDSDI signal in the VANC area. Recorders like the
SRW-1 already do this, so if you are working on a shoot that uses
SRW-1 recorders, you just plug into their HDSDI Monitor output, and
the timecode will already be there.

Previzion is set up to automatically recognize both VANC and LTC
incoming timecode. If LTC is present, it overrides VANC.
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Genlock

Genlock

Now that we can sync the individual frames via timecode, we need to
synchronize the moment where we measure the motion and position of
the camera to the moment when the camera captures an image on the
sensor. This is sometimes a bit tricky.

Some cameras offer a "genlock" function, where their sensors will
synchronize to an external analog sync signal. The sync signal used in
all of the high definition video workflows is called "Tri-level sync"
(http://www.extron.com/company/article.aspx?id=ta062002). There are
small sync generator boxes that can create these signals (the AJA
GEN10), so one way of doing this is to run a sync signal (called genlock
in industry terms) to both the camera and the Airtrack, which is the part
of Previzion that drives the synchronization for the rest of the system.

This can work, but it means that the camera is being externally driven
by a little sync box, which is frequently problematic in terms of
organizing shoots. (You want to be as minimally invasive as possible.)
To get around this, and still get a good sync signal, we use an Evertz
digital to analog converter, the 2430DAC-HD.
(http://www.evertz.com/products/2430DAC-HD).

Creating Sync From HDSDI

This converter takes in a standard 4:2:2 HDSDI signal, and does a D-A
conversion on it. It also passes the original HDSDI digital signal out
untouched, and we then connect this output to the Previzion HDSDI
video input. The D-A conversion results in a Y'CbCr analog HD video
signal, along with a pure HD genlock output. This HD genlock is what
we then route to the Airtrack genlock input, and it works pretty well.

This basically depends on there being a very short delay between the
point where the camera triggers the sensor, and when the resulting
frame comes out the camera's HDSDI port. In practice, it actually works
pretty well. If you really yanked the camera around, you might see a tiny
temporal lag between the virtual background and live video, but in
practice it almost never happens, and it makes connecting to an
existing camera much, much easier. Some cameras, like the Arri D21,
don't have a genlock input, so this is the only way to sync to these
cameras.

Some cameras that have a 2:3 pulldown in their output (The RED, the
Varicam, etc.) require the use of an external genlock signal to sync their
sensor to the Airtrack, as otherwise the uneven cadence of the 2:3
frames in the output causes problems.
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Motion Capture

Motion Capture Overview

Here's a quick overview of several types of motion capture.

Inertial

Manufacturers:
- Animazoo
- XSens/Moven

These use an inertial sensor on each limb for measurement, as well as
a software model of the biomechanics of the human body to help
compensate for the innate drift that inertial systems experience.

Benefits:
- Wide area tracking (can combine with an Intersense IS1200 to lock
the character into the same tracking position as the Previzion camera
tracking data). Can track over a whole soundstage.
- Can operate under costumes; does not need to be visible

Problems:
- Inertial tracking not as accurate as optical based methods
- No provision for face or finger tracking
- Problems can arise when character's feet are off the ground

Active LED Marker

Manufacturers:
- PhaseSpace

Uses pulsed LED lights blinking at specific frequencies, along with very
fast linear array cameras arranged in a circle around the tracking
volume

Benefits:
- Most accurate tracking, in millimeter range
- Each LED blinks at a different rate, so the markers can't get mixed up
— less need for data cleanup in post production
- Provisions for face and finger tracking
- Very, very fast tracking — up to 400 Hz

Problems:
- Expensive to scale to large tracking ranges (needs many cameras)
- Markers on subject need to be wired up and visible

Passive Marker Optical

Manufacturers:
- Vicon
- Motion Analysis
- NaturalPoint

Uses passive retro-reflective "ping pong balls" on subject, with optical
cameras arranged in a circle around the tracking volume.

Benefits:
- More accurate than inertial tracking, less accurate than active marker
LED
- Provisions for face and finger tracking
- Low cost entry level systems ($6k for NaturalPoint OptiTrack)

Problems:
- Markers have to be visible on subject
- Cameras can be confused on which marker is which, leading to

increased data cleanup in post production
- Expensive to scale to large tracking ranges (need many cameras)
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Production Planning

Production Planning Overview
Camera Preparation
Stage Preparation
Live Action Integration
3D Asset Preparation
Shooting Operations
Post Processing
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Production Planning Overview

Overview

This is a brief summary of all of the steps that go into using a Previzion
system in production.

More details on each subsection are available in the detail sections of
the Previzion user manual.

The Previzion production process breaks down into 4 basic sections
which are covered in more detail below.

Stage/Location & Camera preparation
Set and digital asset creation
On set Previzion operations
Post processing (if required)
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Camera Preparation

Camera and Lens Choice

What camera and lens are being used?

Camera Mounting

What are your cameras being mounted on?

Tripod
Technocrane
Dolly
Steadicam
Handheld

Camera Rigging

Lens calibration and operation requires rigging the Intersense and
Airtrack units to the camera.

The mounting of the Previzion tracking system on the camera requires
a 15 mm or 19 mm matte box rail attachment, and can easily
accommodate regular matte boxes and standard teleprompters .

Lens Calibration

Lens calibration requires access to the camera and lens so we can run
the live video from the camera, which is focused on a special optical
target through the Previzion system . The image of the target is
captured 20 x for each zoom and focus distance, and that data is used
to create a customer calibration file of that particular lens.

This calibration  file enables the Previzion system to accurately map the
entry pupil location and any lens distortion for all aspects of a particular
lens. All calibration lens data is stored on a serial number bases as
every lens is slightly different.

The lens calibration process usually takes about 30 minutes for a prime
and anywhere between 90 to 220 minutes for a zoom. This information
is stored in a lens look up file which is keyed by serial number so that
data can follow the lens from camera to camera. To change lenses
takes just a few seconds to change the lens calibration file in Previzion.

Reading Lens Position

The Prevision system requires that the zoom and focus information
from the camera & lens combination is available in a digital format.
Currently we can read from any of the following camera data sources:

Preston FIZ Mark II and III lens controller
C Motion Camin lens controller
Fujinon ENG type lenses with a serial port
Canon ENG type lenses with Digi Power on zoom and focus

More detailed information on each of these is available in the manual
under the Documentation->Connections heading.

Recording Decks

Which decks do you connect to to record takes?

Tether Length

How long  is the distance from the camera's shooting location (on
stage) to the Previzion station?

The longest data tether we can support from camera to system is 300ft
(91.44m) with standard data cables.

Longer runs (up to 1km) can be achieved with fiber optic transceiver
units such as the Telecast Copperhead 3400.
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Stage Preparation

Stage Preparation

This involves the basic set up of the Intersense fiducial markers that
have been printed at an appropriate size and in sufficient numbers so
they can be recognized by the tracking camera and mounted to the
ceiling or walls depending on the nature of the shot and other set pieces
involved.

Soundstage Dimensions

What is the overall size of the soundstage? An overhead view is
valuable for planning target locations.

Stage Ceiling Height

The tracking targets have to be sized so that their diameter is between
1/5 and 1/20 of the maximum distance form the Intersense camera, In
the event that the camera is mounted on a crane or Jib we often will
have 2 different sized targets mounted on the same panel so that the
camera can have an increased range of vertical movement. More
details are here.

Fiducial Target Construction

It is important that the fiducial is mounted to a flat smooth surface,
usually spray mounted on 1/2" Gatorboard, although we have applied
them to plywood panels and even printed them on transparency film
which was mounted to the spacelights on a stage. These Gatorboard
panels can easily be screwed in place, clamped or tie wrapped to the
grid or ceiling.

The orientation of the markers is quite flexible, as we calculate the
surface normal when we survey them, and record that data along with
the exact position for each target.

Tracking Target Mounting

Care must be taken in the mounting of the targets to the ceiling or
lighting grid so that a minimum of 4 targets are visible at any time. We
tend to err on the side of caution and will overpopulate the stage with
targets by a factor of 2 or 3 x what is required in order to be able to
cope with the inevitable occlusions (blocking of targets) that can happen
with light, flags and wires during a hectic shoot.

The tracking camera has roughly a 80 degree field of view and is
adjustable so it can be used on under-slung heads or other support
systems that may interfere with its view of the markers.
For instance we often will put a row of markers just above the green
screen in order to extend the field of view when the camera is pointed
down at an extreme angle.

Tracking Target Survey

The survey of the mounted targets on the stage is usually done with a
surveyor's tool called a total station. A large stage with 200-300 targets
can take approximately 3 hours to complete. It is very important the the
targets are mounted securely and that they don't move after the survey
has been made. The more accurate the measurement of the position of
the targets is measured the more accurate the camera tracking will be.
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Live Action Integration

CG Element Integration

Visible seams between CG and live action elements cause the most
difficulty, due to the difficulty of achieving a subpixel match in real time.
It is recommended to hide the seams between CG and live action
whenever possible, so that small amounts of sliding are not noticed.
Ways to achieve this include:

Feathering the practical surface (sand, etc.) to a green floor
Having a raised live action edge, so that the intersection to the
CG is hidden

Practical Objects

What practical objects will be present in the scene? Tables, chairs, and
midground objects are very helpful for selling the shot.

Practical Floors

Our first recommendation here would be to make the floor practical
using real tiles. This will limit the amount of floor contact between your
actors and CG elements.

Greenscreen floors cause a very large amount of green spill to be
reflected onto the actors, and make it very difficult to key correctly
without many artifacts.

Stage Photographs

Photographs of the stage are very useful for planning.

Matched Coordinates

For 3D CG elements to connect to live action elements, the CG
elements must be modeled precisely, with 1 CG unit = 1 centimeter.
Previzion's model units are all centimeters.

In addition, the live action coordinate system origin must match the CG
coordinate system origin. (0,0,0) must be located in the same place for
both CG and live action for an accurate match.
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3D Asset Preparation

3D Assets

Previzion uses standard FBX file format (version 2010.2) and
Collada(.dae) format, which can be generated in most standard 3D
packages. The files are created with baked in textures, and the data
should be cleaned to remove modeling artifacts like object history,
duplicate polygons, excessive polygon count and to keep textures
within an 8 GB limit, look here for further details on clean scenes.

It is usually a good idea to run the data past our shading expert to verify
that there is not too much other junk floating around in the file, (things
like duplicate points and big Maya modeling history can cause
problems).

There is extensive support for custom shaders in Previzion for
reflections, bump maps and other sophisticated surface treatments.
Previzion includes a version of these shaders that can be used in Maya
so that the performance and look of the models can be tested off line
with out tying up the Previzion system. Details on these shaders can be
found here.

Additional shaders can be requested from us if you need a particular
look. At this point in time we don't support sophisticated lighting, so
baked in textures work the best. The system can handle multiple 2K
animated textures and up to 12K texture maps.

As with any real-time system you can slow it down by throwing too
much data at it. Generally anything under 6,000,000 polys and 1
gigapixel of textures is okay. Previzion can handle more polys at the
cost of texture count, and vise versa.

Photogrammetry

A lot of work has been done in developing a Photogrammetry pipeline
that enables the designer to create photo realistic models by using a
series of overlapping photos of an actual location. This enable them to
get a very good and realistic model in a matter of a few days instead of
the weeks that it can take to create the same look synthetically. All of
these techniques are extensively documented on our web site under the
support tab.

Photogrammetry

Video Assets

Previzion can decode and playback multiple 1920×1080 HD videos
encoded in the MPEG2 format, as well as a limited number of 4K
videos.
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Shooting Operations

Shooting

On Stage operations are generally pretty straightforward and involve
the following steps.

Set up various video and data cables between the camera and
the Previzion computer. This includes genlock for data
synchronization and timecode data inputs for Previzion, and the
feeding of the HDSDI composited output signal to recorders, HD
capable camera viewfinders, and on set monitors.
The set and camera calibration files are loaded, and key offset
parameters are recorded for the Intersense camera to focal
plane offset. The keyer levels are set and color balance can be
adjusted for the best match between the foreground and
background.
After the lighting has been set on the green screen the operator
would then set up the keyer levels, adjust the matted density
and background mix, then add in any garbage mattes if
necessary. If the output is going to be a final in camera
composite, the operator then sets up color matching between
the foreground (green screen player) and the 3D backgrounds
or plates.
When the camera is rolling the operator records all camera
tracking data through the Previzion take system including shot,
take, show as well as any changes that have been made to the
3D environment. This is recorded into a Collada text file for post
processing, as well as capturing a jpg image every 10 seconds
for reference.

Monitoring

The Previzion system continually displays tracking data and a visual
lineup, so you can verify that everything is working properly. The UI has
a series of status lights to indicate any errors or broken connections to
the camera.

We strongly recommend providing a Previzion composited output to the
camera operator as it makes a huge difference is setting up a shot
when you can see it all together. This also is a big help in adjusting
lighting to match between the green screen and synthetic elements.
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Post Processing

Post Processing

In the event that the end user is going to render and composite
backgrounds in post, the various take files from production can be
processed though our Take Converter software. This enables the user
to select specific ranges of data, by timecode, and format the output to
suit the various 3D packages and post pipelines.

Almost every 3D system treats concatenated rotations slightly different,
so the Take Converter also formats the output so everything matches.

Take data can also be used with post tracking systems as seed tracking
data, which dramatically simplifies the tracking and subpixel alignment
of the 3D elements with the live action footage.

Survey data collected during stage prep can also be used as seed data
to speed up the post tracking pipeline.

Programs

We have worked out simple pipelines for certain programs.

PFTrack
Syntheyes
3D Equalizer

Other programs, like Nuke, can be compatible with Previzion data, but
we have not worked out the pipeline in-house.
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Surveying Instructions

Survey and Total Station Instructions
Coordinate Systems – Cartesian Model and Northing, Easting and
Elevation
Surveying for Visual Effects
Survey Elements
Using the Portable Target Boards (Floor Targets)
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Survey and Total Station Instructions

Surveying Process

The surveying process is a procedural one and, by following these
instructions, you should be able to survey an entire stage from
beginning to end.

The order of the survey process:

physical setup of survey instruments
configure data collector
measure and store points
move to another physical location (if necessary)
finish measuring points
export points

The survey process can take anywhere between 1-5 hours depending
on the size of the stage and visibility of targets.  Stages with wires and
lights in the way of the targets will take longer because you will need to
move the survey instrument to multiple locations to capture all points.

Required Equipment

Survey equipment can vary depending on the application.  For the
purpose of surveying for Visual Effects and Previzion, you will need the
following equipment:

Total Station with Reflectorless Mode - this allows the total
station to take measurements without the use of a prism or
reflective stickers.
Right Angle Eye Piece - for surveying points overhead, a
90-degree eye piece makes it easier to see the targets.
Total Station Tripod  and Spreaders - the tripod and tripod
spreader are important tools.  Without these, the survey gun
cannot be properly leveled.
Data Collector - this is a separate piece of hardware that acts
like a handheld computer.  The Data Collector is able to store
and output point data as well as configure the total station.
Bluetooth Data or Serial Data Cable for Data Collector – for
the Data Collector to communicate with the Total Station, you
will need either Bluetooth connectivity or a hard wired serial
cable connection.  We recommend having a cable as Bluetooth
often drops out in sound stages.

When working with professional surveyors, their tools may differ. Read
notes about this on Surveying for Visual Effects.

The survey instruments often come in their own transport bags or
protective cases.

 

Physical Setup of Survey Instruments

When picking the place to set your survey instruments, keep in mind
that the first place you set the survey tool will become the "Origin" of the
survey.  That will be the place where all measurements will be
measured from.

Make sure the first physical setup has enough clear line-of-sight to the
center of as many targets as possible.

 

Assembling Tripod and Spreaders

We start by assembling the tripod spreaders or tripod stabilizer.
 The spreaders have three rubber rings and is made up of three steel
bars with threading and screws on the ends.

1.With the rubber rings around the steel bars, join the two ends of
the spreaders forming a triangle.
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2.Unscrew the thumb screw and place the end without a thread on
top of the threaded end.

3.Place the screw through the two parts and tighten firmly.

4.The screw will be holding the parts together.

5.With the spreader on the floor, position one rubber ring in each
corner.
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6.The ring should be in the space under the raised bar on each
corner. 

7.We are ready for the wooden tripod.

8.Undo the leather loop and spread the tripod legs.

9.With the tripod upright, position each one of the legs' spike on
the center of the thumbscrews on the spreaders.

10.Holding the tripod down, stretch the rubber ring on top of the
tripod's foot.

11.This should be done for each tripod leg.  This makes the tripod
and the spreaders move as one.
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12.One leg at a time, raise the tripod to a comfortable working
height. Undo the butterfly screw with one hand and raise the
tripod with the other.

13.Finger tighten the butterfly screw at the proper height.

14.Repeat this for each leg.

15.We will now remove the top mount screw cover.
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16.Undo the large hand screw under the top mount of the tripod.

17.Remove the top cover.

18.There is a metal clip on the cover.

19.Secure the cover on the raised side mounts on the tripod.
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20.The cover should clip securely to the mount. 

21.The tripod is now ready for the survey gun.

 

Mounting the Survey Gun

The survey gun will need to be mounted on the tripod and leveled.

1.Using both hands, place the survey gun on top of the tripod.
 Align the screw on the top of the tripod with the threaded hole in
the base of the survey gun.
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2.Still holding the survey gun, firmly tighten the screw to the
survey gun.

3.Still holding the survey gun, check that the instrument is
securely fastened.

Battery Compartment

1.We are ready to insert a battery to the survey gun.  Locate the
side of the gun with a small latch.

2.The latch releases by pushing the gray tab down.  This releases
the latch.
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3.Pull to open the small door for the battery.

4.Insert the proper battery with the pins facing down.

5.Gently close the battery compartment door.

6.Lock the door latch by pushing the tab in.
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Leveling the Survey Gun

In order to properly measure points, the survey gun needs to be
properly leveled.

There are three levels of leveling the survey gun: two analog and one
electronic.  Some survey guns are equipped with just two levels: one
analog and one electronic.

1.First we do a coarse leveling. Locate the coarse circular bubble
level.  At this point, the bubble will not be leveled.

2.Using the tripod legs, one at a time, level the survey gun looking
at the coarse bubble level.

3.Repeat this process for each leg always looking at the circular
bubble level.
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4.Get the bubble as close to the center of the bubble level as
possible.

5.Next, we will do a semi-accurate leveling.  For this, locate the
long bubble level on the side of the survey gun. If your survey
gun is not equipped with a long bubble level, skip to step 13.

6.Locate the pan lock and unlock pan by gently turning it 90
degrees to a horizontal position. 

7.Rotate the instrument to make the display parallel to two of the
bottom leveling screws.  There are three of these
back leveling screws. Align the display to any two of them.
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8.Using just one of leveling screw at a time, rotate the screw to
adjust the long bubble level.  Spin the screw counter-clockwise
(left to right) to make the bubble move right and clockwise (right
to left) to make the bubble move left.

9.You are done when the bubble is centered within the two larger
lines.

10.Rotate the instrument 90 degrees.  Aligning one of the sides of
the gun square to two of the alignment screws.

11.The other side of the survey gun will be aligned with the third
alignment screw.  Rotate this screw to level the instrument. Spin
the screw counter-clockwise (left to right) to make the bubble
move right and clockwise (right to left) to make the bubble move
left.
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12.You are done when the bubble is centered within the two larger
lines.

13.Next, we'll do an accurate-leveling.  For this, we will need to
turn the instrument on.  If the instrument is not turning on.  Make
sure you have a battery in the instrument.

14.Some total stations start up with the electronic tilt automatically.
If your total station is already on the TILT screen, skip to step 16
.  If it does not go to the level, on the main screen, locate and
press FUNC to toggle the function keys.

15.When the option TILT shows as one of the function keys, press
that function key.  In the image below, we have F2 as our TILT.
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16.This will show a very accurate electronic version of the analog
levels.  We need to level the instrument as close to zero minutes
and seconds as possible.

17.Just like before, use one leveling screw at a time to level the
instrument.  Note that, the adjustments should be very subtle at
this point.

18.You are done when the tilt angles are close to zero.  At this
point, the instrument's leveling is so precise that standing next to
the instrument from different sides will offset the level.

19.This menu is also where, in some survey guns, there is a
function button labeled L-ON. This will turn on a laser pointing
down on the ground that indicate the exact position of where
the occupy point is. (The current point that the survey gun is
in.)

20.To exit this screen, press ESC.  This takes you to the main
menu.
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21.You are ready to setup your Data Collector.

Total Station Communication Setup

Total Stations sold by Lightcraft Technology are pre-configured to work
with the serial cable as well as Bluetooth, when available.

In case the total station was reset or is not communicating properly,
navigate to the configuration menu as follows:

1.From the main screen, press ESC to see the access to
the CONFIG option.

2.Using the "F" buttons, select CNFG. 

3.Using the arrow buttons, arrow down to highlight Comms

setup.  Press the enter ( ) button to enter the menu.
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4.Using the arrow buttons, adjust the settings as follows:

Wireless: NO
Baud Rate: 9600bps
Data Bits: 8bit
Parity: Not set
Stop Bit: 1bit

Check Sum: No
Xon/Xoff: Yes

 Reflectorless Mode

To survey regular surfaces without the aid of a prism or retro-reflective
material, you will need to set the Total Station to reflectorless mode.

- Sokkia Gun

1.Next to the Battery Icon, there will be one of three icons
indicating the mode the survey gun is in.

2.Reflectorless Mode has an icon with an arrow and a line

3.If you are seeing anything that is not this icon, press the SFT
button toggling the modes until reflectorless mode is selected.

- Sygnus Gun
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1.Press the (*) (star key) to view the instrument options.

2.Use the Arrow up and Arrow Down ( ) to navigate
to NP/P.  NP and P stand for Non-Prism and Prism, or 
reflectorless and reflector mode respectively.

3.Set the device to NP mode,
or reflectorless (Non-Prism) mode.

4.In the main display you should see the NP indicator showing the
system is in reflectorless mode.

5.This setting needs to be changed every time the survey gun is
turned off.  The survey gun will default back to prism
(or reflector) mode when it looses power.

Connecting the Data Collector

Some data collectors are equipped with Bluetooth, but it's preferred to
use the Serial cable for reliability over the course of your survey.

The Data Collector cable has a Hirose connector on one end and a
Serial DB9 connector on the other.

 

1.Locate the DATA OUT or DATA port on the side of your survey
gun.

2.This is often under a protective cover.  Remove the cover to
reveal the connector receptacle.

3.The male end of the connector will have raised keys to register
the position to insert the connector.

4.With the correct orientation, gently push the connector until it
clicks in place.

5.The Data Collector will have, usually at its bottom, a male DB9
connector.
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6.Connect the Serial Cable to the Data Collector.

7.Use the thumb screws to lock the connector in place.

8.The back of the Data Collector should have a metal clip.

9.Use the metal clip to rest the Data Collector on the side of the
tripod.
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Setting Up SurvCE

The Data Collector runs on a Windows Mobile OS.  There is a small
Windows icon in the upper left corner of the screen.  This is the start
menu.

1.Tap on the start menu and select SurvCE.
2.This opens SurvCE and prompts you to either Continue Last

Job or Select New/Existing Job. We will begin with a new job.

3.This will open SurvCE's documents or jobs.

4.By tapping the Name box at the bottom of the screen, you will
be able to enter the name for your job. The SurvCe
keyboard takes some getting used to, but all the functions are
there.

5.Once you have named your Job you are ready to proceed to
setting up the job parameters.  Confirm by tapping on the Green
Check mark on the upper right corner.
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6.Next, check that your system is setup for:
Distance: Metric
Angles: Degrees, Minutes, Seconds
Zero Azimuth Settings: North
Projection: USA/..

Confirm by tapping on the Green Check mark on the upper
right corner.

7.The next screen confirms the measurements for the first point.
 This first point is our Occupy Point, the point where the total
station is currently sitting on.

Point ID, know to always leave it as a number.  SurvCE
auto increments the number to the next unused digit.
 We'll start with the number 1
Northing, Easting and Elevation, make sure to set
these to 0.000 meters.
Description will be "Home", "Start" or "OP" (for occupy
point).  This needs to have letters in the name (alpha
characters).

Confirm by tapping on the Green Check mark.

8.This will take us to the main screen. Next we need to
communicate with the Survey Gun.

9.The Survey Gun needs to be powered on and connected to the
Data Collector with the Serial Data cable.  See Connecting Data
Collector for instructions.

10.On the Data Collector, select the Equip tab.  Then tap on Total
Station.
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11.This opens Instrument Setup's Current tab.  If you have a
known preset that is saved, you may load it here. Otherwise,
use the following settings to create your own setting and to save
it.

Under Manufacturer, select Sokkia or whichever is the
correct manufacturer for your Total Station.
Then select the Model of your Total Station from the
dropdown menu.  In this example, we are using a Sokkia
SET 330R.

12.Under the Comms tab, check that the connection is cabled with
the following settings:

Type: Cable
Device: Cable or Generic
Port: COM 1
Baud: 9600
Parity: None

Data: 8
Stop: 1

You may have noticed that the Data Collector settings match the
Total Station Communication Setup.

13.Under the Settings tab, set the following to:
EDM Mode: Fine
Target Type: Reflectorless
Prism Offset: -30mm
BS Prism Offset: -30mm
Target Sheet Offset: 0.0
Compensator: Two axis

This tells the data collector to read points in reflectorless mode.

14.Under the Inst tab, leave these settings to the default ones.
 They should be approximately:
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Temperature: 22.00 Celsius
Atm. Pressure: 1024 hPa
Zero Hz Angle to Target: Unchecked

15.Finally, back to Current tab, under the list, select SAVE to save
these parameters for future use.Mention in the name it's a
"cable" connection.  

16.Tap on the Green Checkmark for both windows.  This will make
the survey gun beep a few times confirming that the settings
were received from the data collector. IMPORTANT:  If the
survey gun does not beep, check your settings again and make
sure the Serial data cable is plugged in correctly.The data
collector will return to the main menu.

Identifying the Master Side of Total Station

The Total Station or Survey Gun has two identical sides.  The display
and all the buttons are identical on either side.  However, all
measurements must be done from the master side of the instrument.

Whenever taking measurements, make sure to stand on the Master
Side.

The Master Side is indicated by the two adjustment knobs: tilt knob
and pan knob.
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The Dumb Side has the same LCD display and all the same buttons,
but you should not use it when measuring points.

 

Backsight Setup

In order to measure points with the total station, the instrument needs a
projection model that measures the distance of points based on the
angle difference of an initial reference point in an Azimuth "heading".
 This is called backsight point.

Backsight defines the orientation of the coordinate system.  An easier
way to think about backsight is to compare it to a map where the
backsight determines which way is up.

1.In the main SurvCE window, select the Survey tab and then 
Store Points.

2.Next, we have the Single Setup configurations.  Pay attention
to the settings on this window.

3.The first field is Occupy Point. You will notice that the Occupy
Point is already entered.  It defaults to the number "1". When 
Setting Up SurvCE  we save the first point, it becomes point

Page 51

http://www.lightcrafttech.com/wp-content/uploads/2014/07/DumbSide.jpg
http://www.lightcrafttech.com/wp-content/uploads/2014/07/DumbSide.jpg
http://www.lightcrafttech.com/wp-content/uploads/2014/07/Data-Collector_0025_Main-Store-Point-Screen.jpg


Previzion - User Manual
by Lightcraft Technology

number 1: the current occupy point. 

4.The second field is Instr. Height, short for "instrument" height.
 This is a measurement in meters from the floor to the 
reference line on the side of the survey gun.

5.Identify the height reference line on the side of the survey
instrument.

6.Use a metric tape measure to measure the height of the
instrument.  Position the tape measure as square and vertical to
the floor as possible.

7.Make sure to use measurements in meters.  In the example
shown, the tape measure is in centimeters: 151 centimeters is
1.51 meters.
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8.Enter the proper height measurement in the Instr. Height field.

9.Next, we need to enter a number for Backsight Point.  This
field must be a number. Because we have not measured this
point yet, we need to enter the value by hand.  Since point ID 1
is our occupy point, the next available point ID is 2.

10.Leave the other fields as they are:
Backsight N Azi: 0°00'00"
Backsight HT: 0
Use Backsight HT for Foresights: unchecked

11.We now need to measure the Backsight Point.  Pick a location
in the stage that is somewhat square to the green screen and
"forward" onto the screen. It's helpful to use a permanent mark
on the stage itself or the green screen.  In some instances, it's
easier to add a "quick stick" sticker to where you want to place
your "forward" axis (the x-axis in Previzion).

12.Turn the reference laser on by holding down the "Light" button
until you hear the instrument click and the laser is on. 
WARNING Direct laser radiation can cause vision damage.
 Avoid direct eye exposure. Do not stare into the beam.
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13.In order to properly point the instrument to a point, you need to
unlock both tilt and pan with their respective butterfly locks. To
unlock the tilt knob, turn the lock 90 degrees counter-clockwise
to make it horizontal.

14.Do the same to unlock the pan knob.

15.Using the laser as reference, you can now roughly point the tool
station as close to the center of the target as possible.

16.To lock the tilt knob, turn the butterfly lock clockwise by 90
degrees to make it vertical.
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17.Do the same to lock the pan knob.

18.With both pan knob and tilt knob locked, use the tangent
rings to do fine adjustments to pan and tilt.

19.From the  instrument's eye piece, you should be both seeing the
alignment cross as well as the point in focus.  This is how you
know the point is properly measured.The laser alone can
sometimes be too wide when compared to the eyepiece's
bullseye.

Make
sure that you are measuring the point standing in the Master
Side of the survey gun.

20.Now that the instrument is accurately pointing to our
reference Backsight Point, we need to tell the data collector
to trigger a measurement and store it. Back where we left off in
the Single Setup screen, press Backsight in the lower right
corner of the screen.
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21.A dialog window will prompt if we want to Continue in

Reflectorless mode. Press Yes, to continue.

22.Next, we are prompted to either enter point coordinates or use a
backsight Azimuth. Press Use Azimuth to continue.

23.Next, we are prompted to either go back or continue to measure
our backsight point.

Press Continue to enter the Backsight set angle window. 

24.In the Backsight set angle window, at the bottom of the page,
press Set Angle and Read. Note that the green check mark is
grayed out.
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25.This will trigger the survey gun to click and make the laser blink.

26.The check mark is now green.  Press the green check mark to
confirm.

27.This opens a dialog window prompting the Description of
the Backsight Point.

As determined earlier, the Point ID must be a number.
 It should automatically be set to 2.
For the Description, use BP or BS for backsight point.

28.This takes us to the main Store Points window.

Surveying Points and Focusing Instrument

With the survey gun properly setup, we can start measuring points.

1.Pick a fiducial board to start surveying.  In the example below,
we will survey the center board, starting with the fiducial marker
numbered 4500.
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2.Turn the reference laser on by holding down the "Light" button
until you hear the instrument click and the laser is
on. WARNING: Direct laser radiation can cause vision damage.
 Avoid direct eye exposure. Do not stare into the beam.

3.In order to properly point the instrument to a point, you need to
unlock both tilt and pan with their respective butterfly locks. To
unlock the tilt knob, turn the lock 90 degrees counter-clockwise
to make it horizontal.

4.Do the same to unlock the pan knob.

5.Point the instrument to the center of the marker using the
reference laser.

6.When the reference laser being close to the center of the
fiducial marker, lock the tilt and pan knobs. To lock the tilt
knob, turn the butterfly lock clockwise by 90 degrees to make it
vertical.
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7.Do the same to lock the pan knob.

8.For each point, you will need to know how to FOCUS THE
INSTRUMENT.  There are two focus rings: diopter ring
(smaller) and focus ring (larger). When the ground glass cross
pattern is blurry, adjust the diopter ring.  Always start with the 
diopter ring and move on to the focus ring after.

9.The eyepiece itself has a ring for diopter compensation.  If you
wear corrective lenses, to survey without your glasses, you may
use this ring to focus the image.

10.Use the diopter ring to adjust focus only looking at the ground
glass cross pattern.

11.The larger cylindrical black portion of the eyepiece is
actually a focus ring.  Use this only after adjusting the diopter
ring first.

Page 59

http://www.lightcrafttech.com/wp-content/uploads/2014/07/FTN_9974.jpg
http://www.lightcrafttech.com/wp-content/uploads/2014/07/FTN_9974.jpg
http://www.lightcrafttech.com/wp-content/uploads/2014/07/FTN_9974.jpg
http://www.lightcrafttech.com/wp-content/uploads/2014/07/FTN_99821.jpg
http://www.lightcrafttech.com/wp-content/uploads/2014/07/DiaopterFocus.jpg
http://www.lightcrafttech.com/wp-content/uploads/2014/07/DiaopterRing.jpg
http://www.lightcrafttech.com/wp-content/uploads/2014/07/DiopterFocused.jpg


Previzion - User Manual
by Lightcraft Technology

12.Use the focus ring to adjust focus looking at the actual image.

13.With both pan knob and tilt knob locked, use the tangent
rings to do fine adjustments to pan and tilt.

14.Using the pan tangent ring to move the ring until the image is
aligned in the pan axis.

15.Do the same for the tilt tangent ring.

16.Move this ring until the center cross hair is aligned with the
desired target.
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17.The target is now ready to be measured.  Back in the data
collector, we will use the target number, in this case 4500 as
the Description.

18.Input the description as numbers only.  In this case, the board
being measured is number 4500.

19.There are a series of buttons on the top row of the screen: "R"
for "read point", "S" for "store point", "T" for "traverse", "O" for
"offset, etc. Press "S" to read and store point.

20.You will then receive a confirmation of the current reading.  This
screen is very valuable.

Pt ID - This field is automatically entered and shows the
current point ID.  Point ID 1 is our current Occupy Point,
Point ID 2 is the Backsight Point, which makes the next
incrementally available point, ID number 3.
HT - should always be set to zero.  This will
automatically be set to 0.
N: - is the "Northing" measurement, in meters.
E: - is the "Easting" measurement, in meters.
Z: - is the "Elevation" measurement, in meters.
Desc - this is the description of the point and as set in
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the previous screen, it should be the number of the
fiducial circle being measured.

If all the numbers appear correct, confirm by pressing the Green
Check mark.

21.The new point will show in the main store points window like an
overhead diagram.

22.As more points are measured, you will notice points being
grouped in groups of 5, like they are on the fiducial marker
boards.

Continue adding points until your boards are all measured.  Should you
run into points that are occluded or out of sight, move the total station to
another position using Resection below.

Resection Function

Often times, when surveying a stage you may need to move to another
location either because not all points were visible from the first location
or because you needed to move out of someone's way.

For this and other uses, you may Resection back into a survey.  This
function makes use of 2 or 3 known points that you re-measure from
this new location.  This will calculate where the total station is  and
place it in the same coordinate space.

Once this new occupy point is calculated, you may continue adding
points to the survey.

1.For the Resection Feature, we will start SurvCE, but we will
choose to: Continue Last Job
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2.In the Survey tab, select Resection.

3.This opens the Resection window.

4.Start with - and this is VERY IMPORTANT - entering the
proper instrument height in meters.

5.Just like before, this is measured from the floor to the horizontal
reference line.
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6.In the example shown, the instrument height is 151 centimeters,
which is 1.51 meters.

7.Next, tap on the point list button to view all the points in the
survey.

8.This opens a list, like a spreadsheet, with all the points in the
survey.  The first few columns don't show the
target Description.

9.Scroll to the right to reveal the column.  The Resection
reference points can be any one of the 5 fiducial circles on a
board. In this example we are using point 1850. Tap on the
correct row and commit with the Green Check mark.
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10.Back in the Resection window, the Point ID field will have the
number of the Point selected. Point the survey tool to the
selected point. In this example, our Point ID 12 is fiducial
number 1850.

11.When the survey instrument is properly aiming at the center of
the reference marker, press READ to trigger the survey gun to
shoot.

12.This will trigger the survey gun to click and measure the point.
 In the data collector, and this is VERY IMPORTANT, there will
be a dialog window asking: Would you like to zero the
instrument? Select NO!!!

13.The next window will have your reading results for this first
reference point. Leave Target Height at zero.

Page 65

http://www.lightcrafttech.com/wp-content/uploads/2014/07/Data-Collector_0011_Point-List.jpg
http://www.lightcrafttech.com/wp-content/uploads/2014/07/Data-Collector_0011_Point-List.jpg
http://www.lightcrafttech.com/wp-content/uploads/2014/07/Data-Collector_0011_Point-List.jpg
http://www.lightcrafttech.com/wp-content/uploads/2014/07/Resection1.jpg
http://www.lightcrafttech.com/wp-content/uploads/2014/07/ResectionRead.jpg
http://www.lightcrafttech.com/wp-content/uploads/2014/07/ResectionZeroInstr.jpg


Previzion - User Manual
by Lightcraft Technology

14.We will need to do this again for a second and a third point.

15.After the second point, the Calculate button will be enabled.

16.After the third point is measured, press Calculate.  This will
open Review Resection window. Check elevation (Z:), which
should be zero or close to zero, unless you are at a stage where
there are multiple levels or stairs where the total station is setup.

17.Next, we save the current resectioned location as a new point.
In the Description, save it as RS1 or Resection.
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18.In the Survey tab, select Store Points. The fields for Occupy
Point, Instr. Height (Instrument Height) and Backsight
Point are all set according to the Resection process. Instead of
measuring another backsight point, confirm by pressing the 
green check mark. 

19.You are now ready to add more points to the survey.

 Export Survey

To export the survey to use in Constellation Tool, use the Export
Function.

1.In the File tab, select Import/Export.

2.Then select Export Ascii File.
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3.In the Export Ascii window, select the following settings:
Coordinate Order: North,East,Elev,Desc
Delimiter: Comma
Range: automatically selects all points
All other checkboxes should be unchecked.

4.Save the file with a unique name.

Troubleshooting

If your screen ever reads Out of range, this means that the instrument
is not leveled.  See above for Leveling Total Station instructions.
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Coordinate Systems - Cartesian Model and Northing, Easting and Elevation

Cartesian Model to Three
Dimensional Model

In a 2-axis Cartesian model, we have X axis running left to right and  Y
axis running down to up.

Points in this model are defined by two values: X and Y.

In Visual Effects and Surveying, we add a third axis to define points in
three values.

For this, we use a three dimensional Cartesian Model with X, Y and Z
axes.

It's important to note that, in Previzion, X-axis run back to front
and Z-axis runs left to right.

In surveying, the same model applies, but the axes have a different
name:

Northing: X-axis
Easting: Z-axis
Elevation: Y-axis

Northing, Easting, Elevation to XYZ

When converting from the survey coordinate system from
Northing,Easting,Elevation denomination to X,Y,Z denomination, flip the
second and third values.

Just remember that Y is always up.  And in Surveying terms Y is
Elevation.

This difference is important to keep in mind because, in the survey files,
Elevation, the Y-axis, is the third item, while in Previzion
coordinates, Elevation is the second item in the coordinates.

Northing = X
Easting = Z
Elevation = Y
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Surveying for Visual Effects

Purpose of Surveys

It's not uncommon in virtual productions to use high accuracy
measuring tools like LIDAR or Survey guns.  The Total Station
or Survey Gun functions like a laser tape measure, but with points
measured in three axes: Northing, Easting and Elevation, or XZY.

Sokkia CX-105

For accurate real time tracking, Previzion utilizes data from the
Intersense IS1200 VisTracker.  The IS1200 sensor uses fiducial
markers that are used to reference the position of the camera in 3D
space.

For this to happen, the position of each of the fiducial markers
(or targets) needs to be measured with a Survey Gun.  At the center of
each target, there is a tiny little cross in the optical center of the target.
 This cross is what we need to measure with the Survey Gun.

Fiducial Center Cross

The measurement of all of the targets' centers are then exported from
the Survey Gun to Previzion through a Constellation File.

Coordinate Systems in VFX and Surveys

Nearly all post production tools in the 3D computer graphics world are
based around a 0,0,0 origin as the center of the 'world'. The reason for
this is straightforward; since a computer has a limited number of bits to
represent a number, one can get into strange numerical errors when
one uses very large positive or negative numbers to do all of the
transformations that computer graphics requires.

It is common practice in surveying to start off with a very large positive
number, to avoid having any negative values in the survey. However, as
can be guessed, this conflicts with the practice needed in computer
graphics.

We explain more about coordinate systems in Coordinate System -
Cartesian Model.

Previzion to Surveying Relative Axes

Since Previzion is a 3D computer graphics system, and both sends and
receives 3D data from other post production computer graphics
systems, its world is also based around a 0,0,0 center. The
recommended practice is to specify some point relatively near the
camera to be 0,0,0, and to point the +X axis away from the camera and
the +Z axis to the right of the camera.

This matches cleanly with the standard total station use of northing,
easting, and elevation axes:

Northing = X-axis
Easting = Z-axis
Elevation = Y-axis

Working with Surveyors

When using a Total Station, or Survey Gun, it's important to remember
that this is a tool used professionally by many contractors, land
surveyors and architects to measure landscape, terrain, constructions
and buildings.

When we talk about Surveying for Visual Effects we have four major
differences from professional surveyors:

1.Origin Must be within the Sound Stage - when surveying land
or terrain, it's always easier to work with large numbers so you
never encounter negative values.
However, this is not the case in surveying for VFX.  In VFX, we
want to have positive and negative numbers.
We need the Origin, the point where all axis are measured from
(x=0, y=0 and z=0) to be literally within reach. Origin must be a
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physical place within the stage.
We often place the origin in the middle of the sound stage and
mark it with a nail or sticker.

2.Elevation 0.000, must be on the floor height - because there
is rarely a slope on the floor of sound stages, it's very
convenient and easy to make the floor be Elevation = 0.000 m.

3.Backsight should be perpendicular and directly in front of
the camera  - to make sure that the front of the camera is the
forward axis in the survey, make sure that the backsight (the
heading) of the survey is directly in front of the camera
perpendicular to the green screen or green cyclorama.

4.Output file should be simple CSV with Northing, Easting,
Elevation, Description - there are many ways to write down or
export surveyed points from total stations.  For the purposes of
Previzion, what we need is just a simple text file (.txt) that
contains all points, in meters, as Northing, Easting, Elevation
and Description.

Whenever working with professional surveyors, it's very important to
point out these differences.
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Survey Elements

Surveying Terms

When dealing with the Total Station, you will often encounter surveying
terms that need clarification.

The most important ones are:

Job - the data collector "project" or "document" is a job.  Use a
different job for each location or when re-surveying a stage.
Occupy Point - physical point where the total station is setup.
When starting a new Job, the first point will often be your 
Occupy Point as well as your Origin (Northing = 0.000m,
Easting = 0.000m and Elevation = 0.000m).
Instrument Height - physical height of the Total Station
instrument (measured in meters) from floor to optical witness
mark (often on laser pivot), indicated by a dot.
Backsight - point that determines heading in a survey.
 When setting up a new survey, you will need to elect a
heading for the Northing (X-axis).  This is based on an Azimuth
projection where every point is calculated in an angle derived
from the position of this axis.The height of the backsight is
negligible, it can be on the ceiling, the walls, the floor or any
reference. The one request is that the backsight point be set
somewhat perpendicular to the green screen or cyclorama.This
makes it easier to reference and make changes in real-time in
Previzion.
Traverse - when moving the total station to a known point,
you traverse to this point after measuring it.
Resection - when entering a survey space with a few known
points, you may create a new occupy point based on a
re-measurements of known points.
Point Description - to identify a point, each point gets a 
description. This is often the number of the fiducial target
or OP for occupy point, BP for backsight point and RS/RP for
resection point.

Origin

The origin is the location on the survey where Northing, Easting and
Elevation all equal 0.000 meters.  From this point all measurements are
taken from.

To simplify the process, the first point (occupy point) is defined as the
origin. The origin should be in a central location with respect to the
action of the scene or stage. Exact centering isn't necessary.

 

Required Equipment

There are many Total Stations and various brands.  The two key
features needed to survey without using a professional surveyor are:

Reflectorless Mode - this allows the total station to
take measurements without the use of a prism or reflective
stickers.
Data Collector - this is a separate piece of hardware that acts
like a handheld computer.  The Data Collector is able to store
and output point data as well as configure the total station.
Bluetooth Data or Serial Data Cable for Data Collector - for
the Data Collector to communicate with the Total Station, you
will need either bluetooth connectivity or a hard wired serial
cable connection.  We recommend having a cable as bluetooth
often drops out in sound stages.

Using a data collector is particularly handy because it allows for a
graphical interface and the ability to quickly access and edit points as
needed.

Types of Points to Survey
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There are four different types of points to survey, and each plays a
different role in aligning together the physical and virtual worlds.  Using
the measurements from the total station, you can extend and
reference real sets with virtual elements.

The four types of surveyed points are:

Backsight / Origin (red) - used for setting up the total station
Fiducial Targets (orange) - used by the IS1200 for tracking
Garbage Mattes (yellow) - (optional) can be used by Previzion
to matte out areas where the green screen ends
Stage Props and References (cyan) - (optional) can be used to
create CG scenes with elements that line up with real elements.

Once you've surveyed, you'll need to convert the survey data to X, Y, Z
coordinates. This can be done using Constellation Tool, available for
download from Dashboard.
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Using the Portable Target Boards (Floor Targets)

Overview

There are Four new targets boards that can be arbitrarily
placed on set to match per shot tracking needs
Each board is 1 meter wide by 1 meter long or 1.5m x 1.5m and
can be printed on durable vinyl
The targets on each board are unique so any combination of
these four boards can be used together
The purpose of these new boards is to reduce the work and
time involved in surveying targets for a shoot
The targets are designed to be surveyed at only 3 points on
each board. This means that creating an arbitrarily placed
fiducial configuration of 84 points, requires surveying only 13
points: 3 per board and 1 for backsite Surveying now takes
roughly 10 minutes to create a constellation with 84 unique
fiducials
The targets can be placed and oriented in any manner as long
as the Intersense camera can still see them on set
Targets can be placed easily on the floor or walls or random
incline
Targets can be left uncut on a long strip and pre-surveyed for a
totalstation free setup

 

 

About the Boards

Each Board is Unique

This means that you can't arbitrarily swap out one board for another.
Because each board is unique this allows any combination of boards to
be used to create a constellation file. Additionally, each board contains
unique fiducial IDs and has a unique title. Each board is identified by a
unique letter and contains the following fiducials and survey points:

 

How to Use

The boards can be placed, once mounted to a Rigid Substrate, at any
angle and any location (so long as the intersense camera can still see
it). In the illustrations below, the Intersense camera is mounted to
bottom of the camera rig and is looking down. This works if the portable

target boards are on the floor.

These targets are printed to a size suitable for handheld or small crane
tracking. If the camera gets too high than it may not find the fiducials.
Below is an illustration of the Field of View cone of the intersense
camera.

Dolly Shot

Because of the flexibility of placing the portable target boards, tracking
becomes easier for a wider variety of short. An example would be
tracking for a dolly shot.

 

Process

1.Mount targets to rigid substrate
2.Place targets as desired on location for best camera tracking
3.Set up surveyor / total station
4.Establish Origin and Backsite
5.Make sure the fiducial boards are secure in their environment
6.Survey the 3 points per used fiducial target board

7.Export the Survey file to a .TXT file format
1.Use the "North, East, Elev, Desc" setting for "Coordinate

Order" when exporting from SurvCE
8.Use the Constellation Tool to generate your CFG, cones and
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extra points. (refer to the Constellation Tool page for more
information)

9.Load the newly created .cfg file and send it to the Intersense
camera

10.Position IS1200 on the camera rig so it can see the targets
keeping the LEMO connections coming off the right side. (Front
on the is1200 will be on the back, and back on the front

11.Make Intersense orientation pitch a negative value.
12.Adjust camera sensor offsets to reflect the position of the

camera realitive to the IS1200. For more info see "Camera
Offsets"

 

Requirements

 

 Each target board must be mounted to a rigid substrate

How to Survey

Each board has three unique survey points. Only these points should
be surveyed for each board. Surveying additional fiducial points on the
board will have no affect when creating the final constellation and
orientation. These unique survey points per board are the:

1.Top Left
2.Bottom Left
3.Bottom Right

An example of this is illustrated below with Board A:

Make sure your exported survey file is exported from SurvCE with
the point values in the following order: "North, East, Elev, Desc"

Survey the Fiducial NOT the "A1" Mark

It is important to note that the fiducials are the targets that need to be
surveyed on these boards, and NOT the A1, A2 or A3 marks next to
them. When surveying the fiducial, the A1, A2 and A3 marks are the
"descriptions" used to identify the surveyed fiducials in SurvCE. The
illustration below should assist:

Another illustration to further clarify

How to use with SurvCE
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A Completed Survey

A completed survey file may look like the example below. Notice the
presence of both the ORIGIN and BACKSITE. These two points are still
necessary to determine world center and world orientation. The
additional FLOOR1 point could be used as a physical reference point by
which to integrate your CG elements at shoot time.
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Fiducial Targets and Constellations

Target Layout
Placing Targets on a 25-foot Stage
Placing Targets on a Soap Opera Stage
Survey Constellation Tool and CFGs
Constellation files
Intersense Introduction
Connecting to Intersense
Stage vs. Scene Coordinates
Importing Additional Survey Points
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Target Layout

Circular Fiducial Markers

Fiducial markers are optical patterns that can be identified by machine
vision algorithms to determine a reference point.

Barcodes store numbers.  QR codes store data strings.  And fiducial
markers store position references.

The Intersense IS1200 identifies a specific type of fiducial marker.  It is
called Circular Data Matrix.  These patters function both as a unique
circular barcode, with a unique number, as well as a precise fiducial
marker, with a specific positional reference.

In the interest of simplification, we will refer to each fiducial circle as a
target.

And each board with 5 or more markers as a target board.

Target Size

The IS1200 can recognize fiducial targets at a distance up to 20x the
fiducial diameter. For example, on a 40 foot tall soundstage ceiling, the
fiducial diameter required to enable recognition by a camera resting on
the floor would be 2 feet in diameter.

In addition, the fiducial needs a white margin of at least 25% of the
fiducial diameter around the fiducial itself to provide proper contrast and
enable fiducial detection. In the above example of the 2 foot diameter
marker, the complete fidicual diameter (dark + white) would be (2 feet)
+ (2 feet * 0.25) + (2 feet * 0.25) = 3 feet total diameter.

If the IS1200 will be tilted forward to avoid camera equipment blockage,
as in the case of a Technocrane or an underslung camera head, the
distance increases because of the angle. For example, if the camera is
tilted 45 degrees, the effective distance to the ceiling is increased by a
factor of 1.4, so the target size should be increased by 40-50%. This
creates a 3 foot diameter base fiducial, and a 4.5 foot diameter fiducial
+ white surround.

Each fiducial can have a different size, as long as the size is accurately
recorded in the Intersense calibration file.

Intersense Position Noise

At target heights over 20' (6 meters) from the floor, the Intersense will
exhibit noise in the position tracking of about +/- 1 cm. The visibility of
this ranges from not very noticeable if the background is virtual video
plates located 10 meters away, to very noticeable if the virtual 3D
background object is very close to camera.

To remove this, enable position clamping.

Multiple Size Targets
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Using multiple target sizes solves the near and far tracking distance
problem. As shown above, a standardized 5 target pattern is used to
cover a stage area.

The 2 standard sizes are 25cm diameter center targets, with 10cm
diameter outer fiducials, or 50cm center targets with 20cm outer
fiducials. These fit onto a 2" x 2" or 4" x 4" Gatorboard backing,
respectively.

Intersense-to-Target Distance

The IS1200 can recognize targets from distances ranging between 20x
the fiducial diameter to 5x the fiducial diameter. In the above
soundstage example, this means that the 2 foot diameter fiducials can
be recognized to within 10 feet, or 30 feet off the ground.

Distance min =  5* Diameter fiducial

Distance max = 20* Diameter fiducial

 

Fiducial distance

At the minimum acquisition distance of 10 feet, we can then determine
the total width that the IS1200 can see with its 80 degree field of view:

tan(80 deg/2) = (visible width)/2 * distance

visible width = distance * 1.67 = 16.7 feet

To maintain the correct target density at the minimum distance, 3
targets should be visible across the field of view. To keep the required
white space around the target for recognition, the centers of the
outermost targets should be 1.5 feet in from the edge of the visible
space, leaving 3 targets over a space of 13.7 feet, or a target to target
spacing of 6.8 feet.

At first glance, this would seem to produce a fiducial grid that would
take over the ceiling, given 3 foot diameter markers. However, by
varying the markers size and distribution, the fidicial constellation can
be adjusted to fit typical camera moves.

Floor Targets

The targets don't necessarily need to be on the ceiling of a stage.  It can
be on the walls or the floor for that matter.

With all the above mentioned in mind, Lightcraft has created "floor
targets" or "portable target boards."  By using a variety of sizes on a
single board printed on vinyl, you can have the flexibility of putting
targets on the floor.

We use a durable heavy-duty printable vinyl that, when protected with a
spray fixer, can be used in multiple locations.  The only requirement is
that the portable target board be laid out on a flat surface.

For the 150cm_Floor-Board, we use 45 fiducial patterns at three
different sizes:

(5) 30-centimeter fiducial patterns;
(12) 15-centimeter fiducial patterns; and
(28) 7.5-centimeter fiducial patterns.

This yields that following range of motion (from floor target) :

max camera height: 19' 
min camera height: 1' 5"
max "usable" distance from edge of board: 5 feet (at a height of
5'6")

For information about surveying Lightcraft's floor targets, go to Using
the Portable Target Boards.
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Placing Targets on a 25-foot Stage

Placing targets on a 25 foot stage

Because the Intersense camera has a 80-degree field of view, we must
take into account the minikmun size a target must be on a 25-foot stage
as well as how far apart they are.

In the case of a 25-foot stage, where the camera may go up to 15 feet
high on a jib, targets should be a maximum of 12.7" apart from each
other.

 

 

click here to view pdf

 

For optimal sensor data, the center targets should be 50 cm in diameter
and the outer targets at least 20 cm in diameter.
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Placing Targets on a Soap Opera Stage

Placing targets on a Soap Opera Stage

Because the Intersense camera has a 80-degree field of view, we must
take into account the minimun size a target must be on a 10-meter
stage as well as how far apart they are.

In the case of a 10m high stage, there may be many hanging tross
lights to consider and a minimum amount of targets is always preferred.

 

 

click here to view pdf

 

In this configuration, targets should be no more than 7 meters apart
form each other at a height of 7.8 meter from the stage floor. Or 2.2
meters from the ceiling. Each target should be at least 1 meter wide.

This allows for the camera to be up to 3 meters high on a dolly and for a
good amount of clearance in between each light.

Page 82

http://www.lightcrafttech.com/images/manual/target_projection_diagrams/soap_opera_diagram.pdf


Previzion - User Manual
by Lightcraft Technology

Survey Constellation Tool and CFGs

Generating Constellation Files

Once the survey procedure is complete you should have a mySurvey.txt
file available on the data collector. To convert this text file into an
Intersense Constellation File (.cfg) you will need to run it through a
converter tool.  We recommend using Lightcraft's Constellation
Tool available for download from free from Lightcraft's Download
Center.

We often refer to the Intersense CFG files as "constellations" and the
exported survey files as "surveys."

Installation Notes

On Previzion Systems, Constellation Tool will run in any Previzion
system natively.  Download the tool from Lightcraft's Download Center
 and save the  "ContellationEditor" directory into "C:\Program
Files\Lightcraft\.."

On Non-Previzion Systems, Constellation Tool will need to have a
Windows 7 operating system installed in your machine or virtual
machine.  We recommend the Professional 64-bit version.  You will also
need to install Microsoft's Visual C++ Redistributable, available free
from Lightcraft's Download Center.

Learn more about Visual C++ Redistributable here.

Once the installer goes through, you will need to run Windows
Update and look for Visual Studio updates.  Microsoft is notorious for
their updates and it is always safer to have their latest updates and
security updates.

Introduction to the tool

Constellation Tool is intended to facilitate the stage survey process
and replace all survey python scripts.  This is a freely distributed tool
intended for Previzion operators to use in their workflow. Please email
info (at) lightcrafttech.com for licensing details and our end user
agreement.

The interface is made up of a toolbar and a table viewer.

There are three main key functions that are reflected in both the toolbar
and the menu bar:

1.Add Points- Opens/merges surveys and constellations
2.Clear Points - Clears table of any loaded surveys
3.Export FBX - Outputs the resulting "cones" scene file (FBX)
4.Export CFG  - Outputs the resulting constellation file (CFG)

5.Export Additional - Saves a text file with extra points that may
be in original survey, like garbage mattes, resections or stage
references

6.Export LIDAR (PFTrack Export) - Saves a text file with all
points in survey for use in PFTrack's Survey Solver.

7.Quit - Closes current survey look-up session.

The Survey File (.txt)

"Survey File" is the output file that is generated after each fiducial
marker is surveyed with a surveyor's total station.  Total stations are
often used in architecture and in construction as a way to measure and
verify measurements.  For VFX, we use the same tool, but in a different
manner.  Using a Data Collector, we measure each marker and output
the "job" with each point as a list (CSV).

The output file format from the Total Station hand held has the following
properties:

Comma delimited
No white spaces except line breaks
No header information
All measured data is given in units meter
The Measured Data columns are the first three.

In order, they are: Northing, Easting, Elevation
The Right most column is the "Description"

This is the Unique Fiducial ID

You may use any Total Station and/or data collector as long as it
outputs a simple text file with the above mentioned parameters.

Can I scale "portable floor targets" and use
Constellation Tool?

As of November 26, 2014 our latest version of ConstellationTool
8909 to allows for scaling of floor targets.  You may scale the 45 point
(1.5m) or the 21 point (1m) targets larger or smaller than the original
file.  Survey the corners fiducial of the scaled target the same as you
would a normal size target, then select the appropriate type in
Constellation tool.  Scaling is done automatically based on the
distances between surveyed points on the targets.

What if I have more than one type of
fiducial markers?

As long as all targets are surveyed in the same coordinate space with
the same origin, it's posstible to combine a variety of targets with all
kinds of sizes in various positions.

Different sized markers

When using fiducial marker boards of different sized markers, you will
need to keep both sets of markers in the same coordinate space and
survey one set of markers first, then the second set. At the time you are
exporting the "job" from your data collector, select to only output one set
of markers, then the other set as a separate file.

In ConstellationTool, you can import the first set of targets, select "use 5
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targets" and, when prompted, input the diameters for the respective
markers.  Then immediately after, import the second set of targets,
select "use 5 targets" and, when prompted, input the diameters for this
set of markers.

Floor Targets at the same time as ceiling targets

In very specific applications, mounting "floor" targets on the wall or floor,
in addition to ceiling targets, simultaneously, is necessary.  It's easy to
combine floor targets to existing ceiling targets.

To merge files, simply import to ConstellationTool your original "survey
file" (.txt) and re-process it or the already processed "constellation file"
(.CFG) for the given location.  Then simply "Add Points", selecting your
floor target's survey file and select the type of floor target.

Any duplicate fiducial marker that is on the floor target as well as the
ceiling target will be replaced with the one from the floor target, which
was the last imported set.

Importing a File

This tool will import two kinds of files: txt from surveys and already
generated CFG constellations.

When importing survey files, you will see the following dialog box:

5 Target Import - used on surveys of 5-fiducial boards.  These
are the most commonly used ones on ceilings.

21 Target Import - used on survey of the 42-inch wide portable
targets boards.  This only require 3 surveyed points for each
target board.
For more information on using portable targets boards, read
more here.
45 Target Import - used on survey of the 60-inch wide target
board.  This also only requires 3 surveyed points for each target
board.
Use Additional Points - used to add extra points like garbage
matte points, set prop positions, occupy points, traverses and
back sights.

For 5 Target Import, you will be asked to input the diameter of the
larger and the smaller targets in centimeters.

Merging and Adding More Points

To merge two or more surveys and/or already made constellations, you
may open one survey on top of another.  This will simply merge the two
and ignore the second instance of repeated points IDs.

This means that if a point is used more than once, only the first time it
shows up on the table look-up will be used in the final exported
constellation.

Exporting a Constellation

When ready to export your constellation file, you will have the following
options:

1.Intersense Configuration File - This is your "constellation" file
(.CFG) that holds all the surveyed targets' coordinates.  This is
how the Intersense will know where each target is.

2.Cones Scene File - This scene file (.FBX) will have CG "cones"
that is used for verifying the survey in Previzion.  To learn more
about how to verify stage alignment, read more here.

3.Additional Points - For any additional points, like garbage
matte points, set prop positions, occupy points, traverses and
back sights, Survey Constellation Tool will output a .txt file
with their coordinates.

4.Export LIDAR (PFTrack Export) - To use surveyed points
(usually set pieces, props or additional references in frame) as
seed points in PFTrack's Suvey Solver, use this export format.
 This is called "LIDAR" because it's formatted as a LIDAR
survey and it is what PFTrack accepts.  For more information
about the usage of this format, please refer to our PFTrack
post-production tracking refinement page.

You may not need to export all three.  Most often, all you need is just
the CFG and a Cones.FBX to reference from.

Offsetting, and Rotating Constellations

ConstellationTool 8909 adds the ability to offset and rotate whole
constellations.  Constellations can be offset in X,Y and Z or they can
rotate around the origin in order to compensate for mistakes made
during the survey.

What version of ConstellationTool should I
use?
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Unless there are custom 5-marker boards being used, please use the
latest version of ConstellationTool as we often add new features and
improve old ones.

 

ConstellationTool Change Log

build 8909 (11/26/2014)
Enables automatic scaling for portable floor targets
based on survey
Size suggestion for smaller target when using 5 target
boards
Improved sorting algorithm can correct more normals
problems than before
Offset and rotate constellation functions added
Added support for more extensions (.TXT .txt .CSV .csv)
Reenabled example images of target board types
Duplicate target ID detection and correction

build 7962 (12/05/2013)
sorts any Lightcraft provided 5-marker target regardless
of survey ordering
orders output files by description in ascending order
PFTrack seed file with "LIDAR" enabled

build 7386 (05/01/2013)
PFTrack seed file with "LIDAR" enabled
preliminary sorting enabled (does not work with 5-marker
targets with center marker ending in 50)

build 6521 (07/27/2012)
preliminary sorting enabled (does not work with 5-marker
targets with center marker ending in 50)

build 6399 (02/12/2013)
implementation of self-contained cfg generator with fbx
"cones" export

ConstellationEditor (07/06/2012)
initial ideation of Constellation Tool
no editing capabilities
implementation of "cones", "additional points" and "cfg"
export
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Constellation files

Creating a Flat File

For initial entry of fiducial positions, the IS1200 uses a "flat file" that
consists of four columns of data, separated by spaces or tabs. The first
column contains the fiducial ID number. The second, third, and fourth
columns contain X, Y, and Z values in meters. Note: the Intersense Z
axis is reversed from the surveying instrument's Elevation axis, so
the values should be negated!

An example of the contents of a flat file follows:

2300 -0.455008 1.408265 -0.994395
2400 -0.429971 1.405799 -1.249831
150 -0.00359 0.65526 -0.004673
100 0.387144 0.666332 -0.009281
200 0.391817 -0.002817 -0.002492

The flat file has a standard .txt extension, so it can be read and edited
with Notepad or Wordpad.

Constellation Files

For easier entry of data, Lightcraft has created a set of constallation file
generation tools that are available on the Downloads page. These are
able to go directly from survey data to finished files.
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Intersense Introduction

Intersense Introduction

The combination of the Intersense IS1200 and Airtrack® Precision
Rotary Tracking bring a new level of on-stage camera tracking freedom
and accuracy. However, to get the most out of the sensor, the tracking
reference points on the stage must be set up correctly.

The IS1200 uses a fixed focal length camera with an 80 degree
field-of-view to see and recognize binary coded digital optical fiducial
targets, as shown here.

 

This represents fiducial #100. The binary coded digital pattern enables
32,768 different patterns to be recognized, enabling stages of arbitrary
size to be successfully tracked.

Position Solution

Using the known positions of the circular fiducial markers, the IS1200
VisTracker is able to calculate its position as long as it sees about 4
markers at all times.

To do this, the Intersense IS1200 first captures a black and white frame
through its wide angle lens, and attempts to recognize any fiducial
marks that appear in the frame.

The position algorithm will use the quadrilateral formed by the 4
recognized targets that are furthest from the center of the lens to solve
for the 3D position of the camera. In this case, the 4 furthest targets
would be **100, 250, 1000, and 850.**

The further toward the edges that the recognized targets appear, and
the more accurately their absolute 3D coordinates are known, the more
accurate the solve.

Acquisition and Tracking Modes

The IS1200 VisTracker actually has two operating modes.  The IS1200
starts up automatically in acquisition mode then automatically moves
to tracking mode.

The VisTracker is always in one of these modes.  The IS1200 toggles
between these modes automatically.

In acquisition mode, the VisTracker is looking at the constellation file it
has loaded an it tries to identify fiducial markers in its field-of-view.

By marking an area for where targets are visible and identifiable, the
IS1200 can then calculate its position.
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Acquisition time depends on the size of the constellation file and the
distance to the fiducial markers.  On average, acquisition time should
be no longer than 25-30 seconds at the most.

When using upwards of 300 fiducial markers, or 60 five-marker boards,
acquisition can take up to 60-80 seconds, depending on the height of
the targets.

In tracking mode (or tracquisition mode), the IS1200 is constantly
detecting fiducial markers and measuring its position in relation to the
markers.

 

In this mode, the IS1200 VisTracker is much more robust and is able to
detect markers that may not be initially detectable during acquisition.

In tracking mode, the VisTracker is also operating in a "predictive
tracking" mode.  This means that even if a fiducial target is not perfectly
exposed or not completely in focus, as long as it's not occluded, if it's in
the field-of-view of the VisTracker,  the marker is being used to track.

 

In Optical Data Display Tool, "predictive tracking" is visible through
white bounding boxes: whenever the VisTracker sees anything circular
in a position it expects, it places a bounding box around it.  If this circle
is both in an expected position and the fiducial marker is legible, then it
also gets a small green cross.
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Connecting to Intersense

Intersense IS1200 Settings

On a daily basis, at the beginning of the day and after lunch, it's
important to check:

1.IS1200 Exposure Settings
2.Loaded Constellation File
3.Tracking Stability

Also, check these settings in this order.  Tracking stability cannot
happen until the proper constellation file is loaded, which in turn cannot
properly be verified if the exposure of the sensor is not proper.

Whenever tracking seems "fragile", check your exposure setting in
InertiaCamTest.exe.

Intersense Exposure Settings

Often times, exposure settings need to be adjusted as the lighting crew
models different lighting on set.  This is done through
InertiaCamTest.exe.

When InertiaCamTest opens, the console should output "Devices
Found:2".

 

This means that both the IS1200 camera and internal IMU are properly
detected.

In this main window, there is also an image that is captured by the
camera sensor in the VisTracker.  This image is refreshed every 2-4
seconds.

Make sure that under Devices > Camera Exposure the Manual
exposure setting is checked.  From there you may look at the image on
the screen to judge exposure.

!!! IMPORTANT !!! Don't use InertiaCamTest to judge the number of
detectable markers.  Simply use this to set exposure.  The images don't
cycle fast enough for a proper estimation of detected targets.

As a general rule-of-thumb, when setting IS1200 exposure settings,
Shutter values should be between 4ms and 13 ms (milliseconds).

Gain can be adjusted as needed to any value as needed.  Use gain at
max before setting shutter past 13 ms.

Proper Exposure

 

Under Exposed

The goal is to make the white marker boards not pure white, but a mid
gray.

A common mistake is to forget to save the exposure settings to the
sensor's internal memory.  The IS1200 exposure settings is saved in its
EEPROM (Electronically Erasable Programable Read-Only Memory)
internally.

Once you have your exposure settings saved, you may
close IntertiaCamTest.exe.
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Loading Constellation Files

To tell the IS1200 which fiducial markers to look for, you need to load
a constellation file.  This is done through ISDemo.exe.

The constellation file is the product of the stage survey (see Surveying
Chapter for surveying instructions) and converting the survey file (see
Survey Constellation Tool and CFGs for instructions).  This file with
have a ".cfg" extension.

When launching ISDemo, a dialog window will offer options to connect
to various Intersense sensors.  The VisTracker is the IS-1200.

Click Accept to move to the next window.

Agree to start SFServer (or Sensor Fusion Server).  This opens a
command line program, sfServer.exe, it's very important to keep this
window opened.

Note that in sfServer, the second to last line reads "Found 1 IMU(s)". 
This means that ISDemo will be able to to connect to the VisTracker's
internal IMU.

!!! Important !!! You can only have one instance of sfServer opened.  If
sfServer shows "Found 0 IMU(s)", check that no other sfServer
windows are opened and then check your cabling and connections.

Next, Connect ISDemo to sfServer as localhost.

Agree to connect to localhost 127.0.0.1 and the main ISDemo window
will open.

 

ISDemo has many tools for adjusting the sensors and tracking
parameters, but these are set at Lightcraft Technology at the time a
system is configured and should not be changed.

From the menus, select Tools >  Constellation Tool  this
opens Constellation Configuration Tool.

In this new window, select and open your constellation file (.cfg).
 Under File > Open :
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This will populate the Constellation Configuration Tool windows with
various circles.

Each circle and respective number indicate a fiducial marker.

To zoom in and out of the view in this window, use your
keyboard's Page Up and Page Down.  With ALT+ Click Drag you can
move the the view of the constellation around.

This then needs to be sent to the VisTracker:

Close this window and, in save your settings in the main ISDemo
window.

!!! Important !!! Save current settings.  Select File > Save Current
Settings :

Then commit to saving in "permanent memory".

Close ISDemo and close sfServer before moving on to the next step.

Verify Tracking

Starting with all programs and windows closed, re-open ISDemo.exe.
 Agree to all windows as shown in "Loading Constellation Files".  But
this time, in the main ISDemo window, select Tools > Optical Data
Display Tool.

This opens another window for Optical Data Display Tool.  The window
will be blank.

Page 91

http://www.lightcrafttech.com/wp-content/uploads/2010/11/cfgselect.jpg
http://www.lightcrafttech.com/wp-content/uploads/2010/11/cfgselect.jpg
http://www.lightcrafttech.com/wp-content/uploads/2010/11/cfgselect.jpg
http://www.lightcrafttech.com/wp-content/uploads/2010/11/ViewConstellation.jpg
http://www.lightcrafttech.com/wp-content/uploads/2010/11/SendToTrcker.jpg
http://www.lightcrafttech.com/wp-content/uploads/2010/11/savecurrent.jpg
http://www.lightcrafttech.com/wp-content/uploads/2010/11/savepermanent.jpg
http://www.lightcrafttech.com/wp-content/uploads/2010/11/OpticalDataDisplay.png
http://www.lightcrafttech.com/wp-content/uploads/2010/11/OpticalDataDisplayWubdiws.png


Previzion - User Manual
by Lightcraft Technology

To enable the machine vision target detection view, select Display >
Start Displaying Data. This is what how the VisTracker sees markers.

Also, check that  Display > Persistence  is set to  All within 0.2 sec . 

Whenever the VisTracker sees a circle in an area it is expecting to see
a fiducial maker, it places a white bounding box.  If it can both see a
circle and detect what barcode number it is, the VisTracker places a
green cross in the box.

Here is where you can judge the number of targets being detected.  If
these checks work, you may quit ISDemo and sfServer and move on to
launch Previzion.

 

 

Troubleshooting Tracking Markers

All Yellow Crosses in Optical Data Display Tool

While verifying tracking, if in Optical Data Display tool it shows are
yellow crosses, that could mean one of a two things:

The wrong constellation is loaded
Solution: go back to Constellation Configuration Tool, still in
ISDemo, and re-load the proper constellation.  9 times out of 10,
the problem is that after loading a constellation, the settings
were not saved in Permanent Memory.Make sure to Save
Current Settings in the main ISDemo window. And commit
to Save in Permanent Memory.

The VisTracker has not been able to lock to tracking yet
Solution: pan the camera side to side and see if it acquires a
lock.  In some cases, if the IS1200 is perfectly still, it's unable to
calculate its position.  This is not common, but can happen.

Red and Yellow Crosses in Optical Data Display Tool

If in Optical Data Display Tool, there are yellow and/or red crosses with
some green crosses, this could mean:

Target was moved or "bumped" accidentally
Solution: remove this board from the constellation.
The diameter of the fiducial markers is not accurate
Solution: measure the diameter of the fiducial marker with a
tape measure or total station.  You can use the center mark and
a tangent mark of a fiducial marker to calculate its diameter.

Fragile Tracking

If the tracking seems "fragile", meaning that the VisTracker looses
tracking whenever it's moved from one position to another, check your
exposure.  This means quitting all applications and going back to
InertiaCamTest.

 

 

Page 92

http://www.lightcrafttech.com/wp-content/uploads/2010/11/TracquisitionMode.png
http://www.lightcrafttech.com/wp-content/uploads/2010/11/AcquisionMode.png
http://www.lightcrafttech.com/wp-content/uploads/2010/11/savecurrent.jpg
http://www.lightcrafttech.com/wp-content/uploads/2010/11/Error.png


Previzion - User Manual
by Lightcraft Technology

Stage vs. Scene Coordinates

Stage vs. Scene Coordinates

The stage coordinates generated by the survey tool, and then solved for
by the Intersense or other tracking devices, are then routed into
Previzion and converted into CG scene coordinates for correct
rendering of the CG background.

In the above UI screen capture of Previzion, the highlighted area is the
CG scene coordinates inside Previzion. When you click Edit, and move
the camera around, or enter values into this area, you are directly
adjusting the virtual camera position inside Previzion, in the coordinates
of the virtual scene.

Camera Offsets

While you do this, you will notice that the camera offset coordinates
highlighted above are changing in real time. These numbers represent
the offset (both translation and rotation) between the stage/tracking
system coordinates, and the virtual scene coordinates inside Previzion.

 

Matched Coordinate Systems

When working on a shoot that requires accurate matching between
specific live action and virtual coordinates, the only way to make it work
and remain sane to designate a physical point as the origin, and build
virtual sets with the same virtual origin point and the same +X axis
direction. This way, the virtual and the live action worlds can be aligned
very simply, by setting the camera X, Y, Z, and pan offsets to 0.

Freeform Coordinate Systems

When shooting on a blank green stage, you can freely adjust the virtual
coordinate system to match. However, to ensure that the virtual floor
remains connected to the live action floor, keep the Y offset value at 0,
assuming that the virtual floor is located at Y=0. If the virtual floor is at a
different elevation, you can set the Y offset by moving the virtual
camera over the section of virtual geometry in the scene, and clicking
Set Floor Offset.
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Importing Additional Survey Points

Importing Additional Survey Points

Purpose

When surveying a stage it is often important to also survey the corners
of the green screen and locations of physical props. These points are
stored in the survey file just as the targets are. However, these points
are not added into the .cfg file that gets loaded into the Intersense
camera.

The tool provided here for download reads the "Additional Survey
Points" text file and creates locators inside Maya. This Allows the Maya
artist to create and place their assets in the virtual space. The created
locators make it easier for the 3D artist to:

1.Scale 3D Assets to proper scene scale
2.Properly place 3D assets into physical space before exporting to

Previzion
3.Generate 3D model of green screen wall
4.Align virtual and physical set pieces

 

How to Use

Download the script
Copy it to a shelf item or into your script editor
Run the script

The script will ask for the location of the Additional
Survey Points file.
When hitting okay, Maya has a bug wherein it will ask if
you want to "Save Over" the file.
Hit "yes"… this is a bug in Maya.

 

Result

The finished result is a series of locators all placed exactly as their
physical counterparts in the physical space.

Each locator is given the original point description (from
surveying) as its name in the Maya scene.
Each locator is scaled to 100 (this scaling amount assumes that
the scene unit is centimeters)

Download

You may download the latest version of  Import Survey Points - Maya
script from our Download Dashboard.

 

Features and Updates

Upload Notes

December 5th, 2011
Initial Publication
Reads the "Additional Survey Point" files generated with 
Lightcraft Survey tools.
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Connections

Previzion DATA CABLE
Timecode Connections
External Genlock: Integrated Internal Frame Synchronization
Airtrack Connections
Using Multiple Cameras (Multi-cam setups)
Sync & Video – Evertz 1U (2 DAs)
Sync & Video – Legacy Evertz 1RU (with Audio Embedder)
Sync & Video — Evertz 2430 + AJA 10AMA
Verify Video Input
Analyze Video in BRec
Capture Video in BRec
Generate Color Bars
Lens Connections – Fujinon
Lens Connections – Canon
Panavision Anamorphic Lenses
Panavision Connections
Panavision SD analog video tap
ARRI Alexa/Alexa Plus/Alexa Studio
RED One Connections
RED Epic/Scarlet Connections
Canon C300/C500 Connections
Preston Connections
C Motion Connections
Cooke Connections
Element Technica Connections
Testing Serial Connections
Capturing Serial Data
Preview Output (Deprecated Feature)
Binding Systems Together – Working with more than one Previzion
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Previzion DATA CABLE

Components

Lightcraft's Data cable connects the  Previzion system to the movie
camera and its components.  It comes with a combination of cables:

1.DATA (14-pin Lemo)
2.Camera HD-SDI (RG6/1694F digital video)
3.Monitor HD-SDI (RG6/1694F digital video)
4.GENLOCK (RG179)
5.AUX (RG179)
6.Serial (DB9) *optional

 

 

The DB9 Serial cable is the only cable that has a male and a female
end.  All other connectors are directionless.

All connectors are essentially "pass-through" cables.  In other words,
what is sent through pin 1 on one end, is the received in pin 1 on the
other end.

** in older versions of Data Cable, there is yet another connector for
Lightcraft's genlocked encoders.  These are no longer used.

Configurations

Previzion DATA CABLE comes in three basic lengths: 100-foot,
200-foot and 250-foot.

All our cables have been tested up to 250' (continuously) for DATA  and
digital video.  Any longer runs require digital amplifiers in between, like
any other professional grade cable.

STEADICAM® Tether

For applications where a STEADICAM® is required, we provide a
lighter, more flexible extension that runs the last 4 feet of cable.

This STEADICAM® TETHER has all the same cables and connectors,
but in the form of an extension.  Hence, DATA is male 14-pin Lemo on
one end and female 14-pin Lemo on the other end.

Care and Maintenance

Like any other piece of production equipment, the DATA
CABLE requires care and proper packing when shipped.  Should there
be any mishaps during a production, contact your Lightcraft
representative for assistance.

DATA (14-pin Lemo)

This is the main data cable that both provides power to Airtrack and
Intersense as well as transmit data for Lens metadata, IS-1200 tracking
and Airtrack tracking.

DATA runs between the Airtrack "DATA" and the Serial Basebox
"DATA."

Lemo connectors have a red line/dot indicating how it needs to be
aligned.  To connect it, push it in in the proper orientation.  To remove it,
pull it by the textured jacket.

Camera HD-SDI and Monitor HD-SDI

These two BNC cables are heavy duty digital video conductors.  They
are made from professional grade cable and connectors made to meet
the highest standards.

Camera HD-SDI runs from the movie camera's live HD output/preview
to the Previzion system.  This provides Previzion's primary video source
(typically connected to your audio embedder's HDSDI INPUT).

Monitor HD-SDI runs the final Previzion comp signal back to the
camera operator to feed his or her on-board monitor.  This allows the
camera crew to view the Previzion signal to compose their
shot accordingly.  Typically coming from your DA's HD OUTPUT.

GENLOCK

This is a considerably "skinnier" BNC cable (RG179) and is intended for
running tri-level sync.

Genlock runs sync from Previzion to the Airtrack.  Typically, for
Previzion's purposes, we "extract" sync by running the camera's live
video output through a digital-to-analog converter that outputs a 0.3V
pulse at formation of each frame.  The Airtrack then syncs to that pulse
and locks the tracking data properly to the camera feed.

When there is "house sync" provided or equivalent sync generator, you
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may use this cable to run your own sync instead.

AUX

As a spare cable run, AUX provides the flexibility to run between
camera and Previzion in case one of the other cables break or fail.  For
most applications, AUX can transmit LTC to or from camera.

Depending on the generation of your DATA CABLE, AUX may not be
rated to run digital video over the whole length of your cable tether (in
200' tethers or more).  In recent configurations that use
cable L-1.5C2VS, there is more flexibility and it does allow for the
transmission of digital video.

Serial (DB9)

This is the only cable that does have a direction from which it needs to
run to and from camera.  Typically Male connector over by camera-side.

Serial (DB9) is meant to be used with Fujinon's Lens Data cables as
noted on our  Lens Connections - Fujinon  page.

As noted, this cable is optional and should only be added at the time of
the original order.
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Timecode Connections

Timecode Source

Previzion automatically searches for timecode in the following order:

Timecode embedded in the HDSDI ANC metadata (VITC,
VANC, HANC)
LTC timecode embedded in the incoming audio data

If neither of these options is found, Previzion will generate reference
timecode internally. The UI above is displayed in the Takes panel.

Analog LTC Input — Direct

As of build 5924, LTC timecode can be read directly into the RJ45 jack
of the Merlin I/O breakout box using a BNC to RJ45 adapter.

In Previzion, set the LTC Source drop down to RJ45. Since timecode is
acquired along with the video frame, the LTC light will only go green if
the HDSDI input #1 is enabled and video is coming into the system.

Analog LTC Input — Embedder

Before build 5924, to read the analog LTC timecode format into the
Previzion digital audio inputs, a converter must be used such as the
AJA HD10AMA or the AJA ADA4.

Settings for the ADA4:

LTC is routed into Input B
Output A of the ADA4 is routed into the AES Audio 1 port of
the Previzion breakout box.
All DIP switches on the ADA 4 are set to OFF.

Settings for the HD10AMA:

LTC is routed into Input B

Settings for RJ-45 LTC converter

Previzion now accepts LTC over RJ45 as of build version 5924

This box or panel allows a LTC signal sent over BNC to be converted to
RJ45 and plug directly into the Merlin breakout. This elements the need
for an audio embedder or allows for some audio emenders to be used
to pass Audio through Previzion with with proper delay, while the RJ45
adapter handles getting LTC into the system.

Plug the BNC with LTC coming out of it into the BNC jack, and a RJ45
(ethernet) between the Merlin breakout and the JR45 adapter box.

The BNC-RJ45 adapter comes in panel mount to be installed inside of
an Evertz 1u frame, or a compact 1u high box for systems without
Evertz frames.

 

Supported Timecode Formats

Previzion supports both DF (drop frame) and NDF (non-drop frame)
when the incoming timecode is being sent over as ANC data.

When LTC timecode is injected via an audio pair (Audio Embedder
method) or RJ45 panel adapter, timecode will automatically be
converted to NDF.

Timecode Channel

Under the Takes panel, set the LTC Source to the correct setting:

AES1 Pair if using the AJA ADA4 plugged into the AES Audio 1
port
Embedded Pair 0 if using the AJA HD10AMA to embed
timecode directly into Channel 0 of the HDSDI video

Flickering Timecode

When the timecode light flickers between 'Generate' and 'LTC', it
usually means that the timecode is coming in at a different frequency
than the video frames. (Timecode is set to 23.98 instead of video 29.97,
or vice versa.)

Recommended LTC Sources

In cases where a direct line to the LTC source is too lengthy, an
external LTC sync box can be used. This connects to the original signal
and 'jam syncs' to the timecode. The box can then be disconnected,
and its internal crystal timer keeps timecode sync for several hours.

Models:

Denecke SB-3
Denecke SB-T (includes genlock output, not usually necessary)
Ambient Lockit Box ACL 203

In addition, for debugging purposes, there are IOs apps capable of
generating (but not jamming) LTC. The crystal inside LTC sync boxes
are much more accurate and reliable than IOs devices, but having an
iPhone App with LTC can be handy sometimes. We
recommend JumpStart LTC (available from the iTunes App Store).

To input production LTC coming from a BNC cable, for instance, you
will need a couple of adapters.  One to go from the iPhone/iPad
headphone jack you will need: mini jack (male) to RCA (female) and
another to go from RCA (male) to BNC (female).
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mini jack (male) to RCA (female)

 

RCA (male) to BNC (female)
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External Genlock: Integrated Internal Frame Synchronization

Internal Frame Synchronization Overview

As of build 7818 (publicly released in build 7964), Previzion has an
internal frame synchronizer integrated added to its existing hardware.

This means that all Previzion outputs are able to both lock and time
(phase) to an external reference signal.  This eliminates the need for
external frame synchronizers downstream from Previzion in
multi-camera shoots.

You may still need a frame "delayer" (or synchronizer) for delaying any
camera that is not passing through a Previzion system.

All Previzion systems that have a Merlin I/O Module with the latest
Previzion builds are capable of this functionality.

Merlin I/O Module

Using Previzion's Internal Frame
Synchronizer

To send a reference signal into Previzion, use the "GENLOCK IN" on
your Merlin I/O Module.

This will allow you to make both Previzion Output 1 and Output 2
referenced to this reference regardless of the Camera HD-SDI input's
synchronization.

 

To send your Airtrack a "Genlock" signal, use either the same house
sync (master external reference) or continue to use the same
"extracted" genlock using a DAC (digital-to-analog converter) as
described in Sync & Video pages.

The controls to enable and adjust external genlock parameters are
under Video Tab as  Genlock and External Reference Timing.

By default, Previzion will reference an internal source for generating its
outputs: Freerun.  When Previzion is set to sync to an External
Reference, the output signal will automatically lock to the external
signal.

Keep Enable Internal Termination checked at all times.  We do not
recommend to use the Merlin Module's Genlock OUT and, even if you
are using it to pass Genlock through Previzion, into another device,
keep this option checked.

External Reference Timing refers to vertical and horizontal "phase"
adjustments.  It depends on the video input format and frame rate.
 Previzion has default values that compensate for these differences.
 There are also controls to tweak both horizontal and vertical phase,
should a given system need small adjustments.
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We can only adjust timing offsets using integers (whole numbers, no
decimals).

Vertical Offset rarely will need to be adjusted.  If and when you need to
adjust Horizontal Offset it will probably be a value less than 4 pixels to
advance or retrieve the horizontal video timing.

What kind of reference signals does
Previzion support?

It's important to note that reference, sync, house sync and genlock are
somewhat used as interchangeable terms, but there are two types of
"reference" signals: tri-level and bi-level (or black burst).

For the majority of our supported video formats, Previzion requires a
"tri-level" sync.  In the world of High Definition video, we refer to
"Genlock" or "Sync" when talking about tri-level sync reference, which is
analog sync reference signal.

Additionally, for 29.97PsF, 59.94i and 25PsF, Previzion is also capable
of locking and timing (phase) its internal frame synchronizer to a
"bi-level" reference.  And because the Airtrack's Genlock input also
accepts both "black burst" (bi-level) and "tri-level", this means that the
same source can work for both Genlocking the Airtrack and Previzion's
output.

For "black burst" or "bi-level" references, the phase offset should be set
to (approximately):

When in 59.94i, set "External Reference Timing"
(phase) Vertical Offset: 8 and Horizontal Offset: -625
When in 29.97PsF, set "External Reference Timing"
(phase) Vertical Offset: 8 and Horizontal Offset: -624
When in 25.0PsF, set "External Reference Timing"
(phase) Vertical Offset: 568 and Horizontal Offset: -1051

Sync signals come in many flavors. Previzion accepts all PsF signals
directly.  These include: 1080i 59.94, 1080PsF 29.97, 1080PsF 23.976
and 1080PsF 25.0.

Previzion does not currently support "p" sync signals as an external
genlock source to reference the outputs because most all television and
multi-cam productions run on PsF formats.  Keep in mind that almost
every time that someone mentions "shooting in 24p" or "30p" what they
actually mean (if you plug their video into a scope) is that they will be
shooting in 23.976PsF or 29.97PsF respectively.  The same goes for
25PsF productions.

Other professional cameras like Arri Alexa and C500 are capable of
outputting both "p" and "PsF signals independently from the internal
recording.  If using these cameras in multi-camera productions, make
sure to set the output to "PsF".  These settings are properly
documented under Arri Alexa Connections Page and C500 Connections
Page.

Delaying Non-Previzion Cameras

When using cameras that pass through Previzion and cameras that
don't pass through Previzion, a 5 frame delay offset occurs.

For the non-Previzion cameras, you will still need a frame synchronizer
or delayer to delay the non-Previzion camera to match Previzion.

Passing a video signal through Previzion, like any other video devices,
causes a minor delay in the video.  Previzion delays the footage by 5
frames.   In multi-camera applications,  cameras that do not see the
green or blue screen in its framing do not require Previzion and, hence,
do not get this 5-frame delay.

Ordinarily, this is not an issue.  However, if the intention is to mix or cut
in real-time in a specialized mixing/cutting board, we need to delay the
non-Previzion signals before it gets to the mixing board.

This is also the case when using specialized recorders that are able to
record several cameras at the same time.  Offsets in timecode and
reference (sync) are not accepted by these recorders.

To take this into account, when recording in specialized multi-signal
recorders, the Previzion video signals would require their own recorder
separate from the non-Previzion recorders.

And in live or "live to tape" applications, where the camera signals are
cut in a specialized mixing table, the clean video signals need to receive
5 frames of delay to match the timing of the Previzion signal.

To add this delay, we recommend using a separate signal processor
that is delay capable.

From For.A, the FA-9500 is handy to add this delay and is
guaranteed to pass ancillary data packets (as long as
input/output formats are the same).

From Harris, the X50 is a flexible up/down converter and is able
to perform frame delaying.
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Also from Harris, their 3GB/s line, X75 or X85, also are very
capable of performing this task.
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Airtrack Connections

Data

Power and serial data for the Airtrack, Intersense, and lens connections
are all on the 14 pin Lemo data cable connector going into the Airtrack.

Sync

The Airtrack has a genlock port that accepts bi-level and tri-level analog
video sync signals. The following devices are known to produce analog
tri-level sync:

AJA GEN10 sync generator
Evertz MSC 5500
Evertz 2430DAC-HD (sync out on grey and black cables)
Evertz 7731DAC-HD analog HD signal/sync generator using
sync output

Airtrack Sync Light Colors

The Airtrack light has the following colors:

Red: no sync signal is recognized
Green: an interlaced or PsF signal is recognized (23.98 PsF,
24.0 PsF, 25.0 PsF, up to 60i)
Amber: a progressive scan signal is recognized (23.98P, 24.0P,
25.0P). This is typically the case when using a 23.98P genlock
signal for a Red One or Epic

Seeing the amber color of the Airtrack sync LED is clearest when
looking at it face on.

Lens

Adapter cables from the Airtrack to a variety of lens controllers are
available:

Preston 3 and 4 pin MDR controller
cmotion camin 2/4/8m
Canon lenses with virtual port, using the Canon Data Splitter
RT Motion (legacy support only)

Fujinon lenses use more connectors in the RS232 spec than the TXD
and RXD that the Airtrack lens port contains, and so require a separate
DB9 R232 cable.

Intersense

The 8 pin Lemo connector connects the Intersense mount to the
Airtrack front panel, and provides a pass through serial connection to
the Previzion CPU.
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Using Multiple Cameras (Multi-cam setups)

This page references a previous configuration of this video reference
and sync that has changed in new releases of Previzion. Please
reference External Genlock: Integrated Internal Frame Synchronization
for the latest configuration.

Multiple Camera Setup Overview

Previzion is capable of integrating with other Previzion systems to allow
for multi-camera setups.  This becomes most useful in multi-camera
episodic television shows and telenovelas that ordinarily employ 2 or
more cameras.

Each "chroma" camera (cameras that require Previzion's compositing
capabilities) requires its own Previzion system.  We recommend using
the rack mountable configuration with up to 3 systems (+ spare) per
rack installation.

Taking Into Account Frame Delays

Passing a video signal through Previzion, like any other video devices,
causes a minor delay in the video.  Previzion delays the footage by 5
frames.   In multi-camera applications,  cameras that do not see the
green or blue screen in its framing do not require Previzion and, hence,
do not get this 5-frame delay.

Ordinarily, this is not an issue.  However, if the intention is to mix or cut
in real-time in a specialized mixing/cutting board, we need to delay the
non-Previzion signals before it gets to the mixing board.

This is also the case when using specialized recorders that are able to
record several cameras at the same time.  Offsets in timecode and
reference (sync) are not accepted by these recorders.

To take this into account, when recording in specialized multi-signal
recorders, the Previzion video signals would require their own recorder
separate from the non-Previzion recorders.

And in live or "live to tape" applications, where the camera signals are
cut in a specialized mixing table, the clean video signals need to receive
5 frames of delay to match the timing of the Previzion signal.

To add this delay, we recommend using a separate signal processor
that is delay capable.

From For.A, the FA-9500 is handy to add this delay and is
guaranteed to pass ancillary data packets (as long as
input/output formats are the same).

Taking Into Account Sync Offsets

Previzion currently does not sync its output to its input.  Whatever the
incoming video signal is, the Previzion output will not match its output
100%.

Although all 8 of Previzion's video signals are verified signals, the
reference sync in these outputs do not match the input's sync.  In most
general applications, this does not pose any issues.

However, as previously mentioned, in live or "live to tape" applications,

where all cameras signals are mixed and cut in a specialized table, all
sync references must match to prevent horizontal "rolls" from one signal
to the next.

This means that in these applications, every Previzion signal must be
re-synchronized in an external frame synchronizing device.

To process the signal and synchronize it to a given reference, we
recommend the following external signal processors:

From Harris, the X50.

Also from Harris, their 3GB/s line, X75 or X85, also are very
capable of performing this task.

From For.A, the FA-9500 is also rated to re-synchronize video
signals.

It is part of Lightcraft's road map to sync the Previzion output to its input
so that no external devices are necessary.
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Sync & Video - Evertz 1U (2 DAs)

Evertz 1RU Multiframe

Evertz 7701 Multiframe

The Evertz 7701 Multiframe is equipped with the same type of
converters as the original multi-box sync & video distribution but with
the added benefit of a more flexible, reliable and stage-ready
construction.  It is made of three key components:

Digital to Analog Converter
2 x (two) Distributive Amplifiers

Digital-to-Analog Converter

Evertz 7731 is a digital-to-analog converter that is able to output
tri-level sync.

This extracted sync is used to genlock the Aitrack to the camera's video
feed.

Distributive Amplifier

Using  the Evertz 7700DA, Previzion Comp Output is multiplied by
seven, allowing the feed to be send to multiple monitors and recorders.

Merlin I/O Module

To interface incoming and outgoing video, we use a specialized video
card called Merlin_IP.  This card is equipped with an I/O Module that
takes in up to 2 HD Video streams and outputs 2 independent HD Video
Composites out of Previzion.

Merlin I/O Module

GENLOCK (IN/TRHU), AES AUDIO(1/2) and HD/SD SDI OUT
(3/4) are not used in Previzion.  In the image above, these are covered
with black BNC caps.

The RJ45 port marked as RS422 is used for inputting LTC when
passing audio over HDSDI.  This requires a proprietary BNC-to-RJ45
adapter.

Using external SYNC and "house sync"

In multi-camera applications or when a specific camera requires it, an
external sync source may be used to Genlock the Airtrack directly.  This
replaces the sync "extraction" process done by the digital-to-analog
converter.  Any tri-level sync can generate the proper pulse to genlock
the Airtrack.

Often times, the term "SYNC" or "GENLOCK" are
used interchangeably.  "House sync" is usually used in television
studios where all cameras receive SYNC from a single sync generator.

Connections

When using the LTC-over-RJ45 panel, we designate one DA to
replicate the camera input ("Camera DA") and the other DA to replicate
one of the Previzion outputs ("Previzion Output DA"), that comes from
the Merlin output.

To send the camera signal from the "Camera DA", you will need  plug in
a shot jumper that goes from one of the "Camera DA" into the
Digital-to-Analog Converter's input.

This is an identical setup as Legacy Evertz 1U with Audio Embedder as
all cards are  in the same relative positions.

Previzion LTC Settings

To send an LTC input into the Merlin and, hence Previzion, a CAT5e or
CAT6 Ethernet cable (non-cross).

This connects the LTC-over-RJ45 panel and RS422 on the Merlin I/O
Module.
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To enable LTC in Previzion using this configuration, change "LTC
Source" under "Takes" tab to "RJ45."  On the right-hand side of the
screen, you will notice that "Timecode Source" changes to LTC.

Flickering of the LTC green light often indicates that the incoming
timecode is in a different frame rate than Previzion or a weak LTC
signal.
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Sync & Video - Legacy Evertz 1RU (with Audio Embedder)

This page references a previous configuration of this video distribution
box that included an audio embedder. Please reference Sync & Video -
Evertz 1U (2 DAs) for the latest configuration.

Evertz 1RU Multiframe

Evertz 7701 Multiframe

The Evertz 7701 Multiframe is equipped with the same type of
converters as the original multi-box sync & video distribution but with
the added benefit of a more flexible, reliable and stage-ready
construction.  It is made of three key components:

1.Audio Embedder
2.Digital to Analog Converter
3.Distributive Amplifier

Analog Embedder

Evertz 7721 audio embedder is used to split the incoming camera
signal between the digital-to-analog converter and the Merlin HD-SDI
Input.

LTC is received over a permanently installed jumper that embeds
analog timecode into Embedded Paid 0.

Digital-to-Analog Converter

Evertz 7731 is a digital-to-analog converter that is able to output
tri-level sync.

This extracted sync is used to genlock the Aitrack to the camera's video
feed.

Distributive Amplifier

Using  the Evertz 7700DA, Previzion Comp Output is multiplied by
four, allowing the feed to be send to multiple monitors and recorders.

Merlin I/O Module

To interface incoming and outgoing video, we use a specialized video
card called Merlin_IP.  This card is equipped with an I/O Module that
takes in up to 2 HD Video streams and outputs 2 independent HD Video
Composites out of Previzion.

Merlin I/O Module

GENLOCK (IN/TRHU), AES AUDIO(1/2) and HD/SD SDI OUT
(3/4) are not used in Previzion.  In the image above, these are covered
with black BNC caps.

The RJ45 port marked as RS422 is used for inputting LTC when
passing audio over HDSDI.  This requires a proprietary BNC-to-RJ45
adapter.

Using external SYNC and "house sync"

In multi-camera applications or when a specific camera requires it, an
external sync source may be used to Genlock the Airtrack directly.  This
replaces the sync "extraction" process done by the digital-to-analog
converter.  Any tri-level sync can generate the proper pulse to genlock
the Airtrack.

Often times, the term "SYNC" or "GENLOCK" are
used interchangeably.  "House sync" is usually used in television
studios where all cameras receive SYNC from a single sync generator.

Connections (using audio embedder)

If the incoming video has the correct timecode embedded into the
HDSDI VANC or HANC, then the RECLK OUT output of the audio
embedder should be used to properly pass timecode.  RECLK OUT is a
redirect copy of the incoming HDSDI Input and should be connected
straight into Merlin HD/SD SDI IN #1.

If the incoming video needs to be synchronized with an external LTC
analog timecode feed, the analog timecode is connected to the single
LTC IN input on the audio embedder. This causes the analog timecode
signal to be embedded in the right channel of embedded audio pair #0
in the HDSDI stream.

In this case,  HD OUT out of the audio embedder is connected to the
Merlin HD/SD SDI IN #1, instead of RECLK OUT.
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To enable LTC in Previzion using this configuration, change "LTC
Source" under "Takes" tab to "Embedded Pair 0."  On the right-hand
side of the screen, you will notice that "Timecode Source" changes to
LTC.

Flickering of the LTC green light often indicates that the incoming
timecode is in a different frame rate than Previzion or a weak LTC
signal.

 

 Connections (using RJ45 panel)

The key advantage of using our LTC-over-RJ45 panel over embedding
LTC over audio is that is there is embedded audio in the original video
feed, then this audio is left untouched.  In other words, if you need to
change between incoming LTC to using timecode over SDI (HANC or
VANC), you won't need to change any of your wiring.

When using our custom LTC-over-RJ45 panel, no changes are needed
on the video input from the audio embedder RCLK OUT and Merlin
HD/SD SDI IN #1.  In fact, in some configurations, there is no need for
the audio embedder as it is replaced with another Distribution Amplifier.

A straight CAT5e or CAT6 Ethernet cable connects the LTC-over-RJ45
panel and RS422 on the Merlin I/O Module (as shown above).  This will
never need to be physically changed.

To enable LTC in Previzion using this configuration, change "LTC
Source" under "Takes" tab to "RJ45."  On the right-hand side of the
screen, you will notice that "Timecode Source" changes to LTC.

Flickering of the LTC green light often indicates that the incoming
timecode is in a different frame rate than Previzion or a weak LTC
signal.
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Sync & Video — Evertz 2430 + AJA 10AMA

The use of Evertz 2430 combined with AJA HD10AMA is still supported
as a legacy setup. See limitations below. However, we strongly
recommend the use of the more robust Evertz 1RU setup specified here
.

Previzion Connections

Evertz 2430 DAC HD settings

The incoming 4:2:2 Rec. 709 signal from the camera is
connected to the HDSDI Input BNC connector.
The HDSDI Output BNC is connected to the Previzion HDSDI 1
input.
All DIP switches on the 2430 are set to OFF. This corresponds
to YPrPb with tri-level sync.

A straight tri-level sync signal is present on the black and the

grey sync BNC cables from the Evertz analog output. This is
connected to the Airtrack over the tether using the Genlock BNC
cable.
Sync is set to Airtrack in the Tracking tab.

Timecode (using AJA HD10AMA)

If the camera does not timecode embedded in the HDSDI stream,
timecode is supplied by an external device in analog LTC form.

LTC timecode input to Previzion is covered here.

Power

Power to the Airtrack and Intersense is provided by the included 9V
power adapter. This plugs into the Intersense serial adapter on the
computer side of the data cable.

Legacy Configuration Limitations

This legacy configuration may be limited to 110V power and PsF video
signals only.  It does not support "p" signals, like the ones output from
RED cameras.

There is also a limitation in the form factor as this "loose boxes"
configuration is not intended to be shipped around too much without
proper padding.
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Verify Video Input

Verifying Video Input

Double click the "BRec1" application shortcut on the desktop.
Verify that live video in feed is displayed in monitor window.
Exit BRec before starting Previzion, to avoid video card conflict.
If video does not display, or there are other problems, go to the 
Update Video Firmware page.
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Analyze Video in BRec

Shut Down Previzion Before Starting BRec

Previzion and BRec access the same hardware resources of the video
capture card. Starting one program while the other program is still
running can blue screen the system.

For example, when exiting Previzion, wait a moment after the window
has disappeared and make sure that the sfServer window is no longer
active.

Starting BRec

To start video in BRec:  Start->All Programs->Merlin->BRec1.

Setting Video Inputs

Video->Input Select HD->HDSDI1 or HDSDI2

Opening Monitor Window

Video->Open Source Window

Setting Incoming Video Format

Video->Input Select HD->see list

Analyzing Incoming Video Signal

Select Video->Video/Genlock Settings to bring up the above panel. This
is extremely useful, as it will automatically identify the type of incoming
video, shown under the Video Standard line. In the above image, the
video standard is HD 1080/23.98PsF.
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Capture Video in BRec

Capturing MPEG2 Video

BRec captures high quality MPEG2 video that will load directly into
Previzion. To capture:

Have the correct video input settings selected, as shown to the
left.
Right click in the BRec Batch List window, and select Insert
New Job.
Right click on the new filename, select Rename and pick a
destination folder and filename.
Right click on I to I, and select 5.
Right click on I to P, and select 1.
Right click on VT-Bitrate, and select 40,000.

Under the main BRec window:

Click the red Arm button on the main panel to prepare the
encoders.
Click the red Start Recording button to start capturing.
The status of the capture is shown in the BRec Messages
window below the main window.
Click Stop to stop recording.
Wait and watch the yellow Muxing line cross the interface; this
is BRec fusing the various data streams together.

The resulting .mpg file can be loaded and played directly in Previzion,
and the high bit rate of the encoding will mean that MPEG2 artifacts will
be minimal.
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Generate Color Bars

Generating Color Bars

HDSDI output #3 on the Merlin video I/O breakout box outputs high
definition color bars. To use:

Start->All Programs->Merlin->BRec1
Video->Video/Genlock Settings to bring up the settings panel

As shown above, select Freerun as the genlock reference. This
uses the internal timer of the Merlin card to provide a correct
clock reference for the HDSDI output signal on the color bars on
output 3 if no other input signals are connected to genlock from.

Page 113

http://www.lightcrafttech.com/images/manual/brec_bars_orig.jpg


Previzion - User Manual
by Lightcraft Technology

Lens Connections - Fujinon

Fujinon ENG Lenses

Fujinon ENG lenses provide a built-in encoder that can be read directly
through a port on the lens marked "Serial". There are two ports: 10 pin
(13 bit encoding), and 20 pin (16 bit lens encoding).

For Fujinon standard ENG type lenses w/10 pin Hirose
connectors use Fujinon part #: SA-206A-005. This is an DB9
female to Hirose male plug adapter cable.
For Fujinon 16 bit encoded ENG lenses w/20 pin Hirose
connectors, use Fujinon part #: SA-206D-005. This is a DB9
female to Hirose male plug adapter cable.
For Fujinon PL Mount Cabrio series lenses, use the Fujinon 16
bit cable: SA-206D-005.  In cases where the Cabrio lens
does not receive power from the camera body, use
SA-206D-005 combined with Fujinon SA-206R-R16P (Fujinon
RED One, RED Epic, Canon C300, Early Alexa, Etc. 20P
Preson Fiz Cable and P-Tap PWR).  This combo allows for
power to the lens as well as data pass-through to Previzion.

See "Activating Fujinon Data For Previzion" below for instructions
to power on Fujinon lenses.

To identify which kind of encoding your lens has, you may either look
closely at the bottom data port of the lens itself or by model number. A
13-bit encoded lens often has an ending model number like -S58 and a
16-bit encoded lens often has an ending model number like -T5DD.

Buying Cables

Both cables are available from B&H (search with the part #):

13-bit cable (SA-206A-005) from BH
16-bit cable (SA-206D-005) from BH

or from Fujinon's L.A. office:

Fujinon Inc.

Broadcast and Communications Products Division

2621 Manhattan Beach Blvd.

Redondo Beach, CA

90278

310-536-0800

Encoding quality

13 bit encoding is marginal — some lenses will work fine, but others will
display a slight oscillation in the zoom output, as the potentiometer
inside jumps back and forth between readings.

For reliable, high quality encoding, use the 16 bit encoding option.

Previzion Connection

To connect any of these to Previzion, you will also need a pass-through
DB9 M/F RS232 cable that is the same length as the rest of the tether.
This connects from the Fujinon adapter cable to the RS232 DB9 input
marked Lens on the Previzion system.

Fujinon Cine Lenses

For Fujinon 2/3" cine-type lenses, use the Fujinon cine 16 bit
lens encoder # FP314A. This uses incremental encoders, and
thus requires setting the min and max positions of the lens
manually at the far point of the lens barrel travel.
Alternatively, the Preston controller can be used with the Fujinon
cine-type lenses, as with any other cine lens.

Activating Fujinon Data For Previzion

On some instances, Previzion either received "stuck" values that don't
match the lens zoom/focus position or it does not detect the lens as
being connected.  The 16 bit encoded lenses use internal encoders
instead of potentiometers, so they may need to move the lens from lock
to lock to zero the encoders correctly with the lens set to "servo".

The proper startup sequence is:

1.power on the lens (re-plug the lens to the camera or power on
the camera) with the toggles underneath the lens focus and
zoom set to servo mode;

2.move zoom from lock to lock;
3.check that data is properly detected in Previzion; and
4.switch the focus and/or zoom over to manual mode as needed.
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Lens Connections - Canon

Canon Lens Connections

Canon ENG type lenses with a "virtual" port can be connected to
Previzion by using a data splitter box made by Lightcraft.

Only Powered Axes are Encoded

Only axes with internal servo control are encoded. To check this,
underneath the lens controllers, there are toggle switches that go from
"Manual" to "Servo." The lens must have a manual/servo switch for
both zoom and focus in order to read both zoom and focus data.

Finding the Remote/Virtual Port

Click the image above for a larger view. The lens data splitter box
connects to the Remote/Virtual port, as shown in this image.

Passive Data Collection

Previzion does not drive the motion of the lens. The lens motion is
controlled in the usual way, either by an operator directly moving the
lens (with the lens servo switches set to manual), or remotely with a
wired zoom or focus demand.

Canon Zoom and Focus Demand

The Lightcraft lens data splitter for Canon cameras lets standard Canon
zoom and focus demand controllers control the camera as in normal
operation, while sending out the lens position data to Previzion. The
image above shows the standard Canon FPD-400D and ZSD-300D
lens demand controllers attached.

The lens data splitter is connected to the Remote/Virtual port, and the
zoom or focus demand is connected to the matching port of the back of
the data splitter box.

There is an additional demand port on the Canon lens that the zoom or
focus demand is connected to in the usual manner. In this way,
traditional zoom and focus demand controls can be used while still
reading the real time lens motion data for Previzion

Connecting to Previzion

Connect the 4 pin Lemo lens port on the Airtrack to the 4 pin Lemo lens
port on the data splitter box with the same 4 pin to 4 pin cable used to
connect the Preston lens controllers to the Airtrack lens port.

Inside Previzion, select Canon from the lens drop down menu. The light
will go green if the lens is present.

The Canon lens encoders are high precision 16 bit encoders, but they
are incremental. When the lens is first powered up, it needs to be
moved through its full range of zoom and focus information to properly
zero the encoders; the scene will "pop" visibly under motion until this is
completed.

Older Lenses May Not Be Encoded

When using older lenses, IASD (Potentiometer Type Drive) Lenses do
not work with Previzion. Only Encoder Type Drive Lenses will work
(labeled "SE", like IASE or IRSE lenses).
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Panavision Anamorphic Lenses

Previzion and Panavision anamorphic
Lenses

Previzion is capable of working with Panavision anamorphic lenses as
long as a few requirements are met.

Video fed into Previzion must be the proper aspect ratio
corrected for the anamorphic squeeze. Meaning a circle held in
front of the camera should look like a circle on Previzion not an
oval.
The video needs to fill the whole Previzion viewer window from
right to left edge, not be a small rectangle in the middle. It also
can't fill the screen top to bottom since it is supposed to be wide
screen video and that would mean we are cropping off the right
and left sides.
Video must be in a format Previzion understands.

Once those requirements are met in Previzion select "Panavision S35
anamorphic" as your camera sensor, or manually input "49.78" for the
sensor width.

For help with Analog Standard definition video taps please see
Connections> SD analog video tap.

Panavision Transvideo monitor set to 4/3 ratio

Previzion with Panavision anamorphic video converted from SD tap

Page 116

http://www.lightcrafttech.com/overview/technical-specifications/
http://www.lightcrafttech.com/wp-content/uploads/2011/10/1000916.jpg
http://www.lightcrafttech.com/wp-content/uploads/2011/10/1000917.jpg


Previzion - User Manual
by Lightcraft Technology

Panavision Connections

General mounting for Panavision cameras

Panavision and "Panavised" cameras require additional hardware from
Panavision to mount sensors rods and follow focus motors.

First off cameras from Panavision do not use the same rod
configuration as Arri, Red and Broadcast type cameras. Panavision
cameras typically have 5/8 inch rods on the right side of the camera
instead of 15mm or 19mm rods below the lens.  Panavision does
however have a Panavision to Arri L-bracket adapter1.  This hooks onto
the Panavision side rods and gives the camera 15mm rods with 100mm
spacing above or below the lens, depending on how the bracket is
hooked to the camera. Unfortunately for this situation our sensors are
all set up with 60mm center to center spacing, so you will need to
provide one more adapter which takes the 100mm and gives you a
60mm center to center.  Zacuto 2 and Redrock3 both make such an
adapter.  However in a pinch you can use two swingarms4 to provide
the same result at the cost of added weight and bulk.  One swing arm
with 100mm spacing the other with 60mm spacing and two short rods
to attach the two together.

Secondly cameras from Panavision do not usually have a follow focus
that mounts to rods below the camera (because there usually aren't any
rods at the bottom) the follow focus instead slides onto a proprietary
block on the front of the camera body just below the lens. Thus you will
most likely need to get your focus motors from Panavision if not your
whole focus system.

1 Panavision to Arri rod adapter

2 Zacuto Jeep 100mm to 60mm center to center adapter

 

3 Redrock Omni Mount 100mm to 60mm center to center adapter

 

4 Double swing arm kludge

Page 117

http://www.lightcrafttech.com/wp-content/uploads/2011/10/1000926.jpg
http://www.lightcrafttech.com/wp-content/uploads/2011/10/jeep.jpeg
http://www.lightcrafttech.com/wp-content/uploads/2011/10/microOmniMount_lg.jpeg
http://www.lightcrafttech.com/wp-content/uploads/2011/10/1000911.jpg


Previzion - User Manual
by Lightcraft Technology

Panavision SD analog video tap

Panavision analog video tap to Previzion

In order to connect an analog video tap to Previzion you must have
some additional video converters. This is because Previzion does not
natively accept analog or standard definition video.  A combination we
have tested is to take the composite video out of the tap, and convert it
to SD SDI using an AJA D10AD then the SD SDI gets converted to HD
SDI using a Decimator MD-DUCC then into Previzion.

Video going into Previzion must be formatted and converted properly for
tracking to work properly.

The video must be in one of the supported input frame rates.
The video must fill the screen from the left to the right edge.
The video can not be squeezed or distorted, a circle held in front
of the camera must be a circle in the Previzion window, not an
oval.

We had success using the Panavision video tap to remove the
Anamorphic Squeeze from the video, then passing that through the AJA
D10AD, then have the MD-DUCC upconvert that video to 23.98PsF.
 The DUCC also had to zoom into the video cropping off the top and
bottom, which were just black, to make the video fill the viewer window.
 We were successful using the "9. IN=4:3 FS,OUT=16:9 with 4:3 ZM"
setting referenced on page 4 of the DUCC manual.  If you aren't using
Anamorphic lenses just have the video tap pass the video normally, no
need to unsqueeze however the rest of the settings still apply.

Panavision reference manuals can be found
here: http://www.panavision.com/reference?page=1&category=84

 

Decimator MD-DUCC reference manual can be found
here:
http://www.lightcrafttech.com/pdf/Decimator_Designs_MD-DUCC_V1.1
_SETTINGS_TWO_PAGES.pdf

 

 

Previzion with Panavision anamorphic video converted from SD tap

 

Panavision Transvideo monitor set to 4/3 ratio
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ARRI Alexa/Alexa Plus/Alexa Studio

Arri Alexa's output

The Arri Alexa is the only other camera with the ability to record one
signal format internally and output another format through its
MON/HD-SDI OUT outputs.  It is very important to always check that,
unless purposefully doing so, the HD-SDI output matches the internal
recording format.

For instance, the camera can record a 29.97 PsF signal internally and
output a 29.97p signal through it's MON output.  Since Previzion can
use either signal, as far as Previzion is concerned, there is no conflict
with this.

The easiest way to check that all of your frame rates are correct is to
push Info>FPS INFO

Alexa Plus/LDS Data

In the Alexa Plus, Arri LDS lens positions can be read directly out of
HD-SDI into Previzion.  In other words, when using LDS
protocol-enabled lenses on an Alexa Plus, Previzion is able to read the
lens data from the same SDI line video comes in.

Basic Requirements:

After Arri Alexa Plus firmware 7.0.2 (release notes), Lens
Metadata is now recorded/output as both raw lens encoder
information and interpreted LDS information.
Previzion uses the raw lens data.  For the latest version of Arri
Alexa Plus' firmwares, please visit Arri's website.
Previzion build 7224 or later.
In previzion you can choose to read data from a lens's internal
LDS encoders or Arri motors if they are attached to the camera.
Make sure the lens pins are aligned properly with the camera's
pins to establish a connection.

Previzion in the Electroinc Viewfinder

The are Alexa has the ability to display an incoming video signal on the
internal viewfinder, as well as an attached monitor.  This works really
well with Previzion, and helps to immerse the camera department in the
virtual environment.

Connect a composite signal from your DA to the Alexa's 
"RET/SYNC IN" using the "Monitor Out" bnc on the tether
On the Alexa go to Menu>Monitoring>RET IN
path>EVF+MON
Press the "USER" button on the Alexa, then press the jog wheel
to edit user buttons
Select which button you want to toggle the Previzion video, then
scroll down and select "Return in active"

 

ARRI Alexa's Sensor

The image sensor in the Alexa, Alexa Plus and Alexa Studio all have a
pixel pitch of 8.25 µm and share the same sensor: the ALEV III CMOS
sensor.  At a pixel recording size of 2880 by 1620 pixels, the physical
Alexa sensor width, which is ultimately the number you input into
Previzion and any post-tracking software, is 23.76 mm.

The Alexa has a look-around mode they call "Surround View", but this
uses a slightly larger range of the sensor; the actual imaged size is the
size shown above.  In order to ensure that the image size registered in
Previzion and the  image size being recorded by the camera match, tun
off  "Surround view" in "MENU>MONITORING>MON OUT or simply
plug Previzion's output into HD-SDI out 1 or 2.  The output of the Alexa
needs to be set to 1:1 of the actual imaged size, without the
look-around, to maintain tracking accuracy.

 

Status info should also be turned off, this will cause the sensor size to
be inaccurate with our default sensor size.

"Menu>Monitoring>Mon Out>Frame lines +status info>Status info>Off"

Arri D20/D21 sensor width

On Arri D20 and D21 models, the sensor has the same effective sensor
width.  When shooting 1920 by 1080 at 16:9 format it ends up being
23.76 mm wide.
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RED One Connections

RED One Configuration Overview

For using RED One signals with Previzion, there are two things to keep
in mind: the sync from the RED preview output is different and the
actual preview output is actually at a size of 1280x720px at 59.94Hz
and 720p at 50Hz, in the case of PAL signals. In other words,
regardless if you are shooting in 2K, 3K, 4K or 4.5K on the RED One,
the preview output is always at a 720p size with a sync pulse of either
59.94Hz or 50.00Hz. The issue with having the camera output a sync of
only 59.94Hz or 50.00Hz is that the Airtrack expects sync at the
shooting rate.  This becomes especially problematic when using a
frame rate of 23.978 or 25.

We recommend  two ways of solving this:

An external sync generator for locking both the Airtrack and the
RED One (see RED One Configuration, Sync Generator at
23.98 PsF or 25PsF depending on the application).
A converter to bring the RED one video to a more standard
format and derive Airtrack sync from this signal.

 

RED One Configuration
Sync Generator at 23.98 fps

When using the RED One, motion can strobe or look jittery.  In order to
make the video signal proper and motion proper, use a Genlock source
at 1080/23.98p (tri-level sync reference signal).  And SET PHASE TO
45.

There are a few options to generate sync source.  We recommend
using a dedicated box, like the AJA Gen10.  We also recommend
Sound Devices' Pix 240i.

To set Phase on a RED One:

In the RED menu, navigate to SENSOR->SHUTTER->PHASE
and advance the shutter phase by 45 degrees for correct sync.

When using an AJA GEN 10 or equivalent generator:

Select the option to generate a 1080p 23.98 reference (not
1080PsF).
This should be the signal feeding both the Airtrack and the RED
One camera.
Run two separate feed to these and avoid splitting the signal.
The DIP switch setting on the back panel of the AJA Gen10 for
23.98p is:

1.OUT 1-4: HD
2.OUT 5-6: HD
3.SD OUT: BLK
4.FORMAT: 59.94
5.HD FMT: 1080 or 720 (does not matter)
6.S1: 0
7.S2: 1
8.S3: 0

 When the DIP switch is set to the above, and the GEN10 is
connected to the Airtrack, the Airtrack's Sync light will switch
from red to amber, signifying the presence of a 23.98P (as
opposed to PsF) signal. PsF signals generate a green sync
light.

Set the frame delay under the Tracking tab to match the RED
One (about 1.5 frames in our tests.)

RED One Configuration
Sync Generator at 25 fps

When using the RED One in 25fps, the output will be 720 in 50Hz.  For
1080×720 HD formats, 50p and 25p have identical video signals.
Previzion is able to take this video input and convert it to 1920×1080
25PsF.

Like the setting about, you will need to generate a separate sync pulse
to "Genlock" the Airtrack at 25PsF.  Use a Gen10 with the same
settings as above, but with switch "Format" set to 50.

NOTE: that audio pass-through does not work with this format.

RED One Configuration
Format Converter at 29.97fps

For using RED One signals with Previzion at frame rates other than
23.98, we highly recommend up-converting the signal to a more
standard signal that other professional devices understand.  For this,
we recommend using a up/down/cross converter box like Decimator
Design's MD-DUCC, or equivalent, like MD-CROSS. In the RED
menus, advance the shutter phase by 45 degrees for correct sync.  This
is under "Sensor", "Shutter Menu" and "Phase".

The MD-DUCC is a converter box that might as well be the Swiss Army
knife of video converters boxes.  It is an inexpensive and effective tool
that we strongly recommend. For 25 fps, 29.97fps, 60i and so on, the
procedure is essentially the same: up-convert the signal to
1920x1080px at the closest PsF rate.  Connect the MD-DUCC to the
RED One preview output (720p) and, through an active loop, extract
Airtrack's required sync from this retimed scaled output as well as
Previzion's main output. For setting up a RED One at 29.97:

1.Set your MD-DUCC's "Scaled Output Format" to
1080/29.97PsF. This will convert the preview output from
720/29.97 @ 59.94Hz to 1080/29.97PsF.

2.Extract Airtrack sync from this signal.
3.In Previzion, select 1920x1080px - 29.97PsF.

The one tricky part of the MD-DUCC is its menu and settings which can
be somewhat confusing. For a list of all the menus and settings,
download it from:

MD-DUCC Manual Firmware Version 1.1 Settings

NOTE: VANC (video time code) does not pass through the DUCC, the
camera and Previzion will need to pull timecode from an external
source. Also the factory setting for the output scaling is OFF. Please
ensure that your MD-DUCC's "Scale Enable" is ON. 
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RED One Post

The RED One is unique in the sense that the field-of-view being
recorded internally is different from the field-of view coming out its
720p/HD-SDI outputs.  In other words, RED Ones use a different
sensor size for the live output than for the actual recorded image.

For example, when shooting 4K (16:9), the preview output will use a
24.192 mm sensor width, while the actual image uses a 22.118 mm
sensor width. The live preview sensor width is about 109.375% the size
of the internally recorded image.  The correct sensor size needs to be
entered into Maya, Syntheyes, etc. for the data to track properly.

This difference varies when using Anamorphic resolutions (ANA) or the
whole sensor at 4.5K WS resolution. Please use the tables below to
reference the proper sensor size to input in your post-tracking software.

IMPORTANT:  The focal length is a property of the lens alone, and will
not change.

Sensor Width

Red ONE cameras with the Mysterium-X (MX) sensor have the
following sensor sizes:

 

RED ONE Mysterium-X format sizes:

 Recorded Resolution
Resolution Name on

RED One Menu
Recorded Sensor

Width

MON OUT Sensor
Width

4480 x 1920 4.5K WS
(2.33:1)

24.192 mm 24.192 mm

4096 x 2304 4K  (16:9) 22.1184 mm 24.192 mm

4096 x 2048 4K  (2:1) 22.1184 mm 24.192 mm

3840 x 2160 4K HD  (16:9) 20.736 mm 24.192 mm

2816 x 2304 4K ANA  (2:1) 15.2064 mm 16.308 mm

3072 x 1728 3K  (16:9) 16.5888 mm 18.144 mm

3072 x 1536 3K  (2:1) 16.5888 mm 18.144 mm

2112 x 1728 3K ANA  (2:1) 11.4048 mm 12.2688 mm

2048 x 1152 2K  (16:9) 11.0592 mm 12.096 mm

2048 x 1024 2K  (2:1) 11.0592 mm 12.096 mm

1408 x 1152 2K ANA  (2:1) 7.6032 mm 8.2944 mm

 

In Previzion, we use the widths in the "MON OUT" column.  But, when
doing any type of post-tracking, make sure to use the sensor widths
from "Recorded Sensor Width."

Timecode Sync

The HDSDI preview output of the RED One will sometimes exhibit drift,
even when genlocked. This will show up in the Previzion user interface
as a red light on the Sync error panel, and an elevated frame rate (26 or
27 instead of 23.9-24.0). This can be corrected by stopping and
restarting the incoming video.

Timecode Embedding

To enable timecode embedding in the output preview HDSDI signal,
check the box in the Red menu: Project->Timecode->Output. You can
verify the Previzion timecode sync with the Red timecode with
Project->Timecode->Display.

Shooting High Speed

Red ONE cameras have the ability to shoot in variable frame rates.
 However, the HD-SDI monitor outputs (Mon Out, HD-SDI Out) are
always at a standard frame rate that Previzion can read.  This is often
24fps at 720p resolution or 25fps at 720p. The reason for this is
because the camera's monitoring  outputs must always be usable by
regular HD monitors.  Since this is the same output that Previzion
listens to, Previzion simply composites on the signal as a regular signal.
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RED Epic/Scarlet Connections

RED Epic/Scarlet Connections

Most often, when a camera manufacturer writes that their output is
23.98p, they actually mean that it outputs 23.98PsF.  The Red Epic,
however, actually outputs a 1080/23.98p (not PsF) output.

As of Build 6466, Previzion's 1080/23.98p video format setting takes
this signal directly and outputs it without any video conversion.  In other
words, Previzion takes in a "p" signal and outputs a "p" signal.

Previzion also supports 1080/25.0p  and 1080/29.97p inputs.
 This discards the need for any video converter boxes in virtually all
RED Epic/Scarlet applications.

EPIC at 25fps and 24fps

It is important to note that, unlike the RED ONE camera, RED EPICs
have an extra setting for its HDSDI output that needs to be changed
whenever going from 24fps to 25fps and vice versa.

An indication that your timebase is off will be to see "timecode
repeating" flashing in random intervals in Previzion or by hooking up a
professional reference monitor to the HDSDI output from the RED
directly.  There are two settings in EPIC cameras to watch out for:

1.Timebase - the internal recording of RED EPIC/SCARLET
cameras is set under SETTINGS > PROJECT > TIMEBASE >
25fps or desired frame rate

2.HDSDI Output - the frequency of the HDSDI output from EPICs
can be set independently from the internal recording.  The
mismatch is what can cause monitors and Previzion to act up.
 Make sure that whatever frame rate your project is set to the
HDSDI output matches it.  Under SETTINGS > AUDIO/VIDEO >
MONITOR CNTL > HD-SDI> FREQUENCY (BRAIN HDSDI) >
25Hz or corresponding frequency. Verified with RED EPIC X
firmware version 3.3.14.

The designation "Brain HD SDI" refers to the left-most mini-SDI port that
is next to the HDMI output in the rear of the EPIC.  This is the output
that should be going to Previzion.

As long and the HDSDI output frequency matches your project's frame
rate, Previzion is able to read ANC Timecode (build 6903) as well as
embed tracking metadata properly.

Older Builds of Previzion ( - For older versions of Previzion, a
converter must be used to convert the 1080/23.98p signal to
1080/23.98 PsF. The following 2 converters are known to do this:
Cobalt Digital 8021,Decimator MD-DUCC.

Genlock and Sync

It is recommended to use an external 1080/23.98p or 1080/25.0p
sync generator to directly sync the Red Epic and the Airtrack,
instead of deriving sync from the Epic HDSDI output. This is
because the HDSDI output can drift, requiring adjusting the
tracking delay to keep the foreground and background in sync.

Epic/Scarlet Sensor Size (Mysterium-X)

As of June 2012 firmwares, Red Epics have a "5K HD" mode, along
side "5K 16:9" and the "5K" (Full Frame) mode.  Make sure there is
no look-around area being sent out the HD-SDI output.  See the
notes below for more information.

Here is the calculated sensor widths for all of the Red Epic
settings (based on a 5.4 µm, or 0.0054 mm, pixel pitch):

 

Resolution Description Sensor Width

5120 x 2700 5K FF (Full-Frame) 27.648 mm

4800 x 2700 5K HD 25.920 mm

5120 x 2560 5K 2:1 27.648 mm

5120 x 2160 5K WS (2.37:1) 27.648 mm

3600 x 2700 5K ANA 19.44 mm

4096 x 2160 4K 22.1184 mm

3840 x 2160 4K HD 20.736 mm

4096 x 2048 4K 2:1 22.1184 mm

4096 x 1706 4K WS (2.4:1) 22.1184 mm

3072 x 1620 3K 16.5888 mm

2880 x 1620 3K HD 15.552 mm

3072 x 1536 3K 2:1 16.5888 mm

3072 x 1280 3K WS (2.4:1) 16.5888 mm

2048 x 1080 2K 11.0592 mm

1920 x 1080 2K HD 10.368 mm

2048 x 1024 2K 2:1 11.0592 mm

2048 x 854 2K WS (2.4:1) 11.0592 mm

1280 x 720 1K HD 6.912 mm

1280 x 480 1K WS (2.4:1) 6.912 mm

** Based on 955-0003_v.3, Rev-A1

Epic Focus Magnification

If using the Epic focus magnification to get correct focus while
calibrating lenses, be certain to turn it off before starting a lens
calibration sequence! Otherwise, you will get incorrect results (a
32mm prime will read as a 85mm focal length.)

RED Epic/Scarlet "HD-SDI Output" with
Look-Around

In addition to the above, it is important to check the "HD-SDI
Output" before running lens calibrations and comps in Previzion.
 As of October 2012, RED Epics have a firmware update that allows
for Lookaround that affects Previzion during lens calibration and
tracking.

The default setting for "HD-SDI Output" in the new RED cameras is
"PROGRAM" output, which provides a clean video feed.  However,
this setting can also be set to "MONITOR" output, which provides
a slight look around view as well as burn-in Timecode and Title
Safe/ Action Safe Frame guides.

Epic Black Bars in Video Signal

Since the Epic sensor is a 1.88:1 sensor, and the live HDSDI output
is 1.78:1, there are black bars on the top and bottom of the image.
These will create a slightly strange artifact when they intersect
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with garbage mattes, but will not affect the 5k recorded data.
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Canon C300/C500 Connections

Using Canon C500

The Canon C500 is a good camera for broadcast and works great with
Previzion.  Other than the usual adjustments, like disabling sharpening,
lowering the ISO/gain a notch below native, etc., if the production
intends to use any of the 4K or 2K formats that are in 17:9 aspect ratio,
make sure to adjust the sensor width to match (see "Canon Cinema
Sensor Sizes" below).

The C500 has an internal recording that is always in the respective
frame rate at 1920×1080 resolution in MXF format, regardless of which
capture mode (HD, 2K or 4K) the camera is set to.  Transcoding
Canon's MXF format and preserving timecode along the way is not
trivial.  Make sure to try this format with your post-production pipeline
before entering production.

From Canon C500 User Manual, page 23

Canon's recommendation is to actually use an external recorder such
as the AJA KiPro line of recorders to properly capture footage.  For 4K
or 2K productions, make sure to implement the use of a supported DPX
4K capable external recorder such as AJA KiPro Quad. Currently, AJA
KiPro Quad is capable of recording the C500's full 4K resolution, but it
does not record Preivizion's tracking metadata (SMPTE 315M)
for reperformance. Please use a KiPro or KiPro Mini for reperformance.

There are a few options for connecting Previzion to the output.  To
avoid confusion, for everything Previzion, use HD/SD SDI instead of
any of the 3G or Mon 1 & 2 outputs. When using HD/SD SDI, disable all

menus from being displayed in the output (VIDEO SETUP> HD/SD
OUTPUT> HD Onscreen Disp.> Off).

If, for whatever reason, HD/SD SDI is not available, you may choose to
use MON 1 or MON 2 as Previzion sources.  Make sure that MON 1&2"
is set to:

Resize Output  to LETTERBOX
Output set to On
LUT to Rec. 706
Scan Mode can be either P or PsF (make sure to set matching
input format in Previzion)
Resolution should match your project (i.e. if project is set to 4K
4096 resolution, the output resolution should be the same.)

Also, when using supported formats, the C500 SCAN MODE will have
to option of being a "PsF" or "P" signal, independently set from the
internal recording.  Previzion can work with either.  Just make sure that
whatever is set on the camera is set in Previzion.

Additionally, you may choose to use the SYNC OUT from the camera
as a genlock source to feed the Airtrack's Genlock input.  Simply set
SYNC OUT as Output and "HD Sync" (tri-level sync) with SYNC
OUT>SCAN MODE set to "P" or "PsF" to correspond with HD/SD
SDI>SCAN MODE. This is not necessary, but it is an option.

Using Canon C300

Canon C300 is not always recommended as a Previzion camera
because of the many quirks in its output signal.  If the intention is to film
a project at 24fps, this is not the camera for you.  However, if the show
is being captured at 25.00PsF (set Prevision to 25PsF), 29.97P (set
Previzion to 29.97.PsF) or 59.94i (set Previzion to 59.94i), the C300
works fine with Previzion.

Just like the C500, the internal recording in the C300 is always in MXF
format at 1920×1080 in the corresponding frame rate.  Make sure to try
using the footage in your post-production pipeline before implementing
this camera in your show.  Using the footage recorded internally
preserving timecode and other metadata from MXF format requires
some attention.

Use the HD/SD SDI terminal to connect to Previzion's input.  Make sure
to set VIDEO SETUP > SDI OUTPUT to HD and disable the onscreen
menu from the output in VIDEO SETUP > HD Onscreen Disp.  and set
to OFF.

Canon Cinema Sensor Sizes and Aspect
Ratio

Both Canon C300 and Canon C500 cameras share the same Digic DV
III CMOS sensor.  This sensor has a 6.4µm cell pitch. This yields the
following sensor widths (or backplate):

C300/C500 in HD-MXF (16:9 mode) - 24.58mm
C500 in 2K 1920×1080 (16:9 mode) - 24.58mm
C500 in 2K 2048×1080 (17:9 mode) - 26.21mm
C500 in 4K 3840×2160 (16:9 mode) - 24.58 mm
C500 in 4K 4096×2160 (17:9 mode) - 26.21mm

The C500 does not crop into the sensor to match the pixel count of the
resolution as much as it uses the same are of the sensor, but it
down-samples the image.  In other words, the FOV (field of view) of the
4K image in 16:9, for instance, matches the FOV of the MXF HD image
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in 16:9.
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Preston Connections

Preston FIZ/MDR Connections

The Preston MDR Mark II or III can be connected with the Airtrack with
the included Preston 3 pin or 4 pin cables. The connection on the
Preston MDR motor controller is labeled Serial.

To get the best performance and lens sync from the Preston, the
firmware on the MDR motor controller should be updated.

To update your Preston FI+Z unit you will need a Serial to Lemo cable
(part # 4538) and a usb-to-serial adapter if the computer where the
update is being performed does not have available Serial COM ports.
 The latest downloads are avaiable from  Preston's website.
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C Motion Connections

C Motion Connections

Previzion connects to the C Motion cvolution camin 2M/4M/8M
controllers as well as the Compact LCS system, and reads zoom and
focus information.  Legacy 3 channel LCS systems are not supported
by Previzion, or C-Motion.

Notes:

Previzion requires C Motion firmware rev 3.9.16 or higher on the
camin.
Camin 2M units must be mapped for focus, and zoom on the
hand unit to work properly with Zoom lenses.  The Iris slider
may be mapped to zoom, but that must be changed in the hand
unit's software.
To update the C Motion firmware, you will need the C Motion
CPC-3 cable and USB/Serial adapter, along with C  Motion's
CUpdate PC program.
To connect C Motion data to Previzion:  use the Airtrack to C
Motion cable from Lightcraft. This removes the need for an
external DB9 cable. The lens data is then read as usual through
the Airtrack lens port.
A C Motion 'Motion Control' serial connection cable, part #
RMO-1, connected to the EXT 1 port on the camin motor
controller, can also be used. This requires the use of an external
DB9 RS232 serial cable.
If using the RMO-1 connection cable, on the Previzion side it
goes to the same COM3/ Lens port that the Preston and other
lens controllers connect to.
In the Previzion UI, the C Motion is selected with the 'C Motion
camin' selection under Lens. If the Camin is connected and
awake, the light will go green in the Previzion UI.

Remapping Axes

The C Motion camin 2M motor controller has only zoom and iris motor
inputs. However, the iris motor can be mapped into a zoom motor, so
that the camin 2M can be used with Previzion for a zoom lens. This is
accomplished through the C Motion hand control unit menu.
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Cooke Connections

Cooke Connections

To connect to Cooke lenses, use the Cooke Lens data cable sold by
Lightcraft. This cable includes a Anton Bauer D-Tap connection for a
12-14V input, which provides power for the internal processor on the
Cooke units.

This has been tested on the Angenieux ADS encoder for zoom lenses.
Check with Lightcraft for support on other Cooke encoded products.

Connect the 4 pin 0B size Lemo to the Airtrack, the 4 pin 00 size Lemo
to the ADS encoder, and the D Tap power connector to a live Anton
Bauer receptacle.

Initialize Lens

When you power the ADS unit you need first to initialize the encoders.
For that, when the led is blinking green:

Put the iris ring at T:22 end stop.
Put the zoom ring at wide angle end stop (28mm for the 28-76).
Put focus at close distance end stop (less than 2').
Press the button on the unit less than 5 seconds. The led will
stop blinking and stay green. The unit is now initialized.

The unit is equipped by a battery to keep the encoded values if you stop
the power for less than 20mn. When you power the unit again the led
will become green again without blinking. If you stop the power for more
than 20mn you WILL need to re-initialize the ADS unit.

Connect in Previzion

In Previzion, select Lens->Cooke; the light by the tracker will go green if
the lens is correctly recognized.
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Element Technica Connections

Element Technica Connections

Serial data is read from the Element Technica rigs through their
Metadata port. A Lemo to DB9 cable is required for this; contact
Element Technica for details.

Part #: T3D-C-232-10DB9-C10
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Testing Serial Connections

Testing Serial Connections

When using several Serial Port connections, it is always good practice
to be able to test each port to ensure that all the connections are
communicating properly.

The purpose of this test is to send some data from one port to the other
to ensure that the Serial cards, the cables and all the connectors are
good. The way we will do this is using a program called RealTerm. We
will open two windows of it. One sending data. The other receiving data.
When we type a message on one port, the other port should pick it up.

What you will need

(1) Null Modem Serial Cable (a crosslinked Female Serial to
Female Serial. 
http://www.amazon.com/Startech-Serial-Modem-Cable-Cross/dp
/B00006B8BJ)
"Realterm.EXE" (free to download from the SourceForge pages
- http://sourceforge.net/projects/realterm/)

Install RealTerm

1.Download the .zip from the above mentioned link.
2.Copy it to your Previzion machine.
3.Unzip the folder and open "SETUP.EXE"
4.Follow the setup with "typical" installation. This should only take

a minute or so.
5.When the installation is complete, you will find the RealTerm

program under "Start", "All Programs", "Realterm" and
"RealTerm.exe"

Connect the Cable

Firstly, locate your motherboard serial connection.  This will be by the
USB connectors.

If you have an older Nexcom Machine, the connector is the lower one
and it is located on the panel on the right.

Secondly, identify the serial connectors that come out of your Serial
Card on your Previzion Machine.  These are color coded and are
labeled (S1 Lens - Red, S2  Encoders - Green, S3 Airtrack - Blue and
S4 Intersense - Yellow).

Thirdly, we will physically connect the Null Modem Serial Cable to the
motherboard serial connector on one end and to the S1 (Lens -Red)
serial connector on the other end.  We will start with S1 and work our
way up to the other ports.

Run the tests

We now have the motherboard serial port(COM1) connected to our
Lens Port (COM3).  To open Realterm, go to "Start", "All Programs",
"Realterm", "Realterm".

This opens one instance of Realterm.  Let's open another one.  This will
give us the following prompt.  Just okay it for now.
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To keep this process neat, let's place one window to the left of the
screen and the other to the right.  We will use the left one to send data
and the right one to receive data.  If the ports are all working properly,
we will see a message go through.  That is essentially the test.

Under the "Port" tab in Realterm, set the BAUD rate on both windows to
"9600".

On our left transmitting Realterm window, set "Port" to "1".  Check
"Transmit".  Click on Open.  Conclude by clicking on "Change".

On our right receiving Realterm window, set "Port" to "3".  Check
"Receive".  Click on Open.  Conclude by clicking on "Change".  Your
status indicators should chance at this point.

Finally, what we need to do is click on the black portion of the left
transmitting window and type on the keyboard "Hello World!".   You will
not see it on that window, but on the right receiving window.  This

means all is good and your ports are all working.

If you are not seeing this.  Please triple check your cable (must be a
Null Modem Serial) and that it is connected to the ports indicated
above.

Testing other ports

To test the other ports, disconnect the Null Modem Serial cable from s1
Lens port and connect to S2 Encoders port.

On your right receiving window, change "Port" to "4". Click "Change".

On your left transmitting window, type out "Hello World from Port 4".
This should be displayed in your right Receiving window.

Continue with the next two ports this same manner. S3 (Airtrack - Blue)
will be "Port 5" and S4 (Intersense - Yellow) will be "Port 6".

If you have the optional upgrade for a second serial card, you will have
another set of 4 serial ports. These will also have on them S1, S2, S3
and S4. They will follow S1 as "Port 7", S2 as "Port 8", S3 as "Port 9"
and S4 as "Port 10".
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Capturing Serial Data

Capturing Serial Data in Realterm

Once you can see packets of data coming into Realterm, you can
capture them to a text file.

Change to the Capture tab.
Set the End After setting to about 5 seconds.
Make sure Direct Capture is checked. This will stop sending
data to the screen during capture, which takes computer time,
and will prevent missing characters in the captured file.
Click Start: Overwrite to capture the file to the specified
location.
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Preview Output (Deprecated Feature)

This page references a deprecated feature. Please check with your
Lightcraft representative for the latest process.

Preview Output

In addition to the standard HDSDI output on the Merlin card, Previzion
has a low latency preview output that is generated through the 2nd
DisplayPort output connector on the nVidia Quadro card. This has a
much lower latency (1-2 frames, depending on the camera), but shows
significant visual artifacts (tearing, etc.) and does not have embedded
timecode, audio, or any HDSDI metadata. It's meant as a high speed
preview for camera operators, with the regular synchronized HDSDI
signal being used for recording and editing in post.

The way it works is to create an extended desktop with a DisplayPort
device connected to the output, then run Previzion. Previzion will
recognize the second device, and write a full size copy of the current
preview window to the second desktop. If a device such as an AJA HA5
HDMI to HDSDI converter is connected, the result is a very rapid
HDSDI composite preview.

Connection and Screen Setup

Exit Previzion before changing desktop mapping settings.
Connect the AJA HA5 to the second DisplayPort
connector, using a DisplayPort to HDMI converter cable.
Right click on the desktop, and select nVidia Control
Panel
Under Display->Set Up Multiple Displays, select Clone.
The red light on the AJA will light.
Reboot the machine.
When the machine comes up, right click the desktop and
select nVidia Control Panel again, then Set Up Multiple
Displays. If it does not default to DualView, select
DualView and confirm. The 'DVI 1920' remains the
primary monitor display.
You can verify the extended desktop by sliding a window
over to the right; it will appear on the HDSDI stream.
If necessary, return the main display to 1920×1200 or
1600×1200 with the Change Resolution panel in the
nVidia Control Panel.
Exit the nVidia Control Panel.
Now start Previzion. The output will appear on the
secondary display, with the same low latency that the
primary UI window has.
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Binding Systems Together - Working with more than one Previzion

Multi-Previzion Systems

When working in multi-camera shoots, you may need to work with more
than one Previzion system.  With that in mind, Previzion has a TCP/IP
based system state transmission that, from a Master Previzion System,
sends the system state information relevant to all bound systems.

In other words, you can setup 2 or more systems together, change all
crucial settings in the master system and make all connected systems
mimic the settings.

Operating Multiple Systems and Adding
Connections

When using multiple systems, things can get confusing really quick.  As
a recommendation, we suggest always having a piece of paper or
notepad to jot down important notes.  It is also helpful to have the
desktop image in your systems have an identifying feature like a tag
that shows "SYSTEM 1" or "CPU 1."

Multi-rack systems shipped from Lightcraft are configured with high-end
KVM switches that can be triggered by the keyboard number pad and
all desktop images have an identifying tag.

1.Start by designating a system to be the "Master" system. All
other systems will be set as "Bound" (or "Slave") systems.

2.Make note of the IP addresses for all Slave systems. To look up
the IP address from your Slave systems, please reference
below under "Looking up your IP address."

3.Create a new Previzion network connection for the Slave
systems.  To do this, in the Master system, select Add,
under Network Connections, in "System" tab.

4.Input your IP and select "State/Event" for the connection type.
 Then press Add.

5.Repeat steps 3 and 4 for each Slave system.

Once the systems are bound together, when the master system
"transmit" a change (i.e. background color, video play/pause or take
directory information), all bound systems reflect this change.

Confirming Connectivity

The Master system should list the "Type" of connection as "State/Event
- Out" for each Slave system.  The Network Connections Pane should
look something like this:

Also, check that the "Status" of all Slave systems is "Connected."
 Should you find a system that reads "Connecting" and is not resolving
within a few seconds, check that Previzion is launched and operational
in that system.

Each Slave system should list the "Type" of connection as "Previzion -
In". The Network Connections Pane, in System Tab, should look
something like this:

Removing Connections

To remove or disconnect from another system, simply select the system
from your Network Connections Pane list and click on "Remove".

Transmitting System States

To "Transmit State," use the hotkey shortcut Ctrl+T.

For rolling/cutting takes, when a take starts or cuts either by pressing
"Roll"/"Cut" or by using the corresponding keyboard shortcuts, all bound
systems will also "Roll" and "Cut" simultaneously.  Please note that
when changing take information, the "Transmit State" must be triggered
to send all changes.

For controlling videos, "Play All", "Reset All" and "Pause All" are also
transmitted in real time without the need to "Transmit State."

For opening scenes, loading and assigning videos to video destinations,
simply adjust these on the Master system and, as long as all assets are
located in the corresponding directories in all Slave systems, at the time
of "Transmit State," these will be loaded in all Slave Systems.  Please
refer below to "Sorting Scenes and Assets in Multiple Systems" for
more details.

All other settings are only sent when "Transmit State" is triggered.  The
entire state of the system is sent over the TCP/IP when this is triggered,
with the following exceptions:

Tracking sources (Sync, Pos/Rot, Lens Source)
Tracker to Camera Offsets (each mounting may be different)
Lens File Selection (each lens is unique)
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Take Camera Name (each camera name is different)
CgFx parameter values (not yet supported in system state
save/load)

Looking up your IP address

To look up the IP address from a given system within Previzion, in the
System Tab, click on About.

This will open a window with the system IP number and build number.
 Make note of your IPv4 Address.

IP addresses are unique numbers that identifies a given system in a
network.  IPv4 has been widely implemented and it is still commonly
used.   The address should start with 192.168.#.### or 10.0.#.### and
so on.

If you are not getting a valid IP address (like 127.0.0.1), make sure that
the Previzion system is connected to a router, all cables are properly
connected and the router is turned on.

Please note that systems must be plugged into the same router and
network.

Sorting Scenes and Assets in Multiple
Systems

For bound systems to work the same, the location of assets should also
be the same.  This is the same case for Take directories.

In other words, a video that is intended to be used in a multi-Previzion
shoot that is saved in the C:\Program Files\Lightcraft\Scenes\ folder in
the Master system should also be saved in that exact same location in
all Slave systems.

We recommend saving all cg scenes, videos and alpha videos
in C:\Program Files\ Lightcraft\Scenes\ or sub-folders within.  Avoid
saving anything in the desktop as Desktop folders can vary depending
on the Windows username.
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Tracking Interface

Trackers, Sync Sources and Tracking Delay
Intersense Connection
Intersense Orientation
Camera Sensor Offsets
Watching Intersense Targets
Airtrack Smoothing
Lens Data
Stereo Data
Observer View
Stereo Rig Offsets: Technica3D
Setting Angular Offsets
Stage Alignment
Camera Position Panel
Camera Offset Panel
Tape Measure Tool
Feature Tracking (TTL Tracking)
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Trackers, Sync Sources and Tracking Delay

 Sync Sources

Previzion's internal data capture and rendering engine can be
synchronized to external, data driven signals, or an internal timer when
no external sync data signal is available. The external encoder box and
the Airtrack both generate serial data streams when triggered by a
tri-level sync genlock signal applied to their genlock input.

When first started up, Previzion defaults to the Timer sync, but will store
the selected sync sources when shut down, and automatically
reconnect to them when started up again.

Tracking Delay

The frame delay sets the delay of the tracking data to synchronize with
the video. Digitizing the video frames always takes longer than bringing
in the tracking data, so the delay lets you adjust this to make the
images synchronize with the tracking motion.

Turn off Motion Blur in Scene Tab by setting the Motion Blur
Scale to 0.00.  This will make it easier to view the delay
difference.
Have the camera operator pan back and forth in short hops
while looking at the foreground/background registration and
adjusting the time delay by 1/2 a frame at a time.
There should be a point where FG and BG move closely in
sync.

Lens Delay

As of build 7818 (publicly released in build 7964), Previzion has a
separate slider for Lens Delay.  Because some lens controllers can be
faster or slower than the physical tracking data delay, you will need to
adjust this as well.

The difference between Tracking Delay and Lens Delay should be
around 0.5 frames or so.

Quickly zoom in and out with the lens controller until the virtual
and real elements move together.
For prime lenses you may do the same with the focus
adjustments, but, setting the Lens delay to match Tracking
Delay, may be easier.  Prime lenses are harder to tell delay
differences.

Airtrack Sync

When the Airtrack or encoder box is connected to Previzion over RS232
and connected to a genlock signal, the green light to the right of the
drop down box will light up to show a sync connection.

Select Airtrack from the Sync menu, and verify that the green light
goes on. If not, check the power and serial data connections for the
Airtrack.

Video on Previzion Tracking Delay
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Intersense Connection

Position and Rotation

The menus for Location sources are similar. The Intersense and
Airtrack are treated as a single data source.

To connect to the Intersense/Airtrack, make certain that no other
Intersense applications (ISDemo, SFServer, or InertiaCamTest) are
running. Select Intersense from the Position menu, and wait about 5
seconds. The green light should come on, and the virtual background in
the main display window should move.

SFServer

The sfServer window should open when Airtrack/Intersense tracking is
selected.

1 IMU should be detected
The Vertical Refresh Rate should be about 2x the current frame
rate; in this case 59.94
The highlighted number at the bottom should be around 180
when running at 29.97 frame rates, and around 140 when
running at 23.98 frame rates.

Once the background moves, select Intersense in the Rotation drop
down selection box, and the virtual background"s rotary motion should
be driven by the Intersense.

Intersense Offsets

Clicking the Configure button next to the Location drop down menu
when Airtrack/Intersense is selected brings up their configuration menu
within Previzion.

The default orientation of the IS1200 is with the lens facing forwards (in
the same direction as the camera lens), and the cable exiting the body
from the right. In typical stage tracking applications, the IS1200 will be
tilted up at an angle, or pointed directly up at the ceiling.

In the Pitch/Tilt value box, enter 90 degrees if the IS1200 will be pointed
vertically up from the main camera. The adjustable Intersense mount
has 22.5 degree increments, and rotating the mouse scroll wheel will
cause the tilt to change in 22.5 degree increments, for fast on-stage
correction.

Position Scaling

For previsualization purposes, it is useful to be able to scale the position
data. This enables large camera moves to be simulated within a small
physical space.
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Intersense Orientation

Intersense Orientation

When configuring offsets and settings for the Intersense IS-1200, you
will also need to take into account the Intersense Orientation in relation
to the production cinema camera.

To access the Airtrack/Intersense Configuration window, navigate to the
Tracking Tab and, under Sync or Location, you will need to have them
set your Sync and/or Location trackers as to Aitrack
and/or Aitrack/Intersense respectively.  Click on "Configure" next to
either of these trackers to open this Configure window.

To enter the Intersense orientation, we reference the Intersense camera
as pointing all the way forward, with the Intersense sticker facing up
and with its connector sticking to the right as being 0 degrees for Pan
and 0 degrees for Tilt.  This is the Intersense's default orientation.

Yaw/Pan - refers to the rotation of the Intersense in a horizontal
plane.
Pitch/Tilt - refers to the rotation of the Intersense in a vertical
plane

In Previzion builds preceding 6310, there used to be another parameter
marked as "roll."  It referred to the rotational offset in degrees around
the length of the IS-1200 from front to back and it made things very
confusing.

With that in mind, if we have the Intersense on top of the production
cinema camera, pointing straight up, at 90 degrees (perpendicular to
the cinema camera), the Intersense Orientation would be 90 degrees
tilt.

Lightcraft's omni mount for the Intersense is equipped with a
spring detente pin that clicks in tilt position at every 22.5 degrees.  So at
every "click" the IS-1200 will be set to a known angle.

Intersense Orientation with Floor Targets

When using Portable Floor Targets, it is not uncommon to point the
Intersense to the floor.  In that case, the references are still the same,
but the angles become negative numbers.

As a side note, some Intersense mounts have labels that say "front"
and "back".  These, when the Intersense is pointing down, become
reversed and "Front" actually points back in this configuration.

Pointing IS1200 to the side

Where the targets are located to the left or right of the camera, the
Intersense can be oriented to the left or right of the camera.  Try
keeping any "pan" offsets to whole 90-degree increments.
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With the Intersense label facing up,when the Intersense is pointing:

left, perpendicular to the camera lens, the "Pan Offset" is
negative 90 degrees (like image above)
right, perpendicular to the camera lens, the "Pan Offset" is
positive 90 degrees
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Camera Sensor Offsets

Setting Camera Sensor Offsets

When mounting the Airtrack or Intersense IS1200 sensors, the position
of the sensors will vary depending on your mounting points.  The
Airtrack has a "Front" and a "Top" and its position in relation to the
camera sensor is negligible.  The Intersense IS1200 is different.

When mounting the Intersense IS1200, use a tape measure to
physically measure the position of the IS1200 to the camera sensor.

The offsets are measured from the Intersense IS1200 to the center of
the camera's sensor.  In other words, zero offset is in the center of the
IS1200.

The goal is to indicate in the virtual camera exactly where the IS1200
VisTracker is in relation to the cinema camera.

 

References for Measuring Offsets

The IS1200 mounting block has a pivot mount and registration lines to
measure all offsets from.

The reference for Axial Offsets on the camera is the actual sensor
plane.

This is marked by the "witness mark", a symbol that is made up of a
circle with a vertical line across.
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The reference for Vertical Offset is the center of the lens.

 

And the reference for Lateral Offset is the lateral center of the lens.

 

Intersense IS1200 on top of camera

If the IS1200 is on top of the camera (vertical) and in front of the sensor
(axial), the values for vertical and axial will be negative numbers.

Always use Observer View to verify that the offsets are correct.

If, in Previzion, the Observer View (Perspective Camera) is showing the
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sensor in the incorrect position, check if your values were entered
negative or not.

Intersense IS1200 to the side of camera

When the Intersense IS1200 is to the side of the camera, make sure to
know which side the sensor is on.

When the sensor is to the right (from the perspective) of the camera,
the values are positive.

Always check in Previzion's Observer View to make sure the offset is
correct.

Entering Values in Previzion

These measurements are then entered in Previzion, in centimeters. It's
important to know that these measurements start from the IS1200
VisTracker.

The axis sign orientation is:

Axial:
positive values if IS1200 is behind the camera sensor
negative values if IS1200 is in front of the camera sensor

Vertical:
positive values if IS1200 is below the camera sensor
negative values if IS1200 is on top of the camera sensor

Lateral:
positive values if IS1200 is left of camera
negative values if IS1200 is right of camera

 

Verifying Vertical Offset

By following the proper survey settings and these offsets, the virtual
camera height in relation to the real camera height should match.

To verify that your vertical measurements are correct, in Previzion,
make note of the vertical height of the camera.
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With a metric tape measure, level the camera and measure the height
of the camera from the center of the lens barrel to the floor.

The distance should be within one or two centimeters from Y position
shown in the Previzion.

If it is off by a long range, there may be a mistake in the axis sign in the
Tracker to Camera Offset tab.
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Watching Intersense Targets

Watching Intersense Targets

Sometimes, you will want to see how the Intersense is tracking while
Previzion is still running.  To see if the Intersense is still tracking, you
can actually bring up ISDemo32 while Previzion is on and connected to
the Intersense. Since sfServer is already running, ISDemo will connect
to sfServer. You can then open Tools->Optical Data Display and display
the current tracking state while running Previzion.

Warning — the real time display of the tracking targets in ISDemo32 is
intensive on the system, and will cause Previzion to drop frames, so we
don't usually recommend it. It's useful in the verification and testing
stage, however.

To lower the impact on the system, you can shrink the window until it is
down to about 2" x 2"; this lets the system operate more normally.
When doing real shots, however, the tracking display should be turned
off.

You may also notice a weird rendering artifact (a small dark square) in
the Previzion video display after running ISDemo32; that's due to how
ISDemo32 renders into the framebuffers. It doesn't affect the output
signal, but if you don't want it to be there just move over the Previzion
screen so that the ISDemo 32 screen does not overlap it.

Windows 7 and Watching Targets

The Windows 7 builds of sfServer can only support 1 TCP/IP
connection at a time. This is a problem, as by default both Previzion
and ISDemo use the TCP/IP connection protocol. Under Windows 7, if
you connect to sfServer with ISDemo while a session of Previzion is
running, the Previzion session will be disconnected and will not receive
updated tracking information.

Setting Previzion Connection to UDP

To correct this, it is possible to set Previzion to connect to sfServer over
UDP. Warning: the UDP data stream is read-only, so this means
that users cannot set the Pitch and Yaw angles of the Intersense
from inside Previzion. Instead, the Pitch and Yaw angles must be set
using the ISDemo interface.

This modification is recommended only for users that truly need the
ability to monitor target recognition in real time.

To set Previzion to connect over UDP:

Create a file called isports.ini in the /Previzion main directory.
The contents should be:

Port1=5001

While sfServer is running, open ISDemo and choose
Tools->Command String. Enter:

MEthUdp1

and press Enter.

Save settings with File->Save Current Settings.

Exit ISDemo, sfServer, and Previzion. Restart Previzion, which
should now bring up sfServer and connect normally.

You will notice that changing the Pitch and Roll values in the Previzion
Airtrack/Intersense Configure interface no longer affects the data from
the IS1200. These must now be set within ISDemo.

In addition, the orientation of the wireframe drawing of the IS1200 in
Previzion's Observer View will no longer correspond to the actual
setting set within ISDemo.

Setting Pitch Angle Manually in ISDemo

Start ISDemo, connect to the IS1200, and select
Parameters->Station and Sensor Parameters.
Make sure station 1 is selected, then click Change.
Input the desired pitch into the highlighted Pitch line , then select
Command->Exit.
Exit the Station Configuration window to get back to the main
ISDemo window.
Select File->Save Current Setting to save the pitch value.

Reverting to TCP/IP

In ISDemo, select Tools->Command String and enter:
MEthUdp0 and press Enter.
Select File->Save Current Settings.
Change the isports.ini file in /Previzion to

Port1=127.0.0.1:5005

Restart Previzion. When Previzion starts up sfServer, it should
now be in TCP/IP mode.
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Airtrack Smoothing

Airtrack Smoothing

When using lenses that have a FOV of 10° or less and/or the fiducial
targets are mounted above 20 feet (6.09 meters), there can be
considerable amounts of visible noise in the CG background.  To
counter this effect, as of build 7229, Previzion has a feature called
Smoothing.

This noise is most noticeable with Airtrack 1.0.  In Airtrack 1.5, the
internal solid-state gyros have about 85% less noise, or about one sixth
of the noise, when compared with Airtrack 1.0 in the same thermal
conditions.

It's important to know that Smoothing is actually averaging out data to
make up for noise.  In a way, it's not as accurate as when having it off.
 Therefore, as Smoothing averages out data, there is an accumulation
of data being removed.

Make sure to always, in between takes, use Clear Offset in Smoothing.

The default values in Smoothing have been optimized for use with
Airtrack 1.5 and 1.0.   If needed, you may tweak some of the values in
smoothing to accommodate a particular scenario.  If the values get
changed too much, use Reset to reset all parameters to default values.

Note that the default value for "Angle Threshold" is optimized for
Airtrack 1.5.  The value resets to: 0.0020500.

After build 7964, Previzion automatically detects and adjusts Airtrack
Smoothing threshold values based on the model of Airtrack connected
to the system.

However, for older builds, please note that the value for Airtrack 1.0
is 0.0032500.  And may need to be input manually.

By default, Smooth Angles as well as Smooth Position are enabled.
 The first is in charge of smoothing out noise that occur in the Airtrack.
 The latter is in charge of smoothing out noise that occur in the
Intersense.  Having both on is usually more effective.

Lock  is intended to use on locked off shots where there is no pan or
tilt, but zoom and focus still occur.  This removes all tracking information
and simply locks the background to the position last input by the
sensors.  Completely locked off shots are not commonly needed, but in
the rare instances they are used, this is where to make the background
lock as well.

Airtrack Drift

As the Airtrack is an inertial (gyroscopic) system, it has a certain
amount of drift. The Airtrack Drift panel provides control for this. Leaving
the **Auto Sample** box checked causes Previzion to continuously
sample and correct for the rate of drift.

When Previzion is started up, the system waits 20 seconds for the
IS1200 to stabilize, then automatically aligns the coordinate systems of
the two sensors. If you wish to manually align the coordinate system,
click **Reset Rotation**.

When Previzion exits, the existing Airtrack drift samples are preserved.
However, when starting up again, the gyros will be cold, and the drift
will have changed. This will automatically correct itself over a few
minutes, but if you wish to correct it more quickly:

1.Deselect Auto Sample and wait 10 or so seconds for the green
Sampling light to go out.

2.While the camera is stationary, click Sample Now and wait 15
seconds for the Sampling light to go out. This performs a
manual drift sample.

3.Click Auto Sample again to re-enable it. The Airtrack drift is
now matched, and will be continuously matched.

Position Clamping (legacy builds)

Note: Position Clamping has been replaced by Smoothing as of build
7178

Page 146

http://www.lightcrafttech.com/wp-content/uploads/2010/11/AT1.jpg


Previzion - User Manual
by Lightcraft Technology

With stage ceilings above 20 feet (6 meters) off the ground, the
Intersense exhibits about +/-1 cm of positional noise, which is visible
when the camera is stationary. To halt the background motion, enable
position clamping in the Intersense/Airtrack dialog.  This uses the
Airtrack as a motion detector, and clamps the Intersense position when
the camera is at rest.

Threshold is the amount of gyro movement per frame below
which the position clamping will turn on if the lack of movement
continues for a period of time.
Delay is the period in seconds before the clamping turns on;
Ramp is the period in seconds that Previzion smooths the
existing position to the current measured position when the
camera is moved.
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Lens Data

Lens Data Options

Clicking the Lens drop down menu shows the current lens data
acquisition options. Presently, these include:

Encoders (through the breakout box)
Fujinon serial data enabled lenses
Preston FI+Z/MDR lens control system
Pace Fusion
Panavision (through the Ethernet connection on the Panahub)
Manual (for manually specifying zoom and focus levels.)

Lens data is usually acquired through the RS232 serial link marked
"Lens" on the Previzion serial connector. In the case of the Panahub,
lens data is acquired through the Ethernet port. When a lens data
source is connected to Previzion and specified in the lens data drop
down menu, the status light to the right will either light up green or
yellow.

Green: the lens data connection is working, there is a calibration
file loaded, and the min/max positions are set.
Yellow: the lens data connection is working, but either the
calibration file or the lens min/max positions have not been set.

Encoder Min/Max Limits

Previzion's lens calibration works by mapping the motion of the lens
barrels as a floating point value from 0.0 to 1.0. Various lens systems
handle setting the end points of the lens in different ways.

Breakout Box Lens Encoders: move zoom and focus lens rings
to minimum position (wide angle/close focus) and click 
Minimum. Then, move zoom and focus lens rings to maximum
position (telephoto/infinity focus) and click Maximum. A green
light will appear by each setting.
Fujinon (ENG type lenses): these lenses use an internal
potentiometer, which automatically sets Minimum and
Maximum. Make sure to get the 16 bit encoding option, as the
12 bit encoding will produce noticeable focal length shaking.
Fujinon (Cine lens encoder): this lens encoder uses the same
Fujinon serial data protocol as the ENG lenses, but uses
encoders for higher precision and needs to have Minimum and

Maximum set. Position the zoom and focus lens rings as
described for the breakout box encoders, and click the Minimum
and Maximum buttons at the proper distances.
Preston: the Preston MDR lens controller box automatically
moves the lens motors to their minimum and maximum position
when the motor is connected to the controller. If the lens data
seems reversed, flip the lens direction switch on the MDR lens
controller where the motor cable is attached.
Pace: the calibration is set at the camera.
Panavision: the calibration is set at the camera, by moving the
lens to its near and far stops.
Manual: no minimum or maximum calibration necessary.

Click Close to close the lens configuration dialog when finished.
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Stereo Data

Stereo Tracking

To enable stereo tracking, connect a compatible stereo rig to the RS232
port on Previzion marked Encoders/Stereo. (COM port 4) If streaming
metadata is detected, a green light will go on by the stereo tracker.
 Stereo rigs must be set to communicate at 38400.

Present rigs supported are:

Element Technica 3D - With special firm ware
from 3alitytechnica
Cameron/Pace Group

Support for additional rigs can be added rapidly if the rigs support real
time metadata output.

Rig vs. Actual IO/Convergence

The IO and convergence metadata that is generated by a 3D rig are
usually based on the distances between the rig's front pivot points. The
pivot points on a stereoscopic rig are mechanical junctions that are
frequently not aligned with the entry pupil (nodal point) locations of the
lenses used. In the case of zoom lenses, the entry pupils move when
zoomed in or out, so the pivot points cannot align for more than one
specific focal length, thus requiring correction.

The effect of the moving entry pupil locations becomes larger as the rig
is operated in a more converged fashion.

Rig Calibration

Previzion compensates for the moving entry pupil locations using its
calibrated lens data, obtained through the lens calibration procedure
outlined in a later chapter. Previzion uses this data, along with
measurements from the rig pivots to the sensor location on the rig, in
order to calculate the true IO and convergence data that the rig and
lens combination is actually set to.

To achieve this accuracy, the distance from the rig pivot point to the
camera sensor plane must be measured and entered into Previzion.
Click the Configure button next to the stereo tracker in question to
bring up the configuration panel.

The front rig pivots are almost always ahead of the camera sensor
plane,  so this value is usually positive.

In the Element Technica 3D and CPG rigs, the front pivot is the pivot
point that the stereo metadata is based upon.
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Observer View

Setting Observer View

At this point, the tracking sources should all be working, and moving the
physical camera will move the camera in the virtual scene. To get a
clearer idea of what the virtual camera is doing, click the Observer
View button in the upper right hand corner of the user interface.

The Observer camera defaults to the same view as the main scene
camera, so at first there is not much difference. Roll the mouse scroll
wheel backwards, and a yellow virtual camera will appear in front.

Navigation with the Observer View camera is very similar to Maya:

Holding down Alt while clicking and dragging with the left
mouse button will cause the scene to orbit around geometry that
is near the center of the screen.
Holding down Alt while clicking and dragging with the middle
mouse button will cause the scene to slide laterally back and
forth.
Scrolling in and out with the mouse scroll wheel causes the
virtual camera to translate back and forth on its view axis. Zoom
is fixed at a 50 degree field of view.
Holding down Alt and Shift while clicking and dragging with the 
left mouse button will cause the observer view to rotate in place
around the existing observer view position.

 

Reset Observer View

To reset the Observer View camera position to the current scene
camera view, click Reset in the upper right hand corner under the
Observer View Enable button.

Disable Observer View

To disable Observer View, and return to the scene camera view,
deselect the Enable button in the Observer View layout.
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Stereo Rig Offsets: Technica3D

Stereo Rig Offsets: Technica 3D

The position offsets are measured to the dominant eye/stationary
vertical camera (left eye). The offsets are measured as if the camera
was aligned horizontally with the moving horizontal camera.

In the above picture, the Tracker to Camera offsets are measured as
follows:

Axial: measure from the Intersense camera center to the sensor
mark on the lower camera. This is a negative number on the
above rig, as the sensor plane is behind the Intersense tracker.
Vertical: measure from the Intersense camera to the centerline
of the lens. This is a positive number on the above rig.

Lateral Offset

Since the offsets are measured from the Intersense to the stationary
camera, the lateral offset must be measured to the vertical camera on
the Technica 3D rig.

Lateral: measure horizontally from the pivot of the Intersense
camera to the center of the vertical camera lens axis. Double
check in Observer View that you have the sensor on the correct
side of the lens.
The offset in the above image is negative.
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Setting Angular Offsets

Aligning Angular Offsets

To correct for the small angular misalignments between tracker
and camera:
Load the FBX file that correlates to the Intersense fidicual
locations of the stage. Instructions for generating this file are 
here.
Check that the right lens calibration file is selected, the zoom
and focus are correctly lined up, and that the correct sensor size
is selected.
Check that the lens controller has not slipped any teeth when
starting up; if necessary power cycle the lens controller and
make certain of this. Small error in barrel position lead to very
large errors in virtual scene position.
Rotate the Intersense camera to 45 degrees from horizontal,
and adjust the Intersense configuration panel"s pitch setting to
45 degrees.
Make sure that the Airtrack"s drift compensation is updated.
Point the camera up toward the ceiling so that the fiducials are
in view of the camera.
Set all of the Coordinate System offsets to 0. (The Tracker to
Camera offsets should be the normal distance from the
Intersense to the camera sensor.)

The fiducials should line up pretty closely to the CG cones.
If they are offset, adjust the Tracker to Camera Offset panel's
Pan and Tilt settings to line them up. Note — this should be a
small number of degrees; around 2-3 degrees in the Pan, and
less than a degree in the Tilt. If it takes more than a degree in
Tilt, look at the mounting bracket to make sure it is seated on
the matte box rails, at a right angle to the matte box rails.
Pan the camera around, and move it back and forth. The
fiducials should stay more or less connected to the CG cones.
There will generally be several pixels of error on large pan
moves, and less error on translation type moves such as a dolly
move or a crane move.

Page 152

http://www.lightcrafttech.com/support/doc/setting-the-stage/survey-constellation-tool-and-cfgs/


Previzion - User Manual
by Lightcraft Technology

Stage Alignment

Stage Alignment ("Cones" File)

To correctly align the optical axis of the camera to the sensor axis, you
will need a model that matches known real world locations to a high
degree of accuracy. The easiest way to do this is to create a 3D model
automatically from the Intersense constellation survey file.

Using Lightcraft's Constellation Tool, one of the files you are able to
create out of the stage survey is an FBX file that contains CG "cones."

These CG cones, when loaded in Previzion can be used to verify that
the constellation coordinate is what we expect it to be.  Not only does it
close loop the whole tracking all the way through the lens real-time
conposite, but it also allows us to tweak half-degree settings in the
sensor offset that may be a result of slight iris rod misalignment or
minor sensor mounting offsets.

When using cones.fbx to align through the lens, make sure to always
have your camera offsets zeroed.

 

To download Constellation Tool, please visit our downloads page. To
learn more about Constellation Tool, please visit Survey Constellation
Tool and CFGs.

 

Page 153

http://www.lightcrafttech.com/login/download
http://www.lightcrafttech.com/support/doc/setting-the-stage/survey-constellation-tool-and-cfgs/
http://www.lightcrafttech.com/support/doc/setting-the-stage/survey-constellation-tool-and-cfgs/


Previzion - User Manual
by Lightcraft Technology

Camera Position Panel

Real Camera and Virtual Camera

Because Previzion uses actual measurements and knows where the
real camera is in physical space, we need remember that we are
dealing with two coordinate systems that are aligned with one another.
 In other words, the virtual camera and the physical camera align to
each other based on the positioning information Previzion's sensors
feed.  Just like satellites allows your GPS to know where it is, fiducial
targets (in the case of the Intersense) lets Previzion know where it is.

In Previzion, the panels to look at in the tracking tab are:

Camera
Camera Offsets

When Camera Offset is all reset to zeros, meaning with no offsets, the
figures displayed in the Camera panel are actual dimensions of where
the physical camera is based on sensor information.  In the image
above, Position y (cm) shows 156.00.  This mean the camera is
actually 156.00 cm off the ground.

Positioning the Virtual Camera

The camera position tab shows a real time update of the current
camera position.  When the Video input is Enabled, the update
frequency is lowered, to lower the system overhead, updating every
second or so.

To edit the virtual camera position directly, click the Edit button, in
the Camera panel. The light next to it will go red, to indicate that the
virtual camera is not being controlled directly by live tracking data. With
the video signal enabled, the Camera position will still refresh at a
slower rate, but Camera Offset will update at a faster rate while things
moves about.

Like other settings in Previzion, the small opposing arrows to the left of
the input box serve as sliders and work by clicking and dragging up and
down to change the value in the corresponding box.  You may also type
in a given value into each box.

Position X (cm) - translates front and back axis or  northing
Position Y (cm) - translates up and down axis or elevation

Position Z (cm) - translates side to side axis or easting
Pan (deg) - rotates side to side
Tilt (deg) - rotates up and down (not editable)
Roll (deg) - "dutch-angles" around x-axis (not editable)

Hold down Control while clicking and dragging for fine grained
control, or scroll with the mouse wheel for high speed motion.

Un-click Edit to commit to your changes.

Free Form Camera Motion

For a more "Maya-like" position editing, you may mouse over
the Viewer Window that is now marked by yellow corners.  Use the
same mouse gestures that Observer View uses:

Scroll up/down - camera moves forward and back
Alt + center-click drag - moves side to side (holding shift
speeds up this movement)
Alt + right-click drag - moves forward and back fluidly (holding 
shift speeds up this movement)
Alt + left-click drag - translates around the geometry/object the
yellow center cross is pointing to
Shift + Alt + left-click drag - pans/tilts the camera from its
nodal position

When editing these values, you will notice Camera Offset panel values
changing to accommodate the changes.

Make sure to un-click Edit to commit to your changes.  Any
offset Tilt and Roll will revert back to match the physical
camera's Tilt and Roll.
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Camera Offset Panel

Camera Offsets

Previzion lets you move the virtual scene wherever you desire, and still
have the physical camera move correctly through the scene. This is
done without moving the virtual scene itself, so that all tracking data will
map correctly back to the original virtual file.

The Camera Offset panel shows the current X, Y, Z, and Pan offsets.
Tilt and Roll are always taken directly from camera tracking data to
avoid confusion and are not editable.

As the virtual camera position is edited in the Camera panel, the XYZ
Camera Offset will change in real time to compensate.

Press Reset to zero any axis.

To pan the virtual camera without moving it, click and drag up or down
on the **Pan Offset** box. As with other controls, fine control is
achieved by holding down **Control**, and rapid motion by scrolling the
mouse wheel. The XYZ offsets will change in real time to keep the
virtual camera in the same place during the panning process.

Set Floor Offset

For scenes that has floor or ground, it is often crucial to position the
camera height offset to match the conditions from the greenscreen.
 Ordinarily, when a stage is surveyed, we set the instrument height to
the floor as the reference start of the y-axis (height or up and down
axis).

When the camera is positioned over this floor or ground geometry, Set
Floor Offset measures the distance between the camera and the floor
geometry.  This is a quick way to align the physical camera height and
the virtual camera height.

Saved Camera Locations

When the scene file is loaded, Previzion's scene loader reads in all of
the virtual cameras that are part of the file, and makes a list of them.
Each virtual camera position can be jumped to immediately by selecting
it from the **Camera Locations** drop down menu. As before, the Tilt
and Roll data is not used.

This lets a director set up a list of desired camera positions for specific
shots, and store them into the FBX file for rapid use.

After the new camera reference location has been selected, make sure
to set the proper Y offset to keep the virtual floor and the live action
floor aligned.  Use Set Floor Offset to set your height.

Save new Camera Locations

To save new camera locations, you may position the camera where you
would like it to be saved at and use Add Current.

Name your location for later use to save time and plan shots.

The location is then stored in the Camera Location panel's drop-down
menu.

Angle Reference System

Many different 3D applications have different zero angles for the
camera. Previzion defaults to the Motionbuilder angle reference system,
where by default the virtual camera points down the +X axis.

The default Motionbuilder zero angle system works well in practice for
most applications. Previzion's data capture system uses Collada, which
has its own defined coordinate system that all applications supporting
Collada are required to transform into and out of properly, so this setting
is independent of the software used to create the FBX background file.
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Tape Measure Tool

Tape Measure Tool

The tape measure tool consists is on the tracking tab and consists of a
red "beam" and a red X and works like a laser tape measure or a
traditional roll out tape measure.  This tool measures how far objects in
the scene are from the virtual camera's sensor.  The
Previzion operator can use it in three distinct ways ways.

Toggle the tape measure on and hit the "Measure" button to
read how far away an object in the scene.
Enter a value in centimeters and the red X will go to that
distance.
Use the scroll wheel over the distance read out to "push" the
tape measure out to any distance.

Note: The tape measure tool does not get sent out the SDI video feeds,
it is only for the Previzion operator.  
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Feature Tracking (TTL Tracking)

Feature Tracking Overview

Lightcraft Feature Tracking or Through the Lens (TTL) Feature
 Tracking is a powerful new feature that allows for sub-pixel accurate
tracking through the lens.   This TTL tracking work in conjunction with
our regular sensor-based tracking to produce sub-pixel accurate
tracking in real-time.

This feature is in its beta stages, but it has been implemented on build
6317 and newer.  There are a few limitations that should be taken into
account when using this feature.  Please use at your own risk.

Limitations

For TTL Feature Tracking to work, the circles have to be in the field of
view of the main camera.  That means that when it is occluded by a set
element or talent walking in front of the circles, the sub-pixel lock is lost,
which is why we recommend positioning 3-5 circles.

With that in mind, whenever the camera pans or tilts away from the
circles and it is unable to view them, sub-pixel lock is lost as well.

If a shot requires quick whip pans, the sheer motion blur caused by the
quick motion may cause TTL tracking to be lost for the duration of the
whip pan.  To take that into account, increase shutter speed
accordingly.

Round objects like watches or polka-dots and even plaid shirts can
cause the TTL tracking to be misread.  Any pattern that creates high
contrast, if in front of the circles may also throw off TTL Tracking.

Getting Started with TTL Tracking

TTL Feature Tracking is listed in Previzion under "Mattes" as "Feature
Tracking."

To start using this feature you will need to use a Total Station that is
re-sectioned within whatever constellation coordinate system your
Airtrack/Intersense are referencing to.

1.Using high contrast black circles on white paper averaging 2
inches in diameter, position circles inside the field of view of the
cinema camera.  You may need at about 3-5 circles to take into
account occlusions. We recommend marking the center of the
circle to facilitate the next step.

2.With a Surveyor's Total Station that is re-sectioned in the proper
coordinate space (as indicated above), survey the center of
each black circle.

3.As you enter the "Position X," "Position Y" and "Position Z" for
each circle, you will notice a check box right below the "Name"
input field that enabled "Lock to Feature."  This is what makes
the marker a "TTL Feature Tracking" Marker instead of a regular
reference marker.
Check this option for  each of the circles.

4.It is helpful to name the circles in case you need to disable that
marker later in the process for whichever reason.

5.To enable TTL Feature Tracking for all circles, click on "Enable"
in the Feature Tracking Pane.

If you would like to view and verify that what Previzion is tracking to,
you may either "ENABLE" Survey Makers by selecting "ENABLE"
under Survey Makers Pane (or use press "C" on your keyboard) or
check that the "Show Locations" and the "Show Current Marker Pixels"
check boxes in the  Feature Tracking Pane.

Simply disable these to hide the TTL Tracking references.
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Camera/Lens Interface

Lens Values
Camera Sensor Width
Subject Depth and Clipping Planes
Lens Calibration Panel
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Lens Values

Lens Panel

When connected to a compatible lens controller, the "Lens" Panel will
automatically update.

You set your lens tracker by selecting the proper "Lens Source" in your
"Trackers" panel, under Tracking tab.

To manually try different focal lengths, you can set your Lens Tracker to
"Manual" (or "None" in older Previzion versions).  This enables sliders
and user input on the Lens Panel for manually adjusting

The main lens values Previzion uses are:

Focal Length (mm)
Field of View (deg) - Derived from Focal Length and Sensor
Width
Focus Distance (cm)
Entry Pupil (cm) - Often termed the "nodal point" of the lens
Center Offset X & Y - Distance from the center of the sensor to
the optical axis. A measure of lens misalignment in mm.)
Distortion R2 - The first order radial distortion of the lens)
Iris (fstop)

Setting Iris and Depth-of-Field

Setting the Iris value to that of the physical lens will hold the best result
for realistic depth between virtual and physical.

This setting is the never set by the lens controller.  It is always set
manually.  In other words, even if the lens controller has encoders or
encoded motor for Iris, Previzion does not listen to this input.

For fine-tuning depth of field use the Depth of Field Scale parameter in:

Scene tab -> Scene Effects -> Depth Of Field Scale

You can keep the scale to:

1.0 to preserve a true depth of field that is input into the Iris
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(F-Stop) field,
values between 0.00 and 1.00 for more depth-of-field,
0.00 for turning depth of field "off" (infinite depth-of-field), where
everything is in focus or
values above 1.0 to exaggerate the effect, narrowing the
depth-of-field.
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Camera Sensor Width

Camera Sensor Sizes

To properly calculate the location of the virtual camera, Previzion uses
the physical dimensions of the camera sensor being used.  In some
post-production software, the sensor size is called "film back" or "back
plate".  In Previzion we call it the Camera Sensor Width measured in
millimeters.

Some cameras rate their sensors as "Super 35" or "2/3 inch" as a way
to indicate the category of the sensor.  But this is far from being an
accurate physical measurement.  This measurement will be in the
specification for the sensor itself.

ARRI, for instance, releases the specifications for its ALEV III CMOS
sensor with the actual size of the sensor.  The size of the sensor is
often called pixel pitch and is measured in micrometer (µm) which is
1/1000 millimeter.

ARRI Alexa Sensor used area specifications

We often publish camera sensor widths in the Connections section of
this documentation under the name of the respective camera.

Adding and Selecting Sensor Sizes

Because sensor sizes are camera and manufacturer specific, we have
changed Previzion's sensor size selector to accommodate the many
documented sensor sizes.

By default, there aren't any sensor sizes selected and you should add
the ones you plan on using.

Under Camera Tab, select "Add" in Camera Sensor.  This will open
Camera Sensor window.

Camera sensors sizes are sorted by manufacturer, then by camera,
then by camera setting. Press the "+" next to the list item to expand the
item.
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You can then select the type of lens being used by the production.
Most all lenses, unless otherwise noted, will be Spherical (1:1)lenses.
This means that the lens is not anamorphic.  If you are using
Anamorphic lenses, you may choose the correct anamorphic multiplying
value.

You may also choose to change the name to a custom name.  The
actual width of the sensor reflect the documented value Lightcraft has
on file.

After you have selected your preferred sensor sizes, these will be listed
in the dropdown menu under Sensor Size.

A number of common camera sensor sizes are already included.  If you
encounter a specific sensor size that is often used, please send a
request to add the new size with your Lightcraft representative.

Removing Sensor Sizes

Should you choose to remove sensor sizes from your favorites list,

simple highlight the sensor size in question and press "Remove."

Aspect Ratios

At present, Previzion assumes a 16×9 sensor width ratio, although this
will be expanded to handle new types of images.  If you are using a
RED Epic in 5k full-frame or an F65 in full frame, the aspect ratio
coming out from the live HDSDI output will actually be in 17×9 aspect
ration where the top and bottom of the image is letter-boxed.

Calculating Camera Sensor Width

The best way to properly calculate the sensor size is to either look up
the detailed technical specifications of the camera being used.  In some
cases it is better to  request directly from the manufacturer, or
knowledgeable source, the correct pixel pitch.

Pixel Pitch is the actual spacing between each pixel and it is measured
in micrometers(µm), or microns.  For our purposes we can assume this
as the "pixel size." Once you have this measurement, you can calculate
the proper sensor width by multiplying it by the width of the pixels being
used.  For example:

in a RED Epic, the pixel pitch is 5.4 µm (or 0.0054mm)
at "4K 16:9," the number of pixels actively capturing light is 4096
px by 2304 px (width is 4096 pixels).
Thus:

pixel pitch * horizontal pixel count = Camera Sensor
Width
0.0054 (px/mm) * 4096 (px) approx. 22.12 (mm)

Creating a new Sensor Width (Legacy
Interface)

To create a new sensor name, click Add.

Enter a description in Sensor Name and adjust the Width.  Select Save
when done.

The sensor setting will be saved in your Previzion system state.  If your
system state is reset or you load a system state that does not have your
custom sensor sizes, the new sensor size will be removed.

To delete the current sensor width, click Remove.
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Subject Depth and Clipping Planes

Subject Depth

As a real-time compositing system, Previzion renders a live video in 3D
coordinates in 3D space.  this means that there are a few ways of
treating the incoming live video to achieve the desired effect.

By default, the incoming video, or video plane, is as close to the virtual
camera as possible.  In the interface, this setting is called Subject
Depth and is measured in centimeters.

In Previzion build 7686 and above, the minimum distance is 25.0
centimeters.

By moving the Subject Depth to a longer distance, the live video input
is placed further away from the virtual camera, projecting out from the
lens' nodal point.

This allows you to place the incoming live video behind and in between
objects.  This is very useful for adding people behind virtual elements or
inside virtual vehicles, for instance.

Fix Subject Depth to a location

As of build 7686, there is the option of creating a mark to which the
video plane stays fixed to.  Ordinarily, the video plane distance is fixed
to the camera.

The Set Depth As Camera to Marker option allows you to make the
video plane to always be in the same location relative to the scene.

This is the same Survey Markers that are located in Mattes Tab.

To use this feature:

Start by surveying or measuring where you would like to create
a marker.  You may do this using a survey tool or adjusting a
marker and using parallax to judge the position of the marker.
Create a new survey marker by pressing "Add."  Name you
marker and enter the coordinates for the desired position.
Back in Camera Tab, check the box to enable Set Depth
As Camera to Marker and select the marker to which it will be
fixed to.  The marker does not need to be enabled or showing
for this feature to work.

Near and Far Clipping Planes

Like other compositing applications that use 3D CG scenes, Previzion
has setting for limiting the range between which things are rendered.
By default this is set to Set Clipping Automatically, which essentially
renders all elements in your scene.

If for some reason you need to change the clipping planes, uncheck this
option and enter new values manually.  This can be used if, for
example, a virtual wall is close to the camera and blocking the scene,
uncheck Set Clipping Automatically and set the near and far clipping
planes.
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Lens Calibration Panel

Lens Calibration Panel

Previzion is unique in the fact that it's part of its solution to map
parameters of a physical lens over the span of its zoom and focus
range.  To load, edit and add lens calibrations.

Editing lens calibration files is a feature that has been implemented as
of build 7686.  The method for calibrating lenses has also changed and
it takes into account values at infinity distance.

Lens calibration files are stored in an XML format and have a .cam
extension.  We recommend doing lens calibrations for each lens on a
serial number basis.

The interface has  a gray grid that represents a matrix of the lens focal
length and focus values.  Starting from left to right, we go from min
zoom (wide) to max zoom (telephoto) and from bottom to top, we go
from min focus to infinity focus.

Old calibration files are still able to be imported and exported.

Lens Controller Inputs

The lens system works by interpolating between valid lens calibration
points. Lens calibration is covered in more detail in a separate chapter.

The input from the lens controller comes into Previzion as a value from
0.000 to 1.000.  This is called the Focal Length Fraction for the zoom
axis and Focus Distance Fraction for the focus axis.

For this to work, lenses have to have what is called "hard stops," which
means that the lens focus and zoom ring cannot be turned perpetually.
The focus and zoom ring need to have a minimum and a maximum
position.  This is what we call the Lens Travel.

Previzion does not currently listen to Iris input.

 

For the full Lens Calibration procedure and recommendations, please
see our Lens Calibration Chapter.
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Stereo Interface

Video Sources
Flip/Flop Video
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Video Sources

Video Sources

The Video Sources panel selects which HDSDI video input is routed
into the dominant or the dependent eye.

Dominant Eye: Left
Dependent Eye: Right

Switching Dependent Eye

The Dependent Eye button switches the keying, tracking, and rendering
pipeline back and forth between the dominant and the dependent eye.
This has no effect on the take data being recorded, as all takes
metadata captured when a stereo tracker is active have both cameras
recorded.

IO and Convergence Display

The Stereo Screen Text button enables or disables the real time
display of stereo metadata on the output composite image.
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Flip/Flop Video

Live Video Orientation

The Flip Video panel lets you flip the incoming live HDSDI 1 and HDSDI
2 video streams horizontally, vertically, or both. This is useful when
working with stereo rigs that end up with inverted or reversed cameras.

In builds prior to 7970, this feature is located in the Video Tab.
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Video Interface

Live HDSDI Video Input
Video Playback
Genlock Interface
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Live HDSDI Video Input

Live Video Interface

The video interface is located under the Video tab in the main user
interface area. The Live Video panel controls the current video format,
and the two HDSDI live video inputs.  To use the second HD-SDI
input, HS-SDI 2 requires HD-SDI 1 to be enabled to read incoming
video.

To enable live video input in Previzion, simply click the Enable button
next to the corresponding input (HD-SDI 1 or HD-SDI2).

When the green light next to Enable is lit, it indicates that a video input
has been detect and is ready to be used.

If no video is present at the HDSDI inputs, the green light will not go on
when HD-SDI 1 is enabled, and the output frame rate will stutter.

Supported Video Formats

The HD-SDI 1 and HD-SDI 2 buttons control the 2 live HDSDI inputs to
the system. When Input 1 is the main input that is sent to the keying
and compositing pipeline, and must be enabled to start the live input
system.

The Input Format drop down menu selects the video format and frame
rate that the system expects to receive. Previzion supports most major
HD input formats.  These include (as of build 7970):

1920 x 1080 px - 59.94i
1920 x 1080 px - 29.97 PsF
1920x 1080 px - 29.97p
1920 x 1080 px - 25PsF
1920 x 1080 px - 25p
1920 x 1080 px - 23.98 PsF
1920 x 1080 px - 23.98p
1280 x 720 px  - 50Hz (outputs 1920 x 1080 px - 25 PsF)
1280 x 720 px - 60Hz in 24fps (outputs 1920 x 1080 px - 23.98
PsF)

If the frame rate selected does not match the incoming serial data rates,
the mismatch will cause tracking problems, and will be indicated by
flashing red lights in the Tracking interface.
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Video Playback

Video Files

Previzion allows simultaneous playback of multiple pre-recorded video
streams mapped onto 3D background geometry. When the virtual set is
being loaded, Previzion will search through the file for any textures with
the video_ prefix, and list these textures in the Video
Destinations interface. Each texture can then be individually selected
and connected to an MPEG2 video on the hard drive.

Once assigned, restart your videos by selecting Restart All(J), to restart
all of the videos at their beginnings, to provide synchronized playback.

In addition, you can Pause All(K) videos while keeping sync, and Play
All(L) to pick up playback still in sync.

Videos can also be paused and restarted individually by selecting the
video, and clicking Pause and Restart.

The Start(s) and End(s) of the video file can also be selected, by
entering the Start and End times. As well as the Duration(s) of the
videos being played.

When editing the Start and End times, the selected video will
automatically be paused, and the frame displayed will move to match
the time selected in order to help find specific areas of the video.

Video Destinations

To connect a video, highlight the texture in the Video Destinations
panel. This is where video_ textures, including those reference by
CgFx shaders, are enumerated.

Then, using the drop-down menu, assign a video to the highlighted
video destination.

Creating Video Destinations

Video streams, whether live or decoded, can be routed using the Video
Destinations panel. This panel lists the possible areas that video can be
routed to.

Video Destinations must be assigned when authoring your CG scene.
 To make a texture a video destination, simply rename the texture with
the prefix video_

Synchronized Playback

Previzion supports simultaneous decoding of multiple HD frames. For
example, a high resolution background matte painting can be broken up
into multiple 1920×1080 textures, and played back simultaneously. 4K
videos also have a limited playback.

To ensure proper playback, each HD frame should be encoded with
identical encoding parameters and number of frames. Look at
our HD and 4K encoding documentation for instructions on proper
encoding for Previzion playback and limitations.

MPEG2 videos will play back at a 1:1 frame match to the incoming
video rate, so they should be shot at the same frame rate as the live
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video to avoid sped-up or slowed down playback results.
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Genlock Interface

Genlock Interface

The Genlock Interface, located in the Video tab controls the ability to
lock and time Previzion's outputs to an external reference (tri-level
sync).

 

This feature has been implemented in build 7818 and newer.  It was
publicly released in build 7970.

To enable this feature, click on the radio button Genlock.

"Enable Internal Termination" toggles the internal terminator inside your
Merlin I/O Module.

Connecting to External Genlock

Connect your external tri-level reference directly to the Merlin I/O
Module's Genlock IN

For the complete set of setting and configurations is available in the
Connections chapter under External Genlock: Integrated Internal Frame
Synchronization
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Keying Interface

Keying Tab Introduction
Getting Started with Keying
Blue vs Green Screen
Screen Materials and Paints
Stage Lighting
Lighting Practice and Light Meters
Keying 59.94i
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Keying Tab Introduction

Keying Overview

Previzion's built-in keyer uses a real time implementation of dvMatte
Pro 3, an extremely fast and powerful GPU-powered visual effects
keyer.

dvMatte Pro works with a combination of keying technologies, including
a special detail extraction system that is capable of extracting single
hairs from the background.

Previzion incorporates parameters found in dvMatte Pro 3 as well as
some customized adjustments optimized for Previzion's real-time keyer.

The keying interface is comprised of drop down menus, color pickers,
sliders and input boxes.

Default Values

Should you need to go back to the original settings, you may quickly do
so with the Reset button.  This will restore all values in the Keying
Tab back to their default "green screen" values.  Even with Blue Screen
this is almost always a good starting point.

Display View Selection

Previzion default Display View is set to the Composite view of dvMatte
Pro, which shows the final composite when live video is enabled, and
the virtual background when it is disabled. Other available views are:

Foreground: shows the unchanged incoming live action
footage.
Unspilled: show Foreground with despilled image.
Matte: shows the current matte.
Blend: shows the detail extraction image, that will be used to
extract fine details.
Scene Blend: shows the background image with a rough
composite of the foreground image, using only the details that
will be added during the blend operation.
Depth: shows a "near-versus-far" display of gradients to
represent the virtual depth.
Composite: shows final composite view.

Most compositing operations will be done in the default Composite
view, where the final effects of adjustments can be most clearly seen.

DvMatte Color Pickers

To set your green/blue screen key, start by picking out your High
Color and Low Color using the color picker and clicking on the live
incoming video.

To select the High Color, click the **Pick High Color** button.
The point of the cursor is used to sample colors, the view
displays the incoming live video, and a real time display of the
RGB values of the pixel that is underneath the cursor
(normalized to 0-1 values) is shown in the **Cursor Color** box.
Click on the brightest area of the green screen, avoiding
highlights that are not a part of the overall tone of the screen.
To select the Low Color, click the **Pick Low Color** button. As
above, the point of the cursor is used to sample color, and the
RGB values are displayed. Select the darkest area of the green
screen, avoiding overt shadows cast by the foreground subject
or other set elements.
When your mouse over the live video to pick your color,
Previzion averages the values of the pixels that the pointer is
dragged over while the mouse button is pressed down. This
way, the user can avoid being spoofed by local noise.

The other matte settings, chroma, supression and mix adjustments are
covered in more depth on the following section.  But when an evenly lit
green/glue screen is set with the High Color and Low Color setup,
almost all the following adjustments should only require
minimal tweaking.

 

Add Mix Composite

If the matte has dark or white edges, you can modify the foreground
and background matte edge curves with this function to remove the
dark or white edge.  This is most useful when making the outline color
match your background.

Always try to set this last, meaning, after the key color has been picked,
base matte's white/black points set and so on.

These controls control the foreground and background matte of a
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traditional Add Mix composite, as described in Wright's book. The
default settings, with gamma=1, provide a standard linear matte
function.

The adjustments here should be very subtle.

 

Base Matte Controls

Base Black Point: As you raise the black point, gray values
below the threshold are pushed toward black. Use this setting to
push darker portions of your matte towards pure black.
Base White Point: As you lower the white point, gray values
above the threshold are pushed towards white. Use this setting
to close dark "holes" in your matte towards white.

Base Matte Color Difference

To produce smooth production quality mattes, Previzion's built-in keyer
uses a 2-color difference keyer and a color difference matte.  While the
effects of these settings are visible with the general view set to
Composite, you'll usually want to have the view set to Matte when
manipulating these settings.

There are three main color difference method options. When first trying
a shot, you'll want to cycle through the methods to see which is going to
give the best results for the clip in question.

Average of 2nd and 3rd channels (default): a combination of
the second and third channels are subtracted from the first
channel to in order to create the base matte.  This works the
best for about 90% of green screen shots.
Max of 2nd and 3rd channels: a maximum operation is
performed on the 2nd and 3rd channels. The result of the max
operation is then subtracted from the first channel to create the
base matte.
Min of 2nd and 3rd channels: a minimum operation is
performed on the 2nd and 3rd channels. The result of the
minimum operation is then subtracted from the first channel to
create the base matte.

Background Blend Controls

Settings in this section are used to adjust the blending of the foreground
and background images during the final composite.

Blend Amount: Adjusts the amount of preserved foreground

detail that is brought into the final composite.
Blend Highlights: Brightens or suppresses highlights in the
blended detail.
Blend Saturation: Adjusts the color saturation of the blend
details.
Blend Brightness: Adjusts the pre-composite brightness of the
background image.

 

Spill Suppression

Channel Mix: This controls the mix between the 2nd and 3rd
channels in the Average setting above. By default, the Channel
Mix is set to 0.5, which is a 50% average between the two
channels. By sliding towards one side or the other, the mix can
be set. In practice, 0.5 works the best for most shots. With
red, frizzy hair, pushing the average to 0.6 will get rid of
green fringes.
Dynamic Spill Suppression: Adjusts the amount of dynamic
spill suppression to apply to the foreground. The removal is
"dynamic" in the sense that it takes into account the brightness
of the background at each pixel in order to determine the
appropriate brightness of the unspilled pixels at the edges of the
foreground.
Edge Color: dvMatte automatically applies a despill operation,
which removes the blue or green light spill that is frequently
found on the edges of a foreground subject. The despill
operation can leave edges of a grayish color, which needs to be
matched to the background to avoid an obvious edge. Click the 
Pick Edge Color to select an edge color that matches the
background.

Detail Matte Controls

Detail High Point: Manipulates the high point of the detail matte
before it is blended with the base matte. Lower the high point
from its default to push gray values towards white in the detail
portions of the matte.
Detail Low Point: Manipulates the low point of the detail matte
before it is blended with the base matte. Raise the low point
from its default to push gray values towards white in the detail
portions of the matte.
Detail Gain: Can be used to raise or lower the brightness of the
detail matte before blending operations are applied.

 

Chroma Controls
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Settings in this section are used to apply blur and translation operations
on the color channels of the foreground material, in order to offset
artifacts due to color subsampling.

Horizontal and Vertical Blur: Apply a horizontal and/or vertical
blur to the color channels of the foreground in order to soften the
blockiness that can occur during compression.
Horizontal and Vertical Shift: Apply a horizontal and/or vertical
translation to the color channels in order to offset slight pixel
shifting that can occur during compression.
Scale: Scales the overall background matte.

Light Wrap

Light Wrap simulates the effects of light wrap in which light from the
background image is seen wrapping around and brightening the edge of
a foreground element. While generally a very subtle effect, it can
provide the extra bit of realism that “sells” a composite and makes your
composited foreground image sit well in its background.

Wrap Composite - Provides three options for computing the
wrap effect. Choose the option that provides the best effect for
your foreground / background combination.
Wrap Amount - Controls the overall intensity of the wrap effect.
Wrap Blur - Adjusts the radius of the light-wrap effect around
the edge of the foreground element.
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Getting Started with Keying

Getting Started

The real-time keyer in Previzion is fast to setup and can be a powerful
tool to have on set.  To set up the keyer, it is a matter of picking the
brightest areas of the green screen and the darkest.  This should be
within one f-stop from each other.

Previzion's keyer creates production quality mattes, however, it does
not do magic.  It is important to keep a few things in mind:

A blue or green screen should always be as even as possible.
 This means both painted evenly (when using
paint), stretched evenly (when using spandex) and lit evenly.
 Within one f-stop range to be exact.
The camera settings and filtration also plays a major role in the
final product.  Set the camera so that there is as little noise as
possible with the cleanest image.  Specifics about filters and
camera settings are below.
Any change on the lighting of the green or blue screen needs to
be adjusted in Previzion during production.  This is also the case
for changing the camera's f-stop.
Wardrobe and reflective surfaces require a little more planning
but they are doable.
Always set your key with people in it where hair, skin color and
wardrobe is being taken into account.

Setting up Previzion's Keyer

Composite View and Matte View

In day-to-day usage, most of the dvMatte controls work best at or near
their default settings. The main overall goal is subtle adjustments.  A
good working methodology for setting keying values is as follows:

1.Click Reset to reset to defaults
2.For High Color, click on Pick Color to its corresponding right

and click on a high green spot on your Previzion
Viewer window.

3.For Low Color, click on  Pick Color and click on a low green
value on your Previzion Viewer Window.

4.Switch Display View to Matte to view the matte.
5.If there are obvious holes or buzzing in the composite, lower

the Base White Point until they fill. Because of the "matteless"
background blending operation, you do not need to achieve a
super-solid matte to avoid holes.

6.Switch Display View back to Composite view.
7.Raise the Base Black Point very slightly to remove spurious

areas of background. Pushing the black point and the white
point of the matte too close together is to be avoided, as this
leads to ugly, blocky edges.

For simple shots with no major floor contacts and shadows, this is a
good place to start.  The default settings for the other parameters may
be enough.  For more intricate shots, subtle tweaks in these settings
may be needed.

If moving the Base Black Point up does not clean up the
background, try tweaking the Detail High Point and Detail Low
Point under the Detail Matte panel. This controls the luminance
keyer controls, which are used to generate more of the detail
matte.
If the composite has a "milky" appearance, it is usually due to
the Blend operation picking up on brighter spots in the
background. In Background Blend, lower the Blend
Highlights slider until the highlights disappear.  For most
applications, Blend Highlights should always be close if not set
to 0.00.
If there is a noticeable bright outline around your matte over a
low key CG scene, increase the Add
Mix composite's Foreground Gamma control slightly to remove
this. Don't crank it in too much, or the edge gets hard.
 Remember to revert this back when you switch to a higher key
CG scene.
If there is a bright one-pixel edge on one side of your matte, you
can slide the matte over slightly with the **Horizontal Shift** and
**Vertical Shift** controls under the Chroma panel.  Almost
always leave this setting alone.
If there is still a visible edge, select the **Pick Edge Color** and
adjust the edge coloration up or down slightly to blend it in.
If there are some edges that are too light, and others that are
too dark, increase the Dynamic Spill Suppression slider
slightly to help bring them in. Excessive use of Dynamic Spill
Suppression will lead to "printing through" from the background.
Don't use the Dynamic Fg Preservation slider, as it will add in
a non-despilled foreground, which brings back the green spill we
already got rid of.

Blue/Green Screen Light Levels

When picking your your High Color and Low Color, there is a quick
way to tell if your screen is over exposed or under exposed.  The best
way it to use a spot meter set to your camera's proper exposure
settings and match that around the blue/green screen within one f-stop.
 However, using Previzion's dvMatte Pick Color, you may mouse over
your Viewer Window and see the RGB values in High/Low
Color change.  These are values based on IRE values and go from
0.00 to 1.00.

When picking out Green Screens:

High Color - the value for G (green) should be around 0.70 to
0.80 IRE
Low Color - the value for G (green) should be around 0.60 to
0.75 IRE
Provided that the actual material or paint the green screen is
made of is the recommended one, R (red) and B (blue) value
will fall within a range of 0.20 to 0.35 IRE.
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When Picking out Blue Screens:

High Color - the value for B (blue) should be around 0.70 to
0.80 IRE
Low Color - the value for B (blue) should be around 0.60 to
0.75 IRE
Provided that the actual material or paint the green screen is
made of is the recommended one, R (red) and G (green) value
will fall within a range of 0.20 to 0.35 IRE.

For more in depth blue/green screen lighting metering and practices,
please refer to our Light Metering page.

Camera Filters

In general, avoid using filters when shooting blue or greenscreen.  They
generally decrease contrast, and cause strange keyer edge behavior.
Adjusting contrast should be done after the keying and compositing
operations.  There are however some filters, which are ok to use in
Green/Blue screen environments.

IR Filters - The use of IR filters to correct red shift in blacks on
Sony EX1/Ex3/F23/F35 and Red camera sensors.  This usually
crops up when the camera has heavy ND filters, which block
visible light, but not IR light. Usually this is not the case in indoor
controlled lighting conditions.  Outdoors, however, there may be
situations where IR Filters are necessary.

ND Filters - When shooting outside it is often a creative
decision to use ND filters to allow for a more open f-stop.
 Always make sure that when you are using ND filters, your blue
or green screen is proportionally lit as well.  In the case of using
heavy ND filtration, there may be a need for adding IR filtration
as well.

Polarizers - Like with ND filters, the addition of polarizing filters
(circular or linear) is a creative decision that requires planning.
 When using this filter you will also need to proportionally

increase the amount of light on your background for proper
separation and exposure for keying.

Diffusion/Star Filters - Avoid using diffusion filters or any kind
of star filters.  This created both a keying issue as well as a look
mismatch between the foreground (real objects) and
background (CG objects).

Camera Gain, Sharpening and Color Space

Gain/ISO - When possible, always set your gain or ISO as low
as it will go.  This compensates for noise sensors in some
cameras and yields a cleaner image.
Sharpening /Detail- Turn off any artificial sharpening as it can
cause bright edges and edge artifacts on your key.  Often times
there are noticeable outlines around the key that require too
many adjustments that can be attributed to Sharpening  being
on.  Triple check that this is off. 

Sharpening effecting hair and edges

No Sharpening

Color Space - For most all applications, we are always in Rec
709 color space.  Most 4:2:2 SDI output from cameras will be in
Rec 709 by default, but there might be options to have a
different reference color space. Previzion's keyer is most
effective when its input is in Rec 709.
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REC 709 and Primaries (Creative Commons Image)

Interlacing Motion

When set to 59.94 i @ 1920×1080, adjust the following settings:

Vertical Blur - Set to 0 in your Chroma settings.  Since the
image is interlaced, any vertical blur can cause artifacts in the
keying process, which will show up as flickering edges around
moving objects.
Horizontal Blur - Set to 1 in your Chroma settings.  Like the
above setting, a flickering fringe shows up around objects
moving in the matte or when the camera is panned/tilted back
and forth.
Light Wrap - Set all Light Wrap values to 0.

Fixing Garbage Matte Seams

If the intersection between the keyed area and the garbage matte is
visible, where one is darker than the scene, even when the matte
channel is clear in that area, the matteless composite Background
Blend controls need to be adjusted.

Exaggerated Garbage Matte Seam

 

In  Background Blend, the Blend Amount and Blend Brightness are
frequently adjusted in tandem.

BlendAmount will tend to darken some areas of the composite
where the greenscreen is less brightly lit, causing an edge
intersection with the garbage matte.
Blend Brightness will increase the brightness of the
background in the greenscreen area, which will fix the darkening
that increasing the Background Amount frequently causes.
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Blue vs Green Screen

The Green Advantage

As a rule of thumb, when dealing with digital footage and non-linear
editors and compositor, green is always the best choice.  There are
many advantages to using digital green over digital blue.

Green Wavelength over Reflection

The primary reason we use green is because green is the color that is
furthest away from human flesh tones.  Also most cameras use a light
capturing technology that "samples" colors and light.  However, with the
way color sampling works out, there is almost always a better sampling
of green than its counter primary colors blue and red.  This has always
been a limiting factor for storage and transmission of color data.

Whenever possible, stick to Digital Green.

Color Sampling

For most professional cameras that output a single HD-SDI signal, the
structure that color is transmitted is called 4:2:2 (Y Cb Cr).  This means
that the luminance (Y) is sampled 4 times, while its counter color
difference components are samples twice.

Digital Green is noticeably brighter than Digital Blue and definitely
brighter than Chroma Green.  When talking about color sampling, what
that means is that not only does the green in Digital Green get
sampled as color difference (CbCr), but it also gets sampled with
luminance (Y).  This yields smoother edges between contrasting colors
and, ultimately, yields a better key.

Illustrative Map of Sub-Sampling

With that said, when using Previzion, avoid using cameras where the
color sampling is 4:2:1 or 4:2:0 as it will prove a much tougher signal to

key.

Chrome Blue and Chrome Green

Chrome Blue and Chroma Green (as opposed to Digital
Blue and Digital Green) refers to the color of Blue and Green designed
for VFX shot using negative film.  For photo-chemical processing of
negative film, these two colors were made industry standard.

Digital Green vs Chroma Green

In general, these colors are very difficult to work with. As mentioned
above, the sheer "lime green" brightness of Digital Green and the
"smurf" blueness of Digital Blue allows for a better color sampling and
easier lighting all around.

Digital Blue vs Chroma Blue

But you may be able to use chroma colors outdoors.  Since there is so
much light outdoors, sometimes the older chroma green and chroma
blue screens can work well, but it is not recommended.

Shooting With Blue

If there are practical green foliage or a particular show has specific
need for green props or characters, then using Digital Green is not an
option. Digital Blue also has the added benefit of a a more natural
looking spill than digital green.
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Blue Wavelength over Reflection

Shooting on Blue Screen is not necessarily difficult, but it does require
an extra bit of effort.  Main differences from green:

Blue is an inherently less bright color, because camera sensors,
and human eyes are less attuned to it.  Because of this blue
keying requires almost a whole f-stop more light (twice as much
light).  Depending on the size of the your stage, this may be no
small feat.
The camera samples blue less than green.  This means that
when setting your key, there may be considerably more tweaks
and adjustments for a smooth natural key.
Keying darker haired people and wardrobe can prove more
difficult with blue.  However, with a Digital Blue Screen at the
proper light levels, this is not as big of an issue.
Blue can create a despill artifact that results in a hard magenta
color.  To add more separation from the background you may
add blue gels to your screen lights (Lee 079 Just Blue) or blue
fluorescent tubes (KinoFlo Blue Tubes).

Just remember that Blue Screens always need more light than green.
 Especially Chroma Blue, which may work out well outdoors, where the
amount of illumination is high, and tends to be blue anyway.

When Blue and Green are not enough

In exceedingly rare cases, where there are no human skin exposed, or
an underwater type setup where green and blue may not work.   Digital
Red may be used, which poses similar challenges as blue.

Composite Color Standards

When we talk about Digital Green and Digital Blue we
are referring to Composite Components Company's (CCC) color
materials.  This will be the case for cloth, spandex, cycs, vynil and paint.

"Digital Green" and "Digital Blue"  is trademark and/or registered under
Composite Components Company, or CCC.

There are other alternative paints and materials, but it is important to
make sure its sheen, pigment color and specs are up to par.
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Screen Materials and Paints

Background Materials

When looking into color difference keying background materials, there
are many options.  Compositing and Keying have a long history, with
many different technical advances that each had their own optimal
solutions.  Some have been optimized for photo-chemical processes
and others for digital video.

For most modern color difference keyers, like Previzion's built-in
DvMatte Pro 3, there are specific recommendations that allow for
production quality keying in real-time.

Among your material options are:

Digital or "Digi" Paint - High pigment specialty paint
Cyc or Professional Cycloramas - Pre-painted seamless floor
and wall modules that cast no shadows onto themselves.
Spandex and Cloths - Portable evenly dyed fabric materials that
can be stretched seamlessly over frames.

In this section, we will cover our recommended paints, cloths and cyc
materials.

Paints

As explained in the Blue vs Green Screen section, there are major
differences between regular Chroma Blue/Green and Digital
Blue/Green.  Chroma colors are optimized and designed for
photochemical processes and work best with negative film.  Because of
this nature, it is inherently "darker" than its Digital counterpart color.

There are other options for paint, like Rosco's DigiComp Paints, but we
still highly recommend Digital Green and Digital Blue ("Digital Green"
and "Digital Blue"  is trademark and/or registered under Composite
Components Company, or CCC).  Another name for these "digital"
colors are Component Green and Component Blue.

The difference between using these specialty paints as opposed to a
similar shade of these colors from your local hardware store is that not
only are these colors consistently been tested and engineered to be
within the proper color spectrum that digital cameras "see", but they are
also a very high pigment paint, meaning that one good coat of these
paints on a properly treated surface is often sufficient to yield the proper
paint coverage.  It goes without saying that the sheen of Digital
Green and Digital Blue is also a very specific matte finish to, again,
yield the proper color spectrum.

CCC' Digital Green or Digital Blue - This paint, when applied
according to the directions on the pail, with a white underlayer,
has a very good separation between the green channel and the
red and blue channels.
Green Kino Flo Tubes -  Colored Fluorescent Tubes are usually
not necessary nor recommended when working with the CCC 
Digital Green paint.  In most applications, green tubes tend to
spill green all over.
Green Gels - Avoid using green gels over your lights, as they
may actually narrow some of the Digital Green/Blue color
spectrum.
Lighting the screen - Lighting the your screen should be around
the same f-stop that the foreground subject is set to, which is
also what CCC specifies for their paints.

Seamless backgrounds and Cycs

(Cycloramas)

For more permanent installations, the most recommended options is to
either purchase easy-to-assemble a seamless background or build one
yourself.  There are experienced construction crews that are very
capable of building seamless backgrounds that can be painted green or
blue.

As an alternative, there are modular cycs that can be easily assembled
and painted on location.

The one area that is always difficult, however, is the occasional
compound corner.  A company that makes very good off-the-shelf
modular cycs is Pro Cyc.

Compound Cyc Corner

Fabrics and Tape

For temporary installations, fabric is often the best choice.  Using
frames to stretch the fabric around is usually a faster setup and lighter
for travelling productions.

There are a couple of things to know about fabric:

When using dyed spandex always use the matte side facing
the camera.  Spandex has a shiny and a matte side.  The matte
side is the one intended to be facing the camera, whereas the
shiny side should always be avoided. 

Digital Green Spandex (matte side to the right)
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Digital Blue Spandex (matte side to the right)

Green/Blue fabrics don't generally produce the same separation
that paint does.
Keep your fabric clean and be careful around sharp corners and
objects as these can tear your material.

We recommend using CCC's fabric backings or equivalent, just make
sure that the fabric is the correct "lime green" or "smurf blue"
that Digital Green and Digital Blue are.

Seam taped with Digital Green Tape

For covering seams, you may use a "magic skirt" of the same material
and color and some tape.

Component Green Tape
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Stage Lighting

Lighting

The target lighting level for a blue or green screen varies slightly, but in
general should be around .70 of the full range of the green channel in
Previzion.  The red and blue channels, of course, should be as low as
possible.  See "Lighting Practice and Light Meters" for more information
on how to convey this to a lighting crew.

The above image was taken of a digital green background with
standard light on a 4:2:2 camera. As can be seen, the RGB values at
the sampling point are:

- R: 0.46
- G: 0.70
- B: 0.25

Lighting Fixtures

When using a digital green screen the use of green fluorescent tubes is
frequently unnecessary, and can often cause problems with the green
screen reflecting on other objects or people in the scene.  For most
productions it is best to match the existing fixtures.  If the rest of the set
is lit with normal quartz tungsten bulbs 3200k tungsten tubes should
work just fine on your fluorescents.

Space lights are very nice for lighting the floor of a stage because they
cover a large area and provide soft light.

Fluorescent lights like Kino Flo lights light green screen walls nicely
because they have a short to medium throw and are soft and able to
cover a large area.

 

Blue Screen Lighting

Blue screen lighting is much less forgiving, and this is one of the

reasons why green screens are so much more common than blue
screens at present. The despill operation on a green subject resolves to
a grayish fringe, which can be easily re-tinted to blend into a given
background.  Also 4:2:2 video has twice as much information on the
green channel which will make for smoother edges.  For more
information on blue vs green screen see the section "Blue vs Green
Screen"

The despill operation on a blue screen subject resolves to a harsh
magenta edge, and this is extremely difficult to remove, and explains a
lot of the ugly dark lines around older composite images. Motion blur is
also a problem with blue screens with inadequately separated light; this
will show up as magenta streaks whenever someone moves quickly in
the scene.

The solution is generally to light blue screens with gelled lights (Lee 079
Just Blue), or color matched Kino-Flo fluorescent bulbs. When lit with
this type of lighting, Digital Blue screens will provide color channel
differences similar to that of the lit green screen to the left, and will not
have the magenta artifacts mentioned above.

UVS 1 lighting grid
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Lighting Practice and Light Meters

Quick outline

Use a spot light meter (reflective metering)
Set the ISO and shutter speed on the light meter to match the
camera’s current ISO or gain and shutter speed or angle also
keep filtration compensation in mind as well
The reading across the entire blue or green screen should stay
only .5 stops above or below the aperture on the camera. This
translates to a 65-87 IRE or .65-.87 values in previzion

Lighting a blue or green screen for Previzion

Lighting for a good key in Previzion is a little less forgiving than lighting
for a post key mainly because you do not have the time or ability to set
multiple keys withing a single shot like in post.  That being said
Previzion’s keyer is very good as long as you follow a few guide lines.

The green or blue screen should be measured by a reflective (spot)
light meter, and should give you an average reading the same as the
current F or T stop on the lens.  On previzion this will translate to
around a .75 in the G or B channel, depending on if it is a green screen
or blue screen.

If the average reading is at the current stop then the brightest and
darkest point on the screen should only be 1/2  a stop above or below
that.  This will give you an IRE of around 87-65.

Basics of light meters for Previzion
operators

On the left is an incident meter (notice the white ball) the right is a
reflective (spot) meter, which the user looks through like a telescope to
get a measurement.  Some meters have both functions combined into
one device.

There are mainly two types of light meters that a Previzion operator will
encounter on a production; Incident and Reflective meters also known
as spot meters.  When set up properly they both measure brightness
levels relative to the cameras current settings in “stops1”.  The main
difference is that an Incident meter measures the amount of light on the
set hitting the light meter at its current position. A reflective meter on the
other hand measures the amount of light reflecting off of a specific
object.  That difference is subtle but important.  If you were to use an
incident meter to measure the amount of light hitting a green screen
and a blue screen sitting next to each other in the same lighting
conditions you would get the same number, however if you were to use
a reflective (spot) meter you would get quite different numbers.  The
spot meter would show that a digital blue screen is about a stop and a
half darker than the digital green screen.  For our purposes in Previzion
what we care about is the reflective number, this tells us how bright the
camera sees the screen, rather than how much light is hitting the blue
or green screen.

1The difference from one stop to the next is double the amount of light,

so if you need something 2 stops brighter you need 4 times as much
light.

Setting up your lightmeter

Previzion operators don’t really need to carry both a reflective and an
incident meter, they can get away with a spot meter and an 18% gray
card.  Spot metering an 18% gray card will give very similar results to
an incident meter.

There are 3 main things to keep in mind when setting up a light meter
for a shoot.

ISO or ASA or gain - This determines the sensitivity to light of
the sensor on the camera
Shutter speed or angle  - This determines how long the sensor
is exposed to light
Filtration - Filters like ND or 80a or 85a can reduce the amount
of light getting to the sensor

ISO also known as ASA or gain is a setting on a camera which has
the ability to make the picture brighter but with the trade off of making
the image more grainy. However keep in mind more grain is bad for
Previzion to get a clean key.  A light meter will want the sensitivity fed
into it as an ASA ISO type number.  Cine style cameras will give you an
ASA or ISO number, (those two terms are mostly used interchangeably)
while ENG or broadcast type cameras will give you a gain number.
 This gain number will have to be converted to ISO/ASA in order for it to
be a useful number on your light meter.  Typically most cameras have a
native sensitivity equivalent to 320 ISO and each 3db of gain added
doubles that, so a camera that natively has 320 ISO with +6 gain will
now have an ISO of 1280 and a fairly grainy picture.

More info can be found here:

Film speed

Shutter speed or angle is a camera setting which determines how long
the cameras sensor is exposed to light.  The longer the sensor sees
light the brighter the image, but also the side affect of having more
motion blur.  Cine style shows and broadcast shows may give you this
number in different forms, but it is pretty easy to convert between the
two of them.  To further complicate things photo style light meters will
only want shutter speed, cine style meters will take either angle or
speed.  Shutter speed is given as fractions of a second, so if you are
working on a soap opera that shoots 30fps they may want the sensor
exposed for 1/30 of a second (more motion blur), or if you are working
on a grittier drama they may want it exposed for 1/60 of a second (less
motion blur).  With shutter angle people usually shoot at 180° shutter
angle, which equates to exposing for ½ the frame rate.  This means that
a show shot at 24fps exposes each frame for 1/48 of a second, or a
show shot at 30fps exposes each frame for 1/60 of a second.  Many
photographic lightmeters will not have a setting for 1/48 of a second, but
they will usually have 1/50 which is close enough.  The formula to figure
out the exposure if you are shooting at anything other than 180° shutter
at 24 is a fairly simple ratio. Shutter angle\360° = frame rate\shutter
speed’s denominator (lower number in the fraction, the upper number
is always 1 for normal shutter speeds less than 1 second).  So for
example 90°/360° = 60/240 would be a show with a 90° shutter angle
shot at 60fps and would have an exposure time of 1/240 for each frame.

More info can be found here:

Rotary disc shutter
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Shutter speed

Filtration is the last thing one needs to know about when setting up a
light meter.  Filtration is not commonly used on blue and green screen
shoots because it has the potential to ruin the key and make visual
effects significantly more difficult if the DP is incorrect in filter usage.
 That being said it is important to know how to deal with it if it is used.
What you need to find out is how many stops is the filter going to
darken the image.  Once you have determined how much darker the
image will be you need to compensate on your meter readings for that.
 Some meters have the ability to subtract full or partial stops from their
reading, others do not.  If yours can do that for you do it it will save you
thinking.  If your meter is unable to do that it isn’t too hard, you just
need to get to know the F/T stop scale. 1, 1.4, 2, 2.8, 4, 5.6, 8, 11, 16,
22 are the whole stop numbers that are on most lenses, some lenses
may not go down to 1.4 or 2, or up to 22, but you will have at least a few
in the middle.  The way it works is that the darker the light meter or
camera sees the room the lower the number you will get, and if you
have a filter adding an offset making the image darker you will always
be moving to a lower number.  A .3 or 1 stop ND (neutral density) filter
will make it so if your meter is reading a 4 pointing at the screen the
camera with the filter will actually see it as a 2.8.  Which means as long
as that filter is in, you need to remember to take out 1 stop  your
reading putting you at a 2.8 on your meter.

More info can be found here:

Photographic filter
Neutral density filter
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Keying 59.94i

Keying 59.94i Interlaced Video

The horizontal and vertical blur will cause artifacts if used with 59.94i
video. Suggested settings:

Horizontal Blur = 0 pixels
Vertical Blur = 0 pixels
Light Wrap Amount = 0 pixels
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Mattes Interface

Holdout and Garbage Mattes Introduction
Surveyed Mattes
Drawn Mattes
Knockout Geometry
Survey Markers
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Holdout and Garbage Mattes Introduction

Mattes Overview

Because Previzion is capable of calculating the position information of
the cine camera, it is also able to track mattes in real time.  This allows
for a very powerful real time composite that has production quality
finish.

Mattes in Previzion can be entered as 3D surveyed points and drawn
mattes.  These can then be sorted, named, selected to be active or not,
and assigned as "Garbage," "Keep," "Foreground" and "Despill."

To activate all mattes, simply click "ENABLE" or use the hotkey "M" on
your keyboard to toggle the "ENABLE" button.

To see the outlines of the mattes, click "SHOW" or press "N" on your
keyboard to toggle "SHOW."

Sorting Mattes

When dealing with multiple mattes in your Holdout Mattes list, you may
use them in any combination as either a drawn or surveyed matte and
sorted to achieve the desired effect.

To sort mattes, simply highlight the matte you need to move and, using
either your up/down arrow keys or the up/down arrow buttons next to
the Holdout Mattes list, move them to whichever order necessary.

Mattes are "seen" from bottom to top.

Toggle On/Off Individual Mattes

When dealing with multiple mattes, there may be cases where you may
not use a matte or another.  Instead of removing an matte and then
having to re-add it later, you can simply toggle it off.

To Toggle Individual Mattes On/Off, simple select the matte by
highlighting it on the Holdout Mattes list.  At the bottom of the list, there
is a checkbox to the left of "Name."  If that box has an "X" in it, that
matte is on.  If it is empty, it is off.

Naming Mattes

To help keep track of mattes, you may name then or rename them by
selecting the matte from the Holdout Mattes list and changing the name
in the "Name" input box at the bottom of the Mattes list.

Blur Matte Edges

In addition, Mattes can the have their edges blurred to create a more
seamless result.

Values can either be entered by typing a number in or using the
drag-slide and clicking and dragging up/down to the desired value.

A good non-intrusive ballpark figure for Blur Radius is 20-30 pixels.

Survey Mattes

Surveyed Mattes where each vertex has an X, Y and Z coordinate that
is measured within the Intersense Constellation coordinates.  This
allows for very powerful mattes that track precisely to real world objects
that either need to be removed or kept in the composite.

Multiple mattes are most effective as surveyed mattes.  Typically, each
corner of the green screen walls and floor are surveyed and made into
their own matte.

We recommend surveying the green screen walls' corners at the same
time the fiducial markers are being surveyed so they are both on the
same coordinate system.

Surveyed Mattes are limited to four vertices and,
hence, quadrilateral shapes, like squares and rectangles.

Read the Survey Mattes Section to learn more about creating and
editing Surved Mattes.

Drawn Mattes

Drawn Mattes is very quick and efficient tool that allows for areas and
shapes to be quickly.  These can then be set to a known distance from
the camera and, for most angles, creating a realistic matte that tracks
with the composite.  Drawn mattes can have as many vertices as
necessary or extend beyond the viewing area of the screen.

The limitation of survey mattes is that the can only be created as flat
surfaces parallel to the camera sensor plane.

Read the Drawn Mattes Section to learn more about creating and
editing Drawn Mattes.

Matte Types

Depending on the application, you may need to add a matte to remove
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keying from an area or adding a set piece back to the composite.  With
that in mind, Lightcraft has implemented 4 types of mattes to handle
most all applications:

Keep Matte
Garbage Matte
Despill Matte
Foreground Matte

 

Keep Mattes

This is the most commonly used matte on green/blue screen stages.
 Keep Mattes are able to show what is inside its boundaries and
discarding all that is outside of it.

Keep Mattes is the proper type to set your green screen walls as this is
what allows for shots that start or end in a framing that goes beyond
what the green screen covers.

That way, if the edge of the green screen is captured in the framing, it is
not seen and it blends seamlessly with the areas that are covered by
the green screen.

Garbage Mattes

Garbage Mattes are able to remove whatever is inside its boundries
and show all that is outside them.

An application of this would be to remove an elements that is coming
through the camera video that should not be in the shot, like a light, for
instance.  You may draw a matte  around the given light and then set to
that matte to "Garbage."

That way, you can remove unwanted set elements from the shot without
having to frame them out.  This works best when the element does not
intersect or interact with set elements and people.

Despill Mattes

Despill Mattes overwrite the key making everything inside
its boundaries solid, with no alpha and removes the given key color.
 Anything inside a Despill Matte that is the color of your keyer is turned
gray.

A good example of an application for Despill Mattes is setups that
involve shooting out windows and doors on a real set where outside, is
all green screen.  If the green screen yields too much green reflections
on set elements like a shiny floor, normally everything that is green will
be keyed and, thus, see-through with an alpha.  For these instances,
you may draw a matte around the area that should not have any alpha
and use it as a Despill Matte.

Foreground Matte

Foreground Mattes bypass all keyer, color correcting and despill
setting and pass-through the original camera signal to everything that is
within its boundaries. Foreground Mattes are similar to Despill Mattes,
but with one key difference: it doesn't turn everything gray that has the
color of your keyer.

Using the same example as above, shooting out windows with green
screen behind it, if there were to be a green plant, not overlapping the
green screen on the set.   The plant would normally be turned gray.  To
correct this and keep the green plant green, you may draw a matte
around the plant and set that matte to "Foreground."
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Surveyed Mattes

Surveyed Mattes

Surveyed mattes are typically used to provide garbage matting for
greenscreens, or other objects that are at a fixed spot in 3D space and
can be measured with the same survey tools used to measure the
tracking targets.

To create a surveyed matte, click Add Surveyed under the Holdout
Mattes tab. A dialog box will appear with default vertex coordinates;
enter the surveyed coordinates to fix the matte position. Remember that
the total station Northing = +x, Easting = +z, and Elevation = +y. All
units are entered in centimeters.

Click OK when completed. The Keep matte preserves the live action
video that is within the blue area, and defaults to the background virtual
scene outside of the blue area. Other commands:

Enable turns on and off the overall matting function.
Show shows a wireframe outline of the existing mattes. The
outline is light blue, and the affected area of the matte is a
darker blue.
Edit brings up the matte highlighted in the list for editing.
Remove deletes the highlighted matte.
Blur Radius sets the pixels to use to transition the matte edge.
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Drawn Mattes

Drawn Mattes

Drawn mattes are useful when you have an irregularly shaped object
that is in the screen that you want to matte out or preserve. As with
surveyed mattes, there are a few types.

Creating Drawn Mattes

Click Add Drawn in the Holdout Mattes tab to create a drawn matte. A
dialog box will appear with the name of the matte, the type, and the
distance from the camera that the matte is generated at.

The matte itself is a planar object in 3D, and the points that are selected
are its polygon border. When a matte endpoint is set into the yellow
perimeter, the matte will extend out into space past the visible frame of
the image for another 5 meters.

Click a series of points to draw the edge of the matte. To remove the
last point clicked, press the Backspace key.

When a matte is created, the original viewing position and vector of the
matte is saved, so moving the matte depth scales and translates the
matte along the original camera orientation vector. In this way, the
position of an object can be triangulated by drawing the object outline,
then dollying the camera sideways and sliding the matte depth until the
matte is again located on the object.

 

Completing Drawn Mattes

To complete the matte, either click in the yellow perimeter (extending
the matte past the edge for 5 meters, or click the initial opening point. At
this point, the screen on one side of the line or the other will highlight
depending on whether the mouse is on one side or the other.  Clicking
in one state or another sets the matte 'side'.

As with the garbage mattes, the active area of the matte is dark blue
when the mattes are being shown.

The plane of the matte object is set normal to the camera direction
when the matte is being drawn, at the distance specified in the dialog
box. If the distance from the camera to the matte is measured and
entered, the matte will track correctly in 3D space when the camera is

moved.

Editing Points and Side

To edit an existing matte, highlight the matte name and click Edit. If the
mouse is placed over an existing point in the matte, the point will
highlight and can be dragged. Other controls:

Add Points: To add a point on a line, double click the line.
Remove Points: To remove a point, highlight it, select it, and
press Backspace.
Change Matte Side: To change the matte side, deselect all
points by clicking anywhere on the preview screen, then press 
Backspace.
Matte Depth: To change the 3D position of the matte, drag or
enter a new number into the depth dialog. As the matte moves
further from the camera, it is automatically scaled to maintain
the correct drawn position. You can see this more clearly in
Observer View.
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Knockout Geometry

How To Use

1.Create Geometry to use for knockout purposes
2.Assign Knockout Shader in Maya
3.Make sure geometry is embedded in scene file
4.Export from Maya and Import into Previzion
5.Adjust video depth in Previzion

1. Create Geometry

The technique of knockout geometry is usually needed when a virtual
object needs to be occluded by an object in the video feed. In this
sense it will be often necessary to survey a prop or set piece, and then
create the geometry from the surveyed points.

Survey prop piece
Import the surveyed points into Maya
Model the object based off the survey points

2. Assign the Knockout Shader

You can find the knockoutShader.cgfx here in our list of CGFX shaders.
Assign this shader to the knockout object.

3. Embed Knockout Geometry with Scene File

Previzion does not currently support knockout geometry as a loadable
object separate from the scene file which means currently the scene file
and knockout geometry must be in the same export file

4. Export From Maya and Load into Previzion

Make sure to export as FBX and then load the scene into Previzion.
This function is in the "scenes" tab in the main interface.

5. Adjust the Video Depth in Previzion

Set the "Subject Depth" (aka. the video depth) to a distance such that
all your CG elements are in front of it. In order for this shader to work,
the CG elements must be rendered in front of the video background,
otherwise the video will cover the entire scene!

Information on the Shader

click here

Illustrated Examples

Clean Background Plate

CG Render - Robots

Knockout Geometry Objects

Knockout Geometry with Robots
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Final Composite
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Survey Markers

Survey Markers

Survey markers are used to help match the CG world with the live
action world.

Click Enable to turn on the display of the markers.
Click Add to add a marker. Enter the surveyed northing, easting,
and elevation or XYZ values into the provided spaces. All
dimensions are in meters for surveyed coordinates, and cm for
XYZ coordinates (indicated on the UI.)
Click Remove to remove the selected survey marker.
You can rename markers at any point. Selecting the marker in
the list will cause the marker displayed in the scene to highlight
yellow. Markers are blue by default.
The markers default to 30 cm tall. You can adjust the scale with
the Scale drag edit.
Survey markers are independent of camera offsets.
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Scene Interface

Scene Loading
Scene Effects
CgFx Parameters
File Browsing in Previzion
Editable Transforms
Editable Lights
Baked Lighting in Backgrounds
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Scene Loading

Loading a Scene

The virtual background scene controls are located in the Scene tab of
the interface. In the Scene panel, click Load to load a new virtual scene.
FBX files are presently supported, with partial support for Collada (refer
to the Collada export settings here).

After the file is selected, the main viewport will show the progress of the
scene loading.

Default Scene

When the Clear button is clicked, Previzion will load the 4-panel scene,
as when the software is reset.

Cancel Load

The Cancel button will cease any scene loading process. So, when
upon startup, a large scene previously loaded can be halted using this
function.

Error Log

The Show Errors button can be used when a scene has not loaded
successfully. You are able to see what aspects of the scene loaded
improperly.

Loader Log Files

In the Show Log button, the full list of scene parameters loaded can be
viewed.

The scene loader also writes out a log file, which can be used to
troubleshoot scenes that load incorrectly. The log file is named after the
scene being loaded, with a .log extension. The file is located in the
/Program Files/Lightcraft/Previzion/Logs directory.

An example of a FBX log file can be seen here.

Default Light

For scenes that are not using baked textures, and did not include a
light, Previzion provides a default light. Toggle Add Light to enable this.

Horizon Line

Enabling the Add Horizon box creates a virtual horizon line overlay to
aid in the alignment of background video plates to foreground live
action. The horizontal line represents the virtual vanishing point, so the
camera vertical (Y) position must be correct for this to be accurate. For

example, if the real camera is 130cm above the ground, the virtual
camera Y value should also be 130cm.

Wireframe

Enabling Wireframe will render the scene in wireframe with the textures
driving the color of the wireframe.
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Scene Effects

Scene Effects

The scene effects panel has controls for antialiasing, foreground, depth
of field, motion blur, and background color.

Antialiasing

This feature allows you to toggle antialiasing of the scene off and on.
This helps when a texture begins flickering because of the denseness
of pixels trying to be rendered within an area. So when a plane is at an
extreme angle to the camera and you begin to see flickering,
antialiasing can blur those pixels and relieve the flickering.

Foreground

This allows the user to turn off all virtual objects in front of the camera
plane, to reduce render time in large scenes.

Depth of Field

A value of 1.0 is physically correct. Setting the value to 0 removes this
feature from the rendering pipeline.

Adjusting Depth of Field will react with any follow focus control you
have.

Motion Blur

A value of 1.0 is physically correct. Setting the value to 0 removes this
feature from the rendering pipeline.

Motion Blue affects the motion blur of virtual objects when moving the
camera or using Prelink animation.

Background Color

Click the colored swatch next to Background Color to adjust the
background color that will appear where the foreground is keyed out
and the CG background ends.

59.94i Rendering Settings

Rendering 59.94i interlaced video is very demanding, as the entire 3D
scene has to be rendered 59.94 times per second. When using video
backgrounds, however, there is usually not a need for antialiasing or
motion blur.

Suggested 59.94i Rendering Settings:

Antialiasing disabled
Depth of Field scale: 1
Motion Blur Scale: 0

If the frame drop light is still going off, decrease the depth of field scale.
The defocus algorithm used for depth of field is adaptive, and requires

more rendering time the larger the radius of the defocus.
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CgFx Parameters

CgFx Parameters

CgFx shaders in a scene are listed in this window, in the Scene Tab.
Highlighting an individual shader and clicking Edit will bring up a
window with the shader's parameters.

Common Parameters

Named parameters that appear in more than one shader are listed
under the Common Parameter name at the top of the list, and can be
highlighted and edited in the same way as independent parameters.

Annotation name

All parameters are labeled with their UIName annotation name instead
of the parameter name, so they are labeled the same as in Maya. If
UIName isn't specified, it reverts to the parameter name.

Parameter Groups

Parameters can now have a UIGroup annotation. All parameters with
the same UIGroup are put together in a box labeled with the UIGroup
name. Any parameters without UIGroup specified show up in an
unlabeled box at the bottom.

 

Color Parameters

Color parameters (those with 3 float values and a semantic of
DIFFUSE, Diffuse, AMBIENT, Ambient, SPECULAR, Specular,

COLOR, or Color) now show up as a color interface (like high/low colors
for the keying). You can click on the color swatch to bring up a color
picker, making it much easier to adjust color parameters.

Reset

Clicking Reset sets the parameters back to their initial values as loaded
from FBX file, so any changes made in Maya are carried over into
Previzion.

Parameter State Save/Load/Transmit

All CgFx parameters can be saved, loaded, and transmitted in scene
states.
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File Browsing in Previzion

Overview

Part of the functionality of shaders, is the ability to have full control of
the look of your scene within Previzion.

Browsing for Files

With browsing, you are able to change texture destinations manually,
without having the back-and-forth of exporting files from Maya to bring
into Previzion. This can be useful when switching between day and
night in the same setting.

It functions as simply as opening the shader parameters in the Scene
tab and choosing Browse next to the channel you would like to change.

http://www.lightcrafttech.com/wp-content/uploads/2014/02/BrowseDem
o_2.mp4
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Editable Transforms

Editable Transforms

While loading a scene, Previzion searches through the heirarchy for
transforms with the prefix edit_. These transforms are displayed in the
Editable Transforms list and can all be translated, rotated, and scaled.
Additionally we have added the new Show feature, which can toggle
objects off and on.

To move a transform, click to select the transform in the menu, and set
the values in the XYZ translation, rotation, and scaling boxes. This can
be done in the following ways:

Typing in the values directly
Scrolling the mouse wheel for fast motion
Clicking and dragging up and down in the number box
Holding down ctrl and clicking and dragging in the number box
for fine control.

To reset the transform to the original position from the scene file, select
the transform and click Reset.

Maya UI

An example of what this looks like in Maya is shown above. This is
particularly useful for items that may be adjusted during shooting, such
as video background where the horizon must be moved around.

This UI also recognizes the hierarchical structure of the transforms, so
that when edit_World is moved, all of the child nodes move with it, while
a single child node can move without affecting others.
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Editable Lights

Editable Lights

Similar to the editable transforms, lights marked with the edit_ prefix
are loaded into a list in Previzion, and can be selected and edited. In
addition to translation and rotation, the cutoff angle can also be
adjusted. Lights that are operable include Point, Directional, and
Spot. These lights will only work on objects shaded with lambert
materials. Cgfx shaders can be lit with lights, but those must be written
into the shader and are only editable within that shader, and are not
linked to the editable lights in Previzion. Cgfx shaders like the
PhongBumpReflection shader have these inner-operable lights.

This is particularly useful when writing video projection shaders,
discussed in the custom shaders workflow.
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Baked Lighting in Backgrounds

Baked Lighting and Textures

As real time lighting is limited artistically, most scenes used with
Previzion make extensive use of baked lighting. If there are no CG
lights in a scene, Previzion treats all textures in the Color channel in a
Lambert shader as incandescent textures. (Placing textures in the
Incandescent channel in Maya gives problems with the FBX translation,
so this is the current solution.)

If transparency is desired, place a texture type that supports alpha
channels, such as Targa, into the Color channel of the shader, and
place the same texture in the Transparency channel. Previzion's loader
will detect that the Transparency channel is being used, and will use
the alpha channel from the texture loaded in the Color Channel.

This is another workaround to deal with ways that FBX does material
translation. For more direct control of which texture is driving which
channel, CgFx shaders are the preferred way to approach the problem.
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Color Correction Interface

Color Correction Interface
Color Correction (Legacy)
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Color Correction Interface

Previzion's new color correction interface is broken up into four
sections: color matching, color grading, graphs, and test patterns.

Foreground and Scene Matching

The color matching section consists of the two sets of sliders on the left.
 These sliders are used to match the look of the real foreground, and
the cg background render to one another.  The controls are pretty
simple, but powerful for matching foreground and background.  The
"Foreground" and "Background" controls are identical to one another
except for the fact that they control the foreground and background
independently from one another.

Your goal when using these controls is to make the foreground and
background look like they can be in the same world.  Usually it is a
good idea to try and have the two worlds meet in the middle by doing
subtle adjustments to both the foreground and background.  However
there are reasons why an operator would want to leave the foreground
camera alone, and adjust only background CG, or the other way
around.

Let's take a look at what each one of these sliders does. Below are the
base line with black to white gradient, as well as a 3d rendered scene.
 Both of these have RGB Overlay turned on so you can see how the
adjustments affect the levels.

First let's adjust the Gamma.  Gamma works a bit like exposure or
brightness making an image darker or lighter.  The big thing that a
gamma adjustment does differently is that it mostly leaves the brightest
and darkest parts of an image in place while moving the middle.  Think
of a slinky that is nailed to the floor and ceiling.  The floor
represents pure black, the ceiling represents pure white.  Gamma
moves the middle up and down between the floor and ceiling.

Contrast is the next control.  Going back to the slinky analogy this
would be like moving the end of the slinky below the floor and above the
ceiling.  Things that go above the ceiling are cut off and turned white,
while things that are below the floor get cut off and turned black.
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Saturation control has no effect on the gradient test pattern since it is
black and white. As you can see for the room scene it can make the
room black and white, or exaggerate the colors.

Temperature control is 1/2 of the white balance equation.  This control
shifts the image between a very yellow/orange image and a very blue
image, simulating what would happen if the camera had its white
balance temperature shifted.

Tint is a control which shifts the image between a magenta and green.
 This control is the other 1/2 of the white balance equation.
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Composite Color Grading

The composite color works differently from the foreground and
background.  This set of controls works most similarly to a traditional
video color system.  This part gives the user controls over shadows,
midtones and highlights individually. We have a basic primary color
corrector. Each control has a reset button next to it to reset it to the
default center value.

The three color wheels affect the color of different ranges of
luminosity.  The farther the cursor is from the center the more saturated
it becomes, while the color you pull the cursor towards is the color it will
cast over the image.  Holding shift while adjusting color allows you to
adjust saturation without hue, and holding ctrl allows you to adjust hue
without saturation.

The Shadows wheel has an extreme effect on the shadows, moderate
effect on the midtones, and almost no effect on the highlights.

The Midtones wheel has an extreme effect on the midtones, and
moderate effects on the highlights and shadows.

The Highlights wheel has an extreme effect on highlights, moderate
effect on the midtones, and almost no effect on the shadows.

Going back to the slinky analogy, adjusting the Shadows slider will
bring the part of the slinky at floor level up, raising the darkest point
your image above black.  Or by pulling additional information below the
floor, cutting it off as black.  While adjusting this you will notice that it
has little to no effect on the white point of the image.

The Midtones slider behaves just like the gamma slider in the color
matching section.  This adjusts the middle while leaving the white and
black in the same place.

The Highlights Slider works just like the "Shadows," except for the
brights parts of the image instead of the darkest.  It will allow the user to
bring the brightest parts of the image down to a grey, or cut off
information by bringing it above the white threshold, while leaving the
black point of the image exactly where it is.

Saturation slider controls the saturation for the composite, and can
take the colors of the composite from black and white to vivid and
over-saturated.

Here is an original composite:

Here are the Foreground and Scene elements matched:

Here is the same shot with looks applied to it:
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Color Correction (Legacy)

This page references an outdated Color Matching/Correction Interface.
Please check Color Correction Interface.

Foreground Color Correction

Previzion has separate foreground and background primary color
correctors, useful for adjustments to help blend the live action into the
background.

There are two ways of matching and manipulating your colors: one is to
select white and black points with Pick Color and the other is to adjust
Foreground and Background color, hue and values manually.

Using Pick Color is an instant effect.  Each parameter controls one
aspect of the image total "look".

Foreground White  Pick Color, allows you to select a white
point from any area within the Video feed.  It adjust saturation
and hue in the image highlight.
Foreground Black Pick Color,  allows you to select a black point
from any area within the Video feed.  It adjust saturation and
also hue in the image shadows.
Background  White  Pick Color,   allows you to select  a white
point from any area in the CG background.  This adjusts 
shadow value and hue in the foreground image.
Background Black  Pick Color,  allows you to select  a black
point from any area in the CG background.  This
adjusts highlights value and hue in the foreground image.

Using the manual color controls allows you to colorize and adjust the
foreground video color much more accurately.

 

When selected, these controls open a color editor that allows you to
change Value and Red, Green, Blue Gamma and Hue.

Clicking Reset resets the values to their default configuration, and
clicking Enable enables or disables the color correction. Color
correction is done after the keying process, and so does not affect the
keying.

Background Correction

The background color controls are similar to a Photoshop Levels, with
gamma controls for red, green, and blue, and in/out points for the black
and white levels.

Clicking Reset resets the values to their default configuration, and
clicking Enable enables or disables the color correction. Color
correction is done after the keying process, and so does not affect the
keying.
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Takes Interface

Remote Take Triggering
Recording Takes
Screen Text
Animation Data
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Remote Take Triggering

UDP Take Triggering

Previzion's take data recording can be triggered remotely over UDP.
For details on this, contact Lightcraft.
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Recording Takes

Recording Takes

Previzion records complete camera metadata into a Collada file.

To specify the name of the take file to be recorded, enter it in
the Take box.
To start recording, click Roll.
To stop recording, click Cut. A Collada file is automatically
saved to the specified directory.

To change the directory in which takes are saved, click the Browse
button and enter the new directory.

Other options include:

Using the Screen Text data fields to automatically generate the
name of the take
Saving editable transform values at the time of the take's
capture into a separate file
Capturing incremental thumbnail images

Thumbnail Images

Either 1/3 size or full resolution thumbnail images can be captured. 1/3
size are recommended for most general use, due to the processing
requirements to capture full resolution images.

Full resolution images are occasionally useful when troubleshooting a
specific visual artifact.

Changing Take Name

The take name and take data (company, show, comments, etc.) can be
changed during the take, up to the point where 'cut' is clicked. Previzion
will then change the names of the following files to the new name:

DAE take data file
Take directory
Saved transform text file
JPEG thumbnail images

Things that are not changed:

The screen text that is 'burned in' to the image of the JPEG files

Take Data Contents

The recorded Collada file includes:

Timecode
Camera position and orientation in a 4×4 matrix to avoid Euler
angle errors

Camera focal length and focus distance
Subject distance (video plane setting)
Camera aspect ratio
Camera sensor width
Camera frame rate

An example of a test Collada file can be found here.

This has been tested with Maya 2009 and the ColladaMaya 3.05C
Collada plug-in. The link to the ColladaMaya 3.05C plug in is here.

When imported into Maya, the take data must be set to be used without
interpolation in the following manner:

The Previzion motion captured camera data must be highlighted, and
the red outlined "step" button clicked to tell Maya to use the data
without interpolation. Otherwise, incorrect results will happen such as
the camera flipping up and down near Euler angle limits.

Each application has a slightly different flavor of Collada in terms of
camera handling. The default Previzion-generated Collada file has a
number of custom tags in it to handle all of the metadata that Previzion
records. However, each application handles camera field of view and
imager size somewhat differently. To convert from the Previzion Collada
files to the application-specific data files, Lightcraft provides Take
Converter, a conversion tool capable of both GUI and command line
operation.
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Screen Text

Screen Text

The Screen Text interface enables real time, high speed display of the
current camera and scene parameters on the output video, and
provides a way to "burn in" desired metadata at the beginning of a take.

The default options are:

Company
Show
Scene
Camera
Lens
Comments

Clicking Enable causes the "burn in" text to appear on the display and
on the final output, as highlighted above. Click the button again to
disable the view.

When the Roll button is clicked to start a take, the Screen Text is
automatically enabled for the first 48 frames of a take, and then
disabled for the remainder of the take.

Color and Location

The position and color of screen text can now be adjusted.

The color picker sets the color of the screen text.
The X and Y offset set the horizontal and vertical positions of
the screen text.
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Animation Data

Animation Panel

The animation panel provides a real time
window into the incoming Prelink animation packets.

Processing shows the percentage of a single frame required to
process the incoming frame packets. This should stay under 100% to
keep animation smooth.

Queue Size shows how many animation packets are in the queue. This
is generally 0 or 1.

Timecode displays the timecode embedded in the incoming Prelink
packets, if present. This is also displayed as 'Animation Timecode' in
the Screen Text on-screen display.

Missing Nodes lights if the incoming animation transforms contain
nodes that do not have a corresponding name in the scene that
Previzion has loaded. The light will flicker once per incoming
unmatched node, after which the missing node name is written into the
Previzion log file and can be examined there.

Capture captures the incoming packets into a text file. Press Capture to
begin recording animation packets, and again to stop recording
animation packets. After stopping capture, a dialog box will show up to
name the file and location to save.
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Pipeline Timers
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System State Save/Load

Save State interface

Since build 7686 Previzion supports save state XML files which allow
the user to choose which parameters to load and send across the
network.

Load - Will load the currently selected state in the list of states.

Save - saves over the top of the currently selected state.

Save As - Saves your state with a new name.

Import - Opens up a file explorer window allowing the user to find a
save state .xml file in the windows explorer and add it to the save states
list.

Export - Allows the user to place a state .xml in a directory using the
Windows file explorer.

Transmit - sends your current state settings to one or more different
Previzion systems on your network.

Reset - Sets your currently loaded state to all default settings.  This can
be helpful if you have recently moved between versions of Previzion
and are experiencing odd problems.

Remove - Deletes a state from the list, as well as from the state
directory.

Transmit Groups - Selects which parameters are sent over the
network to connected Previzion systems.

 

Selectable Parameters

Trackers - Sets your camera location tracker
as well as lens controller and Sync source, and stereo rig if applicable.

Camera Location - Contains user saved camera positions.

Camera Sensor Size - Loads current sensor size, as well as custom
sensor sizes saved by the user.

Camera Lens Settings - This will load a calibrated lens, or manually
input values for a lens.

Videos - Loads vides, as well as destinations they were assigned to in
the currently loaded scene.

Input format - loads the frame rate that Previzion was set to, as well as
vertical and horizontal sync offsets.

Key - Loads all settings in the keyer.

Mattes - Will load all mattes as well as their type and blur.

Survey Markers - Loads survey marks.

Scene - Loads the scene with edit objects.

Shaders - Shader settings for all shaders in the scene.

Color - Color correction settings for foreground background and
composite.

Takes setup - settings on the takes tab such as thumbnail size and
take directory.

Miscellaneous - Contains settings like background color, motion blur,
and depth of field multiplier.

State .XML Files

Save states are stored as .XML files which are located in C:\Program
Files\Lightcraft\States\ .  Previzion.xml is the state which Previzion will
open when first starting the application, and is automatically created
with default settings if it is not found in the proper directory.
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State files consist of human readable and editable XML text.
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System State Transmit/Receive - Legacy Interface

This page is outdated. For builds after 6710, please refer to Binding
Systems

System State Send

This panel controls sending Previzion system state out to other
Previzion systems on the same network.

Local Address shows the current system's IP address; this can be
used by other systems to restrict which system they listen to for data
packets.

Send Port controls which UDP data port the state packets are sent out
over.

Clicking the Send button causes a state packet to be sent out over the
selected UDP  port.

Matching Subnets

In order for Previzion systems to send and receive data from each
other, they must be on the same subnet mask. This means that the
individual machines' IP addresses must be:

192.168.1.xxx

192.168.1.xxy

192.168.1.xxz

or

192.168.0.xxx

192.168.0.xxy

192.168.0.xxz

The machines must be connected to the same router to generate the
correct IP addresses and subnet mask.

System State Receive

As noted, to receive state messages from other Previzion systems, the
machines must be on the same network and have the same subnet
mask.

In addition, the Port setting must match between the send machine and

the receive machine.

Clicking Bind on a receive machine will cause the system to look on the
network for incoming state machine packets from the send machine.

To restrict the receive machine to only accept packets from a certain
sending machine, type in the send machine's IP address into the
Address line of the State Receive Connection panel.

Send Details

The entire state of the system is sent over the UDP packet when Send
is clicked, with the following exceptions:

Tracking sources (Sync, Pos/Rot, Lens Source)
Tracker to Camera Offsets (each mounting may be different)
Lens File Selection (each lens is unique)
Take Camera Name (each camera name is different)
CgFx parameter values (not yet supported in system state
save/load)
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Previzion Error Log and System Error Light

Previzion System Error Log and System
Error Light

Whenever there is an error with any Previzion component or dropped
frames during takes, Previzion triggers the "System Error Log". 
In System Tab,  you may view the error message by selecting "Show
Errors" or by pressing E in your keyboard.

To clear the error log, simply click on "Clear Errors" or Alt+E on you
keyboard.

Previzion writes system errors on each run to a named error log in the
/Program Files/Lightcraft/Previzion/Logs directory.  You view all logs in
this directory if necessary.  In the example above, the log is
named 2012_07_23_115732_Previzion.err.

In builds after 6296 and newer, there is the addition of a "System" error
light that indicates whenever "Error Log" has detected an error.

The "System" error light is most useful when Previzion is running a
scene that is very large or processor-intensive.  During takes, because
drop frames can happen in a split second, this error light behaves
differently.  During Previzion takes, it behaves like a circuit breaker: ON
when it detects something and OFF if the error log is cleared (Alt+E).

 

Previzion Build Numbers

In all Windows 7 builds,  in System Tab, listed under Error Log File,
there is an About button that shows the system IP and build number.  It
is important to know what build number your Previzion system is
running to keep track of feature additions and possible request/reports.
 Lightcraft constantly works to improve Previzion and we welcome

feedback.

The current Previzion build number is shown in the About Previzion
window, as shown above.
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Pipeline Timers

Pipeline Timers

Previzion contains a set of sophisticated internal timers to aid in pipeline
rendering tuning. These are accessed with the Pipeline button under
the System tab.

Timer Descriptions

Note: all times in milliseconds

Frame: # of frames processed
InSync: Time between each incoming sync packet. Packets
typically come in at 2x frame rate.
TrackSet: Time between start of new frame (defined by
incoming sync data pulse) and when all tracking data has been
acquired
TrackToFr: Time between when all tracking data has been
acquired and the video frame is ready for processing
InQueue: # of frames waiting in input queue
InVideo: Time between frames of input video
InDrop: # of frames dropped on input side
OutQueue: # of frames in output queue
OutVideo: Time between frames of output video
OutDrop: # of frames dropped on output side
OutRepeat: # of frames repeated in output side
cVideo: Time in CPU pipeline from start through video ingest
cScene: Time in CPU for scene render
cEffects: Time in CPU for distortion, depth of field, and motion
blur
cComp: Time in CPU for keying and compositing

Timers, Continued

gVideo: Time in GPU for video ingest
gScene: Time in GPU for scene rendering
gEffects: Time in GPU for distortion, depth of field, and motion
blur
gComp: Time in GPU for keying and compositing
cOutput: Time in CPU for output to HDSDI, data recording, etc.
cFrame: Total CPU time for one frame
cIdle: Idle CPU time for one frame
cDecode: CPU time to decode MPEG
gOutput: GPU time for output to HDSDI
gFrame: GPU time for one frame
gIdle: Idle GPU time for one frame
gLag: Time that GPU frame completion lags
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Lens Calibration

Lens Mapping Overview
Lens Calibration Hardware – 14-foot board
Static Lens Mapping Method
Checking Calibration
Lens Calibration Hardware – Legacy Motor
Starting Lens Calibration and Calibration Cycle – Legacy Method
Saving, Stopping and Resuming Lens Calibrations – Legacy Method
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Lens Mapping Overview

Lens Calibration Overview

Lightcraft's Lens Calibration System is the most accurate and field
portable way of mapping the lens' focus, focal length, lens distortion and
entry pupil (nodal point).  For most lenses, it is hard to use the numbers
on the side of the lens, like focal length, for instance, in camera tracking
applications.

Many of the parameters of the lens changes over the course of its
zoom/focus ring travel.  The reason for this is because photo and
cinema lenses are comprised of many elements and each glass
element has its own set of parameters.  Previzion, in it's lens mapping
process, measures these parameters as a whole over the course of the
zoom and focus travel.

We use an optical marker pattern mounted on fiberglass aluminum
honeycomb board to calibrate lenses on a serial number basis.  In other
words, even lenses that are "matched" may have variations that need to
be mapped.  Our lens calibration process takes that into account and
calculates it throughout all steps of a lens.

Some lenses "breathe."  What that means is that by simply changing
the focus from near to far there is a "zooming' effect as the the focal
length changes.  In some extreme examples, a lens may say on its side
85mm, but when in fact it comes out to be 80mm to 100mm depending

on the focus.

In VFX applications you need to take into account lens distortion at
some point in your pipeline.  Since Previzion renders everything
in real-time, the lens calibration system calculates any barrel distorts or
pincushions that a given lens may produce at the time of calibration.

Required Gear

For being able to map the limits and values of a lens' focus and zoom
ring, Previzion requires an encoded lens controller like a Preston FI+Z
II/3, CMotion, LDS Lens, etc.  It is important that the lens controller is
encoded, because otherwise, there is no direct feedback from the lens'
positions.

For this, you will need:

Previzion Computer
Previzion Video Converters
Power source
HDSDI monitor
Production camera
Lens(es) being used
supported Lens controller (see below)
Lightcraft Aitrack
Lightcraft Data Cable Tether
Appropriate lens cable (goes into Aitrack via 4-pin Lemo)
Lens Calibration Hardware (see next section)

Lens controllers are made up of encoders/motors that, when initiated,
turn the focus and zoom ring from end to end and normalize this value
between 0.000 and 1.000.  This is the value for which Previzion uses to
determine the position of the lens.  Tracking the lens so to speak.

Previzion currently supports:

Preston FI+Z II and 3
CMotion Camin 2M, 4M and 6M
CMotion Compact
RT Motion (legacy support only)
Canon ENG lenses
Fujinon ENG Lenses
Fujinon Cine Lenses
LDS encoded lenses (Cooke, Angeneaux and Zeiss) paired with
Arri Alexa Plus

Camera Settings For Lens Calibration

When setting up the camera for lens calibration, it is important to know
a few things about the technical specifications of the camera itself.
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You should know or have someone who knows how to change camera
settings if necessary.  Also, you should be familiar with or have
someone who is familiar with the lens controller and lens controller
operations.

Take a moment and verify all your settings before starting the lens
calibration procedures.  This process can take up several hours and,
should there be a setting that is wrong from the beginning, the resulting
calibration file may not be good for use.

Requirements for setting up lens mapping:

Camera Support - the camera can be mounted on wheels, a
tripod or dolly.  With the new Static Lens Mapping procedures,
there aren't as many camera moves when there are any.
Lens - you should have access to all lenses that need to be
mapped in this process.
Lens Controller - have power and the appropriate data cable
for your lens controller.
Camera Height - the camera does not need to be at the same
height as the board.  It often helps to have the camera at
comfortable height, but know that the calibration board can be
mounted at adjustable heights on its stand.
Clearance of board - make sure that the room or location
picked for the lens calibration has enough room to clear the
motion of the 14-foot board.  If space is an issue, you may use
just the center section of the board, but this limits the lens
calibration accuracy to mostly normal to telephoto lenses.
Frame Rate - Lens calibrations cannot be done in interlaced
frame rates.  The camera should be set to a p or PsF frame
rate.
Image Adjustments - turn off all image adjustments such as sharpness
controls, edge enhancements, image mirroring, etc.
Power - if possible, keep the camera running on a reliable
power source, preferably AC power or enough batteries to run
for a few hours.
Focus assist/Menu on Output - some cameras can send the
on-screen menu and any focus assist magnification out the
HDSDI Monitor Output.  Make sure these are disabled.
Lights - this process requires a considerable amount of light to achieve great depth of field.  Plan on having studio lights.  We recommend at least using cool lights (KinoFlo).

ISO/EI/Gain - for the lens calibration process, you may boost the gain or
raise the ISO rating for the sensor to register more light.
Iris/F-Stop - change the f-stop (iris) to its smallest aperture.
 This value should be around f.22 or less.  This will diminish
depth of field and allow for better capture of the marker patterns.

It's helpful to check that all your components connect together and are
in the correct firmware version for the lens calibration process.

Previzion Settings for Lens Calibration

The lens mapping process in Previzion is a bit different from other
processes in Previzion.  Make sure to check the following parameters:

Trackers - Other than your lens tracker, Previzion does not
need to have SFserver open or any of its trackers enabled or
connected.   Set Sync to "Generated," Location to "None" and
Stereo to "None."  In Tracking Tab, the Lens Tracker is the
only one that should be enabled and checked to be in proper
running order.
Scene - To avoid scene render load conflicts, make sure you
are in the Previzion default scene.  In Scene Tab, make sure to
"Clear" scene or press CTRL + N to clear the scene.
Video Input - the video input HDSDI 1 should be enabled and
set to match the camera's frame rate.
Camera Sensor - this is very !IMPORTANT! and should be
triple checked.  Make note of the setting in the camera for
resolution and the type of sensor.  Check with the
manufacturer's documentation to obtain the proper sensor size
(in millimeters) if in doubt.  Previzion comes loaded with a
variety of documented sensor widths and should cover most
users.
Other Effects - Keying, Color adjustments, Mattes, Markers,
etc. all get overwritten during lens calibration.

Once all the settings and parameters above mentioned are checked
and re-checked, proceed to the actual lens calibration process.
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Lens Calibration Hardware - 14-foot board

Lens Calibration Hardware

Lightcraft's lens calibration system ships with:

1.14-foot lens calibration marker board that breaks up into 3 parts,
2.calibration motor and mount,
3.12-inch offset rod,
4.220V-to-110V transformer (when requested),
5.European ("Shuko") to American ("Edison")  power adapter,
6.foot switch,
7.Allen Wrench,
8.(2x) T-push pins,
9.travel case for boards,

10.Pelican/Storm Case for motor, and
11.its own turtle base c-stand

For taking into account wider lenses and various focus distances, the
lens calibration system uses a 14-foot wide marker board.  The patterns
on the board is a known digital pattern that, during calibration, Previzion
sees through the lens to determine the various parameters of the lens.

We include a c-stand with the system because often times, c-stands are
property of other departments.  The lens calibration c-stand becomes
the VFX department's very own c-stand.  We also remove the gobo arm
from the stand so it can only be used as part of the lens calibration
system.  The c-stand we use has a turtle base that neatly breaks up
and collapses into compact parts.

Shipping and Padding Parts

Because we rely on the flatness and integrity of the pattern of the lens
calibration board, it is important to pad and protect the marker boards.
 The marker boards ship from Lightcraft with a 1/2" medium density
foam.

Just like shipping artwork, we recommend packing the boards
separated by foam in between.  Use the diagram inside the lid of the
case, or download the full PDF from the General Downloads on the
Dashboard.

The motor, foot switch and c-stand are shipped in their own case as to
avoid damage to the marker boards.
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Motor Voltage

The calibration motor is the only component in Previzion that cannot be
customized to 220V.   The motor can only work in  110V and for any
European customers or customers that specify 220 voltage, we include
a 220-to-110-Volt power transformer.

Plugging the motor to 220v will damage the motor.

Marker Board Assembly

As mentioned above, the lens calibration marker board is made up of
three parts: center, left wing and right wing.  The board does not have
an up or down per se, but it helps to define one as left and the other as
right.

To put the board together:

1.Mount the motor onto the post of the c-stand using the two
machined slots and a hex key. 

Machined Slot mount

2. Place the center board onto the motor mount and fix it using the
two t-pushpins.The longer pushpin goes onto the top and the
shorter one clicks on the bottom. 

Mounting center marker board

Top t-pushpin

Bottom t-pushpin

3.Place the 12-inch offset rod, but down attach it onto the motor
yet.  You will need to tighten it 8 inches from the center of the
board.  Don't screw its other end yet as it may damage the
motor. 

Mounting offset rod

At that distance, the board will oscillate just shy of 90
degrees.The offset rod has a single rail nut that slides into the
top of the extruded aluminum frame.

4.With the assistance of another person, attach the side wings.
 Just like the offset rod, the wings have rail nuts that slide into
the extruded aluminum frame. 
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Mounting side wings

These are triple rail nuts and slide into the back of the frame
assembly.

Please note the sides on the board by looking at the from of the
board.  There are double hairlines and single hairlines to assist
with alignment and determining which wing goes to which side.

Single alignment hairline

Double alignment hairlines

5.Plug the foot switch in between the motor and a power outlet.
 Make sure the foot switch is on the off position.  The foot
switch with serve as a on/off switch for the whole assembly. 

Foot Switch

6.Finally, screw in and tighten the offset rod to the motor shaft. 

Offset Rod

7.Turn on the whole assembly and verify that the board's
oscillation does not hit anything.

The boards may differ in width by up to 1/8" and the points where the
boards touch may not be perfectly straight as these boards are
assembled by hand and adjusted to be as optically square as possible.

Board to Camera Orientation

The horizontal board has a nearly 90 degree swing angle. This should
be set up so that the calibration target is at about a 90 degree angle to
the camera lens axis at one extreme, and nearly in line with the camera
lens axis at the other extreme.

This provides the maximum angular variation to the lens calibration
system, so that Previzion can accurately calculate the true focal length
and entry pupil of the lens.
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Static Lens Mapping Method

Static Lens Calibration Steps

Lightcraft Technology has standardized in a method of calibrating
lenses that makes it so the calibration marker board does not move, or
moves a handful of times.  We call this the Static Lens
Mapping method.

This fixed lens calibration procedure goes as follows:

1.Input lens focus distances with lens controller values.
2.Set lens to smallest aperture (i.e. f22)
3.Add light to board as necessary.  Increase ISO or gain as

needed.
4.Determine distance to board.  This will be your first Setup

Distance, measured in centimeters.
5.Input Setup Distance.
6.Initiate calibration cycle (described below) for each step from

this first distance.  Some points may be too out of focus for
proper detection.

Repeat calibration cycle for as many points as possible
from this same position.
Skip steps that are not detectable
Save calibration as you go

7.Before moving anything, verify calibration.  If necessary,
delete a bad point and re-calibrate the point.

8.When verified, move the board to the next position to capture
the points that were not detectable from previous Setup
Position.

9.Repeat steps 5 through 8 until all points in the lens are
calibrated.

A special thanks goes to Mr. Ron Fischer, Technical Director at NBC
Universal, who has collaborated with Lightcraft Technology to improve
the lens mapping process.

The main advantages of this process are:

the ability to re-calibrate points,
obtain a more accurate entry pupil, and
calibrate infinity focus as a distance

Instead of spending hours trying to hand edit or average between points
to achieve a somewhat smoother lens calibration, because the board
never moves, this process allows for re-capture of a point that is
deemed bad.  This removes any guess work.

With our legacy calibration method, we used to have to move the
camera at various distances from the calibration board.  These were:
min-focus (approx. 75cm), 100cm, 200cm, 300cm, 400cm, 500cm and
800cm.  The problem was that the software assumed an absolute even
number, when in reality, if the camera needed to be at 300cm from the

board, it would be a few centimeters off.  At any one distance, one or
two centimeters off would not make a huge difference, but over the
course of the entire lens calibration process, the little offsets in setup
distances add up.  This used to result in an uneven lens calibration.

With the static lens mapping method, we remove all guess work and
get a more far-reaching and accurate lens calibration as a whole.  We
have also implemented a mechanism that saves all captured images in
an archive to allow for future re-calibrations.  This means that, should
Previzion's algorithm improve, you will be able to re-run the same lens
calibration captured images.  This mechanism is still being
implemented, but we are already saving all captured images for future
use.

Setting up Calibration Board

The 14-foot calibration board, when mounted correctly (please
reference Lens Calibration Hardware for more information), should
oscillate almost 90 degrees.

From each extreme, the board should go from flat to almost touching
the camera with one of its wings.

While setting up and moving the board around, always make sure that
the board does not hit anything.  Keep the foot switch accessible should
you need to stop the board from oscillating.

Initial Setup

Before starting the calibration setup, make sure to set your Camera
Sensor and video input.  Other camera and Previzion settings are
described in Lens Mapping Overview.

When you have verified both camera and Previzion settings, we can
initiate the calibration process.  In your Camera Tab (formerly Lens
Tab), select Add under "Lens Calibration."
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This will open the Lens Calibration window.  You should position this
window on top of your main Previzion window as the two interact with
one another.

 

Make note of the camera and lens model and serial numbers for future
reference. Add any comments for other operators to reference when
dealing with this lens calibration file.

Checking Backfocus

Make sure to check backfocus for your lens before starting.

There are a few ways to check backfocus.  A simple test is to move the
focus ring of the lens to one of the focus markings  and then position an
object to the distance that the barrel marking indicates.  Repeat this for
at least three separate distances.

For example, if the lens focus is set to be at 2 meters away, when I
place an object at 2 meters away from the lens, it should be in focus.  A
commonly used pattern to judge focus is a focus chart or a Siemens
star.

Siemens Star (focus test pattern)

The values on the side of the lens should match the position of critical
focus.  If they don't match, backfocus needs to be adjusted.

For zoom lenses, an indicator that the backfocus is off is having the
critical focus plane distance change simply by zooming in or out.  For
instance, the operator zooms in, focuses to an object and when he or
she zooms out, the object is no longer in focus.

Inputting focus distances

To have Previzion determine which distances to calibrate the lenses
from, the lens calibration interface requests that you enter all the focus
distances written on the side of the lens barrel as you physically change
focus to each distance.

As you move the focus on the lens, Encoder Fraction will reflect the
relative lens travel on a normalized value between 0.000 and 1.000,
where 0.000 is the closest focus and infinity focus is 1.000.

If a lens has focus distances: 65cm, 90cm, 1 m, 1.25 m, 1.5 m, 2 m, 2.5
m, 3 m, 5 m, 10 m, 18 m and infinity.

For each distance, move the lens to be on the exact mark on the side of
the barrel, then input the corresponding distance into Previzion and
press Add.

Repeat this for all distances.

For infinity focus, physically type "inf" into the meter input box.  For all
focus distances you may choose to enter values in feet and inches or
meters, with the exception of infinity.

Once all values are entered, select the type of lens being calibrated:
Prime Lens (fixed focal length) or Zoom Lens.  Then press Next.

Previzion will suggest to use only the most crucial points. You may
choose to calibrate more points, but these are the recommended
values.

Load Target File
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Known formally as "Marker File," the Target File contains the
corresponding pattern for the calibration board.

For the 14-foot lens calibration board,
use LensCalibrationCoords_163-4×24.cal.

Determining Setup Distances

In the process of calibrating the lens without moving the board to the
various focus distances, it's crucial to stop-down the lens to its smallest
aperture as the process requires the most depth of field to work.

This is important because, should a point show that it has a bad solve,
we can delete the point and re-capture it.  This only works because
nothing moves.

Under Physical Setup, there are a few options.

We recommend to always start with a Far Setup, then Near Setup,
when necessary, then Fill Setup, when necessary.

The on-screen instructions are actually step-by-step instructions for
determining setup distance.  We start with the camera at max zoom and
max focus and, if there are points in the near focus that we cannot
calibrate, we will move the camera and establish a second setup
distance to capture the near points.

The on-screen instructions read:

1.Set lens to smallest aperture (i.e f22)
2.Light target board as brightly as possible
3.If necessary, increase ISO or gain to make targets visible
4.Set to maximum focal length (zooom)
5.Set to maximum focus distance
6.Press 'Detect' to enable target detection
7.Starting with camera at 1 m from target board, move camera

away from board until a sufficient number of targets are
recognized.

8.Measure distance from camera sensor to center of target board
in cm

9.Enter as setup distance and press 'Next'

The calibration board does not need to actually be at critical focus to be
detected by the software.  Being tangent to the circles of confusion may
be enough for a given lens.  The software is quite forgiving when it
comes to detecting the square markers.

When you have determined the initial setup distance, enter the distance
between the camera sensor and the center of the board.  This
measurement is in centimeters.

To continue, press "Next."

The screen instructions will instruct you to center the crosshair with the
center of the board then turn on the calibration motor.  The text on the
screen says to "start target board spinning," but, in the case of the
14-foot calibration board, the target board actually oscillates.

Using either the camera's center mark (crosshair) or Previzion's
corsshair, aim at the very center of the target board.  There is a tiny dot
that indicates the center.

Because many lenses "walk," center the crosshairs with the lens
zoomed all the way in.

After centering the camera.  Lock pan, lock tilt and make sure that
camera and the board are fixed.  Double check that your Setup
Distance is correct.

Start the calibration motor and press 'Next.'

Try capturing as many points as possible from this position.

Calibration Cycle
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The calibration cycle is the process of calibrating each point.  For
each point, you will need to:

1.Select the point to calibrate,
2.adjust focus to match the value on the screen,
3.adjust zoom to match the value on the screen,
4.trigger the calibration,
5.repeat for the next point

This is what is referred to calibration cycle.

When the screen reads "Press 'Next' to capture values for this point,"
you can pick which point to calibrate.

To select a point, click on the Points grid. The actual point grid is
clickable and you may skip points as necessary.

Start with the lower left box.  This represents the closest and widest
point on your lens.

As you capture points, the points grid starts filling up with light gray
boxes.

It's not uncommon for a zoom lens to need twoSetup Distances to
capture all point near the board and another for all the far points.

We recommend starting with far setup, which results in a calibration
that captures the points close to max zoom and max focus.

If necessary, on another pass, using near setup, you can capture the
points that were not detectable at the first setup distance.  For now,
gather as many points as possible from this first setup without changing
your setup distance.

Saving your progress

To save your file, you may simply "Save" or, if you are editing or
removing points, "Save as…" to preserver the original file.

Verifying Calibration

Should you need to do more than one setup, before ever touching
anything, check that the points that were calibrated are okay.

You may use the graphs to judge which points to re-calibrate and/or
look through the lens to see where there are issues in the calibration.
It's normal to have a few bumps and odd points during the mapping of a
zoom lens.

To edit points using the built-in graphs, see Editing and Removing
Points below.

To look through the lens in Previzion to verify calibration, you will need
to add a CG element behind the live foreground video.  To do this:

Save your progress,
Close the lens calibration interface,
Set the key so that the live foreground video is see-through,
Position the default scene on-screen,
Slowly zoom in and out, and
Focus in and out.

The background should move and track with the foreground.
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Editing and Removing Points

By clicking on calibrated points on the points grid, the screen text will be
replaced with a graph.  This feature has been released as of build 7686.

There are various views for the graph.  Each one representing the span
of a lens parameter.  This is a direct replacement of LensGrapher's
tools.

The most important parameters are:

Focal Length
Entry Pupil
Distortion
Viewable Width

All graphs are actually in 3D and can be moved around to allow for
better visualization of the points. If you ever get lost with the graph, use
"Graph" Reset to reset the graph to its default position.

Always try to "Remove" and re-calibrate a point rather than averaging
between points.  And avoid manually editing a point's value, unless
recalibrating is not yielding better results.  This becomes more crucial in
the wide angle lenses and in small sensor cameras.

Start looking at Focal Length, remove and re-calibrate any point that
jump out from the norm in the graph.  In a 17x broadcast zoom lens,
after the first pass in the lens, this is what Focal Length looked like:

 

After removing and re-capturing the bad points:

 

The same occurs with Entry Pupil and Distortion:

Distortion - before corrections

Distotion - after corrections
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Entry Pupil - before corrections

Entry Pupil - after corrections

As a final verification step, look through the lens as described above
in Verifying Calibration to ensure all points are mapped properly.

Manually editing points

To edit manually a point, click on the the point in the points grid and
adjust its value with sliders next to the values.

It helps looking at all the values for each column to determine how a
given value is tending in the neighboring points.

Should manual editing prove to be too difficult or ineffective, there is
also an "Average" option.  We don't recommend using this option during
the lens calibration process.  Use it only if re-capturing a point and
manual editing of a point are not possible or effective.

Lens Calibration Archive and Legacy
Formats

As of build 7686, the lens calibration format is different from all previous
versions of Previzion.  The file format is still an XML with a .cam
extension, but it also has all images captured during lens calibration in
its own directory.

 

The goal is to have a format that, should Lightcraft improve Previzion's
lens calibration algorithm, the same images can be reprocessed.

For compatibility purposes, Previzion allows older formats of lens
calibration files to be imported into new formats and the current lens
calibration format to be exported as the old format and so on.
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This is most useful when working with older versions of Previzion.

Page 232



Previzion - User Manual
by Lightcraft Technology

Checking Calibration

Checking Calibration

The lens calibration process is not perfect and sometimes requires the
lens data to be massaged.  After completing a lens calibration, verify
calibration using Previzion.

1.Clear scene and point camera to Previzion Default scene.  The
checkerboard patterns help see any discrepancies.

2.Setup your camera with the same settings as the calibration
process (same sensor width, trackers, etc.)

3.Load you new lens file.
4.Adjust focus to the various focus distances that were calibrated

to (min focus, 100cm, 200cm, 300cm, etc.)
5.Set the key so that the CG scene is visible along side the live

action image.
6.Make sure that your Video Plane Depth is set to a really small

value like 10cm to keep the live action image on top of the CG
scene.

7.Slowly zoom from wide to telephoto, paying close attention to
the match between CG and live action.

8.Another approach is to set your focal length and focus in and
out.

9.Write down any lens distances and positions that may need
alterations.

The lens data is written as a regular XML file format and should be
easily editable, but we recommend using LensGrapher which was
designed and built solely for editing and massaging lens calibration
data.

We distribute LensGrapher for free to all our Previzion users.
 Download it from our Downloads page.

Lens Data Fixes

LensGrapher can be a really handy tool for editing and visually seeing
the bumps in a lens calibration.  The next chapter is dedicated to
explaining all tools and concepts in LensGrapher.

The ultimate judge of a lens calibration is not the graphs themselves,
but loading the corrected lens file in Previzion, zooming in and out and
focusing in and out.
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Lens Calibration Hardware - Legacy Motor

This page references an outdated lens calibration process. Please
check with your Lightcraft representative for the latest process.

Mount Motor to C-Stand

Attach the calibration motor to a C-stand as shown.

The C-Stand height is at the minimum.
The motor drive axis is angled up about 5 degrees.
Make sure that the drive gears are not rubbing the C-stand or
the power cable.
The motor uses 110V AC power.
Make sure the C-stand clamps are tight enough to prevent the
motor from slipping when the weight of the target is applied.
Place a sand bag on the C-stand legs to keep the target from
tipping over.

Connect Calibration Frame

Connect the calibration frame to the drive motor as shown.

The quick-release pins are inserted from either side.
The target is rotated all the way to one end of the curved guide,
as shown.
Tighten the socket head cap screws firmly.

 

Test Motion

Connect the motor plug to 110V AC current, and verify that the
calibration target can spin through its full range of motion without
interference.
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Starting Lens Calibration and Calibration Cycle - Legacy Method

This page references an outdated lens calibration process. Please
check with your Lightcraft representative for the latest process.

Trackers Settings

Before we can start, there are a few settings that should be enabled in
Previzion.

On the Tracking Tab, set:

Sync to Generated (previously called "Timer") or Airtrack
Location to None
Lens to your corresponding lens controller
Stereo to None

Check that near focus shows a close-to-zero focus lens fraction and
infinity focus reflects a number close to 1.000.  Do the same for zoom,
when necessary, where all the way wide is a near zero focal length
fraction and all the way long is a number close to 1.000.  To enable this,
go to "System Tab" and check "Show Lens Fraction".

Use your FI+Z controller to verify that the motors reflect the correct
values.  If the values are inverted, there are settings in Previzion that
flip this value.  Under Tracking Tab, click "Configure" next to "Lens" and
check the motor value to be flipped.  Some lens controllers like CMotion
or FI+Z 3 MRD have a physical switch that flips the motor's orientation.

Setting Sensor Size

In addition, the correct sensor width (in mm) must be used.  Most
common cameras are well documented and Previzion has them in the
default settings.

When a manufacturer specify the sensor size to be 2/3", super-35, etc.,
often times that does correlate to the actual sensor size, per se.

The nominal 2/3" (1/2", Four Third) actually refers to the corresponding
vaccum tube size that would have been used to produce the image
circle that corresponds to the image circle of the camera sensor.

For cinema cameras that specify Super-35 sensor size, that, again,
doesn't actually mean the size of vertical cinema 35mm film strips, but it
is very close to it.

Some manufacturers measure it differently from the next.  Sony's F65,
for instance, is really close to the nominal 25mm of Super-35, at
24.7mm, but at a 17:9 aspect ratio.  So, not necessarily the same as
3-perf size of negative super-35, but nominally close.

On RED Cameras, it depends on what resolution and the firmware your
RED Camera is running.  Firstly, resolution changes on RED ONE MX
didn't change the interpolated resolution being recorded.  Instead, the
RED ONE MX cropped the sensor to the corresponding pixel count.
 This changes the effective "sensor width" in Previzion.  Secondly, on
some RED ONE firmwares, there used to not be any 4.5K resolution.
 There used to be up to 4K resolutions, but the camera operator had a
small look-around for framing purposes.

For cameras not listed, you can always add your own.

Load Marker File

You will be prompted to load a Marker file that correspond to the Marker
Board being used.

Click Load to load the correct marker file.

Use LensCalibrationCoords_163-4×24.cal, if you have the oscillating
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14-foot board with detachable "wings".

LensCalibrationCoords_163-4×24.cal board

Use Markers303targets.cal, if you have the spinning calibration board.

Markers303targets.cal board

Currently, all Lightcraft Lens Calibration Systems ship with the 14-foot
marker board with detachable wings.  But we still support the spinning
board as a legacy system.

Starting the Calibration Process

Once all these settings are checked and re-checked, press "Calibrate".

You will be prompted to resume an existing calibration or starting a new

one.  Pick "New Calibration."

Next, pick the number of calibration steps and the various distances to
calibrate at.

The Focal Length Calibration Steps correspond to the number of
steps Previzion will sample from throughout the zoom range of a zoom
lens.  The recommended value is 21 steps.

For Prime Lenses, the number of steps should be set to 1 step.

The Focus Distances correspond to the various distances that you are
able to calibrate at.  These distances are measured from the very
center of the oscillating marker board to the camera's sensor plane.

To add a new distance type in the value in centimeters and press Add.
 To remove a point or change a value, you will need to Clear All.

The recommended distances are:

Minimum focus of the lens
100.0 cm (1m)
200.0 cm (2m)
300.0 cm (3m)
400.0 cm (4m)
500.0 cm (5m)
800.0 cm (8m)

At the minimum focus of the lens, make sure that the board can still
move its whole range at that distance without hitting anything.  A good
way to go about this is to keep the board static and move the camera as
close as possible till it either hits its minimum focus distance or it starts
hitting the board.

Depending on how a given lens's focus travel is setup, you may need to
add more distances.

Also, depending on the limitations of the location where the calibration
is being done, there just may not be enough room for the 8m distance.

Calibration Cycle

The calibration cycle is quite simple, but it is time consuming and
repetitive.  Diligence is required and it helps to have a notebook that
you write down notes from one calibration step to the next.
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This cycle consists of two parts:

1.Adjust the camera at a new distance and focus camera
accordingly.

2.Adjust zoom as indicated and tell Previzion to calculate lens
values.  On prime lenses, this is a single step.  On zoom lenses,
this repeats 21 times.

Set Camera at New Distance

At this point, there are on-screen instructions and to what to do:

1.Make sure the board is not oscillating/spinning.
2.Set the camera at the indicated distance always making sure to

measure from the sensor plane to the very center of the board.
3.Center the cross-hair on the very center of the board.  As

previously mentioned, the camera need not be Center the
cross-hair on the very center of the board.  The Marker Board
has a tiny dot that marks the center of the optical pattern.  You
may zoom in to center and then zoom back out.

4.Focus the camera on the board.  This is where you may open
up your f-stops all the way to help you focus.  Just make sure to
stop back down to the proper f-stop.  From this point until the
next calibration distance, focus should not change.

5.Cautiously start the board oscillation/spinning but keep your foot
on the foot switch and verify that the entire motion of the board
does not hit anything.

6.Press "Set" to move forward.  "Set" used to be called "Enter."

Set Focal Length and Calibrate

The next screen will ask you to zoom to the indicated value.  The
orange arrows will go from blue to orange when the zoom is at an
acceptable range.  When ready, make sure the board is moving and
press "Set."

For Prime Lenses, you will just need to press "Set."

Previzion will now capture several still images, identify the marker

patterns and calculate the lens values.  DO NOT change focus or zoom
at this point until Previzion has completed the calculations.

You will notice that the center of each optical pattern that gets identified
has a purple X and a square.

The text on the screen outputs the values for each point being captured.

To the right of that screen, you will notice blue rectangles being stacked
on top of each other.  This is a graphical representation of the number
of Marker patterns being found.  This changes according to the field of
view of the lens as well as the position of the oscillating/spinning board.

At the end of it calculations, a new dialog box appears with the results
of the lens values.  The most important values to keep an eye on and
even write down the values on a notepad are:

Focal Length - This number should be about the same as the
one written on the side of the lens. It can diverge considerably at
higher zoom levels.
Entry Pupil - This reflects the virtual convergence point of the
lens or "forward nodal point."  This distance is from where it
calculates this convergence point to the sensor plane.  Write
down this number and keep track of it to see if it is trending
upward or downward.  For a zoom lens, it will typically begin
near the front element of the lens and progress backwards as
the focal length of the lens is increased, typically becoming
negative at some point.
Distortion R2 - Measures the amount of radial lens distortion. It
will typically be a small negative number (about -0.1) for wide
angle lenses, and rise to be a small positive number (about 0.2)
as the focal length increases. Significant variations can be seen
toward the end of the zoom range. This too should be written
down to see if it trends upward or downward.

As long as these values are close to expected, press Keep and you will
be prompted to zoom in until the blue arrows turn orange, like before.

If any of these values are too large or too different from expected, press
Discard and redo this step.

The other values are not as crucial for determining the accuracy of the
calculated point because they were either entered or are literal encoder
readings:

Focal Length Fraction - Shows the value coming from the lens
controller for focal length in a value from 0.000 to 1.000.
Focus Distance Fraction - Shows the value coming from the
lens controller for focus in a value from 0.000 to 1.000.
Focus Distance (cm) - Displays the current calibration
distance.
Center Offset X (mm) - Shows the calculated lateral distance
from the center of the sensor to that of the optical axis.  Lenses
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are not perfectly centered, and zoom lenses may move around
as they go from wide to tight.
Center Offset Y (mm) - Shows the calculated vertical distance
from the center of the sensor to that of the optical axis.
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Saving, Stopping and Resuming Lens Calibrations - Legacy Method

This page references an outdated lens calibration process. Please
check with your Lightcraft representative for the latest process.

Saving a Calibration

Before moving the camera from one calibration distance to the next, it is
good practice to save your calibration.

Between calibration points you may Save or Save As.

Save As will prompt you to choose a name for the calibration
file and a location to save it in.  Previzion defaults to its
"Calibration" directory for all lens calibrations.  Make sure to
save the lens with its make, focal length range and serial
number.
Save will save on top of whatever lens file is loaded.  If this is a
new calibration, it will prompt you to choose a name and a
location to save it in.

Stopping a Calibration

Should you need to stop the calibration for whichever reason, you may
choose to do so, as long as you are able to setup the camera the same
way as before.

By following all the setup steps, there should be no trouble successfully
resuming a calibration at a later time.

To stop the calibration process, simply "unpress" the Calibrate button
on the Lens Calibration pane that, throughout the lens calibration
process remains "pressed."

If the lens file has not been recently saved, a dialog box will come up to
let you save the data.

Resuming a Calibration

To continue a lens calibration or to add points that were skipped or
deleted, simply load the lens file by pressing Load  on the Current
Calibration pane.

When all settings both on camera side and on Previzion side have been
checked, press the Calibrate button on the Lens Calibration pane.  You
will see a dialog box that queries to start New Calibration or Add
Points.

Press Add Points and the calibration will go to the very first empty
calibration point and indicate the distance and zoom step to position the
camera in.
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Lens Grapher

Lens Grapher Overview
How to Use
Lens Grapher Interface
Working with Viewable Area Graph
Glossary of Terms
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Lens Grapher Overview

Why The Lens Grapher is Used

The importance of the .cam file is to accurately register the virtual and
real world camera lenses. Occasionally the calibration process may
produce bad values for one of the three lens parameters (entry pupil,
distortion or focal length. Read more about them in the glossary). If the
operator catches them during calibration they may be easily fixed by
redoing the calibration step but occasionally the calibration process
produces a bad result that needs to be either averaged out with its
surrounding values or deleted and replace with a better solution.
The best way to see these errors is to graph the points over the zoom
or focus range as they will appear as a spike  or inconsistent value.
Hence the graphical usefulness of the Lens Grapher.

[line] 

Lens Grapher Introduction

The Lens Grapher is Lightcraft's tool for visualizing and editing lens files
(*.cam) created in Previzion.
The Lightcraft Lens Grapher Utility is designed to give Previzion
operators and lens calibrators the tools necessary to quickly and
visually view and edit a Lightcraft Lens Calibration file. The graphing
utility gives users the chance to view the important lens parameters
through the extents of both rack zooming (defined by number of zoom
steps per focus distance) and rack focusing (number of focus
distances). Over both zoom and focus axes, the editor displays both
table and chart data for these three important parameters (AKA
dependent variables):

calculated focal length of lens
entry pupil of lens
distortion value of lens

 

The program's icon is very similar to other Lightcraft Icons, with
only a slight modification to signify it's specific function.

 

Features

Reads the following types of lens (*.cam) files:
Incomplete Lens Files
Zoom Lenses
Prime Lenses
Zoom Lenses calibrated to a single Focus Distance

Missing Data Point signifier
Undo / Redo
Adding Row and Column Offsets
Baking Offset Data
Independent Graphs for: Entry Pupil, Distortion and Focal

Length Lens Parameters
Graph for "Viewable Area" Lens Characteristic
Toggle Lens Parameter graphing over choice of Rack Zoom or
Rack Focus
Data Point Editing in Spreadsheet style Table
Analogous Data Highlighting between Graph and Table
Hotkeys
Averaging Multiple Data Points together
Force inclusion of zero as min or max when graphing
Show or Hide non-Highlighted graphs with opacity slider and
Hotkey
Help menu with information about program build, calibration file
construction and illustrations of lens parameters
Pop-up information when mouse hovering over a point in the
graph

The Lens Grapher is an easy to use graphing application that lets
Previzion operators view the quality of the lens calibration graphically.
Operators can view the lens file whether it's completed or incomplete,
as during the middle of a calibration. The Lens Grapher can be used to
view the quality of the calibration for zoom lenses, prime lenses, or
calibrations with one focus distance.

Here are examples of lens calibration files that are complete and
incomplete:

 

Complete Lens File

Incomplete Lens File: Notice the "missing" vs. "deleted" points

Here are examples of a zoom lens, prime lens, single focus zoom
lens file:
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The rows represent zoom steps. The columns represent focus
distances

Example of a Prime lens with only one (the default) focal length

A Zoom lens with a single focus distance
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How to Use

How to use the Lens Grapher Application

1. Launch Lens Grapher

Lens Grapher can be found on your Previzion system
It is in the following directory:

C:\Program Files\Lightcraft\LensGrapher
It is accompanied by 3 .dll files. These files are
Mandatory and MUST be in the same directory as the
main program file

QtCore4.dll
QtGui4.dll
QtXml4.dll

If you don't have a Previzion machine, or _Lens Grapher_ isn't
installed on your system, you can download it from here:

Click Here for _Lens Grapher_ Download
You can also run this on any Win7 x64 system with the latest
updates

2. Open a file

You can open a file one of there separate ways:

Hotkey
CTRL+O

Button

Menu

3. Make sure the same lens file is loaded into
Previzion

Instructions on how to load a lens file into Previzion can be here:
http://www.lightcrafttech.com/support/documentation/lens-interface/lens
-calibration-panel/

4. Use Previzion to look for errors in rendering

Now that the lens file is loaded, step through all focus and zoom steps
with your lens controller. Make sure to step through the full range of
focus for each zoom step, and vice versa. Look for pops in zoom (as in,
when the video is zooming in but the CG elements do not zoom in at all,
or at the same rate); these are errors in either focal length or entry
pupil. Also look for pops in when stepping through your focus controller
(when the CG elements do not bow or bend the same way as the live
video); this indicates an error in the distortion values for the lens.

Write down the focus distance fraction and the focal length
fraction from Previzion when you see an error.

These fractions will help you pinpoint where to locate your errors in the
Lens Grapher application. If you can't find these two fractions, then
Enable Screen Text and view the Focal Length and Focus Distance
values.

5. When an error is found, Use Lens Grapher to fix
the data

When searching for errors in a lens file, there are two properties that
need to be checked and corrected: distortion and viewable area.

Distortion
Viewable Area

Distortion

The distortion parameter defined how much radial distortion the virtual
lens renders. Remember, the virtual lens and physical lens
characteristics are supposed to match. So if the physical lens is adding
barrel distortion to the video feed, but the virtual lens is adding
pincushion distortion to the CG rendering, then an error exists in the
lens calibration file.

An error in the file may also exist if the virtual lens does not distort the
CG elements to the same degree as the video feed from the physical
lens, even if both are rendering barrel - or pincushion - distortion.

Viewable Area

Viewable Area is the combination of two lens parameters: focal length
and entry pupil. If you notice any sliding between the CG and live video
elements, in Previzion, chances are there's an error in either an entry
pupil or focal length value.

NOTE: Please adjust entry pupil and focal length when looking at the
"Viewable Area" graph (CTRL + F). What you see below is an example
of a lens file, while viewing it's "viewable area." Notice that at Focal
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Length 10 there is a spike in entry pupil which is causing the drop in
viewable area.

Because viewable area isn't a parameter in the lens file, entry pupil
must be changed in order to fix the rendering problems that will arise if
this is left uncorrected.

How to Correct

Make all adjustments to data in the chart on the right by typing in
corrected values.

If you need to average multiple cells together, select all cells that will be
used to generate the average value, then select the cell that will receive
the average and Average the Selected Cells (SHIFT + A).

6. Save the file and reload in Previzion

Use the hotkey for saving (CTRL + S) to save this to a new file.
Reload the file into Previzion

7. Check the results

Check the results of your lens fixes in Previzion by walking
through the complete zoom range, and the complete focus
range at each zoom step.

8. Repeat Steps 4 - 7 as necessary
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Lens Grapher Interface

Lens Grapher Interface

The interface for the Lens Grapher is best understood as six distinct
segments.

1.Menus and Shelf Buttons
2.Working Filename
3.Lens Data Graph
4.Table of Values
5.Viewing Options
6.Status Report Bar

1. Menus and Shelf Buttons

Every Command that is used in the Lens Grapher can be found in the
one of the 4 menus:

File
Open (CTRL + O)
Close (CTRL + W)
Save files (CTRL + S)
Exit Program (CTRL + Q)

Edit
Bake Offsets (CTRL + B)
Undo (CTRL + Z)
Redo (CTRL + Y)
Average Cells (SHIFT + A)
Delete Point (DEL)

View
Toggle Viewable Area Graph (CTRL + F)
Toggle Graphing Over Rack Zoom or Rack Focus
(CTRL + G)
Toggle Graphed Lens Parameter (CTRL + H)
Toggle Non-Highlighted Graph Visibility (CTRL + R)
Toggle Graph to Force Drawing to Zero as Reference
Base (CTRL + 0)
Focus Step Increment Down (CTRL + LEFT ARROW)
Focus Step Increment Up ( CTRL + RIGHT ARROW)
Zoom Step Increment Down ( CTRL + UP ARROW)
Zoom Step Increment Up (CTRL + DOWN ARROW)

Help
About Lens Grapher
About Calibration File
About Lens Parameters

The shelf is detachable and movable to other docking locations in the
interface.

1.Open
2.Save
3.Undo
4.Redo
5.Close File
6.Bake Offsets

7.Average
8.Delete Points

2. Filename and path

This section gives the filename and full path so it's easily readable and
you always know which file you're working on. The "asterisk" becomes
present at the end of the filename when the file has changed.

3. Lens Data Graph

Navigating the Graph

The graph is interactive in that you can click and drag around
the graph to view different pieces of it.
Use the mouse wheel to zoom in and out of the graph
Scrolling down to a Chart Magnification Factor of 1 will always
reset the graph, in case you've lost your place
The farthest the Chart Magnification Factor will zoom in is to a
factor of 20

Each of the data points in the graph have data specific tooltip help that
pops up when the mouse hovers over the points.

Along the top of the graph, the title displays which dependent lens
parameter is being graphed over the currently user selected
independent parameter

Dependent Lens Parameters
Focal Length
Distortion
Entry Pupil

Independent Lens Parameters
Rack Zoom - Focal Length Step
Rack Focus - Focus Distance Step

Missing Data = Broken Lines

Any missing point(s) in the data file will render as a gap in the graph.
This is visual feedback to the user that data is missing from the lens file,
or has been deleted.

Modifying the View
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Forcing The Graph to Zero

In the options tab on the right, there is a checkbox to "Force Graph to
0". This ensures that all graphed data is drawn with relation to a zero
value.The hotkey for this is CTRL+0.

NOTE: This is an excellent tool to use when viewing the "Viewable
Area" graph!! Doing this will force showing all three graphs: viewable
area, entry pupil, and focal length.

Showing / Hiding Non-Hilighted Graphs

Sometimes the number of graphs being rendered can obfuscate data
interpretation. To this end, you can show, or hide, the currently
non-hilighted data. In the Options box on the right of the interface is a
slider for "Non-Highlighted Graph Opacity." The slider controls the
opacity of the graphs and allows for a smooth graduation of opacity
from opaque to completely transparent. There is an embedded hotkey
to toggling the opacity slider from off to partially opaque to fully opaque
and back around again. That hotkey is CTRL+R.

4. Table

Viewing Data

The table shows data for all present calibration points in the lens. Any
points that are missing or deleted are labeled as such.

Editing Data

Type new values in to the selected cell. Selected cells have a light
yellow background color. If you prefer you can overwrite data through
the Averaging procedure.

Averaging
The averaging function works on selected cells, where
the order of selection is important
You may select anywhere from 3 cells to as many cells
as are available in your data.
THE LAST SELECTED CELL RECEIVES THE
AVERAGE
So, if you select four cells: A1, A2, B4, D6

D6 = (A1 + A2 + B4) / 3.0
This implementation allows for selecting non-adjacent
cells when creating the final average output.

Hilighting Data

Use the CTRL and ARROW keys to navigate and highlight data in both
the graph and table

"Deleting" Points

The "Del" key will delete any selected cell(s) from the table. Any deleted
cell(s) will be removed from the graph. NOTE: "deleted" cells can be
reconstituted (either by undeletion or the assigning of a new value)

"Missing" Points

"Missing" points render as "deleted" points do in the graph. In the table
they show up as "missing" points. These points Cannot be
reconstituted in the Lens Grapher and must therefore be reassigned in
Previzion (via lens calibration interface) or by hand editing the text file.

5. Viewing Options

The options for the Lens Grapher are broken into three sections:

Z00m - Focus Controls
Lens Parameters
Options

Zoom - Focus Controls

Use the radio buttons to select which independent variable to view the
data by zoom or by focus. Below are images that illustrate the
difference

The sliders decide which graph and point are highlighted in both the
graph and the table.
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Lens Parameters

Choose which of the three dependent lens parameters to graph. Or…

Choose the viewable area graph.

Options

Change the alpha opacity of the non-highlighted graphs with the opacity
slider

Please note that when no columns or rows are highlighted then the
opacity for all graphs defaults to full on

Force Graph to 0

This option will vertically scale the graph (if needed) to include a zero

point in the rendering of the data. Any data set that already crosses
from negative to positive, or vice versa, will be unaffected with this
option is turned on. This does not edit the data in any way, only the
rendering of it.

6. Status Report Bar

Here you can find feedback and program error reports. As en example,
the undo and redo queues report, to this status bar, any modifications
they make.
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Working with Viewable Area Graph

 Viewable Area

Is the horizontal width that the Previzion camera sees at any unique
combination of zoom and focus. The viewable area value is defined by
the combined effects of entry pupil and focal length.

The Previzion Camera

In order to understand how this impacts Previzion rendering, study the
illustration below. It shows the difference in positions of the physical
camera and the virtual camera. The virtual camera is the position that
Previzion renders from. The virtual camera position is defined physical
camera position with the entry pupil offset added in.

Calculating Viewable Area

The illustration below gives a more mathematical approach to
understanding viewable area and shows how entry pupil and focal
length both are important factors in describing what the virtual camera
(aka previzion, aka your-post-renderable camera) sees during render
time.
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Glossary of Terms

Definition of terms used in Lens Grapher
and Previzion

Baking
The process of adding the row or column offsets into the
main data. This is necessary before closing a file
because Previzion does not recognize offsets and
saving a file in LensGrapher does not automatically bake
the offsets into the lens data

Column Offset
A value added to a complete focus distance set of data
When viewing "entry pupil," adding 12 to the column
offset for the nearest focus distance will add 12 units, to
"entry pupil" for all focal length steps in just that column

Distortion
the dependent lens parameter that defines how much
radial distortion the Previzion camera will render

"Deleted" Point
A lens point manually deleted by the user. A deleted
point can be undeleted by assigning a new value or
undo-ing the deletion. Once saved and the file is closed,
the point will be permanently deleted from the file; this
point will then load into Lens Grapher as a "missing"
point.

Dependent Variable
This is the collection of lens parameters that the lens
calibration process attempts to construct. These
dependent variables are so called because they are the
product of the zoom and focus of the lens. In other
words, these dependent variables are changed when the
zoom and or focus of the physical lens changes; the
opposite is not true. These dependent variables are:
distortion, focal length, entry pupil and viewable area

Focal Length
This is confusing because focal length can be
understood as both a dependent and independent
parameter
As an Independent Parameter: this marks the zoom of
the physical lens and is recorded by the focal length
fraction.
As a Dependent Parameter: this is the specific,
measured focal length of the lens. This value is used in
Previzion rendering and post rendering as the focal
length of the CG or virtual camera

Focal Length Step
The unique zoom steps defined when setting up a lens
calibration. Previzion samples the physical lens zooming
into the number of Focal Length Steps as defined in
Previzion.
More information can be found by clicking here. Look for
the first bullet point.

Focus
Relates to the focus on the physical lens. Previzion
tracks the focus by way of encoders and encodes the
focusing into discrete focus steps as defined by the
various focus distances

Focus Distance Step
The number of distances, that Previzion is from the
calibration board, as defined in the initial calibration
setup process. Find out more by clicking here.

Independent Variable
This relates to the two physical lens characteristics that
define the two controllers: zoom and focus. This creates
a 2D matrix of point data: zoom steps multiplied by

Lens Parameter
a characteristic of the lens recorded for each point in the
2D matrix of independent variables.

"Missing" Point
Any point defined as not present while opening a lens
calibration file. These points cannot be edited in the
Lens Grapher and can only be edited in Previzion or by
hand in the text file.

Offsets
any value typed into the row or column offset. These
values augment the graph to show what the parameters
would look like once baked into the source data. There
are unique offsets for entry pupil, distortion and focal
length.

Rack Focus
Changing focus controller on the lens from one end of
the focus to the other. As an example, changing the
focus from completely near to completely far.

Rack Zoom
Changing zoom controller on the lens from one end of
the zoom to the other. As an example, changing the
focus from completely wide/long to completely
tight/short.

Row Offsets
A value added to a complete focal length set of data.
When viewing "distortion," adding 0.32 to the row offset
for the tightest focal length step will add 0.32 units, to
"distortion" for all focus distances in just that row.

Viewable Area
This is the combined effect of the two dependent lens
parameters: entry pupil and focal length. In detail, this
value describes the horizontal area that the virtual lens
sees at the specific location of x focal length step and y
focus distance.
Knowing the horizontal area viewed means you can
more quickly see if there is, or will be, slipping in the
Previzion render when rack zooming.

Zoom
Relates to the zoom of the physical lens. Previzion
tracks the zoom by way of encoders and encodes the
zooming into discrete focus steps as defined by the
various focus distances. The standard amount of zoom
steps is 21.
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Exporting Backgrounds: General

Model Construction
Creating parameters for Previzion use
Modo – Export
SketchUp Pro 8 to Previzion
Transparent Video
Shooting video background plates
Encoding Mpeg2 Videos for Previzion
Encoding 4k H264 Videos for Previzion
Stitching Multiple 4k Video plates
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Model Construction

Overview

This is a set of guidelines to follow to create a scene for Previzion.

Standards

Standard polygon models, 12 Million Triangles for 30p and 4
Million Triangles for 60i.
Node count of 3000, includes objects, groups, and bones.
Normals facing the direction you want the texture displayed
Standard UV texture mapping; the view in Previzion should be
more or less identical to what you see in the OpenGL viewport
in Lightwave, Maya, or Modo with textures on.
Lighting baked into the textures.
Previzion can render a total pixel area of 3 Gigapixels, with a
single texture maximum of 1.1 Gigapixels.
Previzion can decode between 2 and 10 1920×1080 streams of
MPEG-2 video, depending on frame rate and machine
hardware, for more click here.
Previzion can also decode between 1 and 2 4K H.264 videos,
also depending on frame rate and machine hardware, for more
click here.
The still textures that will be replaced by the MPEG2 video
should have a video_ prefix, i.e. video_myTexture1 and 
video_myTexture2 or similar. Previzion's FBX loader recognizes
these textures, and creates a link that lets us drive the texture
with the MPEG2 decoded frames. The original texture should be
the same 1920×1080 aspect ratio that the MPEG2 files will be
encoded at; we usually just use the first frame of the video file
as the placeholder texture.
Textures can be JPEG, PNG, or Targa.
If you want transparency in a still texture, use a PNG or Targa
RGBA file and put the transparency information in the Alpha
channel. Apply this texture to both the Color and Transparency
channels. This works great for ferns, tree leaves, etc. Or use
transparency enabled CgFx shaders, refer to our list of Color
Correction Shaders.
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Creating parameters for Previzion use

Overview

There are a few scene utilities within Previzion that help to make on-set
production easier and more efficient. These few utilities work as a
predetermined parameters that are loaded into Previzion as editable
transforms and camera locations.

Camera Locations

When creating scenes in Maya you are able to create cameras to be
used within Previzion. By creating cameras it will make the operator's
job easier to jump to predetermined camera locations within a scene.
To create cameras for Previzion is simple, just create a new camera
and name it with camera_name. Previzion will only load in cameras
that are created by the 3D team, and not the default Maya cameras.

To select these cameras while in Previzion, go to the Tracking tab and
use the sub-menu Camera Locations.

 

Editable Transforms

While shooting in Previzion you are able to move objects around in the
scene by choosing certain edit_ parameters in the Scene tab and
changing their locations. When creating your scenes you can choose
objects, groups, and sub-groups. You are able to make any object or
group into editable transforms, including having nodes within groups all
as editable objects.

Example edit_ structure:
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Modo - Export

There are a couple different ways to go from Modo into Previzion. Each
method has it's benefits and limitations.

Collada > Previzion

Using COLLADA 1.4.1 will produce a .dae file in your chosen directory.
Using this method you will give you freedom to modify textures after
export, because the textures are not written into the .dae file. To get this
file to work in Previzion it must be located in the same directory as the
images you are using.

FBX > Previzion

In modo 701 you are able to export an Autodesk FBX 2010 format. Use
this option and all textures will be embedded into the .fbx file. This will
only carry through textures, and excludes any complex materials with
alphas, reflections, etc.

FBX > Maya > Previzion

In modo 701 you can export the Autodesk FBX 2010 or in 601 you can
output Autodesk FBX 2006.11. Import this into Maya and apply cgfx
shaders for complex materials and export as you would an FBX from
Maya.
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SketchUp Pro 8 to Previzion

Overview

For those who wish to quickly and efficiently create scenes for
previsualization filming, SketchUp Pro 8 can now be integrated into your
Previzion pipeline. This section will go over the steps needed to pass
scenes from SketchUp to Previzion.

SketchUp Pro 8

SketchUp can be used as a great tool for scene creation for production
with previs and shot blocking. To use SketchUp without much 3D
experience is rather simple.

Navigate

Middle Mouse Button - Orbit
MMB + Shift - Pan
MMB Scroll - Zoom

Object Manipulation

Space - Select tool
M - Move tool
Q - Rotate tool
S - Scale tool

Virtual Set Creation

Downloading assets from Google 3D Warehouse is a great way to get
pre-textured real buildings fast and free.

File > 3D Warehouse > Get Models…

Here you can download models to import into your scene. Since most
models are created third party, you will want to verify their scale is
correct. To do this you can either eyeball with the female cutout "Susan"
in SketchUp or use the measuring tool indicated in the toolbar as a tape

measure.

Exporting Scenes

Scenes are still handled in Previzion as FBX format. For exporting with
SketchUp you'll want to turn on Export Texture maps, Swap YZ
coordinates, and convert Units to Centimeters.

Previzion

Before bringing the new scene into Previzion, the fbx file must be
moved within the same directory as the output textures. The texture
maps folder will have the same name as you gave the fbx, drop the fbx
within that folder.

Next open Previzion as ensure that your scene loads and looks as you
expect it should.

Screen capture of scene in SketchUp Pro 8

 

Screen capture of scene when imported into Previzion,

with Add Light feature on

Known Issues

Translucent materials will only come through with Add
Light feature turned on in the Scene tab.
When film plane is behind translucent material, all objects
between translucent material and film plane are translucent as
well.
Alpha materials do not work correctly.
No known support for reflections.
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Transparent Video

Transparent Video

Overview

MPEG2 does not support transparent video by default, but we can
create the same effect by decoding 2 MPEG2 video streams, and
assigning them to different channels of a custom CgFx shader.

This shader supports graduated, or smooth, alpha channels. This will
allow for long slow alpha gradients. This is an example of a supported
alpha mask:

Assigning Shaders in Maya

Go to Window->Settings/Preferences->Plug-In Manager.
Enable Loaded and Auto Load for cgfxShader.mll, and close the
Plug-In Manager.
Click Create->Polygon Primitives->Plane.
Click Create UVs->Automatic Mapping to apply a UV set to the
plane.
Select Shading->Smooth Shade All and Shading->Hardware
Texturing.
Enable the Hypershade/Perspective view.
Click the Cgfx Shader shiny ball icon to create a new CgFx
material. It will be pink by default.
Middle-click and drag the pink ball over the recently created
plane to apply it to the plane. The plane will turn pink.

Select the cgfxShader1 tab. Your screen should look like the
above image.
Login to Dashboard  to download the TextureWithAlpha.cgfx
file.
Click on the folder to the right of the CgFx File area. Navigate to
the location on your hard drive where you saved the
TextureWithAlpha.cgfx file, and select the file.

Applying Textures

Click the checkerboard box next to the ColorSampler line, select
File, and click the folder to the right of Image Name to pick the
image with the desired RGB colors. Any alpha data will be
ignored.
The image must be named with the "video\_" prefix to be
recognized as a video target by Previzion.
Click on the polygon to show the cgfxShader1 tab again, and
click the checkerboard box next to the AlphaSampler.
Select File as before, and select the image that will be used to
drive transparency. As before, this needs to be named with the
"video\_" prefix.
The only part of the transparency image that will be used is the 
R channel. Since matte images are by nature greyscale, the red,
green, and blue channels are all identical, so the choice is
arbitrary.

The resulting image should appear as above. A red sphere has been
placed behind the polygon plane to demonstrate the correct
transparency display in the viewport.

In order for the CgFx shaders to be embedded in the FBX file, the
Embed Media box must be checked in the FBX export.

The above image shows how this appears when loaded into Previzion,
with a red sphere behind the plane to demonstrate transparency. The
correct MPEG2 RGB and grey scale matte videos can then be loaded
and linked to the appropriate video targets.

Images used as examples:

(/images/manual/video_desertCliff1920.jpg)

(/images/manual/video_CGFX_TextureWithAlpha.jpg)
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Shooting video background plates

There are a few basic guidelines to follow when creating background
plates for use in Previzion.

Use a similar perspective

A big thing to keep in mind when using Previzion to play background
videos is that Previzion is creating an illusion of depth using a
flat image.  This means if the camera goes to far to any side of the
video plane the background will start to look 2 dimensional. For that
reason it is important to create plates that are from a similar perspective
in terms of camera height, and perspective to what you plan to use on
shoot days.

The biggest thing to keep in mind where and when your scene is
supposed to take place.  What I mean by that is that if your scene is
supposed to take place on the 20th story of a building don't shoot
background video at a location that looks like it is only on the second
story with the tops of trees in it.  A very easy mistake to make is to have
the background look too close to the set. This is a common problem,
and one that is harder for the background shooter to detect when they
are shooting.  For example if we wanted to have a cafe with a street
outside of it about 2.5 meters away one might think all they need to do
is take a camera out to any sidewalk along a street and just shoot cars
passing by.  However the problem with that is if the camera shoots the
plate from the sidewalk it wont be able to see the sidewalk it is sitting on
and will look too close to the cars.  So when you take that clip into the
cafe scene it will make it look like there is no sidewalk and that cars are
driving just outside the cafe door less than 1/2 a meter away.

Be cautious of lens flares, because they most likely will not look right in
the back ground plate, since they will not move, and will be behind the
physical set, which is not how real lens flares work.

Keep the camera level. Even if the more interesting stuff is lower or
higher in frame it is important to keep the camera level or very close to
level. If plates are shot with a camera that was tilted off level the
background will not look correct in the final composite and will require
the Previzion operator to raise or lower it in frame leading to seeing off
the edge of the background.

Shooting Multi camera video plates.

In order to get the best results with multi camera video plates it is best
to do some prep work with your cameras before going out to shoot the
plates.

The most important thing is to keep everything the same between all of
your cameras.  That means try to use the same model camera with the
same model lens, at the same focal length and same aperture on both
cameras. Beyond that however it is important to make sure that all of
the cameras have the same settings on them including ISO/gain, white
balance, knee and detail or sharpening. It is also better to keep
Automatic features turned off so all cameras are doing the same
thing regardless of what they are looking at and aren't thinking for you.

In the field the cameras should all be placed at the same height and as
close as possible to one another with a 20% overlap in the video.  Make
sure that both cameras are tilted to the same angle and are level, so
that their horizon lines match when they are put into Previzion.    It is a
good idea to look for things that the video seem can be hid in like trees
or light poles.

If your setup has fast moving objects or people who will be moving from
video plane to video plane it is a good idea to genlock the cameras so
the action can sync up perfectly in Previzion.

Timecode is great for keeping cameras in sync, but as a backup I like to
have something visual in the shot of all of the cameras which I can use
to sync them later.  Something like a camera flash, or a movie slate or
just a person clapping once makes for a quick and easy reference as to
weather the clips are in sync in post when they are assembling the
footage.  If you are using more than 2 cameras you may have
to temporarily pan the cameras over to see the action.

This back ground was shot from the sidewalk.

 

This background was shot 3 meters behind the sidewalk

These images are mockups for demonstration purposes created in Photoshop using creative commons images from Flickr, not from Previzion using a green.
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Encoding Mpeg2 Videos for Previzion

MPEG2 Decoding

Previzion has the ability to decode multiple MPEG2 videos at the same
time for use as textures on elements inside scenes.  However due to
some quirks in MPEG2's history  as a broadcast format not a file format
Previzion can have a hard time accurately determining the length of
MPEG2 clips if they don't have audio tracks embedded in them. This is
very important for scenes with multiple clips that must loop and play
back in sync. "Blu-Ray" encoding settings encode separate audio and
video files which do not work well for Previzion to accurately time.

The easiest solution is to encode MPEG2 files with audio
tracks embedded in them.  The audio track can be completely silent, but
they must be there for Previzion to accurately display clip length.

Recommended Settings

For most applications, the number of MPEG2 streams that Previzion
can decode simultaneously will depend on the frame rate, bitrate and
type of bitrate.  Sometimes the complexity of a CG scene's shaders also
affect the number of video streams.  For example, at 24 fps ( or 23.976
fps), without using too many shaders/textures, Previzion can decode up
to 8 HD video plates.  At higher frame rates, that number is lower.

A rough ballpark number of MPEG2 streams per frame rates can be
seen as:

 

Frame Rate (in fps) Max Number of Simultaneous
HD Streams

23.98 (24) 6 to 10

25 6 to 10

29.97 4 to 5

60i 2 to 3

 

Adobe After Effects

In Adobe After Effect CS5 or later, on top of checking  the "Audio
Output" option, there is a "Multiplexing" option in the audio settings
under MPEG2 Options that allows to embed audio to the video file
directly from After Effects without the need for going through Adobe
Media Encoder.  From your Render Queue, select the output format to:

Format: MPEG2
Activate Video Output with:

Channels: RGB
Depth: Millions of Colors
Color: Premultiplied (Matted)

Activate Audio Output and select Format Options…:
Under tab "Multiplexer," select Mutiplexing: MPEG2
with Bitrate type: Constant.
Under tab "Audio," select Audio Format MPEG
and Audio Layer MPEG-1, Layer II Audio.
Actual sample rate, stereo/mono and bit depth do not
matter for the purposes of Previzion.

Please note that the MPEG2 video that comes out of After Effects may
not be playable in Quicktime, but it is playable in WMP, VLC and other
media players.

NOTE: The transcoding options below require that
the source video file already has audio in it. Either
re-export the file with audio enabled or open the file
in your NLE (Final Cut Pro, Avid, Premier Pro, etc.)
and export it with audio enabled.

Apple Compressor

In Apple Compressor "MPEG-2 Program Stream" preset works
out-of-the-box.  Make sure that the original source file already has
audio before reaching Compressor.  Either re-export the file with audio
enabled from the source or open the file in Final Cut Pro (or equivalent
NLE) and export it with audio.

Sorenson Squeeze

In Sorenson Squeeze we recommend using "HD 1080p".
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Adobe Media Encoder

In Adobe's Media Encoder "MPEG2" is the only one that has embedded
audio with the video track.

Decoding Progressive MPEG2

Previzion decodes progressive MPEG2 video as one would expect — it
decodes one frame of MPEG2 video for each incoming frame of live
action video.

Decoding Interlaced MPEG2

When Previzion's video format is set to 1080/59.94i interlaced video,
the system tracks the camera and lens motion and renders the
background at 59.94 times/second.

To match this motion, Previzion decodes MPEG2 files as normal, and
then uses either the odd or the even lines of the MPEG2 image and line
doubles them to create the background texture for that field. Thus, to
match the look of interlaced camera motion, the MPEG2 files should
also be of an interlaced source format.

 Using MPEG2 with Alphas

Previzion has the ability to decode multiple streams of  videos and, by
using our custome CgFx shadder, you can assign an alpha video to
match another MPEG2 video stream.  For more information about
MPEG2 and Alpha channel visit our Transparent Video section.

Page 258

http://www.lightcrafttech.com/wp-content/uploads/2012/02/squeeze-grab.png
http://www.lightcrafttech.com/wp-content/uploads/2012/02/media-converter-grab.png
http://www.lightcrafttech.com/support/doc/creating-backgrounds/transparent-video/
http://www.lightcrafttech.com/support/doc/creating-backgrounds/transparent-video/


Previzion - User Manual
by Lightcraft Technology

Encoding 4k H264 Videos for Previzion

Encoding 4k H.264 Videos

Previzion is capable of playing back 4k H.264 videos, however these
are quite demanding on the system and will severely restrict the
complexity of the rest of the scene.  Currently we have
been successful in playing back two 4k videos encoded at 35mbit at
23.98PsF, and 25Psf.  29.97Psf and 60i can only play back a single 4k
video without frame drops.

HandBreak Workflow

Our current encoding workflow is not optimized but outputs 4K video
files which go into Previzion.

Using RedCineX output a 4k ProRes video file of the clip or
select of the clip
Convert to h.264 using HandBrake
Set Video Codec to "H.264 (x264) and "Video Quality" to
"Constant Quality" with "RF:" around 18.25 to get a 35Mbit
video.

Adobe AfterEffects Workflow

You may also output 4K videos directly from Adobe AfterEffects as
H.264.

For your Composition Settings, your comp dimensions should
be:

Width: 4096px
Height: 2160px
Square Pixels

When your are ready to render, set Output Module Settings to:
Format: H.264

Click on "Format Options…" and set your H.264 Options'
Bitrate Settings to:

Bitrate Encoding: CBR (Continuous Bit Rate)
Bitrate [Mbps]: 35 (or lower)

All other default settings should be left unchanged:
Multiplexing: MP4
Stream Compatibility: Standard
Video Settings Profile: High and Level 5.1
Key Frame Distance: disabled

H264 4K Playback Application and
Limitations

When using video backgrounds, it becomes incredibly useful to have
high resolution background videos.  Where stitched video plates and
HD video plates start pixelating or showing resolution limits, 4k
background plates shine.  Previzion can decode up to two simultaneous
4k video depending on their encoding settings.

As impressive as it is to decode multiple 4k video streams, there are
major limiting factors to this feature.  The primary ones are heat, bit rate
and bit rate type (CBR over VBR).

Heat can become a problem when using multiple video streams in a
poorly ventilated environment.  If running Previzion System in a hot,
poorly ventilated room, 4k videos can cause a thermal overload and
trigger an internal beep that signals this overload.  At the point that this
beep is triggered, with our motherboards, no harm comes to your
hardware.  Only if the beep is ignore do temperatures climb to harmful
ranges.

Bit rate is important because it determines the rate in which each "real"
frame is encoded to.  The recommended bit rate is about 32 MBps to 35
MBps.  Lower bit rates buy you more CPU cycles.

Bit rate type is directly related to the above described because it
determines how often and to what extent video decoding oscillates in
CPU cycles demand.  The recommended setting is to use Constant Bit
Rate, or CBR, because it will cap the amount of information a give
frame has.  This setting prevents Previzion from having spikes in its
CPU demand, which can cause errors and dropped frames.
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The number of 4k stream Previzion currently supports can be seen as
follows:

 

Frame Rate (in fps) Max Number of Simultaneous
4K Streams

23.98 (24) 2 to 4

25 2 to 4

29.97 1 to 3

60i 1 to 2

 

Previzion has different hardware configurations depending on the
generation of Previzion system.  The higher estimates in the previous
table portray the newest Previzion configuration.

Because of the nature of H264, 4k sizes is not officially supported.  It's
important to know that, if using more than one 4k H264 video stream,
the video streams may not stay in sync overtime.  With that in mind, we
don't recommend using a 4K H264 video stream with a corresponding
4k H264 alpha video stream as it will end up getting out of sync.

Finally, we strongly recommend against mixing H264 and MPEG2 video
streams as they both take up CPU cycles, but different resources that
end up taking over your Previzion system's resources.

Compatibility Notes:

Currently QuickTime based transcoders and players are unable
to create or play 4k h.264 files.  This includes QuicktTme 7,
QuickTime X, Compressor, and Final Cut 7.  For quality control
playback we have been successful with using VLC for playback.
Frequently the limiting factor in playing back these 4k files will
be hard disk speed.  I have only been able to play them back
smoothly off of SSD drives not spinning drives.
 Another possible alternative for a system without a SSD would
be to use a RAMdisk utility to turn a block of ram
into temporary fast storage for playback.
In some system configurations, leaving two or more 4K videos
playing for too long may cause thermal error. This is usually
indicated by an error beeping.
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Stitching Multiple 4k Video plates

Introduction

This is an example of a workflow for stitching multiple 4k video files
together for playback in Previzion as video backgrounds. Different
software and cameras can be substituted.

Notes: Multiple 4k h.264 videos will not play back perfectly in sync, and
may have slightly different start and stop times.

Software used in tutorial:

PTGUI Pro
Quicktime Pro
Adobe After Effects
After Effects Plug-in: "SplitImage"

We shot our background with a single camera mounted nodally and
panned to 3 positions However, multiple cameras shooting
simultaneously could also be used. There are advantages and
disadvantages to both, and you will need to weigh them for yourself.

Single Camera

Pros

Lower Cost.
Lower equipment footprint on location.
Able to shoot without parallax (nodally).
Camera color should match between shots.
No settings to match between cameras.

Cons

Things will not be able to cross seamlessly from one
background to the next.
Takes longer to shoot once set up.
Lighting may not match between cameras if the plates are long
enough.

Multi Camera

Pros

Reduced shooting time.
Things can cross from one camera's frame to the next if they are
far enough away.

Cons

Can be expensive.
Parallax will not be perfect.
Requires multiple cameras to have same lens and same
settings.
Requires genlocked cameras for best temporal accuracy.

Capture background

If using multiple cameras to capture the background be sure you are far
away from any elements which can disappear when they cross from
camera to camera. Also have a look at our guide on capturing
background plates and at PTGUI's video on shooting panoramas.

Make image sequence

Cut off the beginning or end of clips to make them the same length, if
you are working with multiple cameras now is the time to make sure
your clips are in sync before exporting the image sequences. When you
export image sequences from each clip make sure to add "leading
zeros" or "padding" so they will sort properly.

Sort images

Make sure that your images for each frame are grouped next to one
another when sorted alphabetically.

You want them to look like this:

001Center
001Left
001Right
002Center
002Lef
002Right

Stitch panorama in PTGUI

Stitch the first set of images, and then save a PTGUI project file.
 PTGUI has a demonstration video which covers the basic stitching
operation of their software.

Set up batch stitch in PTGUI
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Open "Batch Builder" from PTGUI's "Tools" menu. Under "Use
Template" select your project file.

Now click "Generate new projects…" Your method will be "Multiple
panoramas per folder with a fixed number of images." Select your folder
with all of the images, and tell PTGUI how many images to look for in
each panorama. In our case we use 3 images.

Click "Generate Projects," and then click "OK". The batch stitcher
should open and start stitching images. The batch stitcher should also
generate a .pts panorama project file for each group of images. You will
need some of these .pts files later.

Import batch stitched images into After
Effects

First copy all of your newly created "Panorama.jpg" files to their own
folder.

Import all of your Panorama.jpg files as a JPEG sequence in After
Effects.

In After Effects create a new composition with the following settings:

Width:4096 multiplied by the number of videos you want to
output (ex. 3 videos = 12,288)
Height:2160
Frame Rte:23.976

Setting 23.976 as the frame rate is important. Even if your footage was
shot at a different frame rate, or you plan on outputting at a different
frame rate you must enter 23.976 in order for Adobe's h.264 encoder to
be able to output 4k h.264 files. Since Previzion always plays back
video files at the same frame rate as Previzion is set to, the composition
frame rate doesn't really matter. For more information read up on H.264
Levels

Splitting your panoramas in After Effects

The After Effects plugin called "SplitImage" makes splitting your large
panorama image sequences into even 4k sequences. Once SplitImage
is installed, select your composition with the panorama, then go to "File
> Scripts > Splitimage" enter the number of columns you want to split
your composition into and hit "Execute."
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Play back finding corrupt images. Find and
re-render in PTGUI

This next step is very time consuming, but necessary. For an unknown
reason PTGUI outputs an occasional corrupted image. These corrupted
images will frequently stop your render, as well as be very noticeable in
playback.

Start by rendering one of your newly split panoramas, and where it
stops there is likely a corrupt image. I recommend rendering in ProRes
format for this part so you can open the video file and see the frame
that stopped the render.

ProRes also seems to render faster than H.264. You can open the
automatically generated PTGUI .pts panorama file associated with the
corrupted and re-output the Panorama.jpg file, then replace the
corrupted .jpg in the panorama sequence folder. Now try rendering
again until it stops. Repeat these steps until you can get a full render for
one of the splits of the panorama segments.

It is a good idea to watch through this sequence before rendering the
other two, because occasionally a corrupted image will not stop the
render, and any missing frames from the image sequence will also
interrupt the video as well. Once you have a single section of the
panorama sequence playing back properly move on to exporting all of
the sections as h.264 files.

 

Trouble Shooting

Q: My render keeps stopping in the middle.

A: You most likely have a corrupt panorama JPEG in your image
sequence.

 

Q: My h.264 render fails.

A: As of writing this, Adobe After Efects only supports a maximum h.264
profile of 5.1. This means that h.264 with a resolution of 4096×2160 has
a maximum framerate of 28.5fps. Either create a new comp with a lower
frame rate, or output ProRes, and compress in HandBrake.
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Exporting Backgrounds: Maya

FBX Export
Previzion Export Checker
Light/Texture Baking
Tri-Video Plane
Clean Geometry – Normals
Clean Geometry – Faces
Clean Geometry – Vertices
Clean Geometry – UVs
Clean Geometry – Edges
Clean Geometry – Construction History
Clean Scene – Optimizing Scene Size
Clean Scene – Node Naming
Clean Scene – Clean Shader Paths
Clean Scene – Clean Texture Paths
Clean Scene – Deleting Un-Used Nodes
Clean Scene – edit_ Transforms
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FBX Export

Exporting to FBX

Maya 2011/2012

Use these settings when exporting FBX files for Previzion.

Reset Presets to Autodesk Media & Entertainment.
Uncheck Animation.
Include Cameras.
Uncheck Lights, unless using lights connected to CGfx Shaders
or for rudimentary lighting on Lambert.
Enable Embed Media.
Advanced Options > FBX File Format.

Type: Binary (ASCII format can be used if all textures
located in same directory as FBX file).
Version: FBX 2010.

Maya 2014

Reset Presets to Autodesk Media & Entertainment.
Uncheck Animation.
Include Cameras.
Uncheck Lights, unless using lights connected to CGfx Shaders
or for rudimentary lighting on Lambert.
Enable Embed Media.
Advanced Options > FBX File Format.

Type: Binary (ASCII format can be used if all textures
located in same directory as FBX file).
Version: FBX 2014.

3DS Max

Reset Presets to Autodesk Media & Entertainment.
Uncheck Animation.
Include Cameras.
Uncheck Lights.
Enable Embed Media.
Advanced Options

In Units, turn off Automatic and convert to Centimeters.
Ensure that Up Axis is set to Y-up.
FBX File Format.

Type: Binary
Version: FBX 2010.

Note: Using 3DS Max will only carry through diffuse textures. Shaders
and complex texturing do not come through to Previzion.

Problems loading into Previzion

When you find a scene is not loading properly, you can use the scene
log to check the version of fbx. Go to the Scene tab and use the Show
Log. Check the FBX file version for version 6.1.0, this means the file
was correctly exported with FBX Binary 2010 format. If the file version
reads anything else certain parts of the scene may not function
properly.
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Previzion Export Checker

Previzion Export Checker

The Previzion Export Checker is a tool that helps you check for
common scene export problems. This enables you to be aware of the
most common mistakes, before exporting into Previzion.

The Main Interface

 

Win x64 / Win x32 Version Selector

Thanks to some of the upgrades to Windows 64 bit operating systems,
Previzion is able to handle a great deal more in terms of scene size.
This tool allows you to work with exports meant for the 64 bit OS or the
32 bit OS. You will notice a great difference in the amount of textures
and triangles 64 bit is able to handle as opposed to 32 bit.

 

Delete All Scene History

Cleaning up scene history is very important to do before exporting to
Previzion. Exporting a scene without cleaning it of the hidden nodes will
export an FBX file with unnecessary nodes. Uncleared scenes may
cause the following problems:

Slower load time into Previzion
May cause textures to not be loaded
Slows Previzion rendering times
May corrupt export files

This section has two buttons:

Delete ALL scene history
This removes all intermediate nodes used in the
construction of objects. The function will delete any
skinning or animation deformers in your scene as well as
intermediate polygonal modeling nodes.

Delete ALL Non-Deformer Scene History
This function works as the previous button except that it
preserves skinning and animation deformers.

 

 Total Texture Area Usage

Texture usage is calculated in pixel area. The image below describes
the how space is measured.

In addition to providing numeric feedback for texture usage, The Export
Checker also provides color feedback to help artists identify if they're
about to run out of texture space.

Texture Size Details

The Previzion Export Checker includes the Detailed Listing of Texture
Sizes window. Individual texture sizes are important to know because
any texture that is over the 4K resolution in width &/or height may
produce an error while rendering in Previzion.

Press the "Texture Usage" Button in the main Export Checker
interface
This window shows texture dimensions, AND when a texture is
too large, will give you the option of editing the image.
Item 1 shows the scroll bar on the right. Make sure to view the
entire scrolling section!!
Item 2 gives detailed texture data
Item 3 in the above illustration shows the "Resize" button. When
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pressed, this will open the texture in your specified image editor
of choice.
Item 4opens the Maya preferences and gives you the chance to
change your image editor of choice

Checks for textures that are larger than 4096 in width
and/or height
Checks for "video_" textures that are NOT 1920 x 1080

 

Scene Units

 

When exporting from Maya to FBX, the scene units should be in "cm".
Failure to adhere to this creates scaling errors in Previzion (which can
be seen in geometry and texture projections). When activating the
Previzion Export Checker, the interface automatically detects your
scene units, reports the current setting, and gives you the option of
switching to "cm".

Notice that once the scene units are switched to cm that this button is
now greyed out. When this button is greyed out the scene units are
already set to cm.

Number of Transforms

After Cleaning Transformations and Deleting Scene History the Number
of Transforms should drop considerably if the scene hadn't regularly
been cleaned. It is good practice to often clean the scene and delete
history, it is just as important as saving often. When the scene starts to
get cluttered with unclean history, Maya can start running slower and
sometimes crash.  Currently, Previzion can handle up to 3000
Transforms in a scene without dropping frames.

 

Number of Triangles

This section is based on your selection of Win x64 or Win x32. When
you are in x32 the max number of triangles is 200,000 while in x64 it is
12,000,000. As you reach the maximum the boxes will turn from green
to an orange and then red once the maximum has been exceeded.

 

 

Number of Videos Textures Named with "video\_"
prefix?

This section simply counts the number of textures whose name begins
with video_ and reports the amount. If none of these textures are found,
then the text box turns red indicating there are "No" video textures.

For rules on adding video textures to your Previzion scene, refer
to Video Playback Interface section

 

Number of edit\_ objects in the scene

This gives you a count of the number of objects in your scene that will
be movable inside of previzion. The button in the right column will select
all objects in the scene that are edit_ objects. The purpose of posting
this number is to give the artist a last change to corroborate the given
results with her expectations. If she knows there must be 3 movable
objects in the scene but the Export Checker is showing only 2, then she
can quickly correct the problem before performing an export. For
information on how to set up movable objects in Previzion, reference
Editable Transforms section.

 

Download Latest Version

For latest version of Previzion Export checker login to Dashboard

Last Updated: February 21, 2012 @ 6:04p PST

Update Notes

February 21, 2012
New interface
Win x64 and Win x32 version selection, based on
limitations of the two current Previzion OS'
Includes count of number of transforms and number of
triangles
Separated CGFX swap utility into independent script
Button to recalculate scene without closing and
reopening script

July 7th, 2011
Fixed bug in detailed texture lister that wouldn't open
textures needing to be resized
Includes additional check for "video_" textures that aren't
1920 x 1080 and adds resize button for editing in
external image editor

July 5th, 2011
Added Detailed Texture Lister
Detailed Texture Lister includes button to open oversize
textures in image editor and resize

Feb 15th, 2011
Removed extraneous line of code that caused runtime
error

Feb 1st, 2011
Added function to delete "All Non-deformer Scene
History"
Added color feedback for texture usage

this now sets background color of texture usage
boxes on a scale from green (more space left) to
red (less space left)

Updated CGFX Swap utility
removed Lambert1 from selection list in window
creates empty itemFilters for outliner sections
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with now shaders assigned
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Light/Texture Baking

Overview

This section will show how to properly set up a baking set with Mental
Ray, and V-Ray as well as the global settings that apply to both.

Global Settings

Shadows

Using Raytrace shadows will produce the best shadows for baking. In
the lightShape1 properties, drop down the shadow box and turn on Use
Ray Trace Shadows. In this box you will also see Light Angle, Shadow
Rays, and Ray Depth Limit.

Light Angle controls the sharpness of the shadow. Shadow Rays control
the edge quality of the shadow, less rays mean a grainier edge. And
Ray Depth Limit controls the amount of times a ray can be reflected
before losing ability to cast shadow.

V-Ray Setup

Under Window > Settings/Preferences > Plug-in Manager, ensure that
the vrayformaya.mll plug-in is loaded.

Next enable the Rendering menu set, drop down menu under File.

While editing the lights to achieve the desired look you can actively see
your lighting update using the IPR setting in the Render View. (Note:
The max resolution for IPR is 600×450 so anything larger will not
render.) Another thing to note, is the baked texture will not look as it
does in the IPR. IPR should be used only to set up light direction, it
uses dimmed settings so the actual light will look blown out once the
baking is done. Use the true render from V-Ray to tweak lighting
settings.

Now open the render settings under Window > Rendering Editors >
Render Settings or the icon in the toolbar, and use these settings as a

base. 

Next select the objects you wish to add to the V-Ray baking. Go
to Lighting/Shading > Assign single V-Ray bake options to selection,
and change settings to match this as a base.

The image dimensions are not maxed at 2048px, they can be whatever
you wish, just type in what dimensions you would like. To add more
objects to this V-Ray bake set, simply select the objects and go to
Lighting/Shading > Assign existing V-Ray bake options to selection and
select which options you would like.

To avoid black edge bleeding, you will want to raise the Edge padding
slider in the bake options window. The amount depends on the physical
size of the objects. Bleeding will occur anywhere that UVs seams are
broken.

Now to bake go to Lighting/Shading > Bake with V-Ray… and open the
options box at the right side of the menu. Enter your output file location
and choose Bake or Bake and close. (Note: Baking will not work if you
currently have Render View open)
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Mental Ray Setup

Under Window > Settings/Preferences > Plug-in Manager make sure
the mayatomr.mll is loaded.

Change the menu set to Rendering, drop down menu under File.

Now open the Mental Ray Baking Options, Lighting/Shading > Batch
Bake (mental ray), choose the option box to the right, and use these
settings as a base.

After setting all options click Convert and Close or Convert. The files will
bake to the project folder, and Maya will also give you the location of
the last texture baked on the command window at the bottom right of
the window.
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Tri-Video Plane

Tri-Video Plane Shader

The Tri-Video Plane Shader is a shader written to make a plane into a
video destination for 3 videos.

This allows for on-the-fly multi-camera video plates placement and
adjustments.  This will not cover techniques for video plate shooting and
assumes that the video plate if functional.

While very powerful and dynamic, this shader does minor tweaks,
saving time re-exporting and so on.

This shader also allows for color adjustments, vertical and horizontal
offsets, rotational offsets and many more. See Features below for
complete list of attributes.

If you are familiar with shader editing, the number of video destinations
can be adjusted to meet the application.

 

This tutorial will not cover methods and "best practices" for shooting
video plates, but, instead, focuses on the usages of this video shader.
For advise and pointers shooting multiple videos with the intention of
being "stitched" together, please contact support (at)
lightcrafttech.com.

Downloading the Latest Sample Scene

This shader is applied in a sample scene for ease of use and editing.
 The FBX sample scene can be opened directly into Previzion or in
Maya for customizing parameters.

To get started, log in Dashboard.  Under "Download Center" download
the latest version of the shader embedded in "Tri-Plane Video Sample
Scene."

This is an FBX scene and contains the shader applied to a plane.

Notes and Precautions

There are a few things to keep in mind as far as the technical
parameters of this shader goes.

Do not "Freeze Transformations" of object in Maya.
The bending, via the "Wall Curvature" attribute, happens inside
the vertex shader.  Freezing transformations resets the object

transformations.
To visualize in Maya "persp" window, press '6' to view in
Hardware Texture mode.
The "Wall Curvature" parameter slider in Maya will "offset" the
video plane and not necessarily curve the wall.

This is a known issue and is isolated to Maya.  Wall Curvature
works in Previzion.

Changing Placeholder Images (tex Sampler)

To align 3 videos shot together, forming the video plate "wall", it is
handy take screen grabs of each of the 3 videos at the exact same
timecode address (or relative location) to use to align the videos.

Once the frames are extracted from each of the 3 videos, renamed
them with memorable descriptions, like "right", "center" and "left", but
also, make sure to add the prefix "video_" to the actual image file name.
 For instance, if "image_right.jpg" would need to be
"video_image_right.jpg" to be identified in Previzion as a video
destination.

To do this in Maya, once the scene is loaded, expand your "Attribute
Editor" in Maya.  This is usually collapsed as a tab on the right-hand
corner of the screen.

Each of the default placeholder images will be stored in the parameters
"tex1Sampler", "tex2Sampler" and "tex3Sampler."  Click on the
selection button to the right of that parameter line.

This will open the texture parameters.
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To pick another image, select the little folder icon to open your file
browser.  Pick your image and make sure that it correspond to the
correct video panel (i.e. video_image_center.jpg is assigned to the
center panel).

Once this is done, ensure that "embed media" is checked in your FBX
export settings.

Tri-Video Shader Features

Per Video Color corrections
Contrast
Middle Grey
Brightness
Desaturation
3-Channel Color Additive
3-Channel Color Multiplier

Whole Shader Color Corrections
Same controls as listed above

Per Texture rotation and positional placement
Each texture rotates from it's own center
Independent vertical and horizontal placement
Left and Right texture vertical positioning parented to
Center Texture vertical position

Center texture Border Feathering
Semi-Independent Left and Right border Feather:

uses Global Master Feather
Left and Right side independent feather
adjustments

Layered Compositing of Shader Breakdown

The Tri-Video Plane Shader composites the videos together into one
single plane. This compositing takes place within the shader video
assignment, prioritizing the center image as top-most element.

This illustration shows how the layering is calculated for the three
textures. The Center texture is the top layer, being rendered over the
left and right textures. All the blending functions are performed on the
center texture which is then applied to the textures beneath to create
the final image.

 

Tri-Video Plane Attributes

At first glance the attribute listing for this shader can look very daunting.
This illustration shows that attributes are divided into 7 sections:

Initial Settings
Left Texture Placement and Color Correction
Center Texture Placement and Color Correction
Right Texture Placement and Color Correction
Texture Blending
Final Color Correction
Miscellaneous Settings

These attributes are the identical in Previzion and any changes done in
Maya can be saved and exported into Previzion as a new scene.

Changing Attributes in Previzion On-The-Fly

To make adjustments in Previzion, once the scene is loaded, select
cgfxShader1 in the Scene tab and click on Edit.
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This will open the shader parameters and all settings should correspond
to their equivalent scene in Maya.

Attribute Listing

Setting the Stage

The attributes described here set some of the basic parameters for the
video plane wall.

Use Maya Coordinate Transforms

Maya and Previzion handle some UV space transforms differently.
Specifically, they often see the V, of UV, to be reverses of each other,
or V¹ = 1-V;

Background Color

When you have empty space after sliding the video plates together, this
is the color that will fill in the empty space.

Wall Curvature

A slider value, from 0 -1, that defines the shape of the wall. At a value of
0.0 the wall is flat and at a value of 1.0 the wall is a semi-circle.

Use Mipmapping

This switch will turn on, or off, the used of texture based LODs
(mipmaps). For live filming, it is recommended that you leave off.

Textures 1 - 3, and Whole Object Color Corrections

Textures 1, 2 and 3 are very similar in their attribute listing; only texture
2 has no horizontal positioning attribute. In order from left to right the
textures are:

Tex1 -> Left
Tex2 -> Center
Tex3 -> Right
Final -> Homogeneous color correction for the entire
object

 

Textures 1, 2 and 3 Each texture has attributes that are categorized into
two separate functions: placement, and color

Placement -> These attributes relate to rotating and
moving each texture into place
Color -> Color correction functions include: contrast,
brightness, desaturation, color addition and color
multiplication

 

These per texture, or video, color correction controls are used when 3
cameras have different color temperatures and the colors are different
per texture

The color correction math follows standard function transformations:

colorout = ((colorin - middle grey) × contrast) + middle
grey + brightness
colorout = (colorout × (1.0 - desaturation)) + (((colorout.r +
colorout.g + colorout.b)/3.0) × desaturation)
colorout ×= Multipliercolor

colorout += Additivecolor

Texture Handle: texSampler

Texture connection for left, center or right video plane

Placement: Horizontal Placement
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Moves the Left and Right textures into, or away from, the Center
texture. This is needed to so the Center texture can blend into the
textures below it.

Placement: Vertical Placement

Moves the textures along the vertical axis. The Left and Right vertical
positioning of textures is parented to the center vertical positioning.

Placement: Rotation

Rotates each texture from its own center point (defined by horizontal
and vertical positioning)

Color Correction: Contrast

This controls the amount of contrast of the texture.

Color Correction: Middle Grey

Controls which luminance value is middle grey

Color Correction: Brightness

Adds luminance to the overall texture

Color Correction: Desaturation

Removes saturation from the texture by averaging the red, green and
blue channels.

Color Correction: Color Additive

Provides 3 channel support (RGB color) to color grade via addition

imagenew
red = imagered + colorred

imagenew
green = imagegreen + colorgreen

imagenew
blue  = imageblue + colorblue

Color Correction: Color Multiplier

Provides 3 channel support (RGB color) to color grade via multiplication

imagenew
red = imagered × colorred

imagenew
green = imagegreen × colorgreen

imagenew
blue  = imageblue × colorblue

Image Layer Blending

Alpha Blending from the Center Texture to the Right and Left textures is
performed by edge blending on both sides of the center texture. To
achieve the proper blending there are three components of the blending
algorithms:

Boundary Positions
Defines where, on the left and right sides of the center
texture, the feathering border is.

Boundary Angles
Defines how much the boundaries are rotated when
defining feathering

Boundary Feathering
Defines how sharp or broad the blending boundary is

 

In order to clearly see where the blending boundaries are, the shader
includes an attribute for displaying blending boundaries

Blend: Right/Left Boundary

These attributes move where the blending happens. When both values
are set to 0, the boundaries are at the left and right edges of the center
texture.

zero values here are its default positions

 

Blend: Right/Left Angle

These attributes allow for fine tuning of blending by rotating the
boundaries. The effective range of these attributes is from -90° ? +90°
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Blend: Master/Right/Left Feather

These attributes are created in a manner that allows for
semi-independent feathering amounts between the right and left edges
of the center texture. The attributes are divided into three:

Master Feather: both sides are feathered by this amount
Right Feather: This is an offset feathering amount, allowing for
more, or less, feathering on the right side
Left Feather: This is an offset feathering amount, allowing for
more, or less, feathering on the left side

 

Render Boundary Guides

Check this to render the left and right side boundaries.

 

Transparency

There are two methods for rendering transparency:

1."Transparency" - Renders stencil alpha by default when
turned on (set to 1).

Stencil is a fast transparency render but creates aliased
edges along transparency border

2."Alpha Blending" - Renders alpha blend when turned on (set
to 1).

calculates transparency over a smooth gradient and
avoids aliased edges for internal alpha borders but may
suffer object sorting errors

3.Keeping Alpha Blending off will improve transparency sorting.
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Clean Geometry - Normals

Face Normals

Face Normals should point outward to avoid an
backface culling errors at render time

How to Check & Change Direction of Face Normals

There are two methods in Maya to check for backfaces

Turn on Display > Polygons > Backface Culling
Turn on Display > Polygons > Face Normals

Changing a face's normal direction is a one step process

In the Polygons menu set, go to Normals -> Reverse

Video Tutorial

{{RIGHT}

Edge Normals

Edge normals define the softness or crispness of geometry as it
transitions from one face to another in the same mesh.

Here's an example showing problematic edge normals and
corrected edge normals

Here's an example when a hard edge has soft normals and
must be fixed

How to Correct Incorrect Edge Normals

 

Making edges hard that should be soft

>Select required edges and select Normals->Harden Edge

 

Making edges soft that should be hard

>Select required edges and select Normals->Soften Edge
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Clean Geometry - Faces

Overview

This page discusses keeping clean faces for export

Using Selection Constraints
Co-planar faces (lamina)
N-Gons: Faces with more than 4 sides
Triangulation by Hand

Selection Constraints: Cleaning Faces

The Selection Constraints window pinpoints geometry based on various
search criteria.

Faces constructed with n-amount of edges
Faces with zero area, modified by user defined threshold
Faces with zero texture mapped area, modified by user defined
threshold

Step 1: Triangulate N-Sided Faces

N-Gons, or N-Sided Faces, are any faces constructed by 5 or more
edges. These faces need to be divided until they are quads
(constructed by four edges), or triangles.

Select your object. With mouse still over object, RMB + Click &
Hold to get radial pop-up menu. Select Faces from menu.
Open The Select Constraints Window: -> Polygons (Menu Set)
-> Select -> Select Using Constraints
Make sure to select "All and Next" from the radio buttons along
the top.
For Order type: select "NSided"

Triangulate the selected faces with: Polygons -> Mesh ->
Triangulate
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Clean Geometry - Vertices

Overview

Ensuring your vertices are properly accounted for can reduce rendering
errors, modeling troubles and ease the UV tweaking process. In certain
instances you can reduce poly count without losing useful
geometry. This Documentation is Maya specific, but all of this
information can be interpreted to be used in other 3D applications.

One of the main concerns with clean geometry is stray vertices,
hereafter called 2-star vertices. 2-star vertices occur when geometry is
not as carefully removed and edited on a mesh. For example a series of
edges may be unnecessary or need reworking on a mesh. When a
series of edges is selected and deleted the vertices associated with
those edges remain on the mesh. These 2-star vertices can cause
rendering errors because they create n-sided faces (faces with 5 or
more edges). Rendering programs have to triangulate all geometry, so
an n-sided face can cause an error due to this extra edge.

 

The Heads Up Display for Poly Count

This tool is used to keep track of the number of Verts, Edges, Faces,
Tris, and UVs in a scene. Go to Display -> Heads Up Display -> Poly
Count

Tip: One easy way to tell if you have any stray vertices. If you're positive
your model is all quads, there should be 2 more Verts than Faces.

Finding Stray Verts

Use the Polygon Selection Constraint on Faces tool to isolate n-sided
faces. These faces hold the 2-start verts that will need to be resolved.

 

Merging Vertices

The different tools used to merge verts are found in Edit Mesh menu.

Merge tool: This tool is for merging vertices that are within a range
specified in the tool menu.

Merge to Center: Allows you to select multiple vertices, edges, or faces
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and merge them to the center point of the selected vertices.

Collapse: Allows you to select vertices, edges, or faces and collapse
them to their most local perimeter vertices.

Merge Vertex Tool: Interactively select two verts to merge, release
mouse button to complete action.

Delete Edge/Vertex: When selecting an edge loop, or two or more
consecutive edges, use this tool to delete the vertices associated with
that edge series.

Deleting Vertices

Simply select the verts, if selecting multiple hold down Shift and hit
Delete. Note that only verts with two or less edges attached can be
deleted.

A Vertice's effect on UVs

A set of vertices determine the boundaries of a UV set. A UV point
exists only where a vertex exists. In other words, there can be no UVs
on an edge, only a vertex.
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Clean Geometry - UVs

Overview

Keeping UVs in order can help when working on large scale projects
where there are a mass of different UV Sets.

UV Texture Editor

Window>UV Texture Editor

This tool is used to map out UVs in Maya. In it you can find all the tools
needed to complete a UV layout. This documentation will go over some
of the more useful tools found in the UV Texture Editor.

A: Smooth UV Tool - Unfolds UVs to lay out flat, will only work properly
if physical mesh would be able to roll out flat.

B: Separates UVs along selected edge - Able to cut mesh where
needed to separate without re-projection.

C: Sew selected edges or UVs together - Connects UV edges together
to provide seamless texturing.

Checking for and Creating UVs

Meshes imported from various CAD packages may not have UVs. To
check if UVs exist, first select the object. Open the Attribute Editor and
select the objectShape tab and select the Mesh Controls drop down. If
there is no title in the Current UVSet box then UVs do not exist for that
mesh.

To create UVs, use the tools found under the Create UVs menu. I've
found the easiest and fastest way to lay out a mesh flat is to planar map
by mesh area. Mapping out front to back, different segments (i.e. arms,
legs, chest to back) then sewing together edges later will make
unfolding the mesh much smoother, and give you more freedom of
where the lay seams.

Clean UVs

It's important to keep UVs together as much as possible to aid the
texture artist's task of eliminating seams. More often than not when first
projecting UVs, outliers will occur and will need fixing.

Ex.

Instead of re-projecting this section of the model and editing the
projection settings, move the stray UVs to where they connect. To find
the connection use edge selection and select the edge outlying and it
will highlight the corresponding edge. Move the UVs close to the
desired position and using edge selection sew the edges
together. When the model is fully and properly laid out it should lay flat.
You can verify this by adding the checkerboard texture onto the
character, upscaling the UVs and reviewing the size and distortion of
the checkers. View the two examples below for reference.
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Editing UVSet Names

In the UV Texture Editor you will find the Polygons menu containing the
five options regarding UV Set naming.

Create Empty UV Set: Allows you to create empty set then project new
UVs.

Copy UVs to UV Set: Allows you to duplicate UV Sets and copy UVs to
existing sets.

Set Current UV Set: Manually type in desired UV Set.

Rename Current UV Set: Allows you to edit the name of  a UV Set.

Delete Current UV Set: Deletes UV Set present in UV Texture Editor.

Also, when creating a new projection make sure you have Create new
UV Set turned off as Previzion does not support multiple UV sets
currently.
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Clean Geometry - Edges

Overview

Most work with edges is already covered as a subset of faces and
vertices. One thing we will explore here is detecting edges with zero
length.

These edges appear from a variety of things. When working on a mesh
if you extrude then decide you don't want to extrude, if you don't undo
all the way, edges will remain on the mesh but with no real length. If a
cube is scaled flat on any one axis, the edges which were laying along
that axis are now of zero length. When correcting n-sided polygons, if
two vertices are snapped together but not merged there will still exist an
edge with a zero length.

Using Select Constraints Tool

Select > Select Using Constraints Activate your move tool and make
sure that All and Next is the Constraint selection. Using the Length tab,
activate the option and leave the default min/max at zero. If your Move
tool selection locates to anywhere near the mesh then you have edges
with a length of zero. To eliminate these edges use Edit Mesh >
Collapse
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Clean Geometry - Construction History

Construction History Introduction

Deleting Construction History is one of the best measures to ensure a
scene doesn"t crash in Maya or behave unexpectedly during export to
FBX. History deletion should be followed in relatively the same manner
as saving, early and often.

Construction History is a backlog of information created when working
on a mesh. Nodes are created with every action, storing the information
being performed on the object. It's a necessary when using soft body
rigging or deformers, by storing information about the mesh.

When working on organic/complex models construction history can help
deeper into modeling. After smoothing, a node is created containing the
old mesh, if a problem occurs later on that would make it easier to use
the lower poly mesh, you can revert to that node and start working from
there.

How to turn off making more Construction History

To turn off Construction History temporarily click the Construction
History On/Off Button located in the Status Line.

How to Discern if you have Construction History on
your Mesh

Open the Channel Box/Layer Editor. Under the Inputs space, if there
are multiple nodes within this space, then there is history stored on that
mesh.

How to Clean Unnecessary Construction History

To quickly clean all history for an entire scene go to Edit > Delete All By
Type > History. This will clear your scenes of all unnecessary
construction history.

Keep in mind that this will also delete all nodes relating to
deformers, such as: smooth skins, or lattices. For deletion of
construction history that maintains the deformer relationships
use Edit -> Delete All By Type -> Non-Deformer History.

Window > Hypergraph Hierarchy

In the Hypergraph Hierarchy you can choose to see the individual
nodes created for specific objects. Here you can delete certain parts of
the history that you do not wish to keep, or are unnecessary. This type
of history deletion is more used in the role of rigging.

To view the entire hierarchy of construction history click theInput and
Output Connections button.

Clean History

This type of History is ideal. This example is only for one object, so with
a multi-object scene, the hierarchy will contain more nodes.

Not So Clean History

This amount of history is passable, but with multiple objects it will slow
down render time and be prone to program crashes. So, Always delete
history.

Bad History

This amount of history should never occur. This was created using one
object, and it began to slow down Maya, any further history creation
would have led to a program crash. With multi-object scenes containing
this much history you will encounter problems rendering, exporting and
using the Previzion system.
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Clean Scene - Optimizing Scene Size

Overview

Once your models are cleaned and ready for export, you'll want to clean
your scene of detritus. A scene that has been worked up over time often
contains the remnants of old models, shaders, textures, curves, and/or
layers.

How to Tell if Your Scene Contains Unnecessary
Nodes

In the Hypergraph, with _Input/Output Connections_ turned on, if you
can visually see nodes with no connections then some are likely to be
unused. Most scenes contain unused nodes regardless of cleanliness
while creating scenes.

Preparing for Optimizing Scene Size

In preparing a scene, you should look through your Outliner and
Hypergraph making sure that all nodes are connected properly. Clean
up the Outliner by grouping appropriate transforms. If you see
unused/unnecessary nodes delete them by hand to ensure their
deletion.

IMPORTANT: Before continuing save a new version of the file, as
Optimizing Scene Size is not an undo-able operation.

Optimizing Scene Size

After saving a new version of your scene continue on to optimizing the
scene.

File > Optimize Scene Size (Options)

In this menu you can select which node types to delete and by not
selecting certain types you can preserve them. The bulk of scene clutter
is from Transforms, Display layers, Curves, Cached data, Deformers,
GroupID nodes, Rendering nodes, and Shading networks.

After you have optimized the scene, save this file as a new version.

Testing for Errors After Optimization

To test for errors, begin by looking at the Hypergraph to make sure that
connections are still held. Continue by doing some test renders,
ensuring all textures are placed properly and connected. Test for
animations if you have any, and make sure deformers have been
preserved.

Page 284

http://www.lightcrafttech.com/wp-content/uploads/2010/11/OptSceneMenus.jpg
http://www.lightcrafttech.com/wp-content/uploads/2010/11/OptimizeScene1.jpg


Previzion - User Manual
by Lightcraft Technology

Clean Scene - Node Naming

Overview

A major issue when creating scenes is naming conventions and
practice. It is important to name everything in a scene, even the
smallest node. This way if any errors occur it will be easier to locate the
culprit.

Modifying Node Names

The two easiest ways to modify a node name are with the Attribute
Editor and the Channel Box/Layer Editor. Select your object, and simply
select the node you would like to rename. In the Channel Box change
the name by double clicking the node name, switching to rename mode,
type in the new name and hit Enter. With the Attribute Editor select the
tab with the node you would like to rename and highlight the text in the
box under the tabs, rename the node and hit Enter.

Suggested Naming Convention

Be as descriptive as possible when naming nodes. If there could be any
confusion as to one wall from another for example, make the naming
more precise.

[Descriptive Name]\_\[Node Type]\_\[Optional Modifier] 

Examples:

EastWall2ndFloor\_Geo
EastWall2ndFloor\_Shader
EastWall2ndFloor\_Texture\_Bump
Foyer\_Camera

By following the same naming conventions all the time, it becomes
easier to know exactly what's happening in your scenes. It also helps
for others to view your scene assets and interpret what is going on.

Working with Previzion

To edit object locations in Previzion, each node must be named with the
prefix edit\_. A good practice is to group major parts of the scene
together and name only those groups with the edit\_ prefix. If the scene
includes interconnected buildings that are virtually inseparable, they
should all be parented under the same group node.
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Clean Scene - Clean Shader Paths

Overview

It’s important to have your shader paths properly accounted for. This
will resolve any rendering issues with unlocated shaders. In the past
replacing shader paths involved editing individual shaders one at a
time, now with the CGFX Repath Utility you can view all of your shader
paths at once and edit accordingly. This utility aids in the repathing of
shader nodes to collected locations. In the example below, the Maya
scene contains 95 file texture nodes with each texture scattered over 5
unique directory locations. Texture repathing happens now in
approximately one minute.

 

Features

Lets you repath one unique location at a time, or all at once
Automatically completes user defined paths with “/”
Item #1 (from the key) assumes use of properly defined Maya
Project directory structure

Item #2 & #6 allows the user define an off project
directory location

All interface items and paths are updated with the activation
Interface is modular and is based on the number of unique
CGFX locations, Item #8
Define global paths (#1 & #2) or per unique CGFX location
paths (#5)
User definable subdirectories with “appendable” locations (#6)
to the global directory (#1 & #2)
Repath on a per unique CGFX location basis (#7) or repath all
CGFX locations at once (#9)

Lists Old (#3) and New paths (#4)

Limitations

Assumes your scene is set up with a project appropriately
You may still override this by typing an explicit path

Does Not move or copy your shaders

Download Latest Version

You may download the latest version of  Lightcraft CGFX Repather from
our Download Dashboard.

Last Updated: February 22, 2012 @ 12:30a PST

Update Notes

Feb 22nd, 2012
Initial Upload
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Clean Scene - Clean Texture Paths

Clean Texture Paths Overview

It's important to have your texture paths properly accounted for. This will
resolve any rendering issues with unlocated textures. In the past
replacing texture paths involved editing individual textures one at a
time, now with the Texture Repath Utility you can view all of your
texture paths at once and edit accordingly. This utility aids in the
repathing of texture nodes to collected locations. In the example below,
the Maya scene contains 95 file texture nodes with each texture
scattered over 8 unique directory locations. Texture repathing happens
now in approximately one minute.

Features

Lets you repath one unique location at a time, or all at once
Automatically completes user defined paths with "/"
Item #1 (from the key) assumes use of properly defined Maya
Project directory structure

Item #2 & #6 allows the user define an off project
directory location

All interface items and paths are updated with the activation
Interface is modular and is based on the number of unique
texture locations, Item #8
Define global paths (#1 & #2) or per unique texture location
paths (#5)
User definable subdirectories with "appendable" locations (#6)
to the global directory (#1 & #2)
Repath on a per unique texture location basis (#7) or repath all
texture locations at once (#9)
Lists Old (#3) and New paths (#4)

Limitations

Assumes your scene is set up with a project appropriately
You may still override this by typing an explicit path

Does Not move or copy your textures

 

Download Latest Version

You may download the latest version of Lightcraft Texture Repath tool
from our Download Dashboard.

Last Updated: March 30, 2011 @ 11:57a PST

Update Notes

Mar 30, 2011
Corrected Error at Line 56

Now filters textures to search only file textures
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Feb 16th, 2011
Initial Upload
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Clean Scene - Deleting Un-Used Nodes

Overview

The final step in cleaning up a scene is to visually inspect the Outliner,
Hyperhshade and Hypergraph for any objects that aren't needed and
weren't cleaned in any previous step yet.
The objects are often linger because they are objects with shaders
applied. Because Maya can't tell which objects you intend to use and
which you have forgotten to delete, these objects still remain.

How to Look for Lingering Objects

Outliner

In Wireframe Mode make sure you have the Move tool selected. You
can then begin selecting objects and determine where and what they
are in the scene. If you can verify that any are unnecessary or have
been forgotten then delete accordingly.

Hypergraph

Name everything in your scene, don't let your file get cluttered with
default named objects. This will help keep scenes clear of forgotten
objects. In the Hypergraph you can see grouped objects and stray
objects possibly not intended to keep.

How to Delete these Nodes

Hypershade > Edit > Delete Unused Nodes Will delete any nodes in the
Hypershade that are linked to an object. Do this step after you have
gone through the Outliner.

In the Hypergraph Be Thorough follow these steps to clean up unused
nodes.

Show Input/Output Connections ->
Show assigned shaders in Hypershade ->
Select all nodes in the connection stream in both Hypershade and
Hypergraph This includes the ShadingGroup node ->
Delete
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Clean Scene - edit_ Transforms

Overview

Previzion is set up to use editable transforms for control of certain
scene parameters. This means that Previzion reads and stores the pivot
information of nodes. A clean transform is one that has a local pivot of 0
on all axes.

Detecting Bad Transforms

There are two ways of knowing if a transform is bad, first in Maya and
also an error message on Previzion scene load.

Maya

Under each node, in the transform tab of the Attribute Editor, there is a
tab called Local Space under the Pivots. These are the values that
Previzion reads to store the nodes local coordinates.

Previzion

When loading a scene with bad transforms into Previzion a pop up will
come up telling you which editable transforms have non-zeroed pivots.

 

These can be "OK'd" and Previzion will still run properly without any
issues, other than odd pivot points for objects if edited in Previzion.

Fixing Bad Transforms

In Maya it is very simple to fix bad transforms.

If your node has a very precise pivot point, where you'll need to rotate
or scale the object, you'll need to do a couple steps.

1.Record your 3 World Space pivots(Both lines should be

identical).
2.Translate your object to lock on to the origin at 0,0,0.
3.Go to Modify > Freeze Transformations.
4.Go to Modify > Reset Transformations.
5.Move your object back to the recorded 3 World Space pivots.

These can just be typed into the Attribute Editor by hand, in the
Translate section of the Transform Attributes.

If you just need your scene to load and aren't intending to rotate or
scale the object on a certain axis just do Steps 3 and 4.
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CgFx Shader Library

Basic Texture
Shader Library 2014
Materials
Baked-in Shader
Matte Shader
Reflective Shader
Thin Glass Shader
Thick Glass Shader
Smoke Shader
Alpha Textures
Displacement Shader
Wireframe Shader
Transparent Video
Knockout Shader
Assigning CGFX Shaders
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Basic Texture

Overview

This shader is a basic texture to help new users get used to working
with CGFX shaders. It uses a simple texture map and allows control of
mipmapping.

1.CgFX file path
2.ColorSampler file path
3.MipMapping control

Applying CgFX shaders

First enable hardware texturing and ensure that the CgFX plug-in is
loaded. Plug-in manager is located under Window >
Settings/Preferences > Plug-in Manager.

First press and hold the right mouse button on the object you wish to
apply a shader to. Then move down to Assign New Material… selection
and let go of the mouse button.

Then simply choose theCgfx Shader selection and load in the shader
of choice.

 

Download

You may download the latest Basic.CgFx from our Download Manager.

Last Updated: May 17th, 2012 @ 10:56a PST

The next section contains more advanced shaders with full color
correction. After understanding how to apply shaders move on to the
next shaders to use for production.
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Shader Library 2014

Lightcraft Shader Library 2014

The 2014 shader library takes a new approach to CgFX shaders. It's
designed as a starting point for people who understand building and
lighting CG scenes, but may not be familiar with CgFX shaders and
real-time lighting. It includes shaders for matte and glossy surfaces with
opacity control for glass, and effects shaders for video and smoke
“cards.”

It is designed to:

Produce realistic looks while not limiting artistic choice.
Be versatile but easily controlled.
Have understandable workings.

It's also a gateway to writing your own shaders. The shader programs
are documented internally and copious reference material about writing
shaders is available online.

Zones in Virtual Sets

For many CG scenes, virtual sets are built in zones based on their
proximity to camera. The zones go from infinitely far away (sky/cloud
environment sphere) where parallax is absent and there’s no
interaction with lights on the set or talent. Down to the immediate
vicinity of the talent, where parallax and lighting interaction are crucial.
Each zone works best with different kinds of CG lighting techniques.

Zones in Virtual Sets

Summary:

Long distance zone - Elements about 1 kilometer in distance to
infinity, (eg. the background cyclorama). No parallax evident
when camera moves, not affected by set lighting.
Medium distance zone - 100 meters, (city block). Minimal
parallax is evident if the camera makes a big move, only facing
sides of buildings or set elements will be constructed. Little to no
set lighting effect.
Nearby zone - 10 meters, significant parallax. Most CG
elements fully built, CG and on-set lighting needs to match for a
sense of reality.
Interactive zone - 1 meter. Items in contact with the talent, or on
which they cast shadows. Typically items in this zone will be
built physically.

For indoor scenes the zone scale may be compressed if the stage is
small or camera working area is narrow (limiting parallax effects).

For instance, the camera is in a narrow ground floor apartment where
cars and pedestrians are passing outside a window. In this case the
street view outside the window is Long Zone, while elements at the
borders of the room such as railings and an awning just outside the
window are in the “Medium Zone”. A CG ceiling in the room would be
in the “Nearby Zone,” since it will need to match set lighting to appear
integrated. If there were CG elements close to the actors in the room
these would be in the “Interactive Zone.”

Lighting and Zones

The zone in which a CG element lives determines its lighting needs.

The Long Zone is the environment bubble backdrop, often a sphere.

This represents the limits of what we can see. There are no CG
elements in this zone except the backdrop itself. Like a
cyclorama, the bubble is self lit and does not respond to lighting
from stage. In Previzion this bubble is often made with 4k movie
textures, so that distant lights can glitter, aircraft can move
across the sky or pedestrians pass by a window.

The Medium Zone exists at around 100 meters from the camera.

Typically only the facing sides of the buildings would be
constructed. If the buildings are made of reflective glass these
might use a reflection map so that the mirrored view changes
slightly as the camera moves.
Buildings in the Medium Zone will often have “baked-in”
lighting, in particular if they were reconstructed from photos.

The Nearby Zone exists at about 10 meters and closer.

This is the on-set area where matching set lighting to virtual
lighting becomes crucial to creating an integrated look. Light
maps and the dynamic point light are useful tools for this.
Ambient light from a lighting bubble shot on set helps as well.

The Interactive Zone concerns itself more with delicate adjustments of
the keying system, to pick up shadows and spotlights cast on green
surfaces. Any “green” surfaces within 1 meter of actors or props,
including floors, would be considered part of this zone.

Shaders and Surfaces

Each shader in the library has a base color for the surface, a
“bumpiness” and (in some) their transparency. These surface qualities
are revealed by how the shaded object responds to light.

So, a shader’s surface qualities may include:

1.Surface color (whether opaque or glassy)
2.Transparency
3.Bumpiness
4.Reflectivity / refraction
5.Light response

Base or Surface Color

The base or surface color of an object is “paint on the polygons”. It can
be created several ways, but the shader library focuses on using
textures or images.
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Left; Diffuse with no light : Right; Diffuse with
light

On the left is a sphere showing its base color texture without lighting.
The texture colors are transferred directly to the screen. For contrast,
on the right is the same sphere, but with lighting effects created by a
light-map from a spotlight, plus both diffuse and specular highlights
created by a Blinn-Phong point light.

Note that so far (on the left) we have a perfectly smooth surface, and
that without lighting you wouldn't see the base color.

Transparency and Alpha Maps

There are numerous kinds of transparency, but we’ll focus on one here:
transparency used as a way to indicate where a surface ends, like the
edge of a leaf.

Ragged, natural edges are represented with an alpha channel, which is
in addition to its color channels (typically red, green and blue).

In the above example we've added a rough black on white alpha
channel to the texture on the sphere, making it look like a broken or torn
framework.

The texture is shown above (as seen in Photoshop). The dark pink
areas are the alpha channel, created using black “paint” in Photoshop.

Bumpiness and Normal Maps

When a surface is “bumpy” we use a trick called a “normal map” which
is really just another kind of texture. A normal map gives the look of
more detail than the underlying geometry itself.

Material with and without normal map

On the left is the sphere with specular highlights (simulating bump or
shine areas) and on the right we add bumps from a normal map.

Here are the color, specular and normal maps from the sphere:

A normal map uses its RGB “colors” to define a normal vector different
from that of the underlying geometry. It “bends” or “offsets” the normal
from the base geometry by using RGB like XYZ vector components.
Because it can vary per pixel its much more detailed than the geometry.

Normals affect light response. By “bending” the normals away from
being perpendicular to the surface, light striking the surface may return
closer to the eye, creating a highlight, or be pushed farther away,
indicating a more glancing angle.

Normal maps can be created a few ways. There are Photoshop plug-ins
(including a free one from NVidia) and standalone programs like nDo2
by Quixel and tutorial by philipk.net. Numerous surface modelling and
painting programs support creating normal maps as a way of reducing
object complexity. A lower resolution model is created from a higher
resolution model. The difference between the two is used to create a
normal map which (in many cases) can recreate the effect of the lost
polygon detail.

Note that bumps created by normal maps don’t affect the profile or
geometryof an object. A perfectly round sphere won’t have a profile
that looks bumpy due to normal maps. There are other ways to achieve
that using, e.g. displacement maps, but they’re not currently a part of
the shader library.

Reflection / Refraction and Environment Maps

Reflection and refraction are beautiful and complex responses of a
surface to light. In full generality they require expensive computation to
create accurate images. However, we can get much of the effect of real
reflection and refraction, within narrow limits, in real-time rendering. To
do this, we use a trick called an environment map.

An environment map is in some ways the compliment to a texture map.
While a texture wraps around the surface of an object, the environment
shows what’s around the object encircling it. One form of an
environment map is particularly easy to understand, the spherical
panorama:
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Latitude/Longitude reflection map

The panorama above was created with a “latitude / longitude” mapping,
where the horizon is along the middle, looking straight up is at the top,
and straight down at the bottom. Left to right is a sweep of 360 degrees
around, in other words the left and right edges match.

A reflection effect is created by finding the part of the surrounding
image to show on a surface. That’s done using a ray from the eye to
the object surface and then bounced out to the environment based on
the surface normal.

If we apply this technique to the sphere it looks like this:

Sphere with Reflection

Pretty convincing, but because the reflection is only based on the
environment map it can’t reflect other nearby objects as a “real” mirror
would.

Bump (normal) maps also affect reflection because the normal is used
to determine the bounce angle:

Sphere with Reflection and Normal sampler

A surface can be only reflective by being mirrored at the outside, or
mirrored on the inside of a transparent material like glass. The
examples above assumes the mirror layer is under transparent, colored
“glass”.

If there is no mirror layer, and we assume the object is solid but
transparent. Then some viewing angles reflect away, (when the surface
is more facing away) and some viewing angles will refract down and
through the object, (when the surface is closer to directly facing the
viewer).

A reflection/refraction effect can be combined and created similarly, but
has the same limitation of only showing what’s in the environment map.

Thick Glass shader with refraction

In the example above a “thick glass” object is reflecting the
environment around its edges, and refracting through its middle.

Because of the limitations of real-time shaders for these effects they’re
typically used for windows at the back of a set. On the windshield of a
car, a reflective surface that’s also partially see through can be used.
"See through" here means that objects behind it in the scene are
visible.

Shaders and Light Response

To simulate a “light response” there are four lighting techniques in the
shaders:

1.Baked-in or self-lit.
2.Ambient lighting from the environment around the object.
3.A lighting map, for nearby lights that are static.
4.A point light which can be moved, color changed, etc.

Note how the light response techniques go from static to dynamic. They
also increase in render cost.

The lighting response techniques are stacked up to be available in most
shaders:

Each layer is programmed in the shader, and tricks are used to create
each effect.

Baked-in or Self-lit

In the long zone of the scene, or in any area where there’s no lighting
influence or there is lighting already in the textures (as from
Photogrammetry) a shader can support “self lit” surfaces. This doesn’t
mean incandescent, more like direct transfer of color values from the
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base color texture on the surface to the screen. This is why the
background cyclorama or environment bubble is usually considered
“self lit."

Examples: A backdrop cyclorama or CG models from photo
reconstruction, whose textures will naturally include any lighting present
at the the the photos were shot.

Ambient or Image-based Lighting

Ambient lighting comes from the environment around an object. In
reality an object sitting on a yellow floor gets yellowish light against its
bottom. In full generality this is rendered using ray-tracing techniques
that are too expensive for most real-time applications. So we use a
trick.

Image-based lighting (IBL) creates an effect of ambient lighting by
bouncing an environment map (spherical image around the object) off
the object to light up the base color. The image used for this is low
resolution and defocused.

The math is the same as for reflection, but it illuminates the base color,
rather than adding its own color.

Ambient lighting appears static, but because its based on an
environment map. That map can be rotated into position, and intensity
changed.

Here is the sphere with a point light simulating the sun, but no ambient
light from the environment map. Note that the back of the sphere is
dark. While we could “fill” this area by adding a single color the look
would not be very accurate.

Here is the sphere with ambient lighting applied from an environment
map. Note how the bottom is receiving the ground color, while the top is
being tinted by the sky:

The environment map used for IBL is considerably lower resolution than
the backdrop and reflection maps. It looks like this:

Not only is this smaller, its also heavily filtered. Without this the ambient
lighting effect can make the surface look reflective. To control and avoid
this the shader allows for additional blurring.

Light Map

A light map is a separate texture which “paints” lighting effects onto a
surface. Imagine separating the lighting from a photo reconstruction
texture into fully diffuse color (the base color) and the lighting affecting
it; a color image painting the whole surface of the object which
represents only bright sunlight and dark shadows.

On a CG model this technique separates painting the surface for color,
from applying light to it. Because of this, the technique allows for
swapping lighting effects.

Overall, light-maps allow complex lighting environments to be applied
completely separately from the building and coloring of models. Many
lights can be accurately represented in a light-map.

Here is a light-map effect based on a single spotlight:

The “lighting texture map” used to create this effect is this:

This particular texture is another “latitude / longitude” map that covers
the sphere. You can use any UV projection that covers the object to
adequate resolution.

Because the light map is likely to wrap around the object differently from
its base color texture, there is a separate UV map used for the lightmap.

Creating light maps requires making the object white, with bumps or
normals, then rendering a “baked texture” from the lights shining on it.
This can be done with Mental Ray or V-Ray in Maya. See the Maya
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manual under “Baking lighting.”

Point light

The final light effect is a “Blinn-Phong” point light. This models a single
colored point light source at an arbitrary position and having a
“sharpness” which determines how much “specular” vs “diffuse”
highlighting is created.

The effect on the object is a circle of diffuse light around a highlight
(specular). The diffuse area is the base color of the surface, illuminated
by the light color. The specular area can be varied in “sharpness” and
can be mapped to a texture which replaces the base color in the
highlight area.

In the example above the specular texture map looks like “smooth
abrasions” on the surface. Using a matching normal map can add
corresponding pitting effects (as above).

The specular map used for the above:

The normal map and specular map for this example were both created
from the same tiled texture.

Download

Download the Shader Library 2014 package from the Dashboard.
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Materials

Brick

Shader: Matte.cgfx
Bump: 5
Ambient Sampler: Blurred image
Ambient Intensity: 1.6
Ambient Softness: 7
Diffuse Strength: 0.5

 

Cinder Block

Shader: Matte.cgfx
Bump: 5
Ambient Sampler: Blurred image
Ambient Intensity: 1.6
Ambient Softness: 7
Diffuse Strength: 0.5

 

Stone Floor

Shader: Matte.cgfx
Bump: 5
Ambient Sampler: Blurred image

Ambient Intensity: 1.6
Ambient Softness: 7
Diffuse Strength: 0.5

 

Dirt

Shader: Matte.cgfx
Bump: -2.25
Ambient Sampler: Blurred image
Ambient Intensity: 1.6
Ambient Softness: 7.5
Diffuse Strength: 0.5

 

Granite

Shader: Reflective.cgfx
Opacity: 1
Bump: 0.025
Reflection Sampler: Sharp image
Reflection Intensity: 1.6
Reflection Softness: 8.5
Diffuse Strength: 0
Spec As Dirt: 0.49
Ambient Softness (for dirt): 7

 

Marble
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Shader: Matte.cgfx
Bump: 0
Ambient Sampler: Blurred image
Ambient Intensity: 1.6
Ambient Softness: 7
Diffuse Strength: 0

 

Gravel

Shader: Matte.cgfx
Bump: 5
Ambient Sampler: Blurred image
Ambient Intensity: 1.6
Ambient Softness: 7.5
Diffuse Strength: 0.5

 

Stone

Shader: Matte.cgfx
Bump: 5
Ambient Sampler: Blurred image
Ambient Intensity: 1.6
Ambient Softness: 7
Diffuse Strength: 0.5

 

Sand

Shader: Matte.cgfx
Bump: -5
Ambient Sampler: Blurred image
Ambient Intensity: 1.6
Ambient Softness: 7.5
Diffuse Strength: 0.5

 

Tiles

Shader: Matte.cgfx
Bump: -1.6
Ambient Sampler: Blurred image
Ambient Intensity: 1.6
Ambient Softness: 7
Diffuse Strength: 0.5

 

Slate

Shader: Matte.cgfx
Bump: -4
Ambient Sampler: Blurred image
Ambient Intensity: 1.6
Ambient Softness: 7
Diffuse Strength: 0.5
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Concrete

Shader: Matte.cgfx
Bump: 5
Ambient Sampler: Blurred image
Ambient Intensity: 1.6
Ambient Softness: 7
Diffuse Strength: 0.5

 

Asphalt/Tarmac

Shader: Matte.cgfx
Bump: -5
Ambient Sampler: Blurred image
Ambient Intensity: 1.6
Ambient Softness: 7.5
Diffuse Strength: 0.5

 

Plaster

Shader: Matte.cgfx
Bump: 5
Ambient Sampler: Blurred image
Ambient Intensity: 1.6
Ambient Softness: 7

Diffuse Strength: 0.5

 

Textured Plaster

Shader: Matte.cgfx
Bump: 3
Ambient Sampler: Blurred image
Ambient Intensity: 1.6
Ambient Softness: 7
Diffuse Strength: 0.5

 

Pine

Shader: Matte.cgfx
Bump: 12
Ambient Sampler: Blurred image
Ambient Intensity: 1.6
Ambient Softness: 7
Diffuse Strength: 0.5

 

Cherry

Shader: Matte.cgfx
Bump: 5
Ambient Sampler: Blurred image
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Ambient Intensity: 1.6
Ambient Softness: 6.5
Diffuse Strength: 0.5
Specular Strength: 0.1

 

Wood

Shader: Matte.cgfx
Bump: 5
Ambient Sampler: Blurred image
Ambient Intensity: 1.6
Ambient Softness: 7
Diffuse Strength: 0.5

 

Fir Plywood

Shader: Matte.cgfx
Bump: 5
Ambient Sampler: Blurred image
Ambient Intensity: 1.6
Ambient Softness: 7
Diffuse Strength: 0.5

 

Chipboard

Shader: Matte.cgfx
Bump: 5
Ambient Sampler: Blurred image
Ambient Intensity: 1.6
Ambient Softness: 7
Diffuse Strength: 0.5

Terry Towel

Shader: Matte.cgfx
Bump: 2.8
Ambient Sampler: Blurred image
Ambient Intensity: 1.6
Ambient Softness: 7.5
Diffuse Strength: 0.5

 

Denim

Shader: Matte.cgfx
Bump: 2
Ambient Sampler: Blurred image
Ambient Intensity: 1.6
Ambient Softness: 7
Diffuse Strength: 0.5

 

Canvas
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Shader: Matte.cgfx
Bump: 2
Ambient Sampler: Blurred image
Ambient Intensity: 1.6
Ambient Softness: 7.5
Diffuse Strength: 0.5

 

Wool

Shader: Matte.cgfx
Bump: 2
Ambient Sampler: Blurred image
Ambient Intensity: 1.6
Ambient Softness: 7.5
Diffuse Strength: 0.5

 

Silver

Shader: Matte.cgfx
Bump: 0.1
Ambient Sampler: Sharp image
Ambient Intensity: 1.6
Ambient Softness: 6.5
Diffuse Strength: 0
Specular Strength: 0.2

 

Galvanized

Shader: Matte.cgfx
Bump: 0.035
Ambient Sampler: Blurred image
Ambient Intensity: 1.6
Ambient Softness: 5.8
Diffuse Strength: 0

 

Tarnished Bronze

Shader: Matte.cgfx
Bump: 0.035
Ambient Sampler: Blurred image
Ambient Intensity: 1.6
Ambient Softness: 6.6
Diffuse Strength: 0

 

Chrome

Shader: Reflection.cgfx
Bump: 0.13
Reflection Sampler: Blurred image
Reflection Intensity: 0
Reflection Softness: 0
Diffuse Strength: 0
Specular Sampler: Residue on white JPG, no alpha.
Specular Strength: 0.2
Spec as Dirt: 1
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Ambient Softness (for dirt): 5.45

 

Copper

Shader: Matte.cgfx
Bump: 1
Ambient Sampler: Blurred image
Ambient Intensity: 1.6
Ambient Softness: 0
Diffuse Strength: 0

 

Rust

Shader: Matte.cgfx
Bump: 2.5
Ambient Sampler: Blurred image
Ambient Intensity: 1.6
Ambient Softness: 6
Diffuse Strength: 0.5

 

Glass

Shader: Thinglass.cgfx
Diffuse Sampler: White JPG
Opacity: 0.5

Bump: 0
Reflection Sampler: Sharp Image
Reflection Intensity: 1
ReflectionSoftness: 1
Diffuse Strength: 0

 

Thick Rippled Glass

Shader: Thinglass.cgfx
Diffuse Sampler: White JPG
Opacity: 0.5
Normal Sampler: Large ripples
Bump: 0.065
Reflection Sampler: Sharp Image
Reflection Intensity: 1
ReflectionSoftness: 1
Diffuse Strength: 0

 

Refractive Glass

Shader: Thickglass.cgfx
Reflect Softness: 0
Refract Softness: 0
Falloff Amount: 0.81
Intensity:1
refracted_ior: 1
incident_ior: 1

 

Note:

All values are based on specific cases, and may vary slightly depending
on normal map intensity, and overall look of virtual set.

Textures acquired from, CG Textures and Surface Mimic.
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Baked-in Shader

Baked-in Shader

More distant elements in a scene typically have “baked in” lighting.
That is, the lighting is already in the texture image because (for
example) it's a photo shot at a particular time of day.

Backdrop elements are typically at a medium to long distance. Some
examples are the faces of distant buildings or terrain. The premiere
example is the background cyclorama bubble. This is an image mapped
onto a sphere at great distance, e.g. 1 km from the camera. There are
no lighting effects required. The image is high resolution, e.g. 4k, so
that zooming in doesn't “break up” into large pixels on the background
image. The image can be a movie texture or a still, but in either case it
should map correctly onto the sphere.

Environment images are typically shot as “spherical panoramas” which
wrap 360 around and 180 degrees up and down. These can be
flattened into an image several ways, but one of the most common is
“lat/long” or “latitude, longitude” mapping.

Here is the spherical panorama image from the example above
flattened using “lat/long”:

Because there is only half a sphere, only half of the image above is
mapped onto it.

The shader controls (as seen in Maya):

Sampling anisotropy can generally be left at 4x. It's the number of
passes made to reduce aliasing or “jaggies” on textures that have high
contrast (e.g. checkerboard floor patterns) as they get farther away from
camera.

The color sampler field maps the base color texture onto the object
using the UV set named “UV”.

Because the surface lighting is “baked in” there are a controls to
change coloring.

The MipMapping option can generally be left on. For very large
background bubble texture GPU memory can be spared by turning it
off.

Download

Download the Shader Library 2014 package from the Dashboard.
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Matte Shader

Matte Surface

The Matte Surface shader is for solid materials which don’t have
transparency and which are not reflective. Materials like dirt, plaster and
concrete are its domain. It's most often used in the Medium to
Interactive zones of the scene.

As seen in Maya the controls are:

Sampling anisotropy can generally be left at 4x. It's the number of
passes made to reduce aliasing or “jaggies” on textures that have high
contrast (e.g. checkerboard floor patterns) as they get farther away from
camera.

The “diffuse sampler” is the base color texture painted on the surface.
It uses the UV set indicated by “UV” to map onto the object.

The normal sampler points to an RGB color texture generated with one
of several available tools (NVidia has a Photoshop plug-in). It uses the
same UV set as the base color texture.

The ambient sampler is a “latitude longitude” panorama sphere seen
from at or very near the object position in the scene. It can be either
rendered or made from a photo panorama, but in any case can be of
modest resolution and heavily blurred. Intensity is the “on / off” for the
effect. Softness further blurs the ambient effect on the surface, making
it harder and shinier or softer and duller.

An excellent source of detailed information on shooting and processing
HDR photo panoramas can be found on Christian Bloch’s HDRLabs
web site. The section on sIBL inspired significant aspects of these
shaders.

The light map is described in the previous section. It is a black/white
texture representing pre-rendered (baked) lighting on the object. It can
use a different UV set from the base color texture, in the “LightmapUV”

parameter. Lightmap intensity is the on/off for this effect. Resolution of
the light map need not be high.

The reason for allowing separate UVs sets is that often the base color
will be a seamless texture, repeating on the surface, while the lightmap
must not repeat, and uniquely map the whole object.

The Blinn-Phong point light has a color, a position in global coordinates
of the scene, diffuse and specular strength and specular sharpness. It's
often useful to constrain the position to windows for interiors or the sun
in outdoor scenes.

The final parameter rotates the ambient environment map on the global
Y axis. This allows matching the ambient lighting to an environment
bubble or cyclorama which may be positioned differently.

Setting up Multiple UV Sets

In order for these Multiple UV Set shaders to operate correctly, you will
need to follow one simple guideline. The shader input "UV" requires the
primary default UV Set. This means when viewing the UV Sets in
Create UVs > UV Set Editor, the top UV Set is the default, in this
case map1. "UV2" can then be filled with the second UV Set. Look
below for an example of two separate UV Sets applied to the same
object.

Download

Download the Shader Library 2014 package from the Dashboard.

Materials

Concrete/Brick
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Bumpiness: 5
Ambient Intensity: 1.6
Ambient Softness: 7
Lightmap Intensity: 0
Diffuse Strength: 0.5
Specular Strength: 0
Specular Sharpness: 0

Rust

Bumpiness: 2.5
Ambient Intensity: 1.6
Ambient Softness: 6
Lightmap Intensity: 0
Diffuse Strength: 0.5
Specular Strength: 0.25
Specular Sharpness: 0

Fabric

Bumpiness: 1.6
Ambient Intensity: 1.2
Ambient Softness: 7.5
Lightmap Intensity: 0
Diffuse Strength: 0
Specular Strength: 0.2
Specular Sharpness: 0

Wood

Bumpiness: 3

Ambient Intensity: 1.6
Ambient Softness: 7
Lightmap Intensity: 0
Diffuse Strength: 0.5
Specular Strength: 0
Specular Sharpness: 0

Download sample materials from the Dashboard, sample texture files
provided by SurfaceMimic.
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Reflective Shader

Reflective Shader

The Reflective shader is for glossy surfaces. A typical use is for a car
paint and chrome.

 

As seen in Maya the controls are:

Sampling anisotropy can generally be left at 4x. It's the number of
passes made to reduce aliasing or “jaggies” on textures that have high
contrast (e.g. checkerboard floor patterns) as they get farther away from
camera.

The “diffuse sampler” is the color texture painted on the transparent
surface. It uses the UV set indicated by “UV” to map onto the object.
The surface is simulated as a layer of (base) color glass with mirroring
underneath.

The opacity setting determines how much one can see through the
mirror layer. Highlights and lighting effects on the glass above are not
affected by the opacity.

The normal sampler points to an RGB color texture generated with one
of several available tools (NVidia has a Photoshop plug-in). It uses the
same UV set as the base color texture.

The reflection sampler needs a “latitude / longitude” spherical
panorama of medium to high resolution (e.g. 1k). The intensity of the
effect, its “softness” indicating roughness of the surface can be varied.

The Blinn-Phong point light has a color, a position in global coordinates
of the scene, diffuse and specular strength and specular sharpness. Its
often useful to constrain the position to windows for interiors or the sun
in outdoor scenes.

An additional trick is that the specular layer can be illuminated by
ambient IBL to look like “dirt”. The intensity of the effect (amount of IBL
light) and the softness can be varied. Note that for simplicity the

reflection map is used, and the softness value will need to be higher.

The final parameter rotates the ambient environment map on the global
Y axis. This allows matching the ambient lighting to an environment
bubble or cyclorama which may be positioned differently.

Rendering Reflection Maps with V-Ray

To render a reflection map there are a few guidelines to follow to get a
good map that will work with your scene.

Render a 360° Spherical Panorama, looking down the positive x-axis,
with the positive z-axis to the left (shown below.) In the Render
Settings, under the V-Ray tab, expand the Camera dropdown. Change
the Type to Spherical, Override FOV and change it to 360.

Download

Download the Shader Library 2014 package from the Dashboard.

Materials

Chrome

 

DiffuseSampler: White JPEG
Opacity: 1
Bumpiness: 0.025
Reflect Intensity: 1
Reflect Softness: 1
Diffuse Strength: 0
Specular Strength: 0.205
Specular Sharpness: 0
Spec As Dirt: 0
Ambient Softness(for dirt): 5

Rusted Chrome

Page 307

http://www.lightcrafttech.com/wp-content/uploads/2014/05/ReflectiveShader.png
http://www.lightcrafttech.com/wp-content/uploads/2014/05/Shader-library-2014-Docs-4.png
http://www.lightcrafttech.com/wp-content/uploads/2012/05/render.png
http://www.lightcrafttech.com/support/dashboard/
http://www.lightcrafttech.com/wp-content/uploads/2014/05/UnrustedChrome.png


Previzion - User Manual
by Lightcraft Technology

 

Opacity: 1
Bumpiness: 0.13
Reflect Intensity: 0
Reflect Softness: 0
Diffuse Strength: 0
Specular Strength: 0.205
Specular Sharpness: 0
Spec As Dirt: 1
Ambient Softness(for dirt): 5.465

Download sample materials from the Dashboard, sample texture files
provided by SurfaceMimic.
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Thin Glass Shader

Thin Glass Shader

The Thin Glass shader is for transparent surfaces through which you
want to see other elements in the scene. A typical use is for a car
windshield or windows that look onto other modeled geometry in a
scene. Note: the shader cannot currently distort the appearance of
objects behind it (e.g. with bumps).

As seen in Maya the controls are:

Sampling anisotropy can generally be left at 4x. It's the number of
passes made to reduce aliasing or “jaggies” on textures that have high
contrast (e.g. checkerboard floor patterns) as they get farther away from
camera.

The “diffuse sampler” is the color texture painted on the transparent
surface. It uses the UV set indicated by “UV” to map onto the object.
The surface is simulated as a layer of (base) color glass with mirroring
underneath.

The opacity setting determines how much one can see through the
mirror layer. Highlights and lighting effects on the glass above are not
affected by the opacity.

The normal sampler points to an RGB color texture generated with one
of several available tools (NVidia has a Photoshop plug-in). It uses the
same UV set as the base color texture.

The reflection sampler needs a “latitude / longitude” spherical
panorama of medium to high resolution (e.g. 1k). The intensity of the
effect, its “softness” indicating roughness of the surface can be varied.

The Blinn-Phong point light has a color, a position in global coordinates
of the scene, diffuse and specular strength and specular sharpness. Its
often useful to constrain the position to windows for interiors or the sun
in outdoor scenes.

An additional trick is that the specular layer can be illuminated by
ambient IBL to look like “dirt”. The intensity of the effect (amount of IBL
light) and the softness can be varied. Note that for simplicity the
reflection map is used, and the softness value will need to be higher.

The final parameter rotates the ambient environment map on the global
Y axis. This allows matching the ambient lighting to an environment
bubble or cyclorama which may be positioned differently.

Download

Download the Shader Library 2014 package from the Dashboard.

Materials

Windows

DiffuseSampler: White JPEG
Opacity: 0.25
Bumpiness: 0.2
Reflect Intensity: 1
Reflect Softness: 1
Diffuse Strength: 0
Specular Strength: 0.205
Specular Sharpness: 0
Spec As Dirt: 1
Ambient Softness(for dirt): 5

Download sample materials from the Dashboard, sample texture files
provided by SurfaceMimic.
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Thick Glass Shader

Thick Glass Shader

The Thick Glass shader is intended for glass items at the back of a
scene where the only thing visible through it will be the environment
bubble. Unlike the “thin” glass shader this one can refract the
background image.Its not yet possible to see other CG geometry in the
scene by looking “through” it, only the background environment map.

The controls (as seen in Maya):

The softness sliders blur the reflected and refracted textures, making
the thick glass appear cloudy. Lower values (down to zero) are sharper,
while higher values appear less distinct.

Falloff amount produces a bias on the Fresnel term, which is calculated
from the indexes of reflection and refraction. This varies the transition
from looking through the object (along the line of sight) versus glancing
off and seeing the environment reflected.

The environment sampler is a latitude/longitude texture map of
medium-high resolution (e.g. 1k) of the object surroundings.

Intensity is a brightness multiplier.

The refracted and incident IOR (indices of refraction) model the
refractive power of the media on each side of the surface. Changing
these alters how light rays are bent going through or off of the surface.

The final parameter rotates the ambient environment map on the global
Y axis. This allows matching the object’s environment map to an
environment bubble or cyclorama which may be positioned differently.

Download

Download the Shader Library 2014 package from the Dashboard.
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Smoke Shader

Smoke Fade Shader

The smoke fade shader addresses a very specific but surprisingly
common need: a smoke or steam effect, usually animated with a video
texture, that can appear to be emitting from a hose or grating. Placing a
rendered video card with a steam or smoke texture into the surface will
have a hard edge.

The smoke fade shader defines a ground plane into which the texture is
faded, looking like its appearing just above the surface.

The controls (in Maya):

The shader is intended for flat cards placed in the scene, with smoke
texture or movie on it.

The alpha channel for the card can come from one of three sources:

Static alpha channel in the color texture itself
A separate alpha channel texture (typically for video textures)
Generated using a “clip level” value from the brightness of the
color texture

Either of the two boxes “Use AlphaSampler” and “Alpha
Clipmap/Stencil mode” can be checked to enable the options. When
neither is selected the alpha channel of the color texture will be used (if
present, if not the texture will be solid).

When the AlphaSampler is selected the Alpha Channel option indicates
which of its color channels to use for transparency: 1=red, 2=green,
3=blue, 4=alpha (if present).

When “Alpha Clipmap/Stencil mode” is selected transparency is
generated from the Alpha Clip Level value.

Floor height indicates the height at which the smoke fades to nothing.
Decay distance indicates the distance over which the fading will occur

Smoke intensity helps adjust brightness.

Download

Download the Shader Library 2014 package from the Dashboard.
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Alpha Textures

Overview

The secret to a successful transparent object is a good Alpha texture.
Clean alphas are especially important when planning to finish in-camera
with Previzion. This page will go over what to look for in an alpha and
how to fix it, if necessary.

TextureAlpha.cgfx

This shader takes the Texture.cgfx and adds on an Alpha. You can use
an Alpha sampler image or use the Color Samplers alpha channel. You
are able to select which channel you would like to use.

Furthermore you are able to use an Alpha clip as opposed to Alpha
blend, and are able to edit the clips range.

TextureAlphaLightMultiUV.cgfx

This takes the previous shader and applies an Alpha Sampler. This
shader works especially well for foliage, as you can acquire source
textures that contain alpha, and render out lighting on a separate UV
Set.

 Setting up Multiple UV Sets

In order for these Multiple UV Set shaders to operate correctly, you will
need to follow one simple guideline. The shader input "UV" requires the
primary default UV Set. This means when viewing the UV Sets in
Create UVs > UV Set Editor, the top UV Set is the default, in this
case map1. "UV2" can then be filled with the second UV Set. Look
below for an example of two separate UV Sets applied to the same
object.
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Aliasing

When using an Alpha it is important not to have an aliased edge.
Aliasing will cause your edges to be jagged and unrealistic. Alpha
aliasing is independent of geometric aliasing, which Previzion accounts
for and renders with antialiasing.

Correcting Aliasing

Most aliasing is easy to correct with a simple blur in Photoshop.

For example, this alpha has a rather harsh edge which will not be
realistic when rendered.

To fix an edge like this, simply open in Photoshop. Zoom into the edge
of the alpha and use Filter > Blur > Gaussian Blur… If you set the blur
between .2-1.0 you should be able to achieve a blur that is between 3
and 4 pixels wide. The 3-4 pixel blur will give you a clean edge in
Previzion without aliasing. A blur larger than this will cause the alpha to
have a faint "ghosting" which will not look optimal for finishing
in-camera.

Using Alpha Clip

Using the Alpha Clip setting has it's benefits for the ability to get an
infinite level of alpha stacking, without any z-fighting. The cleaner the
alpha, the lower the alpha clip can be and the better it will look.

Creating Alphas

Photoshop

For objects that don't have many sharp corners (less than 30°) you can
do a simple selection in Photoshop. When working with an image on a
white background, under Select > Color Range… you can select the
range of Highlights from the Select drop down. and this will give you a
solid outline of the desired Alpha. Fill this in with black and leave the
section where the image exists as white. Check your edge and blur
slightly if necessary.

Illustrator

If you come across a texture, such as a palm frond, that you cannot get
a semi-automated alpha from you can use Illustrator. Create the outline
in Illustrator, and rasterize in Photoshop.

Automated

To do a live trace, go to Object > Live Trace > Tracing Options…  use
the default settings, and adjust the Threshold until the silhouette fits.
After the live trace is complete use Expand on the top tracing toolbar.

Manual

Simply use the pen tool to outline the shape and bring that shape into
Photoshop to adjust the blurring on the edges.

Bring the shape into Photoshop and rasterize. When the edges are
properly blurred, line up the shape over the image and verify the look in
Maya and Previzion.
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Displacement Shader

Overview

This shader, built from the standard color correction shaders, can be
used for mimicking animated cloth. With this shader you will be able to
run animated flags and cloth in your scenes using a video to drive the
displacement.

Attributes

The main functions of the shader are to provide displacement driven by
textures.

Color Sampler
Input for Image map

DisplacementSampler
Input for Image map

Displacement Scale
default: 300
range: [0, 500]

Displacement Blend
default: 0.5
range: [0, 1]

This shader also uses a full color correction system, editable in
Previzion individually and globally with other color correction
shaders.  Courtesy of Christian Bloch(EdenFX/HDRLabs.com).

Exposure(f/stops)
default: 0
range: [-2, 2]

Gamma Correction
default: 1
range: [0, 1.5]

Offset Brightness
default: 0
range: [-0.5, 0.5]

Final Contrast
default: 0
range: [0, 1.5]

Shadows
default: Black (0, 0, 0)
range: [+/- ?] Full color spectrum

Midtones
default: Gray (0.5, 0.5, 0.5)
range: [+/- ?] Full color spectrum

Highlights
default: White (1, 1, 1)
range: [+/- ?] Full color spectrum

Saturation
default: 1
range: [0, 2]

Movement Generation

To make the flag displace in the proper direction, the flow of the video
must be from left to right. This video shows what a wave for a flag looks
like. This effect was rendered from Maya and blurred in After Effects.

http://www.lightcrafttech.com/videos/SampleVideo.mp4 

Apply the video to the DisplacementSampler attribute of the shader as a
video_name.jpg this will allow you to attach the video to that attribute
while in previzion. Apply a flag texture to the ColorSampler attribute.

To create a double sided flag, duplicate the front facing side and move
the duplicate just behind front face, the closer they are together the less
the chance of odd intersection. Next apply a separate instance of the
TextureDisplacement.cgfx to the back side, reapply the
DisplacementSampler file from the first side. Next open your flag image
file in a photo editor and flip it horizontally, by doing this the ripple will
be in sync with both sides. If you edit the UV set to flip the reverse side
you will change the direction of the ripple.

After exporting, you can bring the scene into Previzion and attach the
video to see how well the video moves the flag. Note: You may have to
tweak some of the shader properties to get a good look.
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http://www.lightcrafttech.com/videos/flag.mp4 

Download

Login to the Dashboard to download the TextureDisplacement.cgfx.

TextureDisplacement.cgfx - Last Updated: March 15th, 2013 @

3:52p PST

To download a sample of this asset download go to the Virtual Set
Creation section of the Dashboard.
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Wireframe Shader

The wireframe shader is useful when needing to test an object's
position in space and to make sure live action is lining up with CG
characters. In this situation, the live action ground could be recreated as
a 3D mesh and then viewed in Previzion using this shader. This shader
is simple and performs only operations regarding wireframe rendering.

"Transparency"
this defines how opaque or transparent the wireframe
will be
type: float
unit: normalized color
range: [0,1]
Previzion Name: "transparency"

"Hide Backfaces?"
Turning this on will hide all lines that face away from the
camera
It make it easier to see through objects
type: boolean
range: on/off
Previzion Name: "hideBackFaces"

"Depth Range (cm)"
Useful when rendering the wireframe with depth based
coloration
This value sets the max distance from the camera when
defining colors
Setting a smaller value will show change in depth over a
tighter range
type: float
unit: centimeters
range: [0,+?)
Previzion Name: "depthRangeInCentimeters"

"(On) = solid color; (Off) = depth colors"
Toggle between rendering a solid color or rendering
depth based coloration
When on, shader will render a solid color
type: boolean
range: on/off
Previzion Name: "useSolidColor"

"Color for Solid Color Render"
Defines the color when rendering the wireframe with a
solid color
type: float3
unit: normalized color
range: R-> [0,1], G-> [0,1], B-> [0,1]
Previzion Name: "solidColor"

 

Download Latest Version

You may download the latest Wireframe.cgfx from our Dashboard.

Last Updated: Aug. 16th, 2011 @ 2:46p PST

Update Notes

Aug 16th, 2011
Initial Upload
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Transparent Video

Transparent Video Overview

MPEG2 does not support transparent video by default, but we can
create the same effect by decoding 2 MPEG2 video streams, and
assigning them to different channels of a custom CgFx shader.

This shader supports graduated, or smooth, alpha channels. This will
allow for long slow alpha gradients. This is an example of a supported
alpha mask:

Assigning Shaders in Maya

Go to Window->Settings/Preferences->Plug-In Manager.
Enable Loaded and Auto Load for cgfxShader.mll, and close the
Plug-In Manager.
Click Create->Polygon Primitives->Plane.
Click Create UVs->Automatic Mapping to apply a UV set to the
plane.
Select Shading->Smooth Shade All and Shading->Hardware
Texturing.
Enable the Hypershade/Perspective view.
Click the Cgfx Shader shiny ball icon to create a new CgFx
material. It will be pink by default.
Middle-click and drag the pink ball over the recently created
plane to apply it to the plane. The plane will turn pink.

Select the cgfxShader1 tab. Your screen should look like the
above image.
Download the TextureAlpha.cgfx from our Dashboard.
Click on the folder to the right of the CgFx File area. Navigate to
the location on your hard drive where you saved the
TextureWithAlpha.cgfx file, and select the file.

Applying Textures

Click the checkerboard box next to the ColorSampler line, select
File, and click the folder to the right of Image Name to pick the
image with the desired RGB colors. Any alpha data will be
ignored.
The image must be named with the "video\_" prefix to be
recognized as a video target by Previzion.
Click on the polygon to show the cgfxShader1 tab again, and
click the checkerboard box next to the AlphaSampler.
Select File as before, and select the image that will be used to
drive transparency. As before, this needs to be named with the
"video\_" prefix.

The only part of the transparency image that will be used is the 
R channel. Since matte images are by nature grey scale, the
red, green, and blue channels are all identical, so the choice is
arbitrary.

The resulting image should appear as above. A red sphere has been
placed behind the polygon plane to demonstrate the correct
transparency display in the viewport.

In order for the CgFx shaders to be embedded in the FBX file, the
Embed Media box must be checked in the FBX export.

The above image shows how this appears when loaded into Previzion,
with a red sphere behind the plane to demonstrate transparency. The
correct MPEG2 RGB and grey scale matte videos can then be loaded
and linked to the appropriate video targets.
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Knockout Shader

Knockout Shader

The Knockout shader is used to mask elements of the CG render when
composited against the video feed in Previzion. This shader cuts a hole
in all CG elements that are behind it, NOT in front! The shader shows
no remorse in cutting holes in CG elements.

 

Download here:

You may download the Knockout Shader from our Download Manager.

How it works…

Any object with the knockoutShader assigned creates a hole in the
alpha channel of the rendering of the CG plate. This hole in the alpha
allows for the background video plate to be seen. Any part of a standard
3D element which is rendered behind the knockoutObject will be hidden
by the knockoutObject. Any part of the standard 3D object NOT
occluded by the knockoutObject will be rendered  as normal and will
occlude the background video plate.

Wireframe Mode…

Because the shader is essentially a black hole, an additional wireframe
mode has been added. To turn it on, set the value to "1."

For more information, click here
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Assigning CGFX Shaders

1. Load the CGFX Plug-In

This illustration shows how and where to set the CGFX Plug-in for Maya
2011.

Make sure to select "Auto load" from the "Plug-In Manager."
This ensures that the CGFX plug-in will load even if Maya
restarts (save your preferences before a crash, or close Maya
normally, to remember this setting)
Window -> Settings/Preferences -> Plug-In Manager

2. Create a CGFX Shader

Through the Hypershade window you create new CGFXShader
materials. Now that the plug-in is loaded you will see a button to create
CGFX in the Hypershade

3. Assign the shader program to the Maya
CGFX Shader

When viewing the selected shader in the Attribute Editor

1.click the yellow manilla envelope icon
2.Select your desired *.CGFX shader file from the Open menu

and accept
3.The *.cgfx file is now loaded into the CGFXShader material in

Maya

4. Assign the Material to an Object

1.Select the object to which the new shader belongs.
2.RMB+Hold on the object: do not let go of RMB+Hold until all

steps below are complete
3.Navigate to Assign Existing Material
4.Drag mouse over desired material

5.Let go of RMB+Hold over the desired material

5. Assign the appropriate UV sets and Color
sets to the shader

This step is important because this section describes how to assign UV
sets and Color sets to assigned CGFX shaders. If the wrong UV or
Color sets are assigned you will see unexpected results or a solid color
over the whole object

1.In the Attribute editor for the desired shader
2.RMB+Hold over the Color attribute in the Vertex Data section

and select the appropriate Color Set (provided this object has a 
color set assigned)

3.::NOTE:: Not all CGFX shaders use color sets so this attribute
may be missing in some shaders

4.This is the same process for assigning UV sets

6. Assign desired textures & 7. Modify
Attributes

Using the CGFX shader now is just like using a Maya material. Each
shader has a different use and set of functions, just like the various
Maya materials. Both shaders and materials have different render times
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based on shader complexity

Vertex Data

When Passing Data Using Structs in your Shaders

This is an example of CGFX shaders that use structs to pass data
between the internal vertex and fragment programs. The benefit of
using structs in your shaders is attribute types are only listed once. In
this example, as contrasted from the one below, you'll notice that "UV"
is mentioned only once

When Passing Data Using Individual, Local Semantics in your
Shaders

 

Duplicate UV and Color set Names

What you see below is one of the most common errors with CGFX
shader use in Maya. The below illustration shows what happens during
the following conditions

1.When a CGFX Shader is assigned and is looking for a UV set
name that is not located on an object, even when the shader is
assigned to the object

2.When two objects are assigned to the one shader but have
different UV Sets names

 

Troubleshooting CGFX Shaders

Q: My Textures Aren't Showing Up!

1.This is most often caused by the CGFX shader looking for a UV
set name that is not found on the affected mesh.

2.CGFX shaders are only viewable in Hardware Texture mode.
1.To enter Hardware Texture mode press the hotkey 6

 when the persp window is active.

Q: My objects are Pink!

1.Make sure you have a valid .cgfx file and path loaded into the
material attribute editor.

2.Make sure the CGFX plug-in is loaded.
3.Make sure your project folder is set to the right directory,

otherwise a newly opened file may look like it doesn't have
shaders  attached. File > Set Project…

Q: My Objects are Green!

1.Make sure you're viewing in Hardware Texture Mode.

Q: Transparent objects have weird, blocky artifacts!

1.This shows up on some Fermi level cards. Update your nVidia
driver to the most recent version.
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Animation

Animation Overview
Prelink for Maya
Prelink for MotionBuilder
Previzion Binding
Network Setup
Performance and Skeleton Selection
Scene Editing
Precam Configuration
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Animation Overview

Previzion's scene animation system enables objects in the 3D scene to
be driven by external sources of animation over a standardized network
data protocol. This enables the use of external character animation
tools such as Autodesk Motionbuilder, Autodesk Maya or motion
capture devices as animation sources, while still using Previzion's
rendering and video synchronization tools. To enable live animation in
Previzion, you will need a Prelink license to run on an external system
(i.e. a laptop running Motion Builder).  Lightcraft make Prelink plugins
for both MotionBuilder and Maya.

Data Protocol

Previzion's data format uses a series of TCP/IP packets, one for each
frame of animation. Each packet is formatted in XML, with formatting
very similar to that of a Collada document, and contains a series of data
tags: - A frame timecode tag (optional) - An object node name,
specifying the transform that the animation data will be applied to - A
4×4 Collada-formatted transformation matrix that describes the
complete scene position, orientation, and scaling of the object"s
transform An example of a packet is provided below.

 

The general construction of the packet is very similar to a Collada
document, and the use of a standardized matrix transformation
removes the possibility of confusion from various Euler angle
interpretations. The use of the named node ID tag also means that
routing the data to the correct scene transform is straightforward. 'The
addition of the timecode stamp means that any application receiving
data in this format can very easily synchronize multiple inputs with a
simple queue function. Stage operations can be readily handled with
existing Ethernet connections, with packet communication occurring on
a given TCP/IP port.

Supported Animation Types

Previzion presently supports rigid body animation, for on set
previsualization purposes. Skinned animation is planned for a future
point.

Rigging

Since skinned animation is not presently supported, when rigging
characters in 3D applications, a skinning modifier is **not** used.
Instead, the various body components are modeled as separate
components, and parented to the corresponding joints on the skeleton.

The above image shows how the geometry is parented to specific
bones. The recommended bone naming convention is simply to use
MotionBuilder's standard bone naming convention; this way characters
can be rapidly and automatically characterized to control rigs inside
MotionBuilder.
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Prelink for Maya

Prelink for Maya  is a plug-in that allows Autodesk Maya to transmits
animation data transforms over the network into a Previzion system for
real-time character and object animation.

This enables any motion capture system that integrates with Maya to be
used with Previzion, and take advantage of Previzion's frame-accurate
time sync and optically matched renderer. This also enables any Maya
animations to be used with Previzion.

Adding objects to animate is a simple task of dragging and dropping
animated nodes to the new prelinkNode inside Maya. This allows artists
to work in an environment they're comfortable with and use all the
animation controls they already work with.

Installation Process

For Maya 2012 and 2013

Download Prelink for Maya/MoBu 2012/2013 from the Dashboard.

Unzip the Prelink installation folder and run
the Install_Prelink_2012x64.exe.

Follow the instructions to install Prelink.

If you have MotionBuilder as well, install the plug-ins. If not, disable the
installation of MoBu Prelink/Precam.

Use the repair setting of the HASP Run-time Setup.

If you receive a redistributable error like this, disregard and close,
everything will still work with the newer version.

Once installation is complete you can use Prelink with Maya 2012,
using the same methods as before. Be sure the prelinkNode.mll plug-in
is loaded in the Plug-in Manager.

For Maya 2011

This alpha release requires the Microsoft Visual C 2010 Runtime
libraries be installed.

Download the Microsoft Visual C 2010 Runtime
Download and install the license key driver.
Download Prelink for Maya/MoBu 2011 from the Dashboard.
Place libprelink.dll in Maya's bin (C:\Program
Files\Autodesk\Maya\bin).
Place prelinkNode.mll in Maya's plug-ins directory (C:\Program
Files\Autodesk\Maya\bin\plug-ins).
Load Prelink using the Plug-in Manager in Maya: Window >
Settings/Preferences > Plug-in Manager Next to prelinkNode.mll
check the boxes for "Loaded" and "Auto load"

Using Prelink

Prelink is implemented as a Maya ObjectSet. Only DAG nodes can be
transmitted.

Creating prelinkNode

To create a prelinkNode type createNode prelinkNode in the
MEL command line and hit Enter.

Open the Outliner  under Window > Outliner
To select all the joints in a scene, e.g. if the scene has a single
animated character, use Edit > Select All by Type > Joints
To add nodes simply middle mouse button drag them onto the
ObjectSet(prelinkNode1), or select them and use the "sets"
command, (e.g. sets -edit -forceElement prelinkNode1)
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Transmitting Data

To begin transmitting updates to Previzion, open the
prelinkNode, then open its "Extra Attributes" and set the server
address and port, then check "Server Open"

The "Server Connected" checkbox indicates if the connection
was made. It unchecks if the connection is lost, e.g. if the server
address or port are edited the connection is closed. You must
exit the editing mode for the address and port fields before a
connection can be re-established.
The transmission rate is given by the Maya timeline. It is
recommended to set Maya Preference: Window >
Settings/Preferences > Preferences > Settings > Time Slider >
Playback > Playback Speed to Real-time (24fps), or what the
animation is set for.
Nodes in the object set can be operated on in the GUI, or
animation played. Either way their transforms will be sent to
Previzion.
Only the transforms in the prelinkNode are sent. Operating on a
node, e.g. translate or rotate, will not be sent to Previzion.

 

Common problems:

If you encounter a message similar to "Failed to load dynamic library"
when you attempt to load the plugin, it is likely that either the license
key driver or libprelink.dll are not installed correctly. If the server
(Previzion) goes down, the plug-in will not yet report that.

Known bugs:

Some callbacks fail to clear. This may leak memory or reduce
performance after multiple add/remove cycles.
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Prelink for MotionBuilder

Prelink for MotionBuilder is a plug-in that allows Autodesk
MotionBuilder to transmits animation data transforms over the network
into a Previzion system for real-time character and object animation.
This enables any motion capture system that integrates with Motion
Builder to be used with Previzion, and take advantage of Previzion's
frame-accurate time sync and optically matched renderer.

We currently support MotionBuilder 2010, 2011, 2012, and 2013.

Installing Prelink for Motion Builder

Prelink is a plug-in for MotionBuilder that transmits animation data
transforms over the network. This enables any motion capture system
that integrates with Motionbuilder to be used with Previzion, and take
advantage of Previzion's frame-accurate time sync and optically
matched renderer.

MotionBuilder 2010-2011, Windows XP/32

Download Prelink for Maya/MoBu 2011 from the Dashboard.
Download and install the Visual Studio 2010 x32 redistributable
Download and install the hardware protection key installer.
Place the Prelink plugin in the C:\Program
Files\Autodesk\MotionBuilderxxxx\bin\win32\ plugins directory.

MotionBuilder 2012 and 2013, Windows 7/64

Download Prelink for Maya/MoBu 2012/2013 from
the Dashboard.
Unzip the folder and run the InstallPrelink2012x64.exe.
Follow the instructions to install Prelink and Precam.

Use the Repair setting for the HASP Run-time Setup.

If you get a Redistributable Setup error, disregard and close.

Prelink Transform Selection

The connection from MotionBuilder to Previzion is achieved through the
Prelink plugin. To use: Drag and drop the Prelink plugin from the
Devices tab in Motionbuilder's Asset Browser into the scene.

 

In MotionBuilder's Navigator window, select the desired joints and
transforms in the Prelink model list (1). Then choose Add Selected (2).

Note: Prelink sends each transform as a local transform, so all
transforms between the root scene node and the character must be
dragged into Prelink to match character scene motion between
MotionBuilder and Previzion.

Set the Export FPS to match the camera speed, in the Stream
menu.
Set the timeline frame rate to the correct frame rate (3).
Set the frame interpolation to No Snap (4).
To move individual scene elements around, select the object
and click Add Selected in the Prelink window.  After moving the
object, click Sub Selected to remove its transform from the list
being continuously updated.

Deselecting From List UI Quirk (MoBu 2010)

Due to a Motionbuilder 2010 interface quirk, the way to remove nodes
from the list requires 2 steps:
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Click on the node in the list to highlight it, then click Select
Highlighted.
Click Sub Selected to remove the selected node.

Prelink Network Configuration

Change to the Communication tab in the Prelink UI.
Type in the IP address of the Previzion system you wish to
connect to (available in the About button on the Previzion
system in the Systems tab.)
Change back to the Stream tab, and click the Online square. If
both machines are on the same network, and the IP address
was correctly entered into the previous step, the light will turn
green and the link will show up in the Previzion Systems tab.

Enabling Timecode

To embed the time code of the current frame into the data packet,
select Send Time->Local in the Prelink Stream tab.  To set
Motionbuilder into displaying the current frame in timecode mode, right
click on the Timeline, and select Time->Display as Timecode.

The incoming timecode frame from Prelink will be displayed in Previzion
next to the incoming video timecode with the label Animation, and will
be written into the take file.
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Previzion Binding

Previzion Animation Binding

Load an FBX scene with a matching set of transforms to be
animated. The character can be in a different scene, but must
have the same named skeleton and location transforms.
With the new TCP/IP Prelink data stream, there is no longer a 
need to press 'Bind' on the Previzion side. When an animation
connection is made over Prelink, the animated transforms are
automatically bound to the incoming data.

Page 327

http://www.lightcrafttech.com/images/manual/Prelink_NetworkNew.jpg


Previzion - User Manual
by Lightcraft Technology

Network Setup

Setup Steps

Power up router
Turn off wireless option
Connect MotionBuilder or Maya system to router
Connect Previzion to router
Open About menu in the System tab of Previzion
Obtain IP Address
Input IP into Motionbuilding or Maya interface

Continue to Prelink Configuration

Required Materials

Router
Our systems are tested with the Netgear Wireless-N 300
Router.
2 x Ethernet cables
Computer running Motion Builder 2010-2013 or Maya
2011-2013, with Win XP or Win 7
Previzion System
Prelink Dongle and Plugin
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Performance and Skeleton Selection

Animation Performance

The animation performance panel shows what fraction of the available
thread processing the incoming packets are using, the present queue
length of packets waiting to be used, and the incoming timecode on the
packets. These numbers update once per second when video is
running.

The incoming animation timecode is also displayed on a per-frame
basis in the screen text next to the video timecode, with the 'Animation'
description.

Missing Nodes

Previzion builds a fast lookup table when receiving animation nodes, to
make the process of transferring animation data to the scene faster.
When a node that is not part of the lookup table comes through,
Previzion searches the scene to add it.

This can cause a problem if the scene being used to transmit animation
data has nodes that don't exist in the Previzion scene, as Previzion will
search the scene every time that the unknown node comes through.
This dramatically slows down performance. To provide a warning, the
Missing Nodes light will go on when a Prelink animation node is
received that has no match in the Previzion scene.

Packet Monitor

When clicked, the Capture button will begin recording incoming
animation packets until clicked again to stop. A dialog menu will come
up to choose the name and location of the resulting text file.

 

 

 

 

Transmit Only Skeletons

Since the geometry of a character is parented to the skeleton, it is
wasteful to transmit the geometry transforms in addition to the skeleton
transforms.

To select only skeletons in Motionbuilder, select Display->Models
Visibility in Motionbuilder, and uncheck everything except Skeletons.
This way, the skeletons can be quickly selected and added to the
transform list.

Make sure that any parent transforms are also added, by verifying the
transform stack in the selected skeleton goes all the way up to the
scene root.
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Scene Editing

 

Moving Objects

To move individual scene elements around, select the object and click
Add Selected in the Prelink window. After moving the object, click Sub
Selected to remove its transform from the list being continuously
updated.

Hiding Objects

To remotely hide or display an object in Previzion, select the
corresponding named object in Motionbuilder and uncheck its Visibility
attribute in the Properties panel of the Asset Browser.

The object must be in the transform stream list.
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Precam Configuration

Precam Installation

Precam uses streaming network data from Previzion to drive a matched
camera inside Motionbuilder.

To install, place the version matched to the Motionbuilder installation
into

C:\Program Files\Autodesk\Autodesk MotionBuilder 2011
32-bit\bin\win32\plugins

or the equivalent directory on the system.

Adding Precam to Scene

To add Precam to the scene:

Drag and drop it from the Asset Browser into the Motionbuilder
scene. A Precam device will show up under the Devices list.
Double click this to bring up the Precam user interface.

Configuring Network

Change to the Communication tab in the Precam UI.
Type in the IP address of the Previzion system you wish to
connect to (available in the **About**) button on the Previzion
system in the Systems tab.
Change back to the Instruments tab, and click the **Online**
square. If both machines are on the same network, and the IP
address was correctly entered into the previous step, the light
will turn green and the link will show up in the Previzion Systems
tab.

Adding a Precam Driven Camera

Click the dropdown box under Model Binding (highlighted
above) and select Create. This will create a camera in the
scene called Precam: Camera.

Setting Camera Resolution

Double click Precam::Camera to open the Camera UI.
Select Picture Format and set it to HD. This will set the default
window display to a 1920×1080 resolution, as shown above.
The actual window resolution shown will of course depend on
screen real estate.

Matching Frame Rates

To ensure proper performance, make sure that the source
Previzion system and the Motionbuilder system are both running
at matching rate (whole number or video fraction) and TC
counts per second.

Viewing Camera

In the Viewer window, select View->Perspective->Precam:
Camera to enable the Previzion-driven camera to be displayed.
It will now render to the viewport with identical position,
orientation, and field of view as the Previzion camera.

No Distortion

The Motionbuilder camera does not render using lens distortion data, so
the visible scene may be somewhat wider or narrower at the screen
perimeter, depending on the amount of distortion in the physical lens.
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Legacy Photogrammetry
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Photogrammetry

Photogrammetry
Photoscan
Retopology
Modo – Import
Modo – Texturing
Modo – Topology
Optimization
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Photogrammetry

Photogrammetry

The photogrammetry process is used to provide high complexity,
extremely realistic virtual sets from a series of photographs. We are
introducing a new pipeline to speed up and increase the quality of
Photogrammetric set creation for real-time virtual integration.

Process

This process for creating scenes will be adaptive to the level detail you
will want to achieve.

1.Photographing a location
2.Point cloud generation, dense mesh solving with Agisoft

Photoscan.
3.Automatic retopology and UVs in Modo, Mudbox or ZBrush.
4.Texturing geometry

1.Via automatic texture projection in Photoscan.
2.Via hand painting in Modo or Mari.

5.Optimization with 3D software.

1. Photography

This initial step is very crucial, as it can set the tone for the entire
project. Things like, camera, shooting style, time of day and weather

can all affect the outcome. In all of our tests, we have been using

Prosumer cameras, Nikons, Canons, and Panasonics with resolution of

4K+. Tests have yet to be done with Professional film cameras.

Camera Settings

Lock shutter speed, fast enough to eliminate motion blur.
Use a small enough aperture to keep everything in focus. An
f-stop closer to f11 - f16 will be optimal, sometimes the lowest
aperture, like f22, can cause defraction making images overall
less sharp.
Lock ISO to a low setting (ex. 160), to avoid grain.
Lock exposure to desired look.
Use a neutral white balance, making it easier to color correct
later. If you're shooting JPEG this is critical, if you're shooting in
Raw, it can be fixed later.

Procedure

The method to which the photos are taken also has a great
impact on the results. When capturing texture data you will want
to have views from all angles. Usually a method
of orbiting objects and walking parallel to walls while shooting
with 20-40% overlap, will provide the necessary parallax needed
to generate a point cloud. Parallax is needed when solving for
small details like cracks in brick, slots in wood, or other rough
textures. It also helps provide optimal texture coverage, so that
no textures are stretched or left out.

Shooting stills or shooting video and extracting every nth frame,
have no difference on the quality of the solve. Stills will generate
higher resolution images. Shooting stills on a burst mode is a
good method for shooting when light is abundant.
You will want coverage of everything from the ground to sky.
When you shoot also has an effect on point cloud solve,
because natural light is not a constant. Depending on the time of
day, you will want to shoot to preserve equal lighting from
beginning to end.

2. Photoscan solving

Photoscan, in recent releases has massively upgraded their solving
capabilities. Making it an essential tool for a photogrammetry pipeline.
Using version 1.0.4 and up, we will go over the steps to achieve a great
solve. On top of accuracy, Photoscan is offered at a competitive price,
download the Standard edition for Agisoft's website.

3. Retopology

Mudbox and Zbrush both have robust automatic retopology tools, while
Modo can be used to do manual retopology. These programs can also
properly lay out the UVs.

4. Texturing

Photoscan is capable of reprojecting textures onto simplified mesh.

Modo and Mari can also be used to paint texture detail, or touch up an
automatic texture.

5. Optimization

This step is sometimes needed to add in transform names to objects, or
break up the set into areas.
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Photoscan

Lens Calibration

Using Agisoft Lens, you can take the camera you used for a
photogrammetry shoot and calibrate the lens to help with aligning
photos.

This is a simple process of taking photos of your computer screen and
processing them into a file.

When completed with lens calibration. Open the calibration under Tools
> Camera Calibration… using the folder icon, open the calibration and
click OK.

Importing Photos

To start a solve import the photos under Workflow > Add Photos…
Select all of the photos you wish to align and click Open.

Masking Photos

Masking photos can help with alignment, by removing any overhanging
objects that may not solve well, like power lines. Clouds can also
sometimes cause issues with solving point clouds.

There are a few tool options for masking photos.

Rectangle Selection (M)
Rectangular selection to make large selections quickly.

Intelligent Scissors (L)
Polygonal selection, to quickly select around features.

Intelligent Paint (P)
Makes large selections based on color range, by clicking
and moving across the image.

Magic Wand (W)
Makes large selections based on a varied color range,
by clicking in areas.

After making a selection you can add to the mask by clicking
Ctrl+Shift+A on the keyboard, to remove areas from the mask is
Ctrl+Shift+S. Moving between images quickly can be done with the
hotkeys for Next, Ctrl+] and Previous, Ctrl+[.

Aligning

After you have gone through all of the necessary photos you can align
the photos to get a sparse point cloud.

Workflow > Align Photos… Set Accuracy to High or Medium for the initial
alignment.

Chunks

Chunks can be used for a few reasons:

 Multiple cameras, lenses, and/or focal lengths used for source
images.
Some sections solve muddled together.

Duplicate chunks by Right clicking and selecting Duplicate. Once
duplicated, remove images from chunk listings.

When multiple chunks are solved, they can then be lined up using
Workflow > Align Chunks…

Dense Clouds

After initial alignment, building the dense point cloud will give you the
information for building the points into a mesh.

Workflow > Build Dense Cloud…

Set Qaulity to High, or Ultra High. For all intents and purposes, there is
not much of a difference from High to Ultra High, while Ultra High will
take longer to compute.

Meshing

Meshing the dense point cloud often produces a model in the 10 million
polygon range. Later we will go over how to reduce that polygon count
while preserving accuracy.

Workflow > Build Mesh… Use High settings.

Building Texture
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For quick transfer to Previzion, you can build a set of high resolution
texture files to be exported with the scene.

Workflow > Build Texture…

Using Generic Mapping mode, with a texture size of 4096. Generic
Mapping generates automatic atlas UV maps based on the number of
textures you output. Depending on the size of the scene you should
create anywhere from 4-20 textures. As a rule of thumb, one side of a 3
story building should use 2 4k maps. And the further away the objects
are the lower resolution they will need.

For texture rebuilding from ZBrush:

To retexture on a simplified mesh, open the file from ZBrush and import
back into the project.

Tools > Import > Import Mesh…

Once the new mesh is in Photoscan, go back through Workflow > Build
Texture… and complete the textures in the same fashion.

If you're using UVs set up in Zbrush, select Keep UVs, instead of
Generic for the mapping mode.

Exporting

For immediate export to Maya for optimization:

File > Export Model…

Save as Autodesk FBX, enable all of the check boxes, and choose the
file type for the textures.

For export to ZBrush for remeshing:

File > Export Model…

Export file as Wavefront OBJ, in default settings.

Textures

JPEGs created in Photoscan will automatically add edge padding along
UV seams.

PNGs will not add edge padding, but there is a Photoshop plugin called
Solidify from Flaming Pear, download with this link. Place the plugin in
the plugins folder in the program files for Photoshop and run the plugin
over the PNG images.
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Retopology

Semi-Automatic Retopology

ZBrush

ZBrush has an impressive set of retopology tools that will allow you to
quickly convert a high density mesh into a low density mesh while
maintaining detail.

Main interaction with interface.

1.Edit Tool (T)
2.Tool Box
3.Geometry Menu
4.ZRemesher program

We will largely use these for automating the process of remeshing. We
will also go into detail on how to clean up any unwanted sections of the
mesh.

Navigation

Move - Alt + LMB

Scale - Ctrl + LMB

Rotate - LMB

Step 1 - Importing

We will be bringing in our OBJ file from Agisoft Photoscan, and
remeshing with ZRemesher.

Click the import button on the Tool menu, and open the OBJ file from
Photoscan. This will load your model to what is called a ZTool. To bring
your ZTool into the workspace, Right click in the workspace and drag to
the side, it does not matter how large the model gets because you can
zoom in later. After you have done the first click and drag, don't click
and drag again, just hit T on the keyboard. This will put it in edit mode
and you'll be able to move around and look at the model.

 

Step 2 - Remesh

To remesh, open the drop down for Geometry. Open the sub drop
down, ZRemesher, and adjust the settings to use Same or Half
resolution, and turn Adapt off. After you have chosen those settings,
click the ZRemesher button. It will take a few minutes to fully compute.

Note: If a Half or Same resolution remesh fails, turn on Adapt and
adjust the Target Polygons Count to max and the Adaptive Size to max.

Step 3 - Cleanup

To cleanup unwanted areas of the mesh, you can use ZBrush's simple
tools. Using Shift+Ctrl+Alt with click and drag, you can select around
polygons to hide. After hiding polygons, then go to the Geometry drop
down, to the Modify Topology sub menu. Hit Del Hidden to delete the
unwanted geometry.

Step 3.5 - Optional UV setup

Since Photoscan can automatically unwrap UVs, there is the option to
unwrap prior to bringing back into Photoscan. This can help with
determining what resolution certain areas will receive. UVs can be
unwrapped using the plugin called UV Master.

Start by breaking down the scene into smaller chunks, called
"SubTools." The SubTool menu can be found in the Tool Menu. To
break down the scene, start by masking out areas using Ctrl+LMB,
either painting the mask on the object or making a large selection by
starting off of the object. To remove mask sections just hold
Ctrl+Alt+LMB, and to clear either use Ctrl+LMB and select outside of
the object or use Clear from the Masking menu.

After you've selected a masking area, open the SubTool menu and the
Split sub menu. To break up the object select Split Masked Point, do
this until the object is broken up to your liking. Keep in mind the size of
object that is going to be projected to UVs. Make sure you rename the
objects, or they will not export correctly.
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Next, you'll want to create polygroups for each subtool. The Polygroups
menu is also in the Tools menu. This operation works similarly to
breaking up Subtools. Mask out sections you want to break into
polygroups, then go to the Polygroups menu and select Group Masked.
Continue this to break up the UVs along seams.

 

When polygroups are completed, it's time to move on to UV Master.
Disable all options other than Polygroups, since that's what information
we'll be using to unwrap UVs. Select Unwrap, the computer will take a
few seconds to complete to UV set. To view the UVs, select Flatten
from the UV Master menu. If the UVs look good, UnFlatten the SubTool.

Step 4 - Export

No UVs

When completed with the remeshing and cleanup, export the scene
back to OBJ. This scene can be brought back into Photoscan for texture
reprojection.

ZBrush UVs

If you use ZBrush for UVs, use the GoZ function for All, and port the
scene over to Maya. Once it's in Maya, re-export it again as an OBJ for
Photoscan.
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Modo - Import

Modo

We are using Modo 601 SP5 from Luxology with Python 2.7.3.  To
download the Python x64 installer go to python.org and download
Python 2.7.3 Windows X86-64 Installer.

Import Script

Download LightcraftImportSFM.py from the Dashboard under Virtual
Set Creation.

Save this file to a local directory, as a suggestion to avoid loss of script
use C:/Users/Username/Documents/Luxology/Content as your location.

Set Resolution

Open the LightcraftImportSFM.py file with a text editor and look at line
113:

hRes = 3648

The Great Wall images are 3648 x 2736. If a different horizontal
resolution is used for source images, this must be changed to match.

Modo Script Execution

In Modo, hit Shift-F5, navigate to the directory where you saved the
script, and select the LightcraftImportSFM.py script. It will prompt you
for the cameras_v2.txt file; navigate to
C:\Photogrammetry\GreatWall\GreatWall.nvm.cmp\00\ and select this
file.

If everything is correct, a new camera called match_cam will be
created, with keyframes 0-numCams that correspond with the positions
of all the cameras. This lets you scroll through all the camera positions
by moving the timeline slider.

Change Sensor Height

Modo defaults to a 36mm x 24mm camera back, which corresponds to
a 1.5 aspect ratio sensor. The 3648 x 2736 resolution test images have
a 1.333 aspect ratio. To adjust this select the match\_cam  > Camera
View > Film Back > Height and set this to 27mm.

Import OBJ Mesh

File > Import and select meshAvImgTex.obj in 
C:\Photogrammetry\GreatWall\GreatWall.nvm.cmp\00\data\\\_OUT\.
Check Import as Static Mesh, and ignore the prompts to select
alternative textures. We are going to retopologize and create our own
textures for the model. It will take some time to import.

Load Image Seqeuence

In the Images tab, select (load sequence), and pick image 00001.jpg in
C:\Photogrammetry\GreatWall\GreatWall.nvm.cmp\00\data.

Under the Items tab, add a Backdrop Item. In the Backdrop tab set the
image to the sequence you loaded, and the Projection Type to Camera.
Set the transparency to 50%.

To match up the Backdrop Item with the Mesh, change the Frame size
to the dimensions of the originals images (3648 x 2736) Shader Tree >
Render > Frame.

Set the current camera view to match_cam. The mesh should overlay
the camera image closely. You can click the eye visibility icon in the
item list next to the backdrop item to verify the lineup. If you don’t see
the overlay, type ‘o’ to bring up viewport settings, enable Overlay
under Background Imagery. You may need to re-adjust the
transparency in the backdrop item to get it to respond.

To access the timeline outside of the Animate tab, create a new palette
for the timeline. Layout > Palettes > New Palette. Click on the small
arrow in the top right corner of the palette and go to Utility > Time, now
resize the window vertically so that just the timeline bar is visible. Map
"Next" and "Previous" frame, for scanning back and forth through the
timeline in Sytem > Input Editor. For Ctrl-Left map time.step frame
prev and for Ctrl-Right map time.step frame next. Scroll the timeline
forward and backward. You will see the camera view change, and the
associated camera image update.

Example Mesh/Photo Lineup

http://www.lightcrafttech.com/videos/ModoMeshRelight.mp4 

Correcting Orientation

If your model was upside-down, sideways, or crooked you can correct
this by rotating all of the elements. To correct your orientation, select
the mesh, match_cam, and Backrop Item and hit CTRL+G, to group
them together. You can then select your rotation tool, E on the
keyboard, and rotate the model until it is level and upright(use the
Model Quad tab to help level the model).
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Modo - Texturing

UV Unwrapping

When creating UV maps the first thing you will want to do is isolate
large sections or group small objects together to share a UV set. For
this section, I isolated one of the walls from the solve in the
walkthrough.

UV Editing

First, make sure you are working on the original UV Map, Lists > UV
Maps. The default map is named "Texture," to keep everything in order
you will want to rename this to a distinctive name with the object, ex.
MainWall. Making sure you have clean UVs overall will prevent texture
seams when baking later on.

Before we start unwrapping you will want to map a function onto a
hotkey. To do this, open up your Input Editor, System > Input
Editor. Ensure that Show Unmapped Keys is highlighted and Shift+Click
the Ctrl and Alt modifiers. Now scroll down to Ctrl-Alt-S, Right click and
select Edit Command… and enter in uv.sew. This will allow you to sew
your points without going through any trouble.

Now that you have gone through the initial steps it's time to start
unwrapping. To begin, while in the UV tab select your mesh you wish to
unwrap in the Items box. Go over to the left toolbar and select the UV
Projection Tool. For a quick unwrap(usually comes out rather nicely),
use the Projection Type, Atlas or Atlas 2. To unwrap, right click in the
UV viewport and watch the mesh unwrap. If you have red overlapping
sections try to use the second Projection Type and vise versa.

Fixing Overlapping UVs

Overlapping

When you find that you have overlapping UVs, use your Vertices,
Edges, and Polygons selections and use your Translate, Scale tools to
move around points and sections to unwrap.

Separated

If there are missing sections within a large section of your UV set, you
can relocate the separated section and sew together the vertices to fit
inside the UV set. Here you will use the sew tool that was mapped.
Select your first stray vertex and hit Ctrl+Alt+S and select Center of

Unselected (This will always be selected for future quick use). The sew
feature also works with mutli selection, meaning you can select multiple
vertices, or edges and this will sew together in the correct fashion.

Once completed you should have a solid UV map of your object.

http://www.lightcrafttech.com/videos/UV.mp4 

Texturing

Setting Up

Go to the Paint tab.

Select your object and hit "M" on the keyboard to create a material for
that object.

In the Shader Tree tab add in a texture by going to Add Layer > Image
Map > (new image). Name your texture and save it as a jpeg or png. In
the New Still window, change the format to RGB and set your
resolution, then select OK.

In the bottom tab menu Image Inks, load in the directory with the
undistorted images with (add path). (To remove paths slide the menu
structure on the left out.)
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Select Paintbrush in the left toolbar, and highlight Image Inks  in that
same toolbar. Find the image that corresponds to your animation
timeline in the Image Inks tab and select it.

Right-Click in the viewport to adjust your brush size. Then click and
drag on the geometry to paint onto the surface. If you encounter an
error, ensure that you are painting on the correct image and UV map,
double check you have the correct texture and object selected, then go
to the Properties tab > Texture Locater > UV Map, be sure you have the
correct UV map selected.

Sometimes a little light tweaking of the image ink may be necessary to
line up certain parts of the geometry that may not have been perfect in
the solve. This can be done with the handles on the image in the
viewport or with the menu structure on the left.

By painting directly on the surface you have an immediate response to
what is being painted.

The more you paint the closer you will get to a finished product. Some
geometry may still need to be tweaked to fit the images, as solves can
be thrown off slightly by lighting changes in photographs.

http://www.lightcrafttech.com/videos/Paint.mp4 

Export

Refer to the Modo-Export documentation on methods for export. You
may have different needs scene to scene, review your options and
determine the best fit.
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Modo - Topology

Retopology

When creating scenes using Photogrammetry, it is very easy to solve
very high density meshes in a very small area. Previzion can render a
large amount of polygons, but it is often unnecessary to have such a
high poly count. Using Modo you can retopologize a solved mesh with a
10 million polygon density down to under 200k.

Blocking Out General Shape

Start by making a new mesh, in the Items tab go to Add Item > Mesh.

In the Topo tab first use the Topology Sketch tool to block out a stretch
of geometry, like a large floor or wall. You can adjust the amount of
divisions by raising or lowering the Segments in the tool parameters,
and edit the width of the row by adjusting Width.

Use the Topology Pen to move the mesh around, add mesh, and move
points around.

LMB - Move single edge
RMB - Move edge loop
Shift+LMB - Extrude from single edge
Shift+RMB - Extrude from edge loop

Do this until you have a mesh that holds the major geometry from the
original solve.

http://www.lightcrafttech.com/videos/Topo.mp4
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Optimization

Maya

In Maya, the scene can be reoriented into the proper alignment.

Scale should also be set correctly, use a correct scale object to
reference the size of the scene.
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Post Production Workflows

Interlaced 50i or 60i Post production workflow
Working with Take Converter
TakeConverter with EDL Workflow
Rendering Previzion Ready Scene in Maya
Importing Data into 3ds Max
Tracking Refinement with PFTrack
Tracking Refinement with SynthEyes
Syntheyes – Legacy Method
Importing Nuke .chan
Nuke Embedded Data Import(Beta)
Automated EDL Extraction
Importing Data from Previzion Take into Maya
Stereo data into Syntheyes
Previzion Data into 3D Equalizer
A Quick Pipeline for Post Rendering a Scene used in Previzion
Rendering Video as Texture in Maya
Batch Rendering in Maya
Reperformance: HDSDI Metadata SMPTE315M
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Interlaced 50i or 60i Post production workflow

Required software

Adobe After Effects
FieldsKit Deinterlacer -Plugin
FieldsKit Reinterlacer -Plugin
Take Converter

Preface

This article is written for VFX people, as well as the curious video
engineer.  I will Frequently say 60, when I mean 59.94, or 30, when I
mean 29.97.  I will use the two terms interchangeably, but there is a
difference.  One of the main differences is that in the modern NTSC
broadcast wold 30, and 60 almost never exist.  This is a world where
29.97 and 59.94 are used, but people will frequently call them 30 or 60
for the sake of convenience.  If you wish to read up on why it is 29.97,
not 30 and 59.94 not 60 and the history of  black and white compatible
color television please read here.

Basics of interlacing

Interlacing is a way of capturing video at a given frame rate, but
capturing 2 different timing intervals in a single frame.  This means that
video captured at 30fps with interlacing will have motion which looks
much more like 60 frames progressive rather than 30 frames
progressive.  This smoother motion has a trade off of halving the
resolution of a single frame into two distinct times.  It essentially allows
the broadcaster to double the perceived frame rate, without consuming
additional bandwidth.

Read more on Wikipedia

Extracting Take Data

Take data is extracted using TakeConverter. The whole process works
normally, except for one thing. TakeConverter and Previzion output
data for each field of video, rather than frame when working with an
interlaced sequence.  This is because each frame of video consists of
alternating lines from two distinct times.  This means that 1 second of
60i/30fps footage will have 60 different camera position captured for it.
Compared to 30P/30fps video, which will only have 30 data points in a 1
second clip.

Deinterlacing

Shoot a 50i or 60i clip

edit the clip in your NLE of choice

Export clip normally from NLE

In After Effects create a sequence that is 50fps if you shot 50i, or
59.94fps if your footage was shot 60i

Import your interlaced clip to After Effects

If you don’t see comb artifacts on your interlaced clips right click the
clip then “Interoperate footage>Main” or Ctrl+alt G

Then under “Fields and pull down” turn Separate fields “Off”

The comb artifact should now show up in section of the video with
motion.

Interlaced comb artifact

Drop the interlaced clip into your 59.94fps or 50fps comp

Apply the “Fieldskit Deinterlacer” to the clip

The settings for the for the deinterlacer are the following:

Timing: 2x FPS
Field order: Upper, but check on the motion of your clip to make
sure when you play back it isn’t choppy, if it is try lower
Fill method:Use “Best 5 Neighbor” you lose a tiny bit of
resolution, but the video will be smoother, which is necessary for
post tracking.
Detect Motion: No Motion Mask

You are done deinterlacing, now export your clip. It is ready to be
worked on in After Effects, Maya,  Nuke or any other frame based
production software as a 50p/60p clip

Reinterlacing

Import 50p/60p clip

Create a comp that is either 25fps, or 29.97fps depending on if you are
working in PAL or NTSC

Drop your 50p/60p clip into the comp

Apply the FieldsKit Reinterlacer with the following settings:

Field order: should be the same as what you originally output.
Output type: Half frame rate

Export your comp at it's native interlaced frame rate.
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Working with Take Converter

Take Converter Overview

Lightcraft TakeConverter is a proprietary application built to process
Previzion metadata and take information.  All tracking data is synced
with footage timecode.

Previzion is not a video recorder, but it does record camera tracking
data via a "take data" protocol.

With take converter, we convert Previzion's tracking data into the
camera tracking format of your choice.

 TakeConverter is distributed free to groups working with Previzion
take data.   The natively supported post production tracking formats are:

Previzion (Collada take data)
Maya (ASCII)
Nuke (.chan)
SynthEyes (object/camera input format)
Boujou (input tracking format)
Flame (ActionScript)

When using Flame's ActionScript format, make sure that, in Flame, the
correct frame rate is selected.  If using 23.98fps, set Flame timebase to
23.98fps, etc.

EDL Support

As of build Take Converter build 7682, TakeConverter is able to import
EDL and match clips in the EDL to Previzion Takes from a given
directory.  Please see the next section for EDL Operations.

Previzion's Take Data

Previzion's take data is saved as a Collada (.dae) file in a wrapper
folder alongside its corresponding thumbnails (optional).

Thumbnails are saved every 10-seconds as PNG files during take roll in
Previzion and can be disabled.  They can also be force generated by
pressing "Capture Now" or hotkey "U" in Previzion.  This is most useful
if the operator wants to save a thumbnail with the slate in frame.

Previzion Takes Tab

Thumbnails save screen grabs at full 1920px width or 1/3 width (smaller
file size) and may be set to save: foreground, HDSDI1 and HDSDI2.
 For more information about recording take data in Previzion refer
to Take Interface -> Recording Takes.

Thumbnails captured during take roll in Previzion are saved with their
corresponding .dae take file.  Thumbnails captured on their own are
saved in a "Thumbnail" folder.

System Requirements

TakeConverter can run on any Windows machine with a 64-bit OS.
Here are the basic requirements:
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Microsoft Windows 7 or 8
64-bit System
Microsoft Visual C++ Redistributable installed

To download TakeConverter and Microsoft Visual C++
Redistributable, login to our Downloads Center for the latest version of
Take Converter and the zip with Sample Tracking Data.

The current version of TakeConverter is build 6538.  Currently there is
no planned OS X port, but TakeConverter has been verified to work in
Intel Mac systems running VM installations of Windows 7, 64-bit, as well
as in bootcamp setups.

Basic Operations

To get started, open Take Converter and select "Browse" to navigate to
your Takes directory. The takes directory is not the wrapper take folder,
but the folder containing all the wrapper take folders.

TakeConverter will then load all the take files that reside in their
corresponding wrapper take folders and list them under the Input
Directory takes list.

Selecting each take will load the thumbnails and metadata for that take
under Take Information.

Most notably, the corresponding thumbnails are loaded to facilitate the
process of identifying and working on takes.  To scrub through all
thumbnails, use the slider under the thumbnail.

You may also view the full size thumbnail within TakeConverter by
simple double-clicking the image.

When the desired take has been selected the in and out points can then
be "trimmed" to the desired length.  The in/out points are usually given
in timecode by editorial.

This is also where you can rename the take as it will be saved as.  If
you choose to maintain the same name and decide to save it in the
same directory as the original it will overwrite the original file.

Take name, scene number, comments, etc., are for referencing takes
and reading what was written on the day of the shoot.  Thus, at this
point, there are not editable.

To add this take to your "Queue," click on the Queue button.  This
makes the process of outputting multiple takes as easy as output a
single take.

Repeat this process of selecting, trimming and queuing takes for all
desired takes.

As you add takes to your Queue, you will notice a cross on your Input
Directory list indicating the takes that have been worked on.

When you are ready to convert your Queue, select where to save the
takes by pressing "Browse" Output Directory under Take Conversion.

This is also where you can select which, if not all, output formats to use.
 Adding more formats does not take up much space and it is
recommended if the operator is uncertain of what output format editorial
intends to use on a particular take.

The "Previzion" output format is the same .dae format as the take data,
but with the trimmed in/out points.

Verify that all takes that need to be converted are indeed in your queue
and double check the output formats.

When you are set, select Convert and all takes in your Queue will be
converted as specified.

A confirmation of all conversions and outputs is displayed in the
conversion log.  This may be saved for your records if necessary.  We
recommend saving this log if converting multiple takes to keep a paper
trail of your work.

For incorporating take converter in an existing pipeline, we recommend
writing your own scripts and triggering TakeConverter over Command
Line as explained below.

Command Line Operation

TakeConveter  also accepts command line operations for allowing
batch conversion and other applications.   Using a Windows Command
Prompt, navigate to your TakeConverter directory (in this case, the
program has been installed in Program Files):

C:\Program Files\Lightcraft\TakeConveter\
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This will bring up the command line options for all of the commands in
the GUI interface, enabling Take Converter to be run automatically in
batch mode.

Example: TakeConverter.exe -f mayaascii -ti 13:54:01:
18
-to 13:58:59:01 -d my/output/Directory -n OutputName
originalTake.dae

To view all options, using Command Line, navigate to TakeConverter
and type:

TakeConverter --help

This will output:

Options:
  -f   FORMAT        FORMAT can be previzion, mayasci
i,
chan, syntheyes, or boujou
  -ti  TIMECODE_IN   TIMECODE_IN is the timecode of t
he
first frame to output 
  -to  TIMECODE_OUT  TIMECODE_OUT is the timecode of
the
last frame to output 
  -d   DIRECTORY     DIRECTORY is the output director
y
  -n   NAME          NAME is the output take name

Format-Specific Options:
  -map PREFIX        PREFIX is added to the beginning
 of
each node's name

For further information on TakeConverter and other Ligthtcraft products
and services, please contact our support team
through support@lightcrafttech.com.
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TakeConverter with EDL Workflow

Working with EDLs

As of build 7682 of Take Converter, TakeConverter supports EDL
format CMX3600. There are many EDL formats, but the one that most
all NLEs (non-linear editors) are able to generate is CMX3600.

In most modern NLEs, there is also another format called AAF
(advanced authoring format) or a proprietary XML format.  These are
intended to be used to migrate entire projects between editing suites
and does not serve the purpose that we need as far as TakeConverter
is concerned.

Generally speaking, if you never worked with EDL and doing an online,
please read the workflow below and the specifications in this section
carefully. The main difference when dealing with EDLs is that you are
restricted to a single video track (or "layer") at a time, so we recommend
keeping all Previzion clips on their own track to make things easier.

EDL Workflow with TakeConverter

Instead of manually typing IN and OUT timecode points for every clip in
TakeConverter, you can now benefit from the use of an EDL, or "edit
decision list" and batch convert your entire project.  This serves as a
good starting point for creating your TakeConverter Queue, saving
valuable time.

There are many reasons to have to render things in post-production,
and, hence use Take Converter.  The flow chart above uses resolution
as a factor.  For example, because Previzion can only render what
comes out of an HDSDI/Monitor OUT signal, we are limited to Full HD
Resolutions (1920×1080 pixels). If a show is intended to be made in 4K
resolution, for instance, during the editing process, editors will be using
the Previzion comp at HD resolution as a proxy, or placeholder, and,
later, when the 4K composites are completed, these are replaced in the
main timeline, like an "online" process would.

The workflow happens in the following manner:

1.We start with the day of the shoot.  The camera records in full
resolution either internally or through a direct RAW output to an
external recorder.  We will call this the original "Clean Green."

2.In Previzion, we receive an HDSDI video input from the camera
to key and composite a CG scene in real-time.  Previzion's
output is then recorded by an external recorded, also in Full HD
resolutions.   We will call this the "Previzion Comp."

3.Also in Previzion, we "roll" a take, which records tracking data
into a directory.  This tracking data contains: camera, lens
position matched to timecode into a file format called Collada, 
Rolling a take in Previzion also records reference thumbnails
and various take information.  We will call this "Take Data."

4.Take Data and the original Clean Green should be organized
by camera (A Camera, B Camera, etc.) as well as date.  This
workflow relies on timecode to match many of the clips together

and it's helpful to keep these organized.
5.In the editing stage, instead of editing using Clean Green, the

editor may use the Previzion Comp to make editing decisions. 
We recommend keeping all Previzion Comp clips to be on their
own video track in your timeline.  This helps keep things tidy
when it comes time to generate the EDL.

6.Once the editor(s) has(have) completed editing, we generate an
EDL for all Previzion clips.   Please see EDL specifications
below.  To reiterate, it's helpful to keep all Previzion Comp clips
in their own timeline.

7.To match the camera moves that were done during shooting to
render at full resolution, you will need to import Tracking Data
for a specific clip.  To do this, we will use TakeConverter.  We
can import the EDL generated for the given project and match
the IN and OUT points for each clip to their respective Take
Data.  Most of the matching is done automatically, but when
there are multiple timecode matches, TakeConverter queries
for which option is the correct clip.  This will create a "Queue"
with all your Previzion clips.

8.We can then batch export the Queue in the format of your
post-production application of choice (Nuke, Syntheyes, Maya,
etc.).

9.You can then import the converted Take Data as a camera
node.  The camera node is already animated with the correct
curves for motion and lens information.  Depending on the 3D
authoring software, you may need to input the correct sensor
size.  This is sometimes called "backplate" or "film back
settings."  This information is located in the original Take Data.

10.Import your final CG scene/environment and the original Clean
Green.  These all should be trimmed to the specific timecode IN
and timecode OUT to match the camera move.  Key your green
and make sure that the composite looks proper.

11.Output the full resolution composite clip.  Use this video clip to
replace the Previzion Comp in your master timeline in your
non-linear editing application.

12.Verify that the motion and the composite look proper and output
your final output.

Previzion Settings

On the day of your shoot, when setting up Previzion, it is very important
to always check that the timecode coming into Previzion matches the
timecode being recorded by the camera and/or external recorders.

For the Take Data to be useful, it's important that you have timecode
coming into Previzion.

In the Takes tab in Previzion, assign a directory to store all your Take
Data.  Here you also have the option of saving reference thumbnails
during recording.  These thumbnails can be 1920 by 1080 pixels in size
or 640 by 360 pixels (1/3 width).  These are very useful when in
TakeConverter to reference each take.  We recommend always keeping
this option enabled and, if possible, in full resolution or "full width."

You can also choose to capture a Thumbnail of the film slate (or
clapboard) with all the scene information by pressing "Capture Now" or
the key "U" in your keyboard.

There are many fields for inputting information about the production and
the given scene that is accessible later in TakeConverter. We
recommend putting as much information about a given scene as
possible (i.e. circle take, bad take, director liked the acting, etc).  For as
long as a Previzion take is rolling you can enter new information.  At the
time you cut a take, all information typed into Previzion is stored as
Take Data.
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Exporting EDL (CMX 3600)

Most all professional non-linear editors have an option to export your
project as an EDL.  Each NLE has their on set of settings that you need
to check in order to output the proper set of clips.  Here are some
recommendations:

Place all Previzion clips in the same Video Track.  You can then
make this track the main track for your EDL.
Make sure to export as CMX3600 format.
Audio should be either ignored or merged as a single track.

Apple Final Cut Pro 7

We recommend that you place all Previzion clips in the same
Video Track and make that your Target Video Track.  The

Target Track indicator looks like:
When you are ready to create your EDL, select:File Menu ->
Export -> EDL…

Apple Final Cut Pro X

Final Cut Pro X is unique in the fact that it's the only "pro" level NLE
that does not have the capability of exporting CMX3600 out-of-the-box.
 To convert a Final Cut Pro X XML into a CMX3600 compliant EDL, you
will need to use an EDL converter such as XMiL's "EDL-X."  (learn more
on XMiL's website http://www.xmil.biz/EDL-X/EDL-X.shtml).

Avid and Avid Media Composer

If you are working with an Avid station, make sure that you have EDL
Manager installed.  Know that, in Media Composer version 5 and
above, EDL Manager is an optional installer.  This is located in the
Media Composer installer as one of the "Helper Applications."

In MC, to open Avid EDL Manager, navigate toOutput -> EDL…

Go to Options
Ensure that EDL Type is set to CMX3600.
Dupe List tab should be set to None.
In Options tab, deselect the option to "Convert Tapenames to
Numbers"
Save Settings… and return to main EDL Manger window.
Select which track to include in the EDL.  You only need the
video track with the Previzion clips selected.  Not audio needed.

Importing EDL in TakeConverter

Before loading an EDL, make sure to set your take directory to the
correct location of all corresponding Take Data.  The take directory is
the folder in which all Take Data folders are located.  When using
multiple cameras, make sure to have the correct folder selected for the
given camera.

Next, you can import and EDL to start building up your Queue.  To
import an EDL in TakeConverter, simply select the corresponding EDL
file using TakeConverter's EDL impoter.

All direct matches (by timecode) will be automatically added to your
Queue.  Any conflicting timecode matches will pop up in a dialog
window that queries for the correct take.  You can select the correct
take and proceed to the next item.

When you are done building up your Queue, select and Output
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Directory, a folder to save all your converted files and select the formats
for which you would like to convert your Take Data into.

When all of the above are done, select "Convert."  This is a fairly quick
process, but you will see the items being converted in your "Conversion
Log."
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Rendering Previzion Ready Scene in Maya

Overview

Rendering your Previzion ready scene in Maya is easy to do. Here's
what you'll need to do:

Render your scene with Maya Hardware renderer.

Here are some things you'll need to know

Maya will not render the proper lens distortion that is rendered in
Previzion
Maya Hardware renderer will NOT render Maya materials
You Must convert all your maya materials to CGFX shaders to
render in Maya Hardware renderer.

 

Rendering with Maya Hardware

Navigate to the render settings window.  This is where you'll change the
renderer to the Maya Hardware renderer. Using the hardware renderer
is the best fit for rendering a scene that matches the Previzion render
as close as possible. This makes use of the CGFX shaders which
Previzion uses.

The menu navigation is: Window -> Rendering Editors -> Render
Settings

 

 

Render Settings

Number of Samples - This is hardware anti-aliasing.
Motion Blur By Frame - Previzion renders blur over one frame
Number of Exposures - Amount of renders performed to create
blurred image

Page 352

http://www.lightcrafttech.com/wp-content/uploads/2010/11/HardwareRenderMotionBlur.jpg
http://www.lightcrafttech.com/wp-content/uploads/2010/11/Settings.jpg


Previzion - User Manual
by Lightcraft Technology

Importing Data into 3ds Max

Overview

Some customers may want to use our camera data in 3ds Max 2013.
This section will go over how to get that data into Max for post
production use.

One thing to keep in mind when shifting from Maya to 3ds Max 2013,
you will want the camera's Angle of View from Maya to match the FOV
in 3ds Max throughout the entire timeline.

Go straight from Maya 2013 to 3ds Max 2013.

1.Generate Maya Ascii in Take Converter.
2.Open Scene in Maya 2013.
3.File > Send to 3ds Max > Send as New Scene.
4.Double check the camera FOV in Max to match with Maya.
5.Rendering > Render Setup > Output Size adjust to match video

size.

Generate FBX to import into 3ds Max 2013.

1.Generate Maya Ascii in Take Converter.
2.Open Scene in Maya 2011-2013.
3.Check for FPS.
4.Select File > Export All.
5.Choose FBX format relative to the version of Maya.
6.Choose Autodesk Media & Entertainment.
7.Animation > Extra Options > Quaternion Interpolation Mode set

to Retain Quaternion Interpolation.
8.Import the resulting FBX in 3ds Max 2013.
9.Double check the camera FOV in Max to match with Maya.

10.Rendering > Render Setup > Output Size adjust to match video
size.

Page 353



Previzion - User Manual
by Lightcraft Technology

Tracking Refinement with PFTrack

Overview

This tutorial will go over how to take the Previzion Take Data from
production, and use it to refine the track and get it ready for
post-rendering.

Constellation Tool

Download LIDAR enabled version from the Dashboard.

In Constellation Tool open the survey file by adding the points into the
UI. Once loaded, export the points as LIDAR and locate them with the
rest of the survey files.

Take Converter

To start we need to use the Take Converter to write the proper file to
import into PFTrack.

Start by Browsing for your Takes directory, then select the take
you want to work with.
If need be, cut down the length of the take by adjusting the
Timecode In/Out. Note: Write down the ending timecode in/out,
and frame count for reference when sequencing the video.
Name the Output of the file and hit Queue.
Browse for the proper Output Directory
Check off necessary Output Formats and hit Convert

Maya

Import the Maya ASCII from Take Converter into Maya.

Edit the time slider to include all frames from the selected take.

Select the Previzion camera node and go to File > Export Selection…

From there change the Preset to Autodesk Media & Entertainment

Under Advanced Options > FBX File Format

Type: ASCII
Version: FBX 2010

Export file into directory with the shot.

Image sequencing

Extract all frames of the shot by using Quicktime Pro

File > Export > Export: > Movie to Image Sequence

………………> Options > Format: PNG or other lossless format.

You can use any program you wish to extract frames, this is just a
simple easy way to do so.

PFTrack

Create Shot

In the project menu at the bottom left of the UI, create a project under
Projects > Create. If you don't create a project you will not be able to
continue.

Importing Shot

Enable Toggle showing File Browser at the top center of the
window. Navigate to the proper directory for the image sequence, and
drag the image sequence into the Tree View on the left side of the
window.

Importing Camera Path

Right-Click on the shot and add Edit Camera. In the parameters window
at the bottom select Import Camera. Import the fbx file that you created
out of Maya. To verify the camera imported turn on the 2-H view on the
right side of the window. Navigate to find the camera path.

Tracking

Right-Click the Edit Camera node and add a User Track. Then
Right-Click the User Track and add a Survey Solver node.

In the Survey Solver parameters change the tab to LIDAR.

Coordinate system: Right/Y
Static render proxy: None
Dynamic render proxy: None

Import the LIDAR file you created from Constellation tool and turn on
Show LIDAR. The points should appear in the 3D window with the
camera path.

Tracking Surveyed Points

In the User Track you can now start adding in tracking marks.

Locate the points that have been surveyed in the scene and start with
those points  to track. In the paramters window at the bottom
select Create in the right function group. Click in the viewport to add the
tracking mark. Modify the interior box to fit a good selection of pixels to
gain a solid track through the shot. In Parameters > Deformation turn
on Rotate, Scale, and Scew. Also turn on
the Illumination and Blur boxes. You can then start the track by clicking
the >> button. Do this until you have atleast 6 surveyed markers
throughout the shot.

Next move back to the Survey Solver parameters, select the surveyed
tracker,  click Attach and carefully select the corresponding survey point
in the 3D viewer window. Do this to all the survey mark trackers.

Additional Tracking Marks

To get further refinement without survey marks. Create another User
Track node between Edit Camera and User Track.

To add tracking marks use the same method as the surveyed trackers,
without attaching them to surveyed points.

Solve Track

To solve the track go to the Survey Solver, enable Use input motion as
hint and click Solve All.

Export Camera Solve

Download
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Download the full working project file from the Dashboard. The project
includes all necessary elements, and a completed solve project.
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Tracking Refinement with SynthEyes

Overview

This tutorial will go over how to take the Previzion Take Data from
production, and use it to refine the track and get it ready for
post-rendering. Note: This method is optimal mainly for shots with very
minimal to no lens distortion.

Take Converter

To start we need to use the Take Converter to write the proper file to
import into SynthEyes.

Start by Browsing for your Takes directory, then select the take
you want to work with.
If need be, cut down the length of the take by adjusting the
Timecode In/Out. Note: Write down the ending timecode in/out,
and frame count for reference when sequencing the video.
Name the Output of the file and hit Queue.
Browse for the proper Output Directory
Check off necessary Output Formats and hit Convert

Image sequencing

Extract all frames of the shot by using Quicktime Pro

File > Export > Export: > Movie to Image Sequence

………………> Options > Format: PNG or other lossless format.

You can use any program you wish to extract frames, this is just a
simple easy way to do so.

Importing Shot

File > Import > Shot

Set Start Frame at 0, and End Frame one less than the frame
count.
Set Frame Rate to match source.
Set Queue Length to frame count of shot.
Find the Back Plate width in the bottom of the .dae, take file,
under Sensor Width. This will be a camera specific parameter.
This example was from a Sony FS700.

SynthEyes

These highlighted icons are the "go to" icons you will be using when
working with SynthEyes.

1.Feature Panel
2.Tracking Panel
3.Graph Editor
4.Lens Panel
5.Solver Panel
6.Coordinate System Control Panel
7.Viewport Menu
8.Active Camera

Under Edit > Edit Preferences 

Ensure Y Up(Maya) is selected in the first drop down.
Back Plate Width to Take file's Sensor Width, change to mm.
Default Export Type to Maya ASCII Scene.
Export Units to Centimeters.
Maya Axis Ordering to XYZ.

Importing Camera Path

File > Import > Camera/Object Path

Import the .txt file created after processing through Take Converter

Set First Frame to 0 and Last Frame to match the shot length
from when the shot was imported.
Set Axis Mode to Y Up, Right.
Set Rotation order to XYZ.
Set Zoom Channel to Focal Length.

Importing Survey Data

File > Import > Tracker Locations

Import the Example_Survey-Additional.txt from the original survey.

Graph of Trackers

When laying out tracking marks, it is best to run with the Graph Editor
open.

With the Graph editor you can see the tracking progress in a color
coded format:

Red - No solid tracking available
Yellow - Almost enough tracking points
Green - Enough tracking marks to get a good solve
Gray - More than enough tracking marks
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Tracking Surveyed Points

Switch to the Tracking Panel to track the surveyed markers.

Start by hovering over the small yellow plus signs, these are the
surveyed marks brought in with the original survey data.

When the yellow plus sign turns red, click and hold the Left mouse
button. A red box within a box will appear as your curser, move this box
to the proper location on the image where the survey mark is located.
As shown in the image below. Use the preview box in the Tracking
Panel on the left, to line up the tracker.

Next, you will want to play through the shot to let the marker track. Do
this by hitting the play button at the top of the menu, circled in green
below.

If you are in the middle of a shot and believe you could use this tracker
during an earlier portion of the shot, change the direction to go
backward, using the arrow in the menu, circled in red above.

To further lock in the position of your surveyed points, constrain them to
Lock Point. This let's SynthEyes know that these are known points and
help to calculate distortion and steady the track.

Additional Tracking Marks

Most of the time, surveyed tracking marks won't be enough for a good
solve. You then must go through and add in manual points for tracking.
Do this by selecting the create new trackers button and make sure the
type is set to match, as highlighted below.

Click on different unique spots in the image and play through the shot to
track them.

If you have a lot of shake in your video, you will need to enlarge the
outer box on the trackers. Do this by going to the bottom-right corner of
the outer box and dragging out to expand the range.

After some time setting up you should have a shot that has a collection
of trackers, around 20 at any given time will usually put you in the gray
in the Graph Editor.

For the best distortion solve, it is best to have a lot of markers nears the
edges of the frame at all times.

Solve Track
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In the Feature Panel
Change the motion configuration drop-down to Crash
Pan.

In the Lens Panel 
Change the Lens Focal Length to Known.
Turn on Calculate Distortion.

In the Solver Panel
Change the Solution Technique drop-down to From
Seed Points.
Enable Slow but sure.
In Axis Locks enable, L/R - F/B - U/D - Pan - Tilt - Roll.

Once you have all of those settings in SynthEyes, in the Solver Panel
hit Go! A window will pop up showing the progress of the solve, once it
is done hit Ok. Your camera should look very similar to the original path.

Before:

After:

Export Camera Solve

To bring the solve into Maya, go to File > Export > Maya ASCII Scene

Go to your Maya scene, File > Import, and import the solved camera
path.

In the outliner, a node will be created called "group." Open the group
node and locate the Camera node.  In the attribute editor, go to the
camera's Shape node and change the Far Clip Plane to 100,000, to
allow for a larger range. Next scroll down to the Environment tab and
open the Image Plane node. In the Placement tab, change the Depth to
90,000 to allow the geometry to show in front of the camera plane.

For this specific tutorial, when imported into Maya, the camera solve
needed to be rotated by -0.5 in the Y-axis to line up perfectly.

Before SynthEyes:

http://www.lightcrafttech.com/videos/OutDoor_Korea_Test_before.mp4 

After SynthEyes:

http://www.lightcrafttech.com/videos/OutDoor_Korea_Test_after.mp4 

Download

Download the full working project file from the Dashboard. The project
includes all necessary elements, and a completed solve project.
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Syntheyes - Legacy Method

This page references an outdated Syntheyes process. Please check T
racking Refinements with SynthEyes for the latest methods.

Syntheyes

Previzion to Syntheyes Part 1

http://www.lightcrafttech.com/videos/tracking/Refining-Tracking-Synthey
es-part1-Desktop.m4v 

Previzion to Syntheyes Part 2

http://www.lightcrafttech.com/videos/tracking/Refining-Tracking-Synthey
es-part2-Desktop.m4v 

Refined Track: Before and After

http://www.lightcrafttech.com/videos/tracking/Post_Process_BH.mp4
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Importing Nuke .chan

Overview

To make the post process less stressful, we have made Nuke .chan
files available using the tracking data from Previzion.

Prep

Constellation Editor

In Constellation Editor, use the function Export FBX, to use in Nuke to
ensure the camera lines up. Reference the Constellation Editor
instructions.

This FBX asset is also in the /Assets/Survey folder in the example file.

Take Converter

In Take Converter, choose your shot parameters as you would any
shot, and enable the checkbox Nuke Chan. This will give you the proper
file to bring into Nuke or NukeX. Reference to Take Converter
instructions.

Nuke

Interface

1.Frame Zoom
2.View Selection
3.Properties Tab
4.Node Graph Tab

Shot

To import a shot, in the Node Graph Tab, right click in the graph window
and select Image > Read or hit (R) on the keyboard.

Select your image sequence and click Open.

Camera

Next import your camera by right clicking, 3D > Camera.

This will create a camera node in the graph window, now you'll need to
set a few parameters before bringing in the .chan file created in Take
Converter.

In the Properties Tab, you'll see the menu for the camera node, if not
double click on the camera node in the Node Graph.

In the Projection sub-tab, change the horiz aperture to match the
Sensor Width in the original .dae take file.

For the vert aperture, divide your horiz aperture by your Aspect
Ratio, found two parameters below the Sensor Width in the take file.
For example, in this case, the vert aperture is 6.97 mm/1.7778 = 3.92
mm. (Nuke assumes mm for focal length.)

In the Camera sub-tab, change the rotation order to XYZ. Now import
the .chan camera file by clicking the folder icon (directly under the
display : wireframe drop-down menu), find your .chan file and click
open.

Geometry

To ensure everything lines up, you can import the FBX created when
working on the constellation for Previzion. To import, right click in the
Node Graph window, 3D > Geometry > Read Geo

 

Start by importing the geometry, by clicking the folder icon on the right
of the file box. Then enable the display all objects selection,  and
update the display and render options to fit what you are working
on. Also: uncheck read on each frame to dramatically speed up
rendering!

This should be your result:
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You don't have to bring in the constellation geometry, but it helps to
make sure everything is where it should be. You can also import in your
final geometry for rendering and compositing. Change the View
Selection to 3D and select fit under the Frame Zoom to show all of the
objects in the scene. Navigate by holding Alt+(LMB for Pan, MMB for
Zoom, and RMB for Rotate).

Connections and Settings

Move back to the 2D view in the View Selection. Now add in a node to
overlay these things into one image. Right click in the Node Graph, 3D
> Scanline Render. Connect the Shot, Camera, and Geometry nodes to
the Scanline Render by moving the arrows to the Scanline Render
node. Now connect the Scanline Render node to the default Viewer1
node.

The result will be a lined up path for further refinement.

Interlaced video, Previzion and Nuke

Interlaced 50i and 60i video can be used with Nuke and Previzion data.
 The only thing to be aware of is that Nuke does not handle interlaced
video directly, so a plugin called "Fieldskit Deinterlace" must be used

just after the interlaced source video, and again "Fieldskit Interlace" just
before outputting to the "Viewer" or "Write" functions.

The Deinterlacing function should be set to "Deinterlace (duplicate)"
This will turn the 60i/50i video sequence in to a line doubled 60p/50p
video sequence.  This is necessary because Nuke doesn't know how to
deal with fields, and the data that comes out of Previzion when it is set
to an interlaced format is working at either 60 or 50 camera positions
per second.

The Interlacing function should be set to "Interlace" this will convert your
60p/50p work back into 60i

Download

Download a sample of Nuke integration files from the Dashboard.

 

Page 361

http://www.lightcrafttech.com/wp-content/uploads/2013/08/nuke_result.png
http://www.lightcrafttech.com/wp-content/uploads/2013/08/nuke_result.png
http://www.lightcrafttech.com/wp-content/uploads/2013/08/nuke_result.png
http://www.lightcrafttech.com/wp-content/uploads/2013/08/nuke6.png
http://www.lightcrafttech.com/wp-content/uploads/2013/08/nuke8.png
http://www.lightcrafttech.com/wp-content/uploads/2013/08/nuke7.png
http://www.lightcrafttech.com/wp-content/uploads/2013/08/Nuke_Interlaed_2.png
http://www.lightcrafttech.com/wp-content/uploads/2013/08/Nuke_interlaced_1.png
dashboard.lightcrafttech.com


Previzion - User Manual
by Lightcraft Technology

Nuke Embedded Data Import(Beta)

Overview

The Foundry has implemented a beta plug-in for Nuke 8.0v5 and
NukeX 8.0v4 to import Previzion embedded metadata from Quicktime
video files. This will allow you to bring full takes into Nuke and go
straight into compositing without skipping a beat.

Source Code

Download the source code, NukeCameraImportPlugin.zip, from the
Dashboard.

Locate the Nuke plugins folder commonly in C:/Program
Files/Nuke8.0v5/plugins.

Unzip the source code, and move the extracted PrevizionCamera folder
into the Nuke plugins directory.

In the plugins folder, find the file init.py, and open in a text editor. At
around line 65 add in

nuke.pluginAddPath('C:\Program
Files\Nuke8.0v5\plugins\PrevizionCamera'); 

under the existing "nuke.pluginAddPath" line.

Importing

To bring in the Quicktime file locate the file using the browser (1). Set
the frame range (3) using all frames, global, or custom. If you
using custom choose the range (4). The horiz aperture(5) and vert
aperture(6) will automatically be populated after extraction.

Next, hit the Extract button (2), scroll through the timeline and ensure
the values are changing in the blue highlighted fields. Once, extracted,
you can Create Camera (7).

Setup

Once you have imported the Previzion camera, you can start to set up
your composite. This is a simple example of a composite, using Keylight
to re-key green and ScanlineRender to comp together the virtual
elements and render from the Camera.

Known issues:

Distortion is not calculated.
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Automated EDL Extraction

EDL Extraction

EDL extraction is a new feature in TakeConverter.  This feature allows
editorial to provide an EDL file, which will automatically mark in, and out
points in Take converter for the corresponding Previzion takes.

 Process

Generate a CMX3600 EDL file in your editing software, or a
series of EDL files if the shoot was multiple days or used
multiple cameras.
Point TakeConverter at the directory which contains the
corresponding camera and days data.
 Load the EDL file into TakeConverter. by clicking "browse"
under the EDL section and selecting your EDL file
Take converter will attempt to match EDL data with Previzion
data.  If there is overlap, or duplicate timecodes TakeConverter
will prompt the user to pick the correct take file

Features

Ignores audio tracks, and offset audio tracks
Compatible with transitions
Able to convert Previzion take files to multiple file types at once
Detection of repeated timecodes, and will prompt user to choose
correct file.

 Limitations

Currently TakeConverter is only using timecode to match edits with
Previzion data, this means that each camera and each days work must
be exported from your NLE as separate EDLs, and take converter must
also have the corresponding Previzion data separated out as well.
 Failure to do so will most likely cause the wrong data to come out of
take converter.
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Importing Data from Previzion Take into Maya

Maya Previzion State Importing

With the python script located on the Dashboard, you can now import
Previzion State files into Maya. Maya will update all transforms that had
been changed, and will import mattes and survey markers.

Start by moving the stateparser.py, statebuilder.py, and
previzionStateTranslator.py to the plug-ins directory. C:\Program
Files\Autodesk\Maya2012\bin\plug-ins.

Next, open the Script Editor(Window > General Editors > Script Editor),
in a python window input this script:

import maya

maya.cmds.loadPlugin("previzionStateTranslator.py")

This will load the plug-in, and you'll be ready to import any Previzion
state file. To load your state file, start by opening the scene file that
matches your project. Then  go to File > Import, and import the
state.xml file from your take. Notes

This will only function for Previzion State files created from build
7686 and on.
Previzion states are saved on Take cut, unless the user tells
Previzion not to save states. If save state on cut is disabled, a
manually saved state can be used instead.

Download Maya Previzion State Loader from the Dashboard.

Manual Importing

For importing transform changes into Maya with newer builds of
Previzion, you'll need access to the .xml file written in the take folder.
Open up your .xml state file from the take in notepad. Do a simple
replacement using Edit > Replace, and replace any ; with a space. Now
you can locate your edit_ transform matrix.

  In Maya, select the
object you want to move, and using the MEL command line at the
bottom of the window, use the command xform -m with the matrix
information and hit Enter.

 

Legacy Importing

The "Lightcraft Take Transforms Import" tool is used to update all the
"edit_" objects in your scene that were modified on stage during a take.

How to Load

1.Copy the .mel script into the "MEL" tab of the Script Editor
(Menu Path: Window -> General Editors -> Script Editor)

2.Now Execute the Script with the "execute" command

 How To Use

1.Press the "Locate transforms.txt" button. This will load the .txt
file into memory and activate the "Apply Transform" button.

Because of a bug in the new File Loading widget in
Maya, pressing the "Load" button will ask if you want to
overwrite the selected file. Disregard this warning and hit
"yes."

2.The "Transform path" text field will now show the selected .txt
file

3.Press the "Apply Transforms" button and Voila!

Download Here

You may download the latest version of Transform Data from Take
Import tool from our Download Dashboard. Last updated on January
13th, 2011 @ 11:30p PST tested on Maya 2011, please send word if
this tool does not work on your machine.
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Stereo data into Syntheyes

Overview

With 3D films and television production on the rise, the challenge for
artists is to track and render in stereo. Using Previzion's Take Converter
software, artists are now able to import 3D camera data into Syntheyes.
From here the camera motion can be refined and/or exported to other
3D/2D packages.

How To

Load the Stereo Data Into  script into the Syntheyes User Script
folder

On Win7 with Syntheyes 2011, the path is 
C:\Users\[user]\AppData\Roaming\SynthEyes\scripts

Restart Syntheyes
Syntheyes will find the import script during the restart

Start a new Scene
Locate the footage for the left eye and set the proper sensor
depth width

Make sure you press the top, highlighted button once so
that the word "Left" appears
Set your sensor width from the .dae file associated with
your shot

The unit should be set to "mm" when changing
this setting

Now Select the Footage for your Right Eye
DO NOT SOLVE FOR A CAMERA PATH… We're going
to import it

Set your view to "Quad Perspective"

Move the mouse over the perspective window and lock it to the
camera

RMB click, select "Lock to Current cam."
You'll now see the video in the perspective camera

Set the perspective camera to stereo
RMB click -> View -> Stereo Display

Depending on your stereo rig, at this point you may need to flip
one of the eyes horizontally

If your left eye is flipped, select the Left Eye from the
Shot menu
Now open the Image Preparation window

Shot -> Image Preparation
Select the "Rez" menu
On the bottom left of the window, check "Mirror
Left/Right"

Click "OK"
Your Scene will now have two cameras sitting in the same
coordinates and you'll see the anaglyph rendering of the video
footage in the Perspective camera

Uncompress and run the Lightcraft Stereo objrpath.szl sizzle
script

It will automatically be detected and placed in the File ->
Import menu

You will immediately be prompted to located the
syntheyes camera data file created by Take Converter
You will then see a Syntheyes UI window. Here you'll
want to set the last frame, frame offset and any world
scaling desired.
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The Other GUI attributes are present to give you
a sense of how Take Converter writes out data
and what the names of your cameras are that will
be operated on.

Click "OK"
Your Left and Right cameras are now in position

Features

Imports stereo data from Lightcraft's Take Converter
Works with Syntheyes 2011
Assigns unique focal length values for left and right eyes

Limitations

Only tested on Syntheyes 2011
Assumes camera names of "LeftCam01" and "RightCam01"
You must have a stereo camera already in your Syntheyes
scene

 

Download Latest Version

Click here to download the latest version of Lightcraft's
Lightcraft\_StereoCam\_Import.szl script

Last Updated: Feb 23, 2011 @11:41p PST

Update Notes

Feb 23rd, 2011
Updated sizzle script name to better reflect the script's
function.

Feb 16th, 2011
Initial Upload
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Previzion Data into 3D Equalizer

Using Previzion Data in 3D Equalizer

Previzion data can be used with 3D Equalizer by using two tools to
allow the importing of that Previzion take data.

Previzion take data will be recorded as a Collada (.dae) format.  This
will then need to be converted into a Syntheyes format (.txt) through
TakeConverter.

Read our  "Working with Take Converter" page for more information
about using TakeConverter.

You will then need to download a Script (python) from Dashboard and
install it in your 3D Equalizer installation folder.  We have two versions
of the script:

Stereo Data should use the import_previzion_stereo.py.
 Click here to download it from Dashboard.
Regular (Monoscopic) Data should
use import_previzion_mono.py. Click here to download from
Dashboard.

These should be installed into 3DE/sys_data/py_scripts folder.

Then, in 3D Equalizer, for Stereo 3D Projects:

1.Make sure that the dominant camera is selected and is set to a
stereo camera.

2.Select Python->Import Previzion v.03, and pick the output .txt
file from Take Converter. The dominant camera should now
have position, orientation, focal length, and IO data imported.

3.In the Attribute Editor lens tab, set the Filmback Width and
Height to Fixed, and enter the correct values

4.Set the Focal Length to Adjust
5.In the Attributes Editor camera tab, set the lens focal length to

dynamic (zooming). It should show the first frame input value.

and for single-camera monoscopic projects:

1.Select your camera.
2.Select Python->Import Previzion v.03, and pick the output .txt

file from Take Converter. Your camera should now have
position, orientation, focal length, and IO data imported.

3.In the Attribute Editor lens tab, set the Filmback Width and
Height to Fixed, and enter the correct values

4.Set the Focal Length to Adjust
5.In the Attributes Editor camera tab, set the lens focal length to

dynamic (zooming). It should show the first frame input value.
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A Quick Pipeline for Post Rendering a Scene used in Previzion

(Yellow Boxes) are the start of new data streams. The (Green Boxes)
are intermediate steps. The (Blue Box) is the final step.

 

Photogrammetry Pipeline Overview

This page is the guide for you if you answer "yes" to any of the following
questions:

Do you need to render something in post and get it done fast?
Are you new to post-production and want a series of steps to get
you going?
Did Previzion drop frames while rolling during a take?

 

Software

Previzion
Captures camera tracking data and outputs camera data
to *.dae (Collada) file

Quicktime Pro
Converts all captured video (to be used and played back
in Previzion during a take) to a sequence of still images
which Maya can read

Take Converter
Converts the *.dae take file into a file format of your
choice
For this example we'll be converting to the Maya.ma file
format and rendering in Maya

Maya (or 3D application of choice)
This will re-render the 3D material to a separate
sequence of still frames of the background elements
only

Your choice of Compositing Programs
With this software you'll composite the keyed camera
feed and the rendered image sequence from Maya

 

Steps

1.Load up your desired 3D scene into previzion
1.http://www.lightcrafttech.com/support/documentation/sce

ne-interface/scene-loading/
2.Capture a take with Previzion

1.http://www.lightcrafttech.com/support/documentation/tak
es-interface/recording-takes/

3.Use Take Converter to convert a *.dae file into a camera in a
Maya scene file (*.ma)

1.http://www.lightcrafttech.com/support/documentation/pos

t-production-workflows/extracting-metadata-with-take-co
nverter/

4.Open 3D scene (the same one loaded into Previzion when
creating this take) and import the new PrevizionCamera.

1.First, open the scene that was used to generate the FBX
file (the FBX loaded into Previzion) in Maya

2.Second, import the scene file that was created by Take
Convert (see step 3). This file should contain the
Previzion camera

5.If there are any background plates… use Quicktime Pro (or your
compositor of choice) to convert the background plate(s) to
image sequences

1.This can be done using any compositing program
2.http://www.lightcrafttech.com/support/documentation/pos

t-production-workflows/rendering-video-as-texture-in-ma
ya/

6.If there are any background plates… assign the newly generated
image sequences to the video plate geometry in the 3D Maya
scene

1.http://www.lightcrafttech.com/support/documentation/pos
t-production-workflows/rendering-video-as-texture-in-ma
ya/

7.Once all cameras, objects and textures are set, you're ready to
render!

1.http://www.lightcrafttech.com/support/documentation/pos
t-production-workflows/batch-rendering-in-maya/
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Rendering Video as Texture in Maya

Overview

For purposes of post rendering a 3D scene in Maya, it is important to
know how to load an image sequence as a texture. Maya prefers
movies to be loaded as image sequences. Not only does Maya prefer
this but it gives greater control to the end user. For any video that was
used as a background plate in Previzion, this must first be converted to
an image sequence. This can be done using any compositing program.
Examples include: After Effects, Nuke, Quicktime Pro and Fusion.

Once the image sequence is created. Load it into a file node in Maya,
set a few attributes and you're good to go.

 

How To

In order to render this image sequence as a movie and a texture we
need to perform three tasks:

1.Assign a file node to a shader
2.Assign the first frame of the image sequence to the file node

3.Turn on Use Image Sequence attribute in the file node.

2.Notice that this automatically creates a linked connection
to the Image Number attribute

3.Changing the Frame Offset changes when the first frame
of the image sequence will exist
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Batch Rendering in Maya

If you already have experience rendering in Maya,
what follows below will be a brief refresher

Note:

This page is only meant as means to identify the most basic
steps to batch render an animation in Maya of a scene that
uses at least one CGFX shader. This page is not meant to
make suggestions towards replacing a currently existing
post-production rendering process.

Overview

Now that you have your scene together with your Previzion camera
imported into the scene to be rendered. Let's have a look at the steps
required to batch render to an image sequence.

This process will involve:

The Render Settings Window
Project Directory Structure
Batch Render Feature

 

How To

Set Render Settings

First, navigate through the menus to the Render Settings window:
"Window->Rendering Editors->Render Settings"

An explanation of the key features. You'll need to set these before
rendering:

1.Text feedback of what, where and how large your rendered
images will be. Check this during and after modifying these
settings to make sure your files are being rendered to the proper
location and are named appropriately.

2.Define what the filename of the rendered images will be AND
define the file format

3.Define how the numeric ID and frame extension naming
convention should be.

1.The format of name.####.ext is widely accepted
2.Also define how many numerals are used for the

numeric ID. This is also known as frame padding. You
need at least as many digits as is required to represent
the largest frame number. So, if the last frame is 1,000
then the frame padding should be at least 4 (because
"1000" requires four digit spaces to be represented).

4.Define the start and end frame of the animation
5.Define which camera you want to render from. In our case we'll

render from the imported camera, aka
"previzion_cameraNode0"

6.Define which aspect ratio and resolution you want to render to

Hardware Render Settings Tab (same Window, the next tab over)

In the same window, but one tab over, you'll see renderer specific
settings. If these setting aren't what you see please make sure that item
#1 is set to "Maya Hardware".

1.Set this to Maya Hardware if you're rendering with CGFX
shaders

2.This settings works will with CGFX transparency while giving
high quality rendering performance

3.Define the number of samples
4.Transparency is set "per polygon" instead of "per object"…

Important!
5.Turn this on in case you're using textures that are not size, in

both width and height, to a power of two (32, 64, 128, 256, 512,
1024, 2048, 4096, 8092, etc)

Batch Rendering
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To start a Batch Render, first set your Menu Set to "Rendering." Once
you're in the "Rendering" menu set, there is a "Batch Render" button
in the Render menu.

This will start your render. The hardware renderer is fast so it should be
done relatively soon.
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Reperformance: HDSDI Metadata SMPTE315M

Previzion Embedded Metadata

As of build 6710, Previzion's SDI output has all tracking data embedded
in its video outputs. This is valid for both SDI outputs and embeds all
tracking data, like x/y/z location, tilt/roll and lens information.

The data is embedded in ANC packages in line 10 using SMPTE
315M-2004 format.  The process of utilizing a recorded video with
tracking metadata into Previzion is referred to as reperformance.

This feature allows Previzion users to literally bring their Previzion
systems into the post-production environment.

Embedded metadata has the potential to change the way current virtual
productions deal with their assets and Lightcraft is working on more
tools to improve the VFX world.

The actual specifications can be downloaded from Dashboard through
this link.

How does reperformance work?

The embedded metadata is frame accurate and is recorded alongside
your footage.  Using a supported recorder and your Previzion system,
you can replay "foreground" (a clean green screen feed) and set all
your Previzion settings with the advantage of having more time to adjust
the settings.

With simply the HD video recorder and your Previzion box, you can
replay the clean green footage and set your key, load relevant scenes,
move cameras, change lenses (if necessary) and so on.

Reperformance, playing back through Previzion, cannot refine tracking
afterwards.  It's most useful when tracking is working correctly and all
that is needed is to key, color and/or add mattes.

For more tools and tracking refinements, consider using a metadata
extractor in our Nuke pipeline (see Nuke Embedded Data Import).

How can I confirm I am recording the
tracking data?

Since the recorders that are able to capture and store 315M ANC data
can't indicate the presence of SMPTE 315M data, the only reliable way
to confirm presence of the data is to play it back into Previzion as
indicated below in "Recommended Settings".

Please note that many video converters, splitters and embedders often
strip all ANC data, which may include timecode.  In these cases, make
sure to bi-pass such devices to ensure the data is being passed through
properly.

 

Supported Recorders

Lightcraft is actively in conversations with various HDSDI field recorder
manufacturers to implement support with SMPTE315M and
reperformance.

Please reference the table below to see if your recorder supports this
feature:

 

Recorder Support
315M

Untested

Pix 220i No

Pix 240i (v.3.5.1 or
above)

Yes**

Pix 260i (v.2.0.0 or
above)

Yes**

AJA Ki Pro
(3.2.0.17 Tested)

Yes

AJA Ki Pro Mini
(4.2.0.13 Tested)

Yes

AJA Ki Pro Quad
(5.2 tested)

No

AJA Ki Pro Rack
(4.2.0.25 Tested)

Yes

QTake HD (custom
firmware)

Yes

AJA Kona Card
(AJA Recorder)

O

ATOMOS Samurai
Blade

No

Blackmagic Design
HyperDeck Shuttle

No

Blackmagic Design
HyperDeck Studio

No

Cinedeck EX No

Cinedeck RX
(3G/AES)

O

Cinedeck MX O

 ** frame-by-frame tracking position may be recorded as ANC with a
few frames offset.  This is not usable for "reperformance," but it's usable
for tracking data extraction.

We are currently working with video recorder developers to add support
to this feature, test and implement recording/playback to their specific
recorders.

If you are planning on using a recorder and would like to have this
feature supported, please contact support (at) lightcrafttech.com and
let us know which recorder you are using.

Recommended Settings

For this setup, we recommend setting the HDSDI output from Previzion
to be set to "Foreground" (clean green feed).
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All you need to do is plug the recorder, like an AJA KiPro, into your
Previzion HDSDI IN 1 and set as:

Sync: Generated
Location: Previzion Video
Lens: Previzion Video

Video Input Format: the correct video frame rate
HD-SDI 1: Enabled

There should be no error lights on.  However, please not that
you may see "Timecode Repeating" light up when the video is
paused, meaning that the timecode is paused at a given frame
timecode address.

 Once this is setup, you can treat the footage as you would a Previzion
camera.
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General Lift Encoded Technocrane

Default Position
Alignment with Laser Boresight
Serial Connections
Survey Interface
Crane Measurement
Camera Offsets
Crane to Scene Registration
Encoded Slider
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Default Position

Technocrane Default Position

The Technocrane needs to be measured in a standard default position.
In addition, the encoders must be powered on in this position each time
the crane is tracked in order to give consistent results.

The crane's default position is:

Boom all the way retracted

Boom leveled. Many booms have a built in level, as shown
above.
Camera head leveled and pointed in the same direction as the
boom. Note: this needs to be accurately aligned. The method of
aligning the head to the boom is explained next.

Activate Hydraulic Leveler

To keep the remote head of the Technocrane level, there is a hydraulic
leveler. Make sure that it is turned on, and initialized when the crane's
spirit level is horizontal.

Remote Head Alignment

To ensure that the remote head is accurately aligned with the jib:

Place a laser projecting level on the floor (Pacific Laser Systems
PLS180 Palm Laser).

Align the laser so that it projects down the center of the jib.

Add a marker to the wall or to a far away vertical object where
the vertical laser line intersects.
Tilt the remote head down and pan over until the center of the
live video view is centered on the wall mark.
Tilt the remote head back up until the head is leveled.

The crane is now in the default position for both initial measurement,
and subsequent powering on of the encoders.
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Alignment with Laser Boresight

Squaring Head with Laser Boresight

For both Technocrane and encoded sliders, it is important to have the
remote head squared to the boom extension axis (or the slider
movement axis.)  The projected laser method of the previous page
works well for darker or indoor environments, but in outdoor
environments the vertical beam is too faint to see.

Alignment Method

Instead, a recommended method is to use a laser boresight, as shown
above. This inserts into the matte box rails, and has a twist adjustment
to increase its diameter when inside the rails for a tight fit.

Once the boresight is inserted and tightened, the head is roughly
squared and pointed at an object more or less perpendicular to the
boom axis. The position of the green laser dot is marked on the object.
As the boom is extended or the slider is moved, the laser dot should
stay in the same place if the head is properly squared to the extension
axis.

If it moves while being extended, move the head left or right and remark
the dot position until it stays close to stationary.

This process assumes that the camera optical axis is aligned with the
matte box rails, which is usually more or less correct.
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Serial Connections

Serial Connections

General Lift serial data is connected to ports COM7 and COM8. These
are the S1 and S2 labeled cables on the system's second quad serial
port.

Some installations will use both a Encodacam Serial Box for the crane's
boom pan, boom tilt, and boom extension encoders, and a separate
serial connection for a Talon head.

Other installations (typically for motion pictures) will use a Kuper 2000
portable computer to interface all of the encoders to. This is then
connected to the Previzion system with a null modem cable to either
COM7 or COM8.

Genlock

To get clean tracking data, the Kuper computer, Encodacam serial box,
or Talon head must be genlocked.

The Kuper computer uses a General Lift sync box to transform
tri-level HD sync into a square wave pulse, that is then
connected to the Kuper box.
The Encodacam serial box has a built in connection that accepts
tri-level sync.
The Talon remote head firmware must be updated to correctly
synchronize to 23.98 PsF genlock signals.
When the correct Talon firmware is installed, there will be a
'-' on either side of the pan and tilt values in the remote
head LCD panel.

Kuper Data

All of the General Lift systems share a similar serial data protocol,
which is shown above in the terminal program Realterm.

Previzion assumes the use of 8 channels of Kuper data. This is the
standard output from the Encodacam Serial Box. When using the Kuper
2000 computer, the output must be set to 115200 baud and 8 channels
of output.

(The first channel of numbers in the above image is a Kuper timing
variable, which is not used and is not counted as a data channel.)

Kuper Channel Mapping

As shown in the above image, the channels of Kuper data must be
mapped into the correct motions for the Technocrane.

For the Kuper 2000 computer, look at the interface to verify what data
channel is being output.

For the Encodacam Serial Box, the usual channel mappings are:

Channel 1: Boom Swing
Channel 2: Boom Elevation
Channel 3: Not connected
Channel 4: Not connected
Channel 5: Boom Extension

For the Talon head, channel 1 is pan, and channel 2 is tilt.
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Survey Interface

Survey Interface

To access the General Lift Technocrane configuration panel, click
Configure next to the GL Technocrane Pos/Rot Tracker.

Zero the Encoders

After confirming that the crane is in the default position, zero out all of
the encoders before continuing the calibration process. This is
because some of the steps to derive the pulses depend on the crane
starting in the default position.

Entering Points

Click Edit to make the survey point location editable. As each point is
measured, enter it into the appropriate survey area. The coordinates for
the northing, easting, and elevation points are all in meters, so they can
be entered directly from the total station coordinates.

Deselect the Edit button when complete.

Automated Boom Sag

When the initial point and the end point of the boom are surveyed,
Previzion will automatically calculate the deflection in the intermediate
stages of boom extension. This calculation is based on beam bending,
and matches tested data closely without the need to build a lookup
table.

Set the Boom Extension Rate

Finally, the various encoder counts/degree must be set. When using the
Kuper computer, the various counts per degree are usually set by the
operator, so that the Kuper data output is in angles. In this case, the
encoder counts/degree are +/- 1.

For installations using the Encodacam serial box, calculate and enter

the counts/degree values.

320 tooth swing gear, 56 tooth encoder gear: (18,000
counts/rev)(4x interpolation)(320/56)(1/360) = 1142.86
counts/deg (boom swing)
512 tooth elevation gear, 36 tooth encoder gear = (18,000
counts/rev)(4x interpolation)(512/36)(1/360) = 2844.44
counts/deg (boom elevation)

Setting Boom Extension

Previzion provides for automated setting of the Boom Extension
counts/degree. If the encoders were properly zeroed in the default
crane position, and the extended Mitchell pivot survey data has been
entered in the survey coordinates, do the following:

Make sure that the boom is fully extended.
Click Set next to 'Boom is Fully Extended' to automatically
derive the correct counts/degree from the survey.
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Crane Measurement

Locating Total Station

Place the total station on the right side of the crane, with the
remote head tilt pivot toward the right as shown above, if the
remote head is one sided.
Align the total station roughly with the center boom pivot of the
crane. The station should be 20-30 feet away from the crane,
with enough distance to provide a reasonably direct
measurement surface for the laser.
Important: the measurements taken from the pivot
measuring points to the center of the crane are assumed to
lie on the Northing axis, so the total station's northing axis
needs to be at right angles to the boom, and on the right
side of the crane as shown.

Boom Pivot

If the center pivot is blocked by the retracting weights, extend
the crane forward slightly to move the weights backward.

Place a survey sticker on the center of the boom pivot as above.
This provides a good survey surface, and avoids stray
reflections.
Use this as the backsight point in the survey, and to set the
northing direction. The northing direction should then point
straight from the total station location to the boom pivot.
Measure the distance from the measurement surface to the
center of the crane, and enter the survey position and thickness
into the calibration UI.
Retract the crane completely before surveying other points, and
verify that the boom arm is level.

Mitchell Mount Pivot

Place a survey sticker over the front pivot of the crane, referred
to as the Mitchell pivot as the Mitchell mount is commonly used
for underslung remote heads. Be careful to measure to the
bottom pivot.
Shoot the XYZ position of the Mitchell pivot with the total station,
and measure the distance from the measure point to the center
of the crane. In this image, you can see the projection of the
laser level at the center of the crane crossbars. Enter these
numbers into the Previzion UI.

Remote Head Pivot

Place a survey target on the pivot axis of the remote head. Be
careful not to move the overall crane position.
Survey the point, and enter it into the UI.

Measure the distance from the survey point to the center of the
crane's pan axis, and enter this into the UI. Since the camera is
usually centered on the remote head, this is frequently the
same distance as to the center of the camera lens, but this is
not always so.

Mitchell Pivot Extended

After measuring the crane in the default position, extend the
boom completely and measure the final position where the
Mitchell pivot ends up. Previzion will automatically calculate the
droop of the crane inbetween these two locations according to a
cubic curve to account for the beam bending.
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Camera Offsets

Camera Vertical Offset

Measure the vertical position of the center of the camera's lens barrel,
with respect to the remote head pivot. This is most easily done by
measuring the center of the lens with the survey tool, and subtracting
the vertical elevations. You can see the laser dot on the white line
marking the vertical center of the lens.

Camera Axial Offset

Measure the distance from the remote head pivot to the camera
sensor back. It's hard to see in this picture, but the sensor back
is about 2 cm behind the remote head pivot.

Camera Lateral Offset

If the camera is centered on the vertical pivot of the remote head, the
lateral offset is 0. Otherwise, measure the lateral offset.

Enter the crane to camera sensor offsets in the highlighted box. To
verify that the +/- signs on the offsets are in the correct orientation,
check the camera position in Observer View.
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Crane to Scene Registration

Scene Registration

Measuring the crane points only needs to be done once per
crane/camera load combination to ensure correct beam deflection. If the
crane encoders are zeroed out at the crane default position, the crane
can then be registered into an existing LIDAR or surveyed scene with
one total station measurement and a rotation.

Registration Procedure:

Resection the total station so that it is operating in the same
coordinate system as the survey markers.
Survey a couple of stakes or markers, and enter their locations
into the survey marker list.
Orient the camera so that it is facing some of the surveyed
points that have been entered into the survey marker list, as
they will be used for the angular adjustment. Lock off the crane
to prevent motion.
Make sure that all of the Camera Offsets (Position XYZ Offset,
Pan Offset) in the Tracker tab are set to 0.
Check  that the correct sensor size is selected.
Check that the correct lens model and serial number is selected,
that the motion of the zoom live action matches the CG zoom,
and that the near/far focus values match using Screen Text 
values to verify.
Click the Edit button in the highlighted Crane Offset area above.
Select the point on the crane in the UI that you will measure with
the total station. The point should generally be the remote head
pivot.
Shoot the remote head pivot on the crane with the total station.
Enter the northing, easting, and elevation of the surveyed point.
Adjust the Crane Pan value until the survey markers line up
correctly laterally.
Deselect the Edit button.

There may still be some vertical misalignment (a couple of pixels)
between the virtual survey markers and the live action points.

To correct small alignments, use the tilt and roll adjustments in
the Technocrane configuration panel. The values should be less
than a degree for both tilt and roll, especially roll.
This set of steps removes most of the possible errors. If the
survey cone points do not line up pretty closely with the live
action markers, double check the remote head pivot to sensor
back measurements, whether the remote head reads 0 for tilt
when it is physically leveled, and whether the survey cone
points are correctly surveyed.
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Encoded Slider

Encoded Slider Setup

An encoded slider can be handled very similarly to a Technocrane, with
the boom extension axis being used to handle the slide.

The slider is set up with the same default position as the Technocrane —
camera head level and square with the axis slider, and retracted to the
left. As with the Technocrane, the survey is measured from the right
side of the camera, as all remote heads have a right side pivot but
some do not have a left side pivot.

3 survey markers are placed on the slider as above, that correspond to
the boom pivot, the Mitchell head pivot, and the remote head pivot. As
the slider has no elevation change, the Mitchell head pivot can be
anywhere on the slider plate. A marker fixes this for repeatability.

The encoders are zeroed at this position, and the slider surveyed as
before. The slider can then be moved to the furthest position to the
right, and the extended Mitchell mount point surveyed. Since there is no
droop in the slider, this is a bit redundant, but may be useful to
determine the slider encoder count.

Encoded Slider in Operation

The slider data axes must be set up to correspond to the channel
outputs of the Kuper controller connected to this, as with the
Technocrane.

The method for locking the slider into the virtual environment, by
measuring the northing/easting/elevation of the remote head pivot and
adjusting the pan until the live action and CGI line up, is also identical to
the process for the Technocrane.
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GPS/IMU Tracking

Osystems Setup
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Osystems Setup

OSystems GPS/IMU Connections

Set up the Osystems GPS/IMU as per instructions. Differential
GPS will be required for sufficient tracking accuracy.
Connect the serial port of the GPS/IMU to the port used for the
Intersense tracker.
Configure the GPS/IMU to export data at 50 hz with the
command

LOG INSPVASA ONTIME 0.02

Select Novatel GPS/IMU from the Pos/Rot tracking menu.

Coordinate Offset

Measure the offset from the right side of the GPS/IMU unit at its
coordinate origin (marked by a survey marker) to the camera's image
sensor. Enter the offset as shown above.

Switch to Observer View to make sure that the offset to the image
sensor has the correct signs.

Local Coordinates

Transforming the GPS/IMU tracking data into a local coordinate system
set up with a total station is very similar to the technique used with
encoded cranes:

Set all of the camera offsets in the main tracking panel to
0.
Make sure that the status in the bottom line of the
Novatel configuration panel says
'INS\_SOLUTION\_GOOD' before proceeding.
Measure the location of the marker on the GPS/IMU with
the total station.
Click Tracker Offset in the Novatel configuration panel,
and enter the northing, easting, and elevation into the
panel.
Rotate the Offset Pan until a CG object at a surveyed
location lines up with the live action object horizontally
and click OK.

Click Edit on the Camera Sensor Offsets and adjust the
tilt and roll by subtle amounts (Edit when done.

Adjusting Pan Offset

Depending on the IMU used, you may need to adjust the pan offset in
the configuration panel during the shoot to keep surveyed points lined
up with CG points. This offset can range up to 5 degrees.
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Troubleshooting

Updating Previzion Software
Intersense Problems
Video Problems
Rendering Speed
Updating Video Firmware
Tracing Blue Screens
Updating GPU Driver
Updating Runtime
Loading FBX in Maya
Intersense Station Settings
Intersense Diagnostics
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Updating Previzion Software

Updating your Previzion Software

Previzion systems are optimized and tuned to run with very specific
hardware from the manufacturer.  Therefore, any hardware upgrade
has to be either done or approved by the manufacturer, Lightcraft
Technology.

However, Lightcraft is constantly adding new features and
improvements to the Previzion software.  The software itself is usually
fairly easy to update.

To update Previzion, refer to any release announcements or release
notes.  If you are not receiving release announcements, please sign up
by emailing support (at) lightcrafttech.com.

 

Downloading a new Previzion release

Any installers and Previzion releases are available for download
from Dashboard.  Dashboard is a secure file management utility that
allows for Previzion users to easily access new releases of all Lightcraft
tools and applications.

Previzion releases will be listed under Previzion Builds/Plugins.

Only verified Previzion users have access to this web utility.  If you are
a Previzion user and/or owner and you are seeing this utility grayed out,
please contact your Lightcraft representative to have this enabled.

Update Procedure

For most Previzion releases, all that you need to do is literally replace
the current  Previzion.exe file with a new one.

To replace Previzion.exe:

1.Start by backing up your current  Previzion.exe, located in 
C:\Program Files\Lightcraft\Previzion.  You may do this by
copying it to another location.

2.Download the Previzion release from Dashboard.  Regular
releases are typically named Previzion-###, where #### is the
build number.

3.If the file is in a zip archive, extract the zip.
4.Rename  Previzion-###.exe to  Previzion.exe
5.Copy this new Previzion.exe to C:\Program

Files\Lightcraft\Previzion
6.Launch Previzion and verify that it is working properly.

Depending on the amount of change from one Previzion build to the
next, you may need to run a Previzion Installer.

To run full Previzion installers:

1.Start by backing up all your scenes, lens files, takes, save states
and any important data that you may be using in your
productions.  Previzion installers do not usually erase any user
files, but it is always good practice to have these backed up.

2.Dowload the Previzion installer from Dashboard.  Installers
usually follow this naming convention: InstallPrevizion-####,
where #### is the build number in that installer.

3.If the file is in a zip archive, extract the zip.
4.Run InstallPrevizion-####.exe following the instructions on

screen. (Please note that the installer needs to be "Run as
Administrator".  To do this, right click on the installer exe file and
select "Run As Administrator".)

5.Launch Previzion and verify that it is working properly.

Not all installers are compiled with the latest Previzion builds, so you
may need to run full Previzion installers first then replace
the Prevision.exe with the latest one.

 

Installing Hardware Licensing File

Hardware License file is an authentication file that works with your
Previzion license dongle to protect your Previzion system.

To get your company Previzion license file (named
PrevizionLicense.xml):

1.Go to C:\Program Files\Lightcraft\GetSystemId\ and
open GetSystemId.exe

2.When the utility opens, click on "Run"
3.Input your company name and the system number (if you only

have one system, this will be "1".  For a second or third system,
enter "2" and "3", respectively, and so on).

4.Select "Done"
5.Click on "Copy All"
6.Paste this text into an email and send it to support (at)

lightcrafttech.com
7.We will reply with your license file within 24-48 hours.
8.Simpy copy your license file in the same folder as

Previzion.exe C:\Program Files\Lightcraft\Previzion\  
9.Launch Previzion and confirm that everything is working

properly.

Any build numbered 6800 and above will be required to have a
Previzion license file.
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Intersense Problems

Why can I get Intersense to lock in ISDemo
but not in Previzion?

If you get the green crosses and white boxes in ISDemo, then getting it
working in Previzion should be straightforward.  The most common
mistake here is to load a constellation file (cfg) in ISDemo, verify
tracking and close ISDemo without saving.

Make sure that before you exit ISDemo32, are you saving
configurations to "Permanent Memory."   To do this, in the main
ISDemo Window, after verifying that tracking is locking, selecti File ->
Save Current Settings. When the dialog box requests to confirm to
"Save to permanent memory?", make sure to confirm.

Read more about these settings in Verify Tracking.

Why can't I get the Airtrack to "Enable" in
Previzion?

When running the Airtrack/Intersense inside Previzion, you need to set
these as your Location tracker in the Tracking Tab.  When
"Airtrack/Intersense" is selected as your location tracker, by default,
IS_SERVER (the command looking window) opens and opens
communication with the Intersense.  You can verify that these are
working by clicking on the "Configure" button to the right of your tracker.
 This will open the Airtrack/Intersense Configure Window.

If the Airtrack does not have a green light next to it and it is enabled,
make sure there is a sync (Genlock) source being fed to the
Airtrack's Genlock input.

You need to have a stable Sync source - either the Airtrack plugged into
an AJA GEN10, an Evertz 2530 DAC, or similar source of tri-level sync.
The frame rate should be shown in the right side of the UI panel, as
under the Sync Warning Lights.

On the camera side, it is easy to check if the Airtrack is getting a sync
source, by looking at the bi-color "Sync" LED.  When there is not sync
source being fed to the Airtrack, you will see a red light.

When there is a sync source being fed to the Airtrack, you will see a
Green light.

When using "P" (Progressive) sync signals, with RED cameras in
particular, this LED will light Amber.

What is ISDemo Supposed to look like?

When you start up the Intersense inside Previzion, it generates a sync
function that genlocks the data from the Intersense. If you look at the
sfServer startup sequence and sfServer window, you should see a
couple of things in the sfServer window:

Found Mutex Sync Object
Vertical Refresh Rate: 59.94 or 47.96
The bottom left number should be around 180 for 59.94
operation, or about 135-140 for 47.96 (23.98) operation.

Also, check to make sure that the Intersense "Pitch" level is set inside
Previzion correctly, by clicking the "Configure" tab next to the
Intersense dropdown in the Previzion UI . . the Previzion setting
overrides the setting inside ISDemo32 when Previzion is started up.

Basically, if it locks to targets in ISDemo, it will work inside Previzion, so
it's probably one of the above settings.

Intersense stops responding.

Deselect Intersense from the Position and Rotation tracking
menus.
Deselect Airtrack from the Rot Smoothing menu.
Power cycle the Intersense (unplug the larger 3 pin power
connector from the mounting case, wait 10 seconds, and plug it
back in.)
Reselect the Intersense from the Rotation tracking menu. Wait
5-10 seconds for the light to come on. The background should
start moving around.
Reselect Intersense from the Position menu.
Reselect Airtrack from the Rot Smoothing menu.
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Video Problems

Why am I getting a split video with a
horizontal black bar?

Sometimes having several video format options can be quite confusing.
 If you are getting a split video image on your input, triple-check your
camera output.  If you feed a "PsF" signal and tell Previzion that it is a
"p" signal, you may get something like this:

Whenever a camera manufacturer (other than RED Camera) says that
their camera records at "24p" or "23.98p" what they actually mean, as
far as Previzion is concerned, is "23.98PsF".  To adjust this, adjust your
video input format in Video Tab to the proper format.

It is important to note that all RED cameras (One, Epic, Scarlet) actually
output a true "p" signal.  Check our Red Camera Connections Pages for
more information on RED One and RED Epic/Scarlet.

Another important thing to note is that some cameras, like the Arri
Alexa, have the capability of internally recording "PsF" and outputting
over "MON OUT" a "p" signal.  Triple check that these are set properly.

I am not getting any video coming into

Previzion.  How can I check my incoming
video signal?

Not getting video in the Previzion screen could be a hand-full of things.

Let's check that we have video enabled.  If there is video coming into
Previzion, but it is not being displayed and there is no error light on,
make sure that HD-SDI 1 in the Video tab is "Enabled."

To enable video, simply select "Enable" and the green light next to is
should go on.

If this triggers the Video Source error light, then there is no video
coming into Previzion.

Check that the camera output is indeed connected and outputting a
valid video signal.  You may plug an external monitor to this signal to
check its validity.

Also check that your cabling and connectors are all properly seated.

For reference drawings and connection diagrams, read our Connections
Page.

Output HDSDI Video Stutters

If the output HDSDI video stutters after changing frame rates, power
cycle the system, including removing the power cord for 10-20 seconds.

Timecode Repeating Error Light.

Most likely this means the device Previzion is getting its
timecode from is not "FreeRun" time code or "Generated
timecode", but is instead set to "Rec-Run".  This means
Previzion is only getting new timecode numbers when the
timecode generating device is recording, constantly regardless
of record state like Previzion likes.
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External LTC timecode not recognized.

Exit Previzion.
Start All Programs->Merlin->BRec1. Verify that there is a green
bar 2/3 of the way up on the "Audio Level R1" display. Click
**LTC** on the top VTR timecode display to verify LTC
timecode.
If timecode is not displayed, check connections according to 
timecode settings.
Power cycle AJA ADA4 converter.

What if I am still having video problems?

Contact our support team for any video/camera setting questions or
concerns.  Our world class team has seen, worked and troubleshooted
with virtually all professional level cameras.

We chase video signals down everyday.
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Rendering Speed

Tuning for Rendering Speed

If the scene is dropping frames, there are several areas to tune.  You
may not be able to use all of these depending on your setup, but these
are nice things to have in your bag of tricks to speed up scene render
and prevent dropped frames.

Most of these settings will be located under Scene tab.

Enable Antialising: disable anti-aliasing by un-checking this
box.  Antialiasing is a process through which hard edges,
corners and high-frequency patterns are soften to look more
photorealistic and more visually pleasing.
Motion Blur: turn motion blur off by setting Motion Blur Scale
to 0.0.
Enable Foreground: disable "Foreground Rendering" when
possible by un-checking this box.  This make it so all CG
elements are only rendered behind the live video plane.
Depth of Field: This is one of the most computationally
expensive steps in the rendering process. Setting DOF to 0.0
will substantially lower rendering time.  The default value is 1.0,
but the scale can be increased to emphasize the depth-of-field
effect.  We recommend leaving this scale to 1.0 and simply
changing the f-stop value parameter in Lens tab.
Keying Matte Horizontal and Vertical Blur: Set to 0 to remove
chroma edge blurring. Required for correct interlaced field
keying.
Show/Hide CG Objects: un-check "SHOW" for edit_ objects
that are not being seen in the scene.  Previzion only renders CG
elements that are in the view of CG camera.  However, it is
helpful to hide elements that are not being seen to optimize
render time. If your scene is built with edit_ objects you can
disable elements of your scene that you may not need, or in
older versions raise them very high or drop them very low on the
Y access so their geometry doesn't render since it isn't in the
field of view.
Remove unused video playback elements from the list of loaded
elements.
Pause videos which are not going to be seen.
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Updating Video Firmware

Check Firmware Revision

Open BRec, and right click the circle and triangle icon in the top
left corner. Select About BRec.
The F1 Rev should display 0x03 - 04 for Firmware rev 3, subrev
4.

Updating Video Firmware

Download the current firmware, and unzip it to a local directory.
This is located under Previzion Builds/Plugins under Previous
Releases

In a MS-DOS prompt, navigate to the directory location and
type: eepmerlinip -b1 -q3 -w16 MerlinIP_110.bit
Wait while firmware is updated and completion message
appears. Press Enter to exit.
Power down the system, and remove the power cord for 10
seconds to completely remove FPGA state.
Start up the system, and verify in the Hardware Manager that
the card is properly recognized.

Updating BRec

You may need to install a later version of BRec, if the RC198 version
does not properly recognize the display card.

Use the same zip file as "Updating video Firmware" and replace
the BRec.exe in the C:\Program Files\SkyMicro\Merlin directory
with the new one.

Installing Current Driver

This is rarely needed, but just in case:

Use the same zip file as "Updating video Firmware" and unzip it
to a temp directory.
After powering up, use the Device Manager to install a new
driver.

To access Device Manager, right-click on My Computer and select
Properties, then select the Hardware tab and click on Device
Manager.

Direct the driver selection to the /driver\_0x32\_04/driver directory. The
MerlinIP board should show up in Device Manager as below.

Page 392

http://dashboard.lightcrafttech.com


Previzion - User Manual
by Lightcraft Technology

Tracing Blue Screens

Tracing Blue Screens

If a system blue screens, use your phone to take a close up picture of
the screen. Pay close attention to the IRQ# of the screen. After the
system starts back up, track down what IRQ was triggered by
generating an IRQ list:

Start->Control Panel->Performance and
Maintenance->System->Hardware->Device Manager
Select View, then Resources by Type. Click the IRQ list to open
the entire list.
Alt-PrintScreen to capture the image, then open up
Accessories->Paint and Control-V to paste this image.
Save this under Desktop->IRQ_List.jpg. This way, if a system
blue screens, the offending IRQ can be tracked down.

This image is created by default on newly built systems.
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Updating GPU Driver

GPU/Windows Updates

When recommended by your Lightcraft representative, it may be
necessary to update your GPU driver along with other nVidia Drivers.
 In Windows 7, most all drivers get pushed as Windows updates and
are automated in their installation.

Previzion "initializeGl" errors

If, after a Previzion software update, Previzion reports error logs about
"ColorModule::initializeGl" and "Pipeline::initializeGl", perform a
Windows Update and look for the nVidia Driver updates.

It's not uncommon for Previzion to be using the absolute latest nVidia
driver.  However, avoid installing any "Bing Desktop" updates that
sneak into Windows Updates.  These slow down system performance.

Setting VSYNC Off

In order to work correctly, Previzion requires that the VSYNC setting on
the Quadro card be set to FORCE OFF. To do this:

Right click on the desktop, and select nVidia Control Panel
Select Manage 3D Settings
Select 3D App - Default Global Settings
Select Vertical Sync and set it to Force Off
Exit the nVidia Control Panel
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Updating Runtime

Updating Visual C Runtime

Microsoft will occasionally update the C runtimes as part of their
automatic update. If the Previzion build was compiled with a later
version of the C runtime than the build on a system, executing Previzion
will fail with a message indicating that re-installing the application may
fix it.

The correct fix is to install the most up to date version of the C runtime.
 Once downloaded, simply execute to update Runtime.

You may download the latest version of Microsoft Visual C Runtime
from our Download Dashboard.

 

June 2011 Security Update

With builds later than May 2011, this update needs to be installed on
the target machine using Internet Explorer:

http://support.microsoft.com/kb/2538242

To run this update, go to on the link above and select
"http://update.microsoft.com/microsoftupdate/" under "Skip the details:
Download the updates for your home computer or laptop from the
Microsoft Update website now."

This will launch a web browser instance of windows update.  However,
this will automatically prompt you to install and/or enable ActiveX plugin
with Windows Update.

Click on the Yellow Bar and allow this addon.
Make sure to select "Custom" and NOT "Express" installation
when prompted.  Windows Update will run the same, but this
allows it to find important Visual C++ updates.

If you haven't updated Windows in a while, you may need to run
Windows Update more than once.
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Loading FBX in Maya

Why am I unable to open .fbx files in Maya?

If you are running into an error when trying to open .fbx files that reads
"Unrecognized file type," this is due to a disabled option in Maya.

To enable fbx in Maya, do the following:

In Maya, navigate in the menus

for Window>Settings/Preferences>Plug-in Manager

Then select FBXMAYA.MLL for both Loaded  and Auto Load.

Try importing your fbx scene.
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Intersense Station Settings

Intersense Station Settings

The Intersense settings for prediction, smoothing, and enhancement
are reached from the main window by selecting Parameters->Station
and Sensor Parameters, and then clicking Change:

Lightcraft recommends the following default settings for correct
operation with the Intersense IS1200:

Perceptual Enhancement: 1 (setting this to 2 will cause strange
horizontal sliding behaviors.)
Sensitivity Level: 3
Prediction Value: 0
Tip Offsets: 0, 0, 0

The sensor rotation is set from within Previzion in the
Intersense/Airtrack configuration panel.

If you change any of these settings, make certain to save them in
permanent memory with File->Save Current Settings from the
main  menu.
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Intersense Diagnostics

InertiaCamDemo or sfServer Slow Start

If InertiaCamDemo or sfServer takes an unusually long time to sync to
the IS1200, there is probably another serial stream present. Disconnect
the serial streams to the Airtrack and turn off the encoder box to isolate
the IS1200 behavior.

Hardware Refresh Rate Too Slow

When the IS1200 is working properly, the hardware refresh rate
(highlighted in red above) is between 120 and 180. If this number is
much lower, like 9 or 5, then the IS1200 is not responding to the
sfServer calls. Typically, the remedy is to turn off sfServer, power cycle
the IS1200, and then restart sfServer.

Intersense won't lock

Several things can cause this, here is a quick list of things to check for.

Do you have the correct constellation loaded? Follow these
steps
Are your fiducials the correct size for the distance you are trying
to detect them IS1200? More info here
Do you have the required Intersense files in the CFG folder?
The IS1200 requires the following items be present in the CFG
folder;
11x17_Banner.cfg, rootGalaxyPSEs.cfg,
vehicle1\defaultVehiclePSEs.cfg,
vehicle2\defaultVehiclePSEs.cfg
If you have accidentally deleted these and do not have a backup
copy they are available on the dashboard as"InterSense
VisTracker Software" or directly from Intersense

Hardware Diagnostics

If InertiaCamTest shows a correct camera image, and 2 devices are
being detected, but the camera refuses to acquire and track the targets,
check the hardware settings with the HWDiags.exe utility, found in
C:\InterSenseVisTracker\Programs\HWDiags.

Click Connect to connect to the tracker. (Make certain that the
Airtrack and encoder serial streams are not connected.)

Camera and IMU self-tests are selected by default. Click Run
Selected Tests to check the hardware status of the camera and
IMU. After setting the camera on a level surface pointing straight
up, click to confirm the test. HWDiags will return the status on
the camera and IMU self-tests.
Click Disconnect to disconnect, and exit the program.
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